Chapter A
Essential Concepts
Essential Concepts

Introduction
Welcome to Digidesign Pro Tools™. Pro Tools is the leading integrated digital studio that uses the power of personal computers to record multitrack digital audio direct to hard disk, while allowing you to integrate other elements of your studio such as MIDI instruments and MIDI sequencers. This powerful combination of technologies provides you with the means to compose, record, mix, and master professional-quality recordings in your own digital studio.

Along with this new generation of digital tools come a number of concepts that may be new to you if you are just getting started with direct-to-disk recording. This chapter explains some of the fundamental concepts behind digital audio and direct-to-disk recording. Before diving into the specifics of using Pro Tools, you may wish to first familiarize yourself with a few basic audio principles and terms. The first sections of your Software User’s Guide provide an overview of the principles of sound, digital audio, and basic audio production.

Before you go any further in this User’s Guide, you should have already installed your Pro Tools Software and connected your studio according to the instructions given in your Installation Guide. If you haven’t already done this, please take a few moments to do so now. You can then return to this User’s Guide and begin learning how to use Pro Tools’s many powerful tools for creative audio production.

About Your Pro Tools Software User’s Guide
This User’s Guide explains how to use the Pro Tools software to perform digital recording, editing, and mixing. If you have not yet gotten Pro Tools installed and operating on your computer, put this book down and open your Pro Tools Installation Guide, and follow the instructions there.

Even if you’re the type of person who simply hates to read User’s Guides (and most of us are), make an exception with Pro Tools. Your Pro Tools system can do some truly amazing things with sound. Your User’s Guide is the key to unlocking its power.
Your Pro Tools User’s Guide is designed to teach you how to use Pro Tools, not how to use the Macintosh. It assumes that you have a working knowledge of standard Macintosh users techniques, including Macintosh basics such as using the Finder, double-click, select, Shift-select, using menus, etc. If you don’t know how to do all of these tasks, spend some time learning your Macintosh before going any further.

How to use this manual

How you approach this User’s Guide will depend on how familiar you already are with Pro Tools and/or digital audio. There are some conventions used in this manual that all readers should be aware of, and these are listed below:

**System Names**

This User’s Guide contains operating instructions for the following Pro Tools systems:

- **Pro Tools Project.** Pro Tools Project is comprised of the Pro Tools software and the following hardware; the Pro Tools Project Audio Card (formerly called the Session 8 Audio Card), and your choice of the 888 I/O, 882 I/O or 882 Studio Audio Interface.

- **Pro Tools 442.** Pro Tools 442 is comprised of the Pro Tools software and a Pro Tools 442 Audio Card and 442 I/O Audio Interface. This system is also known as Pro Tools I-series hardware.

- **Pro Tools with Audiomedia.** Pro Tools with Audiomedia is comprised of the Pro Tools software and an Audiomedia card.

  Note: In this User’s Guide, “Audiomedia” refers to Audiomedia III cards.

- **Pro Tools with DAE PowerMix.** This configuration consists of Pro Tools and the DAE PowerMix software. DAE PowerMix is a DAE Extension that allows you to run Pro Tools on your Power Macintosh without any additional audio hardware.

**If you’re upgrading from a previous version of Pro Tools:**

If you’re upgrading (or receiving an update) you should go straight to the following section What’s New In Pro Tools 3.4. There you’ll find a quick rundown of all that has changed since the previous Pro Tools version was released. If you find any subject that you need to know more about, look up that word or feature or on-screen item in the Index at the back of this User’s Guide. The index will show you where to find additional information on a topic.

**If you’re new to Pro Tools or new to digital audio:**

If you’ve never used Pro Tools before, we recommend you read through as much of your User’s Guide as you can regardless of how much audio experience you may possess. The first few chapters (Essential Concepts, Pro Tools
Chapter A: Essential Concepts

Basics, Working with Tracks) cover the basics of Pro Tools and digital audio (terminology, concepts, etc.), and describe Pro Tools’ windows and on-screen features in detail. Later chapters get into specific tasks — Recording, Editing, Mixing, Working with MIDI, etc.

What's New in Pro Tools 3.4

Version 3.4 of the Pro Tools software has several new features and enhancements, including:

- Stereo recording and up to 16-track playback on a Power Macintosh without Digidesign hardware when used with the DAE PowerMix extension. (The number of tracks available depends on the processor speed of the Power Macintosh.)
- Sample-accurate Nudge/Grid via the Nudge/Grid pop-up menu in Minutes:Seconds, Feet & Frames, and Time Code modes
- Batch importing of mono and stereo audio files into an open Session via “drag and drop” in the Finder
- Batch deletion of unused files from within a Session
- A Get Info command which allows you to create and store notes about a Session within the Session
- Support for other Digidesign hardware, allowing Pro Tools to be run on Session 8 (Pro Tools Project) and Audiomega systems (functionality will vary).
- Numerous performance improvements

The Physics of Sound

Analog Audio

Sound is composed of sound waves. A sound wave behaves like a ripple in a pond—it travels outward from its source in all directions. If you were to drop a pebble into a pond once every second, there would be a new wave created with each pebble dropped, and the resulting waves would have a frequency of 1 wave per second.
Sound waves are actually variances of pressure in the air. In the audio world, the number of sound waves (cycles) per second are measured in Hertz, which is abbreviated “Hz.” One Hertz = 1 cycle per second. Higher numbers of Hz are perceived by humans as having a higher pitch. The human ear can perceive sound in the frequency range of 20 to 20,000 Hz, though for many adults this range is probably 20 to 16,000 Hz as an individual’s audible frequency range decreases with age.

Microphones take these pressure waves and convert them into electrical signals. Audio represented by these actual electrical voltages is called analog audio. When the pressure increases towards the microphone a positive electrical signal is generated. Conversely, when the pressure is away from the microphone a negative electrical signal is generated. Speakers reverse this conversion process by generating pressure waves from an electrical signal.

**Digital Audio**

Your Pro Tools-equipped Macintosh computer stores audio digitally. This means that analog electrical signals from microphones or other sources are converted into numbers, which are then stored in a digital medium (hard disk, CD-ROM, compact disc, etc.). Conversion from analog electrical signals into numbers is accomplished using a technique called digital sampling. Digital sampling takes a numeric “snapshot” of the voltage over and over again in precise intervals, similar to the way individual frames of film capture action in a movie camera. The number of snap shots or samples taken of the audio in a second is called the sample rate. The more samples taken, the better the quality of the audio. The audio on compact discs, for example, is recorded at 44,100 samples each second (or 44.1 kHz). A 44.1 kHz sample rate produces very high quality audio.

Another factor that affects the quality of the audio is the accuracy of each particular sample. Digital audio uses a number to represent or describe the content of each sample—the higher the number, the more detailed the sample. The following analogy explains why this is so. Imagine if you had to measure the distance between two points using a ruler, but were forced to only use numbers matching the marks on the ruler. If you had a ruler with marks only at inch intervals, your measurement would be accurate only to the closest inch. But what if the marks were 1/4 inch, or 1/8 inch, or even a thousandth of an inch? Then you could measure much more accurately. With digital audio, the accuracy of the sample is determined by the bit resolution of each sample. 8-bit resolution provides 256 different numbers to represent the signal level at the moment the sample is taken. 16-bit resolution provides 65,535 different numbers. Now you can see why bit resolution makes a big difference in digital audio quality.
About the Digidesign Audio Engine (DAE)

When you start the Pro Tools software you will notice that an application called DAE automatically launches in the background. DAE stands for the Digidesign Audio Engine. It is Digidesign’s real-time operating system for digital recording systems. When you install Pro Tools, DAE is automatically installed inside your System folder.

In the same way that the Macintosh System software provides the foundation for programs that run on the Macintosh, DAE provides the hard disk recording, digital signal processing, mix automation, and MIDI functionality required by Pro Tools and other products from Digidesign and its Development Partners. Because DAE is an application itself, it supplies these capabilities to any products (such as StudioVision™, Logic Audio™, Digital Performer™ or Cubase Audio™) which utilize Digidesign DSP cards to record and play digital audio.

DAE allows such programs to run on virtually any Digidesign DSP card. Thus, a Macintosh digital audio sequencing program can run on a Pro Tools III, Pro Tools Project, or Audiomedia III card installed in your computer.

Another benefit of DAE is that such programs need not be updated when future Digidesign DSP hardware cards appear: Digidesign will simply update DAE and the necessary resources will be available to them.

The only thing that you really need to remember about DAE is this: You never need to run or quit DAE by itself. When you start Pro Tools, DAE will automatically start. When you quit Pro Tools, DAE will automatically quit.

What is DAE PowerMix?

DAE PowerMix is a DAE™ (Digidesign Audio Engine) Extension which enables the PPC processor in Power Macintosh computers to perform as a playback engine and provide the required DSP power to run Pro Tools software. With DAE PowerMix in a PPC-equipped Macintosh or clone, Pro Tools can operate without any additional Digidesign hardware being present in the system. Users who have both capabilities can take advantage of both the Audiomedia’s 16-bit RCA input/output jacks for system i/o, and then switch the Playback Engine to DAE PowerMix to obtain up to 16 tracks of simultaneous playback.

DAE PowerMix is installed in a folder “DAE Extensions” which is created by the Pro Tools Installer within your DAE folder in your System folder.
Some New Recording Terms and Concepts

Pro Tools has a lot in common with traditional multitrack recording. However, Pro Tools also provides some distinctly new and exciting concepts and creative tools that may be new to you. Before you jump straight into recording, take a moment to look over a few of these concepts. They are essential to understanding Pro Tools.

How Hard Disk Recording Differs From Tape-based Recording

Hard disk recording systems and tape-based recording systems are two very different things. Tape recorders use a linear recording medium. This simply means that recording is done “in a line”—the line being the tape itself as it moves from beginning to end. To record or play the magnetic signals that make up sound on tape, a tape recorder physically moves the tape across its tape heads. In order to hear a portion of a song recorded on tape, you have to rewind or fast forward the tape to a particular point and play it.

Hard disk recording is quite different. It’s not a linear medium, but a random-access medium. This means that you can go to any spot in a song at random, and do it immediately—without having to rewind or fast forward to get there. This is because sound is not recorded upon a fixed piece of tape, but stored in digital format as a series of ones and zeros on a hard disk. This design allows the audio to be randomly accessed as follows:

A hard disk works something like a CD recorder/player. It has a platter similar to a CD where the data is recorded, and a read/write head like a CD player’s laser head that does the actual recording and playback of data. To read the digital audio information stored on the hard disk, your computer simply “drops the laser head” (the read/write head) in a specific location. Among the many benefits of hard disk technology, two are immediately relevant to recording: First, you can access any part of a recording almost immediately. And second, you can rearrange the parts of a recording even after you’ve recorded them.

Rearranging a recording is achieved by simply making the hard disk read parts of the recording in a different order (similar to telling your CD player to skip from track 1 to track 7). You can digitally “cut and splice” pieces of sound to rearrange or repeat any and all parts of your recording—without ever actually changing or copying the source material. This ability is referred to as non-destructive editing.

Your Hard Disk is Your “Workspace”

Another difference between recording on a hard disk and recording on tape is how you approach your recording projects. In general, you can think of your hard disk as a
"workspace" for your current project. When you begin composing and recording, you do it on disk. When you finish the project, you move it or archive it on DAT tape or another long-term storage medium. That way, your hard disk is free for a new project. After archiving, an occasional bit of hard drive maintenance (optimizing, reformatting, etc.) contributes significantly to the overall performance of your system. Just as open reel decks need to be cleaned and calibrated occasionally, hard disks require their own type of regular maintenance.

How much recording time does a hard disk provide? It depends on the size of the hard disk. Each of your tracks will take five megabytes of hard disk space per minute of recording (at a sample rate of 44.1 kHz). That means that if you are recording simultaneously to 4 tracks you will use about 20 megabytes of disk space per minute. Recording 8 simultaneous tracks for one minute would consume 40 megabytes, 80 megabytes for 2 minutes, and so on. Recording 16 tracks simultaneously will consume in the neighborhood of 80 megabytes per minute.

Though this new approach to recording and editing sound may seem strange to you at first, it will soon become second nature, and you will find that it is far more powerful and flexible that any kind of recording that you've experienced before.

**Essential Concepts Defined:**

**Sessions, Regions, Playlists, Tracks, Voices, and Channels**

Because Pro Tools is a new technology, certain recording terms such as tracks and channels take on new meanings which you should understand before you start using your system. Before you proceed any further, here are some essential terms you should know.

**Session**

A Session is the document which Pro Tools creates when you start a new project. In fact, you could say that it is your project. It contains "maps" of all of the elements (audio, MIDI, and automation) associated with your project. Pro Tools will store each new Session in its own folder. Inside the Session folder will be the Session document, plus an Audio Files folder and a Fade Files folder.

**Sound files**

Each time you record and save a take, it is stored on your computer's hard disk as a file, much like a word processor creates a text file when you type a letter on a computer. We refer to the digital audio files which Pro Tools creates as sound files. Pro Tools saves sound files in the Session's Audio Files folder.
Regions
Once you have recorded a sound file you can divide it up into pieces, or regions, and rearrange them as you like in a track. A region can consist of a musical riff, a verse, or even a single note from a take. You define regions to suit your specific needs. For instance, you could perform several takes of a solo, select the best portions of each take and, by defining each fragment as a region, assemble them into a single composite solo comprised of the best parts from the various takes.

Playlist
A Playlist is a term used to describe a list of regions strung together in a specific order. Because audio is recorded to hard disk in Pro Tools, this list merely tells the hard disk which sections of which audio files to read and in what order. By reusing regions, sections of a recording can be repeated without using any additional disk space.

Tracks
A track is where audio or MIDI regions are strung together for playback. A track can be made up of a single file, a single region or many regions. It can be made up of similar elements, as in the case of a guitar solo track made up of regions from several different “takes” of the solo, or it can be made up of dissimilar elements, as in the case of a track made up of several sound effects. Each Pro Tools Session typically consists of multiple tracks.

The maximum number of allowable tracks is defined by the Pro Tools system being used. (See the table which follows.)

Voices
Voices refers to the number of digital audio events that Pro Tools can play back at one time. Each Pro Tools system (Project, Audiomedia III, DAE PowerMix) has its own limit as to how many digital audio “voices” can play at one time. (See the table which follows.)
Table of Track and Voice Limits of all Systems

The following table lists the Track, Voice and simultaneous recording limits of each system.

<table>
<thead>
<tr>
<th>System</th>
<th>Tracks</th>
<th>Voices</th>
<th>Simultaneous Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pro Tools Project</td>
<td>up to 55</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Pro Tools Audiomedia III</td>
<td>32</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>Pro Tools w/DAE PowerMix - 16*</td>
<td>64</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>Pro Tools w/DAE PowerMix - 12*</td>
<td>48</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Pro Tools w/DAE PowerMix - 8*</td>
<td>32</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

*About Pro Tools with DAE PowerMix

Track and Voice performance of Pro Tools with DAE PowerMix is dependent upon CPU and hard disk speed. The following table shows you what each Power Macintosh CPU provides (NOTE - Power Macintosh models 7200/90 and 7500/100 are limited to 8 tracks):

- 100 MHz or faster: 16
- 80-100 MHz: 12
- <80 MHz: 8

Channels

A Channel refers to a physical input or output. The number of inputs and outputs available is determined by the Pro Tools system you are using. The following table lists the channel capabilities of all audio interface options for Pro Tools Project.

Pro Tools System Channel Capabilities

The 888 I/O, 882 I/O and 882 Studio provide 8 channels of input and output. For use with Pro Tools III and Pro Tools Project.

Pro Tools Audiomedia III provides 2 channels of input and output.

Pro Tools with DAE PowerMix, using the Power Macintosh’s built-in audio convertors, provides 2 channels of input and output.
These terms will become even clearer to you as you begin to actually use your Pro Tools system. In the next section you are going to learn another key concept which is closely related to tracks and voices—virtual tracks.

### The Difference Between Virtual Tracks and Physical Tracks

Pro Tools features an architecture that is unique to the digital audio workstation: the virtual track system. A tape deck records only physical tracks: there are a fixed number of physical tracks on the record and play heads, and the same number of physical tracks on the tape itself. A 4-track analog recorder can record a maximum of 4 tracks, and can play back all of those tracks simultaneously.

A virtual track system operates on a different principle. For example, the Pro Tools Project system provides for up to 55 virtual tracks—tracks which can be recorded upon and cued up for playback but cannot all be played back simultaneously. Such tracks are called “virtual” tracks because they provide virtually all of the functionality of physical tracks except for this limitation.

The number of virtual tracks supported by each system varies, as described below:

<table>
<thead>
<tr>
<th>System</th>
<th>Tracks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pro Tools Project</td>
<td>55*</td>
</tr>
<tr>
<td>Pro Tools Audiomedia III</td>
<td>32*</td>
</tr>
<tr>
<td>Pro Tools with DAE PowerMix 16</td>
<td>64</td>
</tr>
<tr>
<td>Pro Tools with DAE PowerMix 12</td>
<td>48</td>
</tr>
<tr>
<td>Pro Tools with DAE PowerMix 8</td>
<td>32</td>
</tr>
</tbody>
</table>

*Power Macintosh users can switch the Playback Engine to DAE PowerMix and use as many as 64 virtual tracks on playback. See also the explanation of Virtual Voices in Chapter B for more information.

The benefit of a virtual track system becomes clear when you think about the nature of a recorded track. Although some audio tracks in a Session (a drum or bass track, for example) often contain audio from beginning to end, most tracks actually only occupy a small portion of the entire tape. If you were to look at the placement of audio on a typical multi-track tape, it would probably look something like a checkerboard, with “patches” of audio interspersed with blank areas. For example, you might have a track called “Guitar Solo.” Although the solo lasted only 10 seconds, it would probably occupy an entire track in a typical studio session. This is because engineers and producers tend not to place other material on the same track (a vocal overdub, for example), because it would require its own EQ, pan, effects, and level.
A virtual track system addresses this situation by allowing you to create separate tracks for each audio element, each with its own volume, pan, EQ, effects sends, and automation. They act like individual tracks, and as far as the engineer/producer is concerned they are individual tracks.

This provides two significant advantages: First, you can have up to 55 tracks in a given Session (the maximum number is determined by your system configuration). You can then simply choose which of these tracks you wish to play (depending on the total number of available voices), and hit the play button to play them. You never need to erase tracks to make room for other tracks—provided that you have enough space available on your hard disk to store all of them. You can keep dozens of alternate takes of vocals, solos, etc. and always have the freedom to go back and pick and choose the optimum one.

Second, because Pro Tools' virtual track's are dynamically allocated, when a "hole" opens up in one track, its voice is temporarily available and another track, assigned to the same voice, can "pop through" the hole and begin to play. If the original track reaches a point where audio occurs again, the track that had popped through relinquishes the voice to the original track.

You have the power to determine which tracks are allowed to "pop through" holes in other tracks. The way that you actually assign priority to tracks is described in greater detail in Chapter C: Working with Tracks. The most important thing for you to remember is that by arranging tracks so that lower priority tracks can pop through gaps in higher priority tracks, you can get much more performance out of say, a "4-channel" system than just 4 tracks. Learning to use virtual tracks well is an essential part getting the most out of Pro Tools.

The Cycle of a Typical Pro Tools Project

When you begin a project with Pro Tools, you create a Session. A Session is a Macintosh file that contains information about all of the elements associated with a particular project. When you create and save a Session, Pro Tools remembers all aspects of the Session setup: what sound files were associated with the Session, your mixer settings and voice assignments, signal routing setup, EQ configurations, and other aspects of the Session. (This information is saved within the Session document itself. Pro Tools saves your system configurations — i.e., Preference settings, Hardware settings, etc.— in a Pro Tools Preferences file which gets stored in the Preferences folder inside your System Folder.) When you open a Session created earlier, the Session appears exactly as it was saved, and the associated sound files and settings are loaded automatically (as long as you have not altered your system configuration).
Many Pro Tools music projects will typically progress something like this:

- Import some basic MIDI tracks into Pro Tools and record digital audio tracks in sync with them. Punch in any new audio you need and set basic levels for playback. When you have a rough layout of your Session with audio and MIDI, open the Edit window.
- In the Edit window, try out various arrangements of your audio and MIDI tracks—repeat verses, swap choruses, fix mistakes, etc. Continue until the structure of your Session is complete.
- Next, record any additional MIDI tracks to accompany your digital audio tracks. Finally, add any EQ or effects processing, automate a full digital mixdown (with EQ and effects), and mix the Session to a digital stereo master (on disk or DAT). The digital stereo mixdown is then ready for mastering to CD using Digidesign’s optional MasterList CD software.

1. Import MIDI and Record audio in the MIX or EDIT Window.
2. Edit and arrange audio in the EDIT Window.
3. Add EQ, FX and mix down in the MIX or EDIT Window.
4. Bounce stereo master to disk and record it to compact disk (using Digidesign’s MasterList CD™, not included), or record your stereo master to DAT.

A typical Pro Tools music session

If you are using Pro Tools for audio post or broadcast production, your exact project flow may be somewhat different, but the principles are generally the same. Pro Tools 3.4 adds greater flexibility in how projects are completed, because of the ability to open any Pro Tools 3.2 or later Session on any Pro Tools Project, Pro Tools with Audiomedia, Pro Tools with DAE PowerMix, or Pro Tools 442 core system, regardless of the hardware used to record or create it. This allows corporations and large facilities to run multiple smaller editing suites to complement a full Pro Tools III system.
Keeping Your Hard Disk Tuned Up

Because Pro Tools is a disk-based audio production system, keeping your hard drives in good operating condition is essential. Like most other recording devices, hard drives require regular maintenance in order to operate at their optimum level. In this section, you'll learn about formatting, optimizing and initializing hard drives and when you should perform each of these functions to keep your system running smoothly.

Avoiding Fragmentation

For maximum efficiency, digital audio files should be written to your hard drive in a "contiguous" fashion—that is, in an unbroken stream on the disk, similar to a vinyl record, where sound is recorded in one continuous groove from beginning to end. This helps keep the drive from having to search very far to find the data it needs for playback. Unfortunately, your computer can’t always store the sound files in this way because there are other files taking up space on the disk. Thus, when your computer writes a new file, it has to write it where it can find space.

When there are very few files on your hard disk, there is plenty of open space where files can be written contiguously. But as the disk fills up, the areas of open space become fewer and smaller. The end result is that the drive has to break file data into smaller and smaller sections and scatter them around the disk, writing them wherever there is space. This slows down the drive because when it comes time to read the data, it has to do a lot of searching to find the different pieces that make up the file. This phenomenon is referred to as fragmentation.

To keep your drive's performance at a maximum, it's best to keep file fragmentation to a minimum. As fragmentation increases, it's harder for the drive to retrieve and send file information to the computer quickly. What happens if the computer doesn't get the information fast enough? Disk errors, which can interfere with playback of audio. Even minor fragmentation can result in stuttering playback of sound files.

Optimizing Your Drive

What can you do to prevent this from happening? You can optimize your drive. This means rearranging your files into a contiguous form. There are many software programs that do this for you. When you optimize a drive, each file is regrouped and arranged on the drive in a linear format, making it much easier for the drive to access the data when it's needed. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. The amount of fragmentation found will determine if your drive needs to be optimized. In most cases, if your drive shows over 5% or 10% fragmentation, you should consider optimizing it.
How often should you optimize? If you use your system several hours a day, five days a week, you may want to check your drives on a daily basis, since it doesn’t take long for even a large hard disk to become fragmented. This recommendation applies to less frequent usage as well. The more often you check your drives, the fewer problems you’ll have. However, optimizing a hard disk can take time. You should probably allow up to 30 minutes for a 600 Mbyte drive and one hour for a one gigabyte drive. This may take substantially less time if the drives are not completely full. Also, different brands of optimizing software may be faster or slower than others. Since your files will be rewritten by the optimization process, always remember to make a backup copy of the data on your hard drive before you optimize it! This also applies when formatting and initializing your hard drive too, which are discussed below.

**Formatting Your Drive**

In order for a hard drive to locate and rearrange its files, its directory must also be in good shape. The drive’s directory is like a map that the drive refers to in order to locate files when the computer asks for them. Hard drives are a magnetic medium, and over long periods of time, typically months, magnetic data can start to lose its coercive properties. When this happens, it may become difficult for the hard drive to locate files as efficiently.

To prevent directory problems from occurring on your system, it is important that you format your hard drive on a regular basis. Formatting a hard drive replaces the drive’s directory and will also erase any data that is currently on the disk. That is why it is important that you back up (make a safety copy of) all the sound files and other information on your drive before you reformat it. Formatting can take up to an hour for larger drives (such as 1-2 gigabyte drives): Smaller drives may take less time.

**How Often Should You Format Your Drive?**

Most computer specialists recommend formatting every three to four months. It’s important to remember though that recording, processing, and playing digital audio is more demanding on a hard drive than an application such as word processing. Thus, it may be wise to “tune-up” your hard drive more frequently. If you find yourself using your system on a very frequent basis, such as many hours a day, you should consider reformatting on a monthly or even bi-monthly basis.

**Initializing a Drive**

The final procedure that you should know about is initializing a drive. What’s the difference between formatting and initializing? As explained previously, formatting means completely erasing the hard drive. Initializing a drive is similar to formatting in that the drive’s directory, volume partition map and drivers are replaced, but in this case, the drive is not erased, nor is a process called verification performed, where each sector on the drive is read/write tested. In most cases, initializing a drive is not as thorough as reformatting one, but it is much faster. If you’re trying to get rid of a problem with your hard drive, you should reformat it rather than simply initialize it.
Software Products that Can Help You Tune Up Your Hard Drive
There are many software products available to assist you with drive maintenance. When the time to format your drive comes around, it is generally best to use the formatting software supplied with the drive. Most hard drives come with a floppy disk containing all the software you need to keep your drive running smoothly. If your drive didn’t come with maintenance software, some commonly used applications that you may wish to look into are Norton Utilities™ and Norton Speed Disk™. Most computer stores carry these products.

In the end, the time you spend keeping your drive in good shape will be well worth the effort. Take good care of your drive and your drive will take good care of your Pro Tools projects.

About Rebuilding your Desktop
One of the best maintenance operations you can perform yourself with very little effort is to rebuild your desktop frequently. This helps your Macintosh keep track of data on your startup disk. You can “rebuild” the desktop with a simple startup keystroke, or with a utility that has this function. This should be done on a regular basis (weekly, monthly, etc.). Consult the documentation that came with your computer for more information.

To rebuild your Desktop:

• Restart your computer while holding down the Command+Option keys. Keep holding them down until a dialog appears asking you to confirm that you want to rebuild the desktop on the drive named.

• Click OK to rebuild the desktop. If you have multiple drives attached to your machine, the Macintosh will give you the option of rebuilding the desktop on each one. Repeat these steps for each drive necessary.

Conclusion
In the next chapter you will learn some fundamental aspects of using Pro Tools, including how to start up and shut down your system, and how to create, open, and save Sessions. Read on!
Chapter B
Pro Tools Basics
Pro Tools Basics

Introduction

In this chapter you'll learn how to start up and shut down your system, how to create, open, close, and save your projects, and other basic skills involved in using Pro Tools.

Starting Up and Shutting Down Your System

Your Pro Tools system consists of several components that have to be turned on and off individually: your Audio Interface(s), your Macintosh computer, and your external hard drive(s). In order for all of these devices to communicate properly it's important that you start up and shut down your system in a specific order.

Start your Pro Tools System in this order:

- Turn on your external hard drives first. Wait 10-15 seconds for them to come up to speed.
- If you plan to work with MIDI equipment, turn on your MIDI interface and other MIDI devices.
- Expansion Chassis (if used).
- Turn on your Pro Tools Audio Interface.
- Turn on your Macintosh.

Shut down your Pro Tools System in this order:

- Turn off your Macintosh. (Use the Shut Down command in the Finder's Special menu.)
- Turn off your Audio Interface (Pro Tools Project only).
- Expansion Chassis (if used).
- If you’re using MIDI equipment, turn off your MIDI interface and controllers.
- Turn off your external hard drives.
Preparing Your System

The first time you use Pro Tools, you must set several parameters of your system so that they match your studio setup. At this point, if you followed the instructions in your Installation Guide, you should have installed your Pro Tools hardware and software, and configured your system by using the Hardware and/or Playback Engine command in Pro Tools’ Setups menu. You should also have installed the demo files included with your Pro Tools system and confirmed that your system was working properly.

Once Pro Tools is configured, you won’t need to reset anything unless you remove and reinstall Pro Tools (to reformat your hard drive, for example). You will also need to configure everything whenever you wish to change settings such as the number of tracks in your session (if you are using Pro Tools with DAE PowerMix) or to change the settings of your Audio Interface (or Audiomedia III card) such as the input format (analog or digital), sample rate, synchronization source, sync mode, and other parameters.

You have two options for configuring Pro Tools Software:

- **If you have a Power Macintosh and the DAE PowerMix extension**: You can run Pro Tools without any additional Digidesign hardware. Pro Tools will provide stereo recording and from 8-16 tracks of audio playback depending on your Power Mac’s processor speed and the speed of your hard drive. This scenario provides the greatest number of tracks, but relies on the Power Macintosh’s built-in 16-bit audio converters for input and output. These built-in converters provide lower fidelity than those found on Digidesign audio cards and audio interfaces.

- **If you have a Power Macintosh AND a Digidesign audio card/ audio interface**: This arrangement gives you the best of both worlds: the high-fidelity input/output of the Digidesign hardware and the Power Macintosh’s 8-16 track capability. For example, you can use Audiomedia III’s high-fidelity input and output to record your tracks; switch to the Power Macintosh hardware to edit, mix, and bounce (with more tracks); and finally, switch back to Audiomedia if you wish to record your master stereo mixdown to an external mastering recorder such as a DAT deck.
To configure your Pro Tools Project, or Audiomedia III system:

- Make sure that you have powered on your equipment in the order outlined in the previous section Starting Up and Shutting Down Your System.
- Double-click the Pro Tools icon to start the software.
- Next, if this is the first time you've launched Pro Tools, the following dialog appears, prompting you to use the Hardware Setup dialog to configure your system:

  ![Hardware Setup Dialog](image)

  - Click OK. The Hardware Setup dialog appears.

  ![Hardware Setup Dialog](image)

  The Hardware Setup dialog (Pro Tools Project shown, configured with an 882 I/O)

  Configuring Hardware Setup for Pro Tools Project or Audiomedia III:

  - In the Hardware Setup dialog you must configure the parameters for your audio card and/or audio interface.
  - Click the Select Card Type button to choose the Digidesign Card that you want to configure ("Project" for Pro Tools Project or "Audiomedia" for Pro Tools with Audiomedia III systems). Once you have selected an audio card, the remaining options in the Hardware setup dialog control that audio card.
• To configure a Pro Tools Project system, click the Interface pop-up menu to select the correct peripheral device (i.e., the audio interface attached to your Pro Tools Project card). Select 888 I/O, 882 I/O, or 882 Studio.

• Click the Sample Rate pop-up to select the appropriate sample rate for the currently selected card and any audio Interface, if applicable (44100 or 48000 Hz). 44.1 kHz is the Compact Disc standard. This will become the default setting for all subsequent sessions until you change it again here.

• Click the Sync Mode pop-up to select the appropriate sync mode on the currently selected Interface (Internal or Digital).

• Click the Digital Format pop-up to select the appropriate digital format of the currently selected interface (AES/EBU or S/PDIF).

• Click the Ch 1-2 Input pop-up to select the input format of Channels 1-2 of the currently selected Interface (Analog or Digital). If you are recording from an analog source such as an analog mixer, choose analog. If you are recording from a digital source such as a DAT deck, choose digital.

• To continue configuring Pro Tools Project or Pro Tools Audiomedia systems, refer to the following sections for specific information about the Other Options button that appears in Hardware Setup. This button provides additional configuration options for the 888 I/O and 882 Studio interfaces, as well as Pro Tools with Audiomedia systems.

• When you have finished setting all Hardware Setup parameters appropriately, click OK. Your Pro Tools system is now ready to use.

Configuring the 888 I/O Audio Interface
(Pro Tools Project only)

If you selected 888 I/O, click the Other Options button to configure the input format for each of the 888's input pairs (analog vs. digital).

Setting the analog/digital format for 888 I/O outputs (888 I/O Audio Interface only)

If you selected 882 Studio, click the Other Options button to configure the routing of your 882 Studio Audio Interface. The window that appears should be familiar to a few 882 Studio Interface owners. If you are unsure of how to route the 882 Studio, refer to the following section Configuring the 882 Studio.
Configuring the 882 Studio Audio Interface
(Pro Tools Project only)

Using the 882 Studio Audio Interface with Pro Tools requires you to “route” interface inputs to specific Pro Tools inputs. When used with Pro Tools, the 882 Studio can be used in Direct Outputs mode or Stereo Mix Outputs mode, described in the following section.

The 882 Studio provides 8 discrete 1/4” inputs, and 8 discrete 1/4” outputs. You can still use the four front-panel inputs on the 882 Studio. To use these inputs, or to set up effect send/return routings, you must first use the Hardware Setup dialog’s Other Options window to route interface inputs to Pro Tools inputs.

The following dialog appears when you click Other Options with the 882 Studio selected:

Routing 882 Studio input jacks to Pro Tools inputs via the Other Options dialog (HW Setup)

This dialog is used to “route” the input jacks on your 882 Studio Audio Interface to Pro Tools’ software inputs. The vertical items listed down the left-hand side of the dialog represent the input jacks on the back and front panels of the 882 Studio Audio Interface. The top-most 8 are the back-panel input jacks, and the bottom 4 (“Front 1, Front 2,” etc.) are the four front-panel Mic/Line inputs. Along the bottom of this “grid” are numbers representing each Pro Tools Project input channel, 1-8. What this design allows you to do is internally send the signal arriving at any 882 Studio Audio Interface input connector to any Pro Tools input channel.

• To route an interface input to a Pro Tools input, click in the box at the intersection of the interface input (the left-hand column of inputs) and Pro Tools inputs (along the bottom of the grid). The example above shows a typical effect send/return routing, using outputs 7 and 8 as Sends, and inputs 7 and 8 as returns. In addition, a single input is shown routed from front-panel Line input 1 to Pro Tools Project input 1.
You should now proceed to the section Choosing Your Operating Mode to continue configuring Pro Tools Project.

Configuring Audiomedia
To configure Pro Tools with Audiomedia, click the Other Options button. The following dialog appears:

![Input Gain slider](image)

The Input Gain slider (Pro Tools with Audiomedia only)

This fader controls the level of the analog input signal coming into the Audiomedia card’s analog inputs. Adjust the input gain as necessary and click OK to return to the Hardware Setup dialog.

**IMPORTANT**
If you ever wish to switch your system from DAE with PowerMix using a Power Macintosh’s built-in audio capabilities to an Audiomedia card or other Audio Card, or vice-versa, use the Playback Engine command in the Setups menu. This command will prompt you to save the current session and close it before it you change your Playback Engine from DAE with PowerMix to an audio card or vice-versa.

Selecting Your Operating Mode
(Pro Tools Project only)

Pro Tools Project has two different operating modes, Direct Outputs mode and Stereo Mix Outputs mode. These modes allow you to configure Pro Tools to match your particular studio setup.

Systems with no audio interface, such as Pro Tools with Audiomedia and Pro Tools with DAE/PowerMix, should always be used in Stereo Mix mode as they lack discrete hardware outputs.
These modes were explained in greater detail in your Installation Guide in Chapter C: Connecting Your Studio. Here is a brief explanation of these two modes again and how they differ:

**Direct Output Mode**
In Direct Outputs mode, track outputs are routed to a single Audio Interface output: 1, 2, 3, 4, 5, 6, 7, 8. Panning controls are not available in Direct Outputs mode.

**Stereo Mix Output Mode**
In Stereo Mix Outputs mode, track outputs are routed to a pair of Audio Interface outputs: 1-2 or 3-4, 5-6, 7-8. Each track contains controls for panning between the selected output pair.

**To choose an operating mode:**

- From the Options menu, choose Preferences. This dialog appears:

![Preferences dialog]

- Choose the desired operating mode, Stereo Mix Outputs or Direct Outputs.

If you choose Stereo Mix Outputs mode, track outputs are routed to pairs of Audio Interface outputs: 1-2, 3-4, 5-6, 7-8. If you choose Direct Outputs mode, track outputs are routed to a single Audio Interface output: 1, 2, 3, 4, 5, 6, 7, 8. Panning controls are not available in Direct Outputs mode.

- After choosing your operating mode, click OK. To learn about the other options in the Preferences dialog, please see the discussion of Preferences in the Reference chapter.
Configuring Pro Tools for a Power Macintosh:

If you have a Power Macintosh and plan on using Pro Tools with DAE PowerMix, you must first configure Pro Tools Hardware Setup dialog box for your system. If you plan on using Pro Tools with DAE PowerMix and Pro Tools Project or Pro Tools with Audiomedia, be sure to also read the following section Using Pro Tools without Digidesign Hardware.

- Double-click the Pro Tools icon to start the software if it is not already running.
- Choose Hardware Setup from the Setup menu.
- Click the PowerMix button at the top of the Hardware Setup dialog. If you have no Digidesign hardware, PowerMix will already be selected.
- Next, click the # Playback Tracks pop-up at the bottom left of this dialog to select the default number of tracks you wish to have in your sessions. (This will become the default setting for all subsequent sessions you open on the current system until you change it again here.) The greater the number of tracks you choose, the greater the demand on your computer’s performance. To maximize performance, set the track count no larger than you absolutely need. You can always increase the number of tracks later in the Session with the # Playback Tracks pop-up.
- Click OK to close this dialog.

The Hardware Setup dialog (configured for a Power Macintosh)

- To configure the Power Macintosh’s built-in 16-bit input and output capabilities, go to the Apple menu and open the Sound Control Panel.
• When the Sound Manager appears, choose Sound In from the pop-up menu at the top of this window.

The “Sound” Control Panel lets you configure Sound Manager Input and Outputs

• In the Sound In window, click the Options button.

Click the Options button to choose a sound input source

• Select Microphone and then select Playthrough. This selects the sound input jack on the rear of the Power Macintosh. Click OK when you are finished.

Choosing a sound input source
• Next, choose Sound Out from the pop-up menu at the top of the Sound Manager window.

Choosing sound output options

• In the Sound Out window, select the sample rate that you desire (“Rate”). 44.1 kHz is the Compact Disc standard. (This doesn’t affect Pro Tools, just audio playback through the Sound Output jack on the Power Macintosh.)

• Select the bit resolution (“Size”). 16-bit is the Compact Disc standard. (This doesn’t affect Pro Tools, just audio playback through the Sound Output jack on the Power Macintosh.)

• Select mono or stereo format (“Use”). We recommend stereo.

• Close the Sound window when you have finished and go back to the Pro Tools application.

Using Pro Tools Without Digidesign Hardware
If you own a Power Macintosh, you can run Pro Tools without Digidesign cards or an Audio Interface by using the DAE PowerMix™ extension included on your Installer disks.

While you use this option you are limited to the built-in audio input and output capabilities of your Power Macintosh. However this capability will allow you to create a “hardware-less setup” at need, which can be convenient for applications such as editing. On systems where only DAE PowerMix is installed (i.e., no hardware), only the system configuration settings described in the previous section need to be set. The following information explains how to work with both hardware-based and hardware-less Pro Tools systems.

In order to use DAE PowerMix with System 7.5.2 or higher, your Power Macintosh must have at least 24 megabytes of RAM.
On systems where Digidesign audio hardware and DAE PowerMix are installed, Pro Tools automatically defaults to using your installed DSP cards (i.e., Pro Tools Project and Pro Tools with Audiomedia) as its playback engine each time you launch Pro Tools software or open a Session.

If you wish to use DAE PowerMix instead, you must specifically choose to do so by using the Playback Engine command. You can either do this as you launch Pro Tools, or after Pro Tools is already open. Each method is explained below.

**To select DAE PowerMix as your playback engine as you open Pro Tools:**

- Hold down the “N” key on your computer keyboard.
- Double-click the Pro Tools application icon (keep the “N” key held down). As Pro Tools opens, the Playback Engine dialog appears.
- Click the DAE PowerMix button to select this option.
- Click the #Playback Tracks pop-up at the button of this dialog and choose the number of tracks you would like in your Session. (The number of tracks allowed depends on the processor speed of your Power Macintosh. Refer to the system capabilities listings in Chapter A: Essential Concepts for details. In general, you will need a 100 MHz or faster Power Macintosh for a 16-track Session.)
- Click OK to close this dialog. Pro Tools will now use the DAE PowerMix engine to power your Session.

**To switch to DAE PowerMix if Pro Tools is already open:**

- From the Setups menu, choose Playback Engine. If a Session is currently open, Pro Tools will prompt you to save it before it closes it.

![Selection of a new playback engine will automatically save, close and reopen your session. Proceed?](image)

This dialog appears whenever you select Playback Engine from the Setup menu.
• Click OK to proceed. Click Cancel to return to the Mix or Edit window without saving and closing the current Session. After you click OK, the Playback Engine dialog appears.
• Click the DAE PowerMix button to select this option.
• Click the #Playback Tracks pop-up at the button of this dialog and choose the number of tracks you would like in your Session.
• Click OK to close this dialog. Pro Tools will now use the DAE PowerMix engine to power your Session.

The Playback Engine dialog, configured for an 8-voice Pro Tools with DAE PowerMix system

---

If You Plan to Work With MIDI

If you wish to use Pro Tools' MIDI integration capabilities you will need the following hardware and software:

• A Macintosh-compatible MIDI interface

You may also need:

• Digidesign SampleCell II™ or other MIDI sound modules
• Macintosh MIDI sequencing software
• Opcode Systems’ OMS software (version 1.2.3 or higher is needed to use the IAC Driver).

If you plan to synchronize Pro Tools to an external tape deck or other SMPTE-generating device, you will also need:

• a SMPTE-to-MIDI Time Code converter or:
• Digidesign’s SMPTE Slave Driver™

Are You Using OMS?
Pro Tools supports OMS (the Open Music System, from Opcode). This software facilitates communication between MIDI sources and destinations and the Macintosh. If you want to use a dedicated sequencer with Pro Tools you may need to use OMS. Vision™, Cubase™ and Logic™ sequencing software support OMS. Please be aware that some sequencers do not support OMS. To find out if your sequencer is compatible with OMS, consult its User’s Guide.

If you do plan to use a MIDI sequencer with Pro Tools, this will use a significant amount of your computer’s RAM (random-access memory). If you currently have only 16 megabytes of memory in your computer and plan to run Pro Tools and MIDI sequencing software together, you will need to install whatever additional RAM your sequencer requires.

Note: If you are using System 7.5.2 or higher and are using Pro Tools with DAE PowerMix, at least 24 megabytes of RAM is strongly recommended.

Preparing Your Pro Tools MIDI Setup
Because your MIDI setup will differ depending on whether or not you are using OMS, the following section provides instructions for configuring your setup with and without it.

To prepare Pro Tools to work with MIDI (non-OMS):

• Make sure that your MIDI interface and controllers are powered on. Choose Serial Ports from the Setups menu. In the dialog that appears, select the Macintosh serial port that your MIDI interface is connected to, and click OK.
To prepare Pro Tools to work with MIDI (using OMS):

- Make sure that your MIDI interface and controllers are powered on. Choose Serial Ports from the Setups menu. If you are using OMS, a dialog will appear allowing you to select the appropriate serial port. After you have chosen the appropriate port, click OK.

![The OMS MIDI Setup dialog](OMS version 1.2.3)

If You are Using a MIDI Keyboard Controller

- If you are using a MIDI controller, enable MIDI Thru in the Options menu. By doing so you will be able to play your controller and have your MIDI sound modules respond even when Pro Tools playback is not engaged. When a MIDI track is Record-enabled, your MIDI controller will be Thru’d to the port and channel specified by the MIDI track.

If You Are Using a Digidesign SMPTE Slave Driver or JL Cooper CS-10

- If you are using Digidesign’s SMPTE Slave Driver to synchronize Pro Tools Project to SMPTE Time Code, or have an ADAT® connected for use with the Digidesign ADAT Interface, or if you are using JL Cooper’s CS-10 Controller for hands-on control of Pro Tools faders, select the Peripherals command from the Setups menu and click in the appropriate checkbox for these devices. Then, from the pop-up menu next to each of these items in this dialog, select the MIDI port that you wish to send and receive MIDI data over.

![The Peripherals dialog](without OMS), before configuring Pro Tools for a CS-10 or SMPTE Slave Driver
If You Are Using a Digidesign SMPTE Slave Driver with OMS

- If you are using Digidesign’s SMPTE Slave Driver with OMS, you must define your SMPTE Slave Driver as an OMS device in the OMS Setup. In OMS select New Device in the Studio menu. In the MIDI Device Info window, leave blank the Manufacturer and Model names, name the device SSD, uncheck Is Controller and Is Multitimbral, leave MIDI Machine Control unchecked under Options, uncheck Receive Channels 1-16, check both Receives and Sends MIDI Time Code, and uncheck Receives and Sends MIDI Beat Clock. Click OK to close the MIDI Device Info window, and save the changes to the OMS setup.

- Connect the SMPTE Slave Driver to the correct port or MIDI interface in your current OMS Setup window. Click with the mouse and drag the SSD icon over the icon for the desired port or MIDI interface, and release the mouse. Arrows connecting the SSD to and from the desired port or MIDI interface signifies a connection has been made. (Your screen may differ in appearance from the following example, depending on your setup)
• Launch Pro Tools. Select the Peripherals command from the Setups menu and click in the appropriate checkbox for the SMPTE Slave Driver. Then, from the pop-up menu next to the SMPTE Slave Driver in this dialog, select the MIDI port that you wish to use.

Selecting the SMPTE Slave Driver port in the Peripherals Setup dialog (with OMS installed)

If You Are Using a MIDI Fader Box or other Control Surface

• If you are using a MIDI fader box for hands-on control of Pro Tools, connect the device to your MIDI interface. Then, if you haven’t already done so, choose Serial Ports from the Setups menu and in the dialog that appears, select the Macintosh serial port that your MIDI interface is connected to. Click OK when you have finished.

If You Are Using a Digidesign ADAT Interface

• If you are using Pro Tools Project with a Digidesign ADAT Interface for sample-accurate transfer and editing of ADAT digital audio tracks, please refer to your Digidesign ADAT Interface User’s Guide (included in your ADAT Interface for Pro Tools Cable Kit) for instructions on how to install and configure your system with this device.
Creating a New Session

The first step in beginning a Pro Tools project is creating a new Session. When you do so, Pro Tools automatically creates a new folder named after your Session. Within this folder is the Session file itself, and two other folders: an Audio Files folder, and a Fade Files folder. The Audio Files folder contains all audio recorded during the Session. The Fade Files folder contains any crossfaded audio data generated by the Session (you’ll learn how to create crossfades in Chapter E, Editing).

When you record a new audio track, the track is saved as a new audio file and automatically placed in the Audio Files folder. At any time in a Session, you also have the ability to import existing Sound Designer II or AIFF audio files into the Session, and work with them as well.

To create a new Session:

• Choose New Session from the File menu. A dialog appears asking you to name the Session.
In this dialog, choose the drive you wish to create your Session on. If you have a Pro Tools Project system, only drives connected to the Project card can be used.

Enter a name for the Session and click OK. The Pro Tools Transport appears, followed by empty Edit and Mix windows.

To create tracks for your Session:

Choose New Audio Tracks (or if you wish to create MIDI tracks, New MIDI Tracks) from the File menu. A dialog appears prompting you to specify how many new tracks you wish to create. You can add as many new audio tracks at once up to your system's Virtual Track limit. The maximum number of MIDI tracks you can use is 64.

![Create new audio track(s).](image)

The New Audio Track dialog

Enter a number and click OK. Your new tracks appear.

If you wish to give names to your tracks, double-click the Track Name button at the bottom of each track. In the dialog that appears, enter a name and click OK. This name will also be given to any new audio files that you record on the track.

![Name the track:](image)

The Name Track dialog
To show Inserts, Sends, and I/O controls on your tracks:

- To conserve space on screen, Pro Tools allows you to either show or hide the controls for Inserts, Sends, and Input/Output controls on your tracks. If you choose to show these, you can do so in either the Mix or Edit window. To show these controls in the Mix window, choose Show Extra Views in Mix Window from the Display menu. To show them in the Edit window, choose Show Extra Views in Edit Window from the Display menu.

You can choose to display Inserts, Sends, and I/Os in either the Mix or Edit windows.

Any input can be routed to any track, and any track can be routed to any output via Pro Tools Input/Output pop-up controls.

- To show Pro Tools’ Input/Output controls, choose Show I/O View from the Display menu.

Non-TDM Pro Tools systems have various EQ configurations available dependent upon which system you are using. EQs are available via the pop-up menu in the Inserts section of a track. EQs are covered in greater detail in Chapter G, Mixing.

- To show Pro Tools’ Inserts controls, choose Show Inserts View from the Display menu.

Pro Tools Project systems also have two post-fader Sends. Pro Tools Sends are signal busses that allow you to send a track’s signal to an external signal processor. Sends and Returns are covered in greater detail in Chapter G, Mixing.

- To show Pro Tools’ Sends controls, choose Show Sends View from the Display menu.

The Show I/O View, Show Inserts View, and Show Sends View commands.
Opening an Existing Session

If you wish to work on a Session that you created previously, you can open it with the Open Session command. The Session will open in exactly the same state that you saved it, with all settings and audio files intact. If the Session was last saved on a different system, Pro Tools will reset its Hardware and Playback Engine setup so that the Session will be playable on the current platform.

To open an existing Session:

• Choose Open Session from the File menu.

  The Open Session dialog

• Locate the Session you want to open and click Open. All audio, MIDI tracks and regions saved with the Session appear. If Pro Tools is unable to locate any of the files which the Session needs, the “Where is...” dialog will appear. Use this dialog to “point” Pro Tools to the file being asked for, or to “Skip” the missing file or all missing files. The two buttons “Look in Current Directory” and “Look in Selected Directory” can be used to have Pro Tools search for the missing audio. When Pro Tools locates all the needed files and computes waveform overviews (if you have that Preference turned on), the Session will open and you can resume work.

Virtual Voices

All Sessions are compatible with all available Playback Engines. When switching back and forth between Playback Engines, if the number of allocated voices in the Session exceeds the voice capability for the newly selected Playback Engine, all tracks with voice allocations over the maximum allowable will be set to “voice off.” These tracks will still be displayed and may be edited, but will not playback audio. If you switch Playback Engines mid-Session, your Session will be saved, closed and reopened.
When you switch back to a Playback Engine with increased voice capability, the Pro Tools Session will remember the previous voice allocation scheme for each track. If the voice allocation for a specific track has been edited while using a different Playback Engine, however, the original allocation prior to switching engines will not be retained.

Loading Previously Recorded Audio Files into a Session

You can import previously recorded Pro Tools audio files into a Session and work with them in addition to the tracks currently in your Session. The Import Audio command in either the File or Region List menus allows you to do this one file at a time, or you can drag-drop multiple sound files onto an open Pro Tools Session icon to batch import.

Note: When using Pro Tools Project, all audio files must be on the hard drive connected to your Pro Tools Project Audio Card.

If you choose the Import Audio command from the File menu, Pro Tools will automatically create a new track for each file that you select and place the file(s) into the new track(s) for you. If you choose this command from the Region List menu, Pro Tools will import the audio file into the Region List only. From there, you can drag it into a track yourself. If you drag-drop, the file(s) will appear in the Region List only.

Because Pro Tools doesn’t currently support the interleaved stereo file format, importing stereo sound files requires both additional time and hard disk space because an interleaved stereo file must be converted into two mono audio files (split-stereo files) and saved to disk.

On the following page is a picture of the Import Audio dialog:
The Import Audio dialog box lets you select both audio files (the whole recording) and audio regions (a portion of the recording) and load them into the current Session. In the center and right scroll boxes you’ll notice two types of icons which appear next to an item’s name. These icons indicate whether the item is an audio file or an audio region. The icon that looks like a page with two small waveforms on it identifies an audio file. The icon that looks like a highlighted waveform identifies an audio region. When you click on an audio file’s name in this dialog, information appears about the sample rate of the file. The Play button allows you to audition a region to make sure it’s exactly what you want before you load it into a Session.

The left scroll box is a standard Macintosh file directory that lists the audio files on the selected hard drive. (Pro Tools Project users: sound files must be located on the Pro Tools hard disk in order to be imported. In the example above, the directory shows that the folder Audio Files on the hard drive “Pro Tools Drive” contains seven files, and the file Drums is currently selected.

The center scroll box lists all the regions associated with the currently selected Audio File (in other words, the regions which have been created from the original source file, Drums). In the above example, the regions Drums crash, Drums dbl kick, Drums kick, Drums loop, and Drums snare are shown because they are regions associated with the file Drums. The item at the top of the list which bears the name of the original audio file represents the “Whole Soundfile”—the entire source file. Loading this will load the entire source file into the Session.

The right scroll box lists the regions that you have selected to load into the Session.
Auditioning Files in the Import Audio Dialog

The Play and Stop buttons at the lower right of the Import Audio dialog let you audition the selected region/sound file. Simply click the Play button to audition the currently selected file. The counter immediately above Play/Stop serves two purposes: it provides a time display for the file being auditioned, and it also lets you fast forward/rewind the file.

To use the counter to fast forward to at or near the beginning of the file, click on the counter close to the hours value (i.e., the left-most numbers) as shown below:

Using the Import Audio dialog’s counter to fast forward a little ways in to the selected file

To fast forward to the middle of the file, click on the counter close to the minutes:seconds values (i.e., the middle of the display).

Using the Import Audio dialog’s counter to fast forward to the middle of the selected file

To fast forward to at or near the end of the file, click the right-most values of the counter.

There are several keyboard shortcuts that simplify commonly used functions in this dialog.

Import Audio Dialog Keyboard Shortcuts:
• Enter or Return key = adds currently selected audio file/region to the list of chosen items from either the left or center box.
• Command-P = auditions currently selected audio file/region.
• Command-S = stops audition (playback) of currently selected audio file/region.
• Tab key = tabs between file windows.
• Command-Period = Cancels and closes dialog.
To load audio files/regions into a Session:

- Select Import Audio from either the File or Region List menu. As explained earlier, this command functions slightly differently depending on which menu you choose it from. The Import Audio dialog appears.
- Locate the desired audio file and click on its name in the list on the left.
- Select the file you want to import and click Add. (Double-clicking a file or region's name from the left or center scroll box will achieve the same result.) If you want to audition the file or region before you load it, click the Play button at the bottom of the screen (the other button is a Stop button — see the previous section Auditioning Files in the Import Audio Dialog for complete instructions). To add additional regions from the same audio file, double-click on their names to load them as well. To remove an item from the list of items currently chosen, select it and click the Remove button.
- When you have finished, click Done. The regions that you have chosen will appear in the Audio Region List (and in new tracks if you choose the Import Audio command from the File menu).

Batch Importing with Drag-drop

By dragging and dropping any number of files onto the Pro Tools icon in the Finder, you can easily load large numbers of SD II or AIFF files into an open Pro Tools Session without having to go through the Import File dialog and choose each file, one at a time. A Session must be open for this to work, but after you've dragged and dropped, all the files will be in the Region List ready for use.

To batch import using drag-drop:

- Launch Pro Tools and open a Session.
- Return to the Finder (do not quit out of Pro Tools or close the Session).
- Using standard Macintosh techniques, drag and drop as many sound files as you want on to the Pro Tools icon on your desktop (the Pro Tools icon should be grayed out while Pro Tools is running).

Pro Tools will add all the sound files to the Session’s Region List, and compute any missing overviews (if you have Preferences configured to do so).

The key things to remember about using drag-drop batch import is that Pro Tools must be running, and you must have a Session open.
**IMPORTANT**

If this technique for batch importing does not seem to be functioning, it is likely that you need to rebuild your desktop. To do this, press and hold down the Option and Command keys while you restart your computer.

Note: You can launch Pro Tools by dragging-dropping a Session file on the Pro Tools icon to open that Session. Dragging-dropping audio files on to the Pro Tools icon while Pro Tools is not running will launch Pro Tools but no audio files will be batch imported.

*If You Want to Re-use Sound files/Regions in Other Sessions*

Pro Tools keeps a sound file’s region definitions inside the Session file itself. This means that if you want to use a sound file—complete with its regions—in other Sessions, you have to use Pro Tools’ Export Selected command (in the Region List menu) to make the region definitions readable by other Sessions. The Export Selected command is explained in more detail in Chapter E, Editing.

**Track Transfer™ utility software**

*Track Transfer* utility software (included with your Pro Tools system) greatly simplifies the process of exporting regions. This convenient program lets you import, export, or merge entire track entities (including region definitions) into other Sessions.

---

**Saving a Session**

Saving isn’t something that you should do just at the end of your Session. Saving regularly throughout your Session ensures that your work is preserved safely on your hard disk. There are few things more infuriating (or unpredictable) than for a power failure or other unforeseen act to cause you to lose valuable work. To avoid this, get in the habit of saving your work throughout your Session—and of course, at the end of it—with one of the methods below.

**Save Session**

The Save Session command saves the changes you have made to your Session and writes them over the old Session file. The Save Session command cannot be undone.
To Save a Session:

- Choose Save Session from the File menu. Because you’ve already named your Session, you won’t be prompted to name it again when you use the Save Session command.

Save Session As...

The Save Session As... command is useful for saving a copy of the current Session under a different name, or in a different hard disk location. Because the Save Session As... command closes the current Session and lets you keep working on the renamed copy, it is particularly useful if you are experimenting and want to save successive stages of the Session. This way, you can save each major step under a different name such as “FX Session 1.0,” “FX Session 1.1,” etc. By working this way, you’ll always have the option of retracing your steps should you want to go back to an earlier version. Keep in mind that by using the Save Session As command you are saving a new version of the Session file only—not duplicate versions of the Audio or Fade files.

To Save a Session under another name:

- Choose Save Session As... from the File menu. This dialog appears:

![Save Session As dialog](image)

- Choose the destination and type in a new name for your Session.
- Click Save to save the Session or Cancel to cancel.

Save Session Copy In...

Pro Tools’ Save Session Copy In... command is used to save a copy of the currently selected Session document under a different name or to a different hard disk location. But unlike the Save Session As... command, Save Session Copy in... does not close the
original Session, so subsequent edits are made to the original Session. Having a backup copy gives you the option of reverting to the earlier version if you’ve gone too far down the wrong road.

To Save a Session in a different location:

- Choose Save Session Copy In... from the File menu. This dialog appears:

  ![Save Session Copy in dialog](image)

  - Choose the destination disk and folder and type in the name of the Session.
  - Click Save to save or Cancel to cancel.

Creating a Custom Session Template

Pro Tools allows you to create custom Session documents that are pre-configured to the track setups, mixer setups and window arrangements that you use most frequently. Doing this will save you the trouble of having to create your studio setup from scratch every time you start a new Session. You can accomplish this by saving a Session as a Stationery Pad. Once a Session is saved as Stationery, its settings act as a template that you can open and then resave as a normal Session. Before saving a Session Template, you may want to set up your own defaults in your Pro Tools Session’s Get Info dialog so that they will be reflected in your new template.

To create a custom Session template:

- Create a Session and arrange the Mix, Edit, and Transport windows as you like. This includes the actual positions of the windows themselves, as well as the
parameters within these windows, such as signal routings, Inserts and Sends configurations, audio tracks, MIDI tracks, track views, and Preferences settings.

• Choose Save Session from the File menu.
• In the dialog that appears, name the Session and click Save.
• Close the Session.
• Go to the Finder and locate the Session file that you just saved.
• Click once on the file to select it.
• From the Finder's Edit menu (not Pro Tools' File menu), choose Get Info (or press Command-I). The Macintosh Get Info window appears.
• Click on the Stationery pad check box to save the file as a template.
• Click on the window's close box.

Click on the “Stationery pad” check box to save a Session as a template that you can reuse.

This document will now act as a template that you can open, with your settings just as you configured them. To use this template, simply double-click it in the Finder, or open it with the Open Session command if you are already running Pro Tools. When you save the Session, Pro Tools will save it as a normal Session. You can create several custom setups like this for studio setups that you frequently use.

Opening a Session Template (i.e., a Stationery pad)
When you open a Session saved as a Stationery pad, this dialog appears. It offers you the choice of editing the Template or starting a new Session using the Template settings. If you choose New Session, Pro Tools will create a new folder containing the customary Audio and Fades folders.

**Pro Tools' Get Info Feature**

This command in Pro Tools' File menu allows you to save text information about a specific Session with the Session file itself. The Get Info dialog provides five topic fields and five data fields.

The Get Info command, shown with custom topics defined and data entered

The left text field in each of the five rows is the “topic” field. The text that you enter here is saved with your Pro Tools Preferences and will appear in all Sessions. You can define the topic fields to describe each of the five information/data fields. The right text field in each of the five rows is the “information” field. The text that you enter here is Session-specific.

**To set up your Get Info topics:**

- Choose Get Info from Pro Tools’ File Menu. The Get Info dialog appears.
- Enter your topic into the topic fields (the left text field in each of the five rows). Continue until you have defined as many topics as necessary.
- Click OK to close the Get Info dialog. Click Cancel to close Get Info without saving your changes.

**To enter descriptive information about a Session:**

- Choose Get Info from the File menu.
- Click the cursor in the desired text field and type the information that you wish.
• Click OK to save your Session info, or click Cancel to close the Get Info dialog without saving any changes. The text you enter in the information fields will be stored in the Session file itself.

Closing a Session

Because Pro Tools can only open one Session at a time, you must close the current Session if you want to work on another. The Close Session command closes your current Pro Tools Session but leaves the Pro Tools application open. Although Pro Tools will warn you before allowing you to close without saving changes, you will probably want to save your work using the Save Session or Save Session As... command before closing the current Session.

To close a Session:

• Choose Close Session from the File menu (or click the close box at the upper left corner of the Pro Tools window).

If you have made any changes to your Session since the last time you saved, Pro Tools will ask you if you want to save them. If you do, choose Yes; if you don’t, choose No. If you change your mind and wish to continue your Session, choose Cancel.

 Quitting a Session

When you are ready to end your Pro Tools Session, the Quit command will quit Pro Tools and return you to the Finder where you can shut down your computer. Although Pro Tools will warn you before allowing you to quit without saving changes, you’ll probably want save your work before quitting.

To Quit a Session:

• Choose Quit from the File menu.

If you have made any changes to your Session since the last time you saved, Pro Tools will ask you if you want to save them. If you do, choose Yes; if you don’t, choose No. If you change your mind and wish to continue your Session, choose Cancel.
Understanding the Mix and Edit Windows

Pro Tools is designed to provide virtually all of the recording, editing, and mixing capabilities that you would find in a professional recording facility. Pro Tools does this by presenting you with two “windows” into your recording Session, each with a different view of your project. The **Mix** window provides a mixer-like environment with recording, mixing, and automation capabilities. The **Edit** window features a graphical editing environment which also provides recording, mixing, and automation capabilities. The two views are complementary and interdependent. Together they make up your Pro Tools audio production environment.

**The Mix Window**

The Mix window provides a mixer-like environment for recording and mixing audio and MIDI. Here, tracks appear as mixer modules, each with controls for Inserts, effects sends, input/output assignments, volume panning (in Stereo Mix mode), record-enable, automation-enable, and solo/mute. The following several pages explain the use of each of these track controls. Take a moment to familiarize yourself with this window and the tools contained here.

NOTE: Pressing “Command and =” allows you to quickly toggle between the Mix and Edit windows.

Before you begin, if you haven’t already done so, choose the **Show Extra Views in Mix Window** command from the Display menu. Then, choose the **Show I/O View, Show Inserts View and Show Sends View** commands from the Display menu to display Pro Tools Input/Output controls, Inserts, and Sends.
The Mix Window with Inserts, Sends, and I/O controls displayed (Pro Tools Project shown)
An Audio Track

Audio tracks, shown with all extra views displayed (left), I/O views (center) and no extra views (right).

Each audio track has its own set of controls for Record-enable, Automation record-enable, Solo/Mute, Volume, Panning (if you are in Stereo Mix mode), Output assignment, and Voice assignment. EQ is available depending on which system you are using, and these are displayed via the Show Inserts View command in the Display menu. With Pro Tools Project two sends are available as well, via the Show Sends View command.

Tracks can be added to a session with the New Audio Tracks command, removed with the Delete Tracks command, or even hidden from view with the Show/Hide Tracks command, should you need to streamline your on-screen track display.

The meters on audio tracks show input levels when they are record-enabled. They show disk “playback” levels during playback. Pro Tools’ volume faders only adjust the monitoring level of a track—not the recording input gain. In order to increase the input signal level, you need to adjust the level of the actual signal before it reaches the Audio Interface. You can do this by recording it through a quality mixing board or dedicated preamp.
A MIDI Track

Each MIDI track has its own set of controls for Record-enable, Solo/Mute, Volume, Panning, MIDI port assignment, and MIDI channel assignment. MIDI tracks can be added to a session with the New MIDI Track command, removed with the Delete Track command, or even hidden from view with the Show/Hide Tracks command. A maximum of 64 MIDI tracks can be created in a Session. The meters on MIDI tracks indicate MIDI Velocity levels.

Auxiliary Inputs

Auxiliary inputs can be used as effects returns or as additional on-screen inputs for live mixing of instruments connected to your Audio Interface. You can add mono and stereo Auxiliary inputs to your Sessions by using the New Auxiliary Inputs command in Pro Tools's File menu.
Record Enable Button
Clicking this button puts the selected track into record-ready mode. On audio tracks, there is an Input Selector button that allows you to route one of the Audio Interface’s inputs to the track. Once a track is record-enabled, clicking the Transport’s Record and Play buttons will initiate audio or MIDI recording. To record-enable more than one track at the same time (as in the case of stereo recording), hold down the Shift key and click the record-enable button on each of the desired tracks. You can only record on one MIDI track at a time, but one MIDI track can record all 16 channels (i.e., multiple instruments).

NOTE: Option-clicking on the record-enable button enables all tracks for recording.

Automation Record Enable
Clicking the mouse on this button puts the selected track into automation record-enable. Once a track is automation record-enabled, clicking the Transport’s Record and Play buttons will initiate automation recording. Any fader or pan moves that you make on the selected track will then be recorded and played back exactly as you performed them. Be aware that automation recording is always “destructive,” regardless of the status of the Destructive Record option in the Options menu, since it will record over any previous automation data on the track. Like audio and MIDI data, automation can be edited within the Pro Tools’ Edit window.

Solo and Mute Buttons
These buttons apply to both audio and MIDI tracks. Clicking on the Solo button mutes other tracks so that the selected track can be auditioned alone. When a track is Solo’d, the Mute buttons of other tracks in the session are highlighted. More than one track can be solo’d at the same time.

Clicking on the Mute button silences the selected track. More than one track can be muted at one time. If the Mute Frees Voice command is enabled in the Options menu, muting a track will allocate its voice to the next highest priority virtual track in your session. In this mode, there may be a delay (ranging in length from one to several seconds depending on the “voice size” of your system) between the time you mute or unmute a track and the time you hear the effect on playback. This is normal.
**Audio Input Selector**

Audio Input Selector, Pro Tools Project (left), and Pro Tools with Audiomedia (right)

This button allows you to select an audio input and route the input to the track.

Note: You can use the I/O Labels command (Setups menu) to change the names of inputs that appear in the Input Selector. Refer to the Reference chapter for details on using the I/O Labels command.

**Audio Output Selector**

Audio Output Selector, Pro Tools Project (left) and Pro Tools with Audiomedia (right)

This button allows you to route a track to an output channel. If you are using Pro Tools Project in Direct Outputs mode, the pop-up menu allows you to route the track to a single output (1, 2, 3, 4, 5, 6, 7 or 8). In Stereo Mix mode, this pop-up lets you select pairs of outputs (1-2, 3-4, 5-6, or 7-8). Pro Tools with Audiomedia and Pro Tools with DAE PowerMix only support Stereo Mix mode, so this pop-up will only list a single pair of outputs on those systems. When in Stereo Mix mode on all systems, selecting output pair 1-2 (for example) and dragging the Pan slider towards the left will weight the track’s output towards output 1. Dragging to the right will weight the sound towards output 2 (in other words, panning left routes audio to the odd-numbered output of the selected pair, panning right routes to the even-numbered output of the selected pair).

Note: You can use the I/O Labels command (Setups menu) to change the names of outputs that appear in the Output Selector. Refer to the Reference chapter for details on using the I/O Labels command.
Voice Selector

Clicking and holding the mouse button on this box brings up a pop-up menu in which the selected track can be assigned a “Voice” for audio playback. An 8-channel Pro Tools Project system provides eight voices of audio playback, hence the settings Voice 1, Voice 2, Voice 3, Voice 4, Voice 5, and so on.

Pro Tools with Audiomedia: Voices 1-4

Pro Tools with DAE PowerMix: Voices 1-16 (depending on your system — refer to the system descriptions in the Installation Guide).

More than one track can be assigned to the same Voice, but only one of the tracks can be played back at the same time. Track priority, or “which track gets the Voice,” is determined by a track’s position in the Mix or Edit window. If six tracks are assigned to the same Voice, for example, the one farthest to the left in the Mix window (or topmost in the Edit window) will be heard. If there’s an empty spot in that track (you’ll have to look at the Edit window to determine this), audio on the track with the next highest priority will “pop through” during that time. Selecting the Mute Frees Voice command and muting a track will disable playback of that track and allocate its voice to the next highest priority virtual track. Voices and track priority are covered in greater detail in Chapter C.

Chapter B: Pro Tools Basics

57
MIDI Port Selector

Clicking and holding the mouse button on this box brings up a pop-up MIDI Port menu. This menu allows you to route the MIDI track to a desired destination, including the Macintosh's serial ports (modem or printer), OMS port destinations, MIDI Time Piece's Interface ports, or directly to a Digidesign SampleCell™ sample playback card installed in your Macintosh. The appearance of this pop-up will vary depending on whether you are using OMS, a MIDI Time Piece, or neither. (Refer to your OMS Installation and Setup Guides to properly configure your OMS setup.) In order for the Pro Tools software to “see” a MIDI interface attached to the Macintosh’s modem or printer serial port, you must turn on the interface before you launch Pro Tools.

MIDI Channel Selector

Clicking and holding the mouse button on this selector brings up a pop-up menu in which a MIDI track’s MIDI Channel can be assigned. The default setting of this selector is “Channel -” in which all regions placed on a track automatically retain the original MIDI Channel assignments from an imported MIDI file. In other words, they play back on whatever MIDI Channel they were assigned to in the original MIDI file.
**Track Volume/Input Level Indicator**

This indicator shows the current volume/input level of a track as set by the Volume/Input Level fader. Values range from +6 dB (highest level signal), to ∞ (no signal). When recording, please remember that Pro Tools offers no built-in pre-amplification, so you will need to increase the source signal’s amplitude to increase the input record level. The Track Volume slider will not boost a signal’s input level.

**Pan Indicator**

This indicator displays the current pan setting of a track. Pan values range from <100 (full left) to 100> (full right). It only appears if you are using Pro Tools in Stereo Mix mode.

**Pan Slider**

The Pan slider controls the balance of a track within a given output pair. It only appears if you are using Pro Tools in Stereo Mix mode. The outputs used as the stereo pair for the track’s image are set with the Output Selector. The Pan slider on a MIDI track is only effective if you are controlling a sound module that supports MIDI panning. In addition, if your original sequence contains MIDI panning changes, that data will override whatever value you set here.

**Track Volume/Monitor Level Fader**

Moving this fader controls the volume of a track when it is in playback, and the monitor level of the track when it is in record.

The Volume slider on a MIDI track is only effective if you are controlling a sound module that supports MIDI volume. In addition, if your original sequence contains MIDI Volume changes, that data will override whatever value you set here.
Level Meter
These meters are LED-style meters that show you the level of the signal that is being recorded to or played back from the hard drive. When a track is record-enabled, these meters are very important as they are Pro Tools’ record-level indicators. Remember that the Pro Tools system retains a clean, quiet signal path by offering no pre-amplification of the input signal. If your input signal is too low, you must increase it before it reaches the A/D convertors of your particular system (i.e., the audio interface, Audiomedia III card, built-in Power Macintosh inputs, etc.) Digital recording produces the best results when the recorded signal is as high as possible without clipping. Pro Tools’ level meters have a convenient “clip hold” feature so that if you overload your input at any time during recording, the top-most LED will stay lit (red) indicating that clipping may have occurred somewhere in the recording process. You can clear the clip indicator by clicking on it. If the top-most LED is lit an even darker red, it indicates that clipping has occurred repeatedly.

Note: Option-click on an LED to clear all clip indicators.

In Playback mode, these LEDs show you the pre-fader audio level of a track as it plays from hard disk. This means that the meter of a track with audio on it will light up during playback regardless of the setting of the track’s volume fader. On a MIDI track, the meter will show MIDI velocity of the most recent MIDI event.

Track Name
The name of a track appears here. Double-clicking this box brings up a dialog in which you can change the track’s name. When new tracks are created with the New Audio Tracks (or New MIDI Tracks) command, they are given a default name which can be changed at any time. When new audio files are recorded, they will take their default name from the Track name.
Chapter B: Pro Tools Basics

Track Inserts Button/Inserts & Sends Editor

Pro Tools provides pre-fader digital equalizers, but the total number of EQ’s available varies from system to system. The EQs are located on the Inserts section of a track. You can display them with the Show Inserts View command in the Display menu. Five types of EQ are available: high pass, high shelf, peak/notch, low shelf, and low pass. Each EQ can be adjusted or bypassed independent of the other. The parameters of these EQ’s are covered in Chapter G, Mixing. Inserts such as Pro Tools’ EQs can be adjusted via the Inserts & Sends Editor. This floating window provides instant access to any Insert or Send on any Pro Tools track. EQ and The Inserts & Sends Editor is covered in greater detail in Chapter G, Mixing.

Track Sends/Inserts & Sends Editor

In Pro Tools Project systems, each track has two effects sends. These can be displayed with the Show Sends View command in the Display menu. They can be used as two mono effects sends or a single stereo effect send. Send levels are set by clicking the Send button, and in the Inserts & Sends Editor that appears, dragging the level slider to the desired level. The floating Inserts & Sends Editor provides instant access to any Insert or Send on any Pro Tools track. The Inserts & Sends Editor is covered in greater detail in Chapter G, Mixing.

Pro Tools Project uses outputs 7 & 8 as Effect Sends. Effect Returns are set up by first creating a new Auxiliary Inputs or a new Audio Track. You then need to use the Input Selector pop-up to assign the appropriate input for that Aux Input or Audio Track. Sends and Returns are covered in greater detail in Chapter G, Mixing.
The Edit Window

This window provides a time line-type display of audio and MIDI for editing and arranging tracks. Here, the tracks appear as graphic waveforms and MIDI data. As in the Mix window, each track has controls for record-enable, automation record-enable, and mute/solo. Inserts and effects send can also be displayed in the Edit window by choosing these options in the Display menu. Take a moment to familiarize yourself with this window and the tools contained here.
The Slip/Shuffle/Spot/Grid Buttons

These four buttons control how regions can be moved with the Grabber tool (explained later in this section) and also how edit commands such as Cut, Paste, Clear, and Duplicate affect the movement of regions. For this reason, you should always be aware of which mode is currently active before performing any type of edit.

NOTE: Pressing the tilde key (~) allows you to switch between the various edit modes.

Shuffle Mode
Clicking the Shuffle button puts Pro Tools into Shuffle mode. In this mode regions line up end-to-end like magnets. They “snap” to other regions or the beginning of a track. Adding a new region to a track simply “shuffles aside” any regions occurring after it by that region’s length. This mode is most useful for arranging regions together so that they occur one after another in a track without overlapping or gaps between them.

Slip Mode
Clicking the Slip button puts Pro Tools into Slip mode. In this mode, regions can be moved freely, without snapping to other regions as they do in Shuffle mode. Regions can have space preceding or following them. They can be placed so that they overlap portions of other regions or entire regions. Unlike Shuffle mode, regions placed into tracks in Slip mode don’t “shuffle aside” subsequent regions. Compared to Shuffle mode, Slip mode gives you the most freedom for placing regions.

Spot Mode
Clicking the Spot button puts Pro Tools into Spot mode. This mode is useful for Sessions in which you wish to “spot” regions to specific SMPTE frame locations. In this mode, a region in a track can be quickly spotted by simply clicking it with the Grabber. A dialog will then appear prompting you to enter an appropriate SMPTE frame location. If you drag a region from the Region List into a track while in Spot mode, a dialog prompting you to specify a SMPTE time location for the region will appear automatically when you release the region. Regions are spotted by their start times unless you have identified a Sync Point (covered in Chapter F, Working with SMPTE) within the region. If the region contains a Sync Point, spotting is performed in reference to the Sync Point.
Grid Mode

Clicking the Grid button puts Pro Tools into Grid mode. In this mode, the movement of regions is quantized to a user-selectable time value on an invisible time “grid.” This mode is especially useful for lining up regions at precise intervals (as in a music Session based around bars & beats or a post Session using SMPTE frames). For example, if you have set the Grid to quarter note increments, dragging or nudging a region to a new location in a track will cause it to snap to the nearest quarter note location on the Grid. This provides you with a handy way of “quantizing” audio. You will also find that if you drag a region from the Region List into a track while in Grid mode, the region will automatically snap to the grid when you let go of it.

Grid values are selected by choosing the appropriate time format from the Display menu (Bars & Beats, Minutes:Seconds, Time Code, or Feet and Frames) and selecting the desired increments from the Nudge/Grid units pop-up menu at the top right of the screen.

Note: Nudge to Samples is not available when the Time Scale Indicator is displaying Bars&Beats.

The Display Scale Arrows

Clicking on the Display Scale arrows allows you to adjust the track view. The Display Scale arrows adjust the display around its center point, keeping it centered as it changes. The four arrows work like this:

- The up arrow expands the waveform view vertically, expanding the amplitude and making the waveform appear taller. This adjustment is useful in distinguishing amplitude values of audio data, because amplitude differences are more easily viewed at a higher resolution.

- The down arrow performs the opposite function. It compresses the track view downward. Use it to squeeze the height of the track view so you can see its entire amplitude range.
The right arrow expands the track view to the right, performing the same function for duration as the up arrow performed for amplitude. This arrow stretches out the track view, and makes it possible to magnify it until you are looking at only a few audio samples or MIDI events.

The left arrow functions as the zoom out arrow. It compresses the track view to show you more of the duration.

The Zoomer
Clicking here activates Pro Tools' Zoomer. The cursor turns into a miniature magnifying glass. To use the Zoomer, click and drag this magnifying glass over a portion of a track that you wish to view. As you drag, a dashed box appears indicating the range that you will be zooming in on. When you release the mouse, the display zooms in on that portion.

To zoom back out to view the entire Session, double click on the Zoomer. Hold down the Option key and drag the Zoomer over a selection to increase duration while keeping the amplitude magnification the same. Option-click on the Zoomer to zoom so that the current selection fills the window.

NOTE: Pressing the Esc key allows you to “tab” between Pro Tools' various tools.

The Scrubber
Clicking here activates Pro Tools' Scrubber. “Scrubbing” is a term that refers to a method of locating an exact spot on analog tape by rocking the tape reels back and forth with the playback head engaged. By doing this, the exact beginning or end of a specific sound on the tape can be pinpointed. In a hard disk recording system like Pro Tools, scrubbing works a little differently, but the principle is basically the same. With the Scrubber, you can click anywhere on a track and drag the mouse to the right or left to begin playback at that point instantly. Playback speed and direction varies with mouse movement. Scrubbing is more useful at medium levels of magnification.

NOTE: Pressing the Esc key allows you to “tab” between Pro Tools' various tools.
The Trimmer
Clicking here activates Pro Tools’ Trimmer. With this tool, regions can be quickly shortened or expanded to a desired length.

To trim a region, simply click the cursor at the right or left side of a region and drag towards the center. As you drag, the edge of the region is “trimmed off” until you release the mouse button. Note that the cursor changes into the appropriate “right trim” or “left trim” shape as it is placed over the right or left side of the region.

To extend a region or expand it beyond its current definition, click the cursor on the appropriate edge of the region and drag outwards. The more you drag, the more data is “uncovered” until the region is restored to its original length, a portion thereof, or all the way out to the entire length of the original audio or MIDI file.

If you click a region with the Trimmer while you are in Spot mode, a dialog will appear allowing you to enter a value in SMPTE frames to specify exactly where you wish the region’s beginning or end to be trimmed to. This is a convenient way to edit the length of a region to a particular “hit point” if you are doing audio post production work.

NOTE: Holding down the Option key before trimming a region allows you to reverse the direction of the Trim tool so that you can trim in either direction from any point in a region. Holding down the Control key after you beginning trimming will allow you to extend a region up to but not beyond the border of a neighboring region.

NOTE: Pressing the Esc key allows you to “tab” between Pro Tools’ various tools.

The Selector
Clicking here activates Pro Tools’ Selector. The mouse cursor changes to an I-beam. Clicking and dragging the cursor across any audio waveform or MIDI data range in a track will select that range for editing. The cursor position is always indicated in the Selection and Position Indicator boxes at the top right of the screen.

Note: Holding down the Command key while using the Selector temporarily switches to the Scrubber.
Selecting the same range on multiple tracks is also accomplished with the Shift key, but with a slightly different technique. To do this, make your selection on any of the tracks. After you have released the mouse button, hold down the Shift key and click in another track. The same range will then be selected in that track. Continue clicking in tracks. Once a waveform range is selected, it can be captured as a region, “separated” as a region, or modified by any of the other operations listed in the Edit menu. (Capturing regions, separating/healing regions and other editing techniques are explained in Chapter E: Editing.)

NOTE: Pressing the Esc key allows you to “tab” between Pro Tools’ various tools.

The Grabber
Clicking here activates Pro Tools’ Grabber. With this tool, tracks and regions can be moved or rearranged simply by clicking and dragging them to a new location. Pro Tools’ four modes of editing operation, Slip, Shuffle, Spot and Grid, affect how regions can be moved with the Grabber.

NOTE: Pressing the Esc key allows you to “tab” between Pro Tools’ various tools.

The Selection and Position Indicator Boxes
The Data Indicator boxes provide information about the current selection’s start point, end point, duration, and the current playback position.

The Start box gives the start point of the current selection. The End box gives the end point of the current selection. The Length box gives the duration of the current selection. Double-clicking on any of these indicators will present you with a dialog in which you can enter a new time value.

Information in the Data Indicator boxes can be displayed in Bars & Beats, Minutes:Seconds, SMPTE, or Feet and Frames depending on which Time Scale format is selected in the Display menu.

If you are using Pro Tools to “spot” audio to SMPTE Time Code, clicking on the Start, End, or Length buttons will present you with a dialog in which you can edit the current selection’s start, end, or length in SMPTE frames.
Clicking the Start, End or Length buttons brings up this dialog.

**Time Indicator Box**

This box displays the current point in time at the cursor’s insertion point in a track. Time can be displayed in Bars & Beats, Minutes:Seconds, SMPTE, or Feet and Frames, as chosen in the Display menu. Time values shown here are slightly rounded off.

Position the mouse pointer over any of the time fields in this box and click to increase or decrease the time shown in that field and move the insertion point to that time location. Move the mouse up and click to increase the time; move it down and click to decrease the time.

**The Nudge/Grid Units Selector**

![Nudge/Grid Selector, showing Minutes:Seconds (left), Time Code (center), and Feet & Frames (right)](image)

Clicking on this pop-up menu allows you to select the value used in Pro Tools Grid Mode. It also defines the amount that regions can be “nudged” by pressing the plus (+) and minus (-) keys on your Macintosh keyboard. In addition, the value chosen here
serves as the quantization value for Pro Tools’ MIDI Quantize and Quantize Region commands if you are using Bars & Beats as your time format. The units that appear here are controlled by the time format currently selected from the Display menu (Bars & Beats, Minutes:Seconds, Time Code, or Feet and Frames).

**The Time Scale Indicator (a.k.a. the Timeline)**

This indicates the time scale currently in use. Options are Bars & Beats, Minutes:Seconds, Time Code (SMPTE frames) or Feet and Frames as chosen in the Display menu. If you double-click the Time Format button at the far left of the scale, a dialog will appear allowing you to quickly change time formats. If you wish to display data in Bars & Beats you must have MIDI Regions in the current Session or you must use the Identify Beat command in the Edit menu to provide Pro Tools with Bar/Beat information. SMPTE formats can be chosen with the Time Code command in the Setups menu.

You can grab the Time Scale Indicator and move it so that it is between any two tracks in the Edit Window.

**To move the Timeline:**

- Use the Grabber tool to grab the left-most end of the time scale.

- Continue to hold the mouse button down and drag the timeline between any two tracks. You can’t see the time scale while it’s being moved but you can see the borders of the Track Name fields flash where the time scale is about to be moved.
An Audio Track

This is where audio regions are strung together to form a "Playlist" for audio playback. Audio regions can be arranged in any order in a track and can even be dragged onto other audio tracks. Each audio track has its own Name, Record-enable, Automation Record-enable, Solo, Mute, Volume, Voice, and Track Display Format selector. Data on each track can be individually viewed in waveform, block, volume graph, or pan graph format by selecting any of these options in the pop-up Track Display Format pop-up menu. All tracks can also be viewed at reduced height by choosing Reduce Track Size from the Display menu. They can even be hidden from view with the Show/Hide Tracks command, should you need to streamline your on-screen track display.

A MIDI Track

This is where MIDI regions are strung together to form a Playlist for MIDI playback. MIDI regions can be arranged in any order in a track and even be dragged onto other MIDI tracks. Each MIDI track has its own Name, Record-enable, Solo, Mute, Channel/MIDI Port selector, and Display Format selector. Data on MIDI tracks can be displayed in Region Block or Note format by choosing one of these options from the pop-up Track Display Format selector. All tracks can also be viewed at reduced height by choosing Reduce Track Size from the Display menu. They can even be hidden from view with the Show/Hide Tracks command, should you need to streamline your on-screen track display.

Track Name

The name of a track appears here. Double-clicking this box brings up a dialog in which you can change the track's name. Audio and/or MIDI recorded on a track will get their name from the Track Name field.
Record Enable Button
Clicking this button puts the selected track into record-ready mode.

Automation Record Enable
Clicking this button puts the selected track into Automation record-ready mode.

Solo and Mute Buttons
Clicking on the Solo button mutes other tracks so that the selected track can be auditioned alone. Clicking on the Mute button silences the selected track. See the explanation of these functions in the Mix Window section of this chapter for more information.

Voice Selector

The Voice Selector in the Edit window (Pro Tools with Audiomedia shown)

Clicking and holding the mouse button on this box brings up a pop-up menu in which the selected track can be assigned a “Voice” for audio playback. This function is explained in greater detail in the Mix Window section of this chapter.
MIDI Channel

Clicking and holding the mouse button on this selector brings up a pop-up menu in which a MIDI track's MIDI Channel can be assigned. The default setting of this selector is "Channel - " in which all regions placed on a track automatically retain their original MIDI Channel assignments. In other words, they play back on whatever MIDI Channel they were assigned to in the original MIDI file.

MIDI Port Selector

The MIDI Port selector, as it appears: 1) with OMS 2) with a MIDI Time Piece (no OMS) 3) without OMS or a MIDI Time Piece

Clicking on this button brings up a pop-up MIDI Port menu. This menu allows you to route the MIDI track to a desired destination including the Macintosh's serial ports and SampleCells installed in your Macintosh. Depending on whether you are using OMS, a MIDI Time Piece MIDI Interface, or neither, the appearance of this pop-up menu will differ. In order for the Pro Tools software to "see" a MIDI interface attached to the Macintosh's modem or printer serial port, you must turn on the interface before you start Pro Tools.
Track Display Format Selector

Clicking and holding the mouse on this button brings up a pop-up menu in which a track’s data display format can be chosen. Choices include Region Blocks, Waveform, Volume Graph, or Pan Graph. When a track is displayed as a volume or pan graph, the automation data for that track appears in the form of a line graph with a series of editable breakpoints. The breakpoints can be dragged to modify the automation data. When a track is displayed as region blocks, regions are displayed as simple blocks with the region name inside. Displaying a track as region blocks helps speed up screen redraws since there is much less data to be shown.

Note: Holding down the Option key while you choose a display format will display all tracks in the format that you choose.

Audio Region List

This is where audio regions appear after being recorded, loaded into Pro Tools with the Import Audio command, or created with one of the Edit commands. From here, they can be dragged into tracks and arranged in whatever order you choose. Regions that bear only the name of the original sound file represent the entire sound file. Regions appear in alphabetical order in this list and can be selected by typing the first letters of the region’s name.
Holding down the Option key and clicking and holding the mouse button on a region’s name in this list will allow you to audition that region.

A region’s name consists of two parts: the File name, which represents the audio file from which the region originated, and the unique Region name that you gave it when you created it. Pro Tools defaults to displaying just the region portion of a region’s name. If you wish to display the full name of a region (both the File and region portion), simply choose Show File Names in Region List from the Display menu. This will affect all regions in the Region List.

If you have a Pro Tools Project system with multiple hard drives and wish to know which drive a particular region resides on, choose the Show Volume Names in Region List option from the Display menu. Enabling this display option adds the hard drive (volume) name to region names in the Audio Region List. This too will affect all regions in the Region List.

Because region names can become lengthy (up to 31 characters in length for each half of the name), the Audio Region List can be scrolled in order to view full names. Clicking the name of an audio region in the Region List will highlight it in a track (and vice-versa — refer to the discussion of the two Preference options Region Selection follows Track Selection and Track Selection follows Region Selection in the Reference chapter.) Also, the window “split” can be moved to increase or decrease the width or length of the Region List.

**MIDI Region List**

This is where MIDI regions appear after being loaded into Pro Tools with the Import MIDI command in the File menu or after recording on a MIDI track. From here, they can be dragged into tracks and arranged in whatever order you choose. Regions appear in alphabetical order in this list and can be selected by typing the first letters of the region’s name.
MIDI Region names reflect both the name that you have given them and the name of the MIDI track in the original sequence from which they came. If you choose to display both names with Show File Names in Region List command, the original MIDI track’s name appears first, followed by a slash (/) and the name that you’ve given the region. The MIDI Region List can be scrolled in order to view full names. Clicking the name of a MIDI region in the MIDI Region List will highlight it in a track.

Note: Pro Tools’ MIDI playback supports Type 0 (merged) and Type 1 (multitrack) Standard MIDI files.

The Transport

The Transport functions much like a conventional tape transport and provides controls for (from left to right) on-line, return to zero, rewind, stop, play, fast forward, go to end, and record. In addition the Transport contains Pro Tools’ 100 autolocate buttons and Punch In/Punch Out Time indicators.

On-line
This button puts Pro Tools On-line, just as if you had selected Online from the Options menu. In this mode, recording or playback can be triggered by an external SMPTE-driven source.

Return to Zero
This button sets the playback cursor to the beginning of the Session.

Rewind
This button rewinds through the Session starting from the current cursor position.
Stop
This button stops playback.

Play
This button begins playback from the current cursor position.

Fast-Forward
This button fast-forwards through the Session starting from the current cursor position.

Go To End
This button sets the playback cursor to the end of the Session (more precisely, to the end of the last sound file/region in the Session).

Record
This button arms Pro Tools for recording. Clicking the Play button then initiates recording.

Autolocate buttons

Option-clicking one of these buttons (there are a total of 100) captures the current cursor location (or selection) in the track as an autolocate point and allows you to give the location a name. Autolocation points can also be dropped "on the fly" during playback or recording by pressing the Enter key on your computer keyboard. After you have defined one of these points, you can quickly navigate to it by clicking on the numbered autolocate button once. Pressing a number on your Macintosh keyboard (1-100) followed by a period will also take you to the corresponding autolocation...
point. You can rename an autolocation by double-clicking it. The scroll bars at the bottom of the transport allow you to scroll through the lists of all 100 buttons, ten at a time. Use of the Autolocate buttons is covered in greater detail in Chapter E, Editing.

Double-clicking an autolocate button brings up this dialog in which you can rename or set preferences for the selected autolocation button.

**Punch In/Out Time Indicators/Buttons**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>play start</td>
<td>0 : 28.208</td>
</tr>
<tr>
<td>record start</td>
<td>0 : 31.208</td>
</tr>
<tr>
<td>record length</td>
<td>0 : 57.400</td>
</tr>
<tr>
<td>record end</td>
<td>1 : 28.607</td>
</tr>
<tr>
<td>play end</td>
<td>2 : 36.600</td>
</tr>
</tbody>
</table>

These boxes display the values currently set for punch in/punch out recording. As you will learn later in this manual, Punch Ins are accomplished by selecting a waveform (or MIDI data) range on a track with the Selector Tool and then recording normally. The selected area becomes the section that is punched in. The Pre/Post-Roll command in the Setups menu allows you to leave a time before and/or after the punch occurs.

The Play Start box indicates the point at which Pre-roll begins, as specified in the Pre/Post-Roll dialog in the Setups menu.

The Record Start box indicates the point at which recording begins, as specified by the selected range on the track.

The Record Length box indicates the length of the punch, as specified by the selected range on the track.
The Record End box indicates the point at which recording ends, as specified by the selected range on the track.

The Play End box indicates the point at which post-roll ends, as specified in the Pre/Post-Roll dialog in the Setups menu.

You can edit these values by clicking and holding the mouse on the appropriate time field. A small up or down arrow will appear depending on whether you are closer to the top or bottom of the display. To increase the value, hold down the mouse with the up arrow displayed. To decrease the value, hold down the mouse with the down arrow displayed. If you are in Grid mode, time increments are determined by the Nudge/Grid Units Selector.

If you are using Pro Tools to “spot” audio to SMPTE Time Code, clicking on the Play Start, Record Start, Record Length, Record End, or Play End buttons (to the right of the time fields) will present you with a dialog in which you can edit the current selection’s start, end, length, and pre- or post-roll values in SMPTE frames. This dialog also allows you to capture incoming time code.

Clicking the Play Start, Record Start, Record Length, Record End, or Play End buttons brings up this dialog.
Conclusion
You should now be familiar with the tools and function of the Mix, Edit and Transport windows. You should also have the knowledge you need to open, close, create, and save Pro Tools Sessions. In the following chapters you’ll learn how to put these skills to use in your recording projects. When you have become sufficiently familiar with the Pro Tools interface, move on to Chapter C, Working with Tracks. There you will learn how to perform basic track management tasks including how to play, hide, display, and delete them, as well as how to assign voices, track priority, and track size.
Chapter C
Working with Tracks
Working with Tracks

Introduction

Before you begin recording to disk, it is first necessary that you have a fundamental understanding of Pro Tools tracks and how to manage them. Tracks are built from regions. Here we are going to deal with tracks at the simplest level—a track consisting of a single region. You will learn how to open a Pro Tools Session and perform basic track management tasks such as creating a new track, assigning voices and output channels, soloing and muting, adjusting volume and panning, and deleting a track. Some of this information has been introduced in previous chapters, but this chapter goes into greater detail about each topic.

How Pro Tools Manages Tracks

Though you may think of audio and MIDI data as very different entities, Pro Tools treats them much the same. The result is that the recording and editing techniques you will learn are identical for both. This approach is one of the most powerful aspects of Pro Tools.

When you are editing audio or MIDI with Pro Tools, you are basically dealing with two things: Tracks and Regions. For simplicity’s sake we'll deal with audio tracks and audio regions in the following explanation.

As you’ve already learned, a Region is a “piece” of audio data (or MIDI, or automation data) of arbitrary length. An audio Region could be a guitar riff, a verse of a song, a sound effect, a piece of dialog, or even an entire sound file. Regions are strung together to create tracks.

Pro Tools’ definition of a track is somewhat broader than the conventional multitrack tape analogy. A track can be made up of a single region or many regions. It can be made up of similar elements, as in the case of a composite guitar solo track made up of...
regions from several different “takes” of the solo. It can also be made up of dissimilar elements, as in the case of a track made up of several sound effects regions.

Though Pro Tools’ Mix and Edit windows differ in the way that they display tracks (a mixer module in the Mix window, versus graphic waveforms in the Edit window), the way that they manage them is the same. However unusual this new way of dealing with sound may seem to you at first, you will soon find that recording and editing sound this way is far more powerful and flexible than anything you have experienced before.

To summarize: Tracks are made of regions. Regions are the building blocks you will use to create tracks.

Creating New Tracks

You can add audio and MIDI tracks to your Session at any time by using the New Audio Tracks or New MIDI Tracks command (in the File Menu). New tracks created with this command will then appear in your Session in both the Edit and Mix windows.

Here’s a quick reminder of the number of tracks that are possible with each of the Pro Tools systems covered in this User’s Guide. These numbers represent the total number “virtual” tracks which each system supports — do not confuse these numbers with the specific voice capabilities of your particular Pro Tools system. Refer to the section Table of Track and Voice Limits for All Systems in Chapter A: Essential Concepts for more information:

<table>
<thead>
<tr>
<th>System</th>
<th>Virtual Track Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>55 tracks</td>
</tr>
<tr>
<td>Audiomedia</td>
<td>12 tracks</td>
</tr>
</tbody>
</table>

Pro Tools DAE PowerMix systems provide the following virtual track limits:

- 16 voice system* 64 tracks
- 12 voice system* 48 tracks
- 8 voice system* 32 tracks

*Note: Remember, the number of voices available on DAE PowerMix systems is dependent on CPU speed. Refer to the section “Table of Track and Voice Limits for All Systems” in Chapter A: Essential Concepts for details.
To create a new Audio or MIDI track:

- Choose New Audio Tracks (or New MIDI Tracks) from the File menu. The following dialog appears prompting you to enter the number of tracks you wish to create (the default value is 1).

![Create 1 new audio track(s).](image1)

The New Audio Tracks dialog

- Enter a number and click OK. The selected number of tracks appear. The new track is empty until you record on it or place a region into it from the Audio Region List or MIDI Region List.

- From the Mix or Edit window, double-click the new track's Track Name button. In the dialog that appears, enter a name for your new Track and click OK. This name will also be given to any new audio files that you record on the track.

![Name the track:](image2)

The Name Track dialog

- If you wish to display track Inputs/Outputs, Inserts, or Sends on your track, choose Show I/O View, Show Inserts View, or Show Sends View command from the Display menu, as you desire. (Note: Sends are available in Pro Tools Project only. On Audiomedia or DAE PowerMix systems the Show Sends View command will be grayed out.)

- Next, choose either the Show Extra Views in Mix Window or Show Extra Views in Edit Window command, depending on which window you want to display the selected controls in. The selected controls then appear on the new track (and all other tracks in the window).
Deleting a Track

At some point in a Session you may decide that you don’t need a track you have created. In that case, you can remove it from the Session with the Delete Track command in the File menu.

To Delete a track:

• Click on the name of the track to select it.
• Choose Delete Track from the File menu. A dialog appears asking you if you wish to delete the track from the Session.

Don’t be alarmed by this warning. Your audio or MIDI Region data will remain in the Region List, untouched. Your arrangement of the Regions on the track (the track’s “playlist”) will be lost, however.

• Click OK and the track will disappear from the Session.

Playing an Audio Track

Pro Tools gives you three ways to start a Session playing back: with the Transport’s Play button, with the Space bar, or via a MIDI controller. Each of these three methods will be explained in his section.

Before proceeding, take a moment to make sure all your audio and computer equipment is on and connected to an amplifier and speakers.
The Transport

One way to play back a track is with the Play button on the transport. Pro Tools’ transport will begin playback from the current playback point. To start playback from a different point in a track, you have several options: you can use the fast-forward or rewind buttons, you can click one of the autolocate buttons (if you have defined any), or you can jump to the Edit window to place the playback cursor at a new playback point. For now, simply use the Play button to start playback from the current location.

To play back a track with the Transport:

• If it’s not currently visible, choose Show Transport Window from the Display menu to make the Transport appear.
• Press the Play button. Playback begins.
• To stop playback, press the Stop button.

The Space bar

Another way to play back a track or region is with the Space bar.

To play back a track with the Space bar:

• Press the Space bar on the Macintosh’s keyboard. Playback will begin at the current playback point and continue through the end of the track, or until you press the Space bar again.

MIDI Controller

Pro Tools allows you to map a MIDI controller to any of Pro Tools’ Transport controls. You can also map MIDI controllers to Pro Tools faders and sliders (see the Mixing chapter for more information on controlling faders and sliders) using the same technique.
Because the Transport buttons are “on/off” controls, we recommend that you map a “switched” (on/off-type) controller, or a single MIDI key/pad, rather than a continuous controller (such as a pitch/mod wheel, slider-type control, etc.).

To map a MIDI controller to a Transport control:

- Hold down the Control key and click once on the Pro Tools Transport button you wish to remotely control. It turns green.
- On your MIDI device, move the controller that you wish to “map” to the Pro Tools Transport (again, use an on/off type controller such as an individual key or pad from a MIDI controller). When you move/press the MIDI controller, the on-screen Pro Tools Transport will toggle in tandem with it.
- You can now engage the desired Transport function from the MIDI controller.
- If you want to “unmap” the Transport control, hold down the Control key and click twice on the button, fader or slider you want to unmap. It is now unmapped.

You’ll learn about other playback options such as loop playback and track scrubbing in Chapter E, Editing.

---

Virtual Tracks, Voices, and Track Priority

As we begin to explore playback of tracks in more detail, it is probably a good time to say a few words about voices, track priority and “virtual tracks.”

The hardware which makes up your Pro Tools system provides a specific number of voices of audio playback. This number is the maximum number of different sounds that can play back at one time. With Pro Tools Project (an 8-voice system) a maximum of 8 sounds can be played back simultaneously. On a 4 voice system such as Pro Tools Audiomedia, 4 sounds can be played simultaneously. Pro Tools DAE PowerMix systems provide 8, 12, or 16 voices depending on CPU speed (for more information, refer to the table at the end of this section for a complete listing of Pro Tools' voice, track and virtual track limits).

The Pro Tools software, however, lets you create and use more tracks than the number of available voices (the exact number of available tracks depends on the hardware used) in a Session — tracks which can be recorded upon and cued up for playback but cannot all be played back simultaneously. Such tracks are called “virtual tracks” because they
provide virtually all of the functionality of real tracks except for this limitation. Note that track limits for each Pro Tools system vary — refer to the table at the end of this section for a complete listing of Pro Tools’ voice, track and virtual track limits.

In an environment such as this, where there are potentially many more tracks available than could ever play back at one time, Pro Tools must have a way of deciding which tracks get priority when more than four compete for just four voices. For instance, if you have one drum track and four guitar tracks in a 4-voice system, you may want to ensure that the drums have priority and always play back, and that Guitar 1 should always take precedence over Guitar 2; Guitar 2 over Guitar 3, etc. For this reason, Pro Tools provides two ways of assigning playback priority to audio tracks:

1) The Voice Selector pop-up menu (in each Track in the Edit and Mix window).

2) Track placement: The left-most track in the Mix window (or the topmost track in the Edit window) has priority over other tracks with the same Voice assignment.

When you click and hold the mouse on a track’s Voice selector, a pop-up menu appears offering a choice of Voices 1-4 (or 1-8, 1-12, 1-16 depending on your system). The numbers refer to voice assignments. Selecting Voice 1 for a given track signifies that the track will be played by Voice 1, selecting Voice 2 assigns the track to Voice 2, and so on. Enabling the Mute Frees Voice command (in the Options menu) and muting a track disables playback of that track, and surrenders control of its voice to the next highest priority track.

An Audio Track’s Voice selector on a 4-voice Pro Tools with Audiomedia system (left) and an 8-voice Pro Tools with DAE PowerMix or Pro Tools Project system (right)

It is possible to assign more than one track to the same Voice, but only one of the tracks—the one with highest priority—will play back at one time. The following illustration shows the Edit window with the two rhythm guitar tracks in the Demo Session assigned to the same voice (Voice 2). In this case, the topmost track (“Guitar”) has priority and will be heard. The lower track (“Guitar Echo”) will not be heard.
Two guitar tracks assigned to the same Voice

Another important point to understand about Pro Tools is that it has dynamic voice allocation. This means that it is smart about allocating voices when and where they are needed. So, when a “hole” opens up in a high priority track, its voice is temporarily available, and the track with the next highest priority “pops through” and begins to play. When the original track returns, the track that had popped through relinquishes the voice to the higher priority track again.

The following example demonstrates this concept:
The "Guitar Echo" track will "pop through"

If you look closely at the above illustration, you will see that there is an open area in the Guitar track where no region appears. At this point, Voice 2 is free since it is not being used, and the next highest priority track, Guitar Echo, will pop through the open area and play. This type of intelligent dynamic voice allocation is one of Pro Tools' most powerful features and one of the key reasons why Pro Tools is so much more flexible than conventional multitrack tape systems.

There is one important trick to remember when using this feature: in order for a lower priority region to pop through, it must be placed so that its beginning occurs after a higher priority track's region has ended. By arranging tracks so that lower priority tracks can pop through these open areas, you can get much more performance out of a system than just 4, 8, 12 or 16 tracks playback (or "voices" in Pro Tools parlance). Learning to use virtual tracks well is one key to unlocking the power of the Pro Tools system.
NOTE: Do not confuse the Voice Selector with the Output Channel Selector (covered later in this chapter). The Output Channel Selector routes Pro Tool’s digital audio to the physical output channels of your system.

**Summary of Voice and Virtual Track Limits of Pro Tools systems**

**Voices**

Voices refers to the number of digital audio events that Pro Tools can play back at one time. Here are the Voice limits of non-DAE/PowerMix Pro Tools systems:

<table>
<thead>
<tr>
<th>System</th>
<th>Voices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>8</td>
</tr>
<tr>
<td>Pro Tools with Audiomedia</td>
<td>4</td>
</tr>
<tr>
<td>Pro Tools with DAE/PowerMix systems</td>
<td></td>
</tr>
<tr>
<td>100 MHz or faster</td>
<td>16</td>
</tr>
<tr>
<td>80-100 MHz</td>
<td>12</td>
</tr>
<tr>
<td>&lt;80 MHz</td>
<td>8</td>
</tr>
</tbody>
</table>

**Virtual Tracks**

The number of virtual tracks supported by each system varies, as described below:

<table>
<thead>
<tr>
<th>System</th>
<th>Tracks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pro Tools Project</td>
<td>55</td>
</tr>
<tr>
<td>Pro Tools with Audiomedia</td>
<td>12</td>
</tr>
<tr>
<td>Pro Tools with DAE PowerMix</td>
<td>64 (16 track configurations)</td>
</tr>
<tr>
<td></td>
<td>48 (12 track configurations)</td>
</tr>
<tr>
<td></td>
<td>32 (8 track configurations)</td>
</tr>
</tbody>
</table>

For Power Macintosh users who have multiple Pro Tools systems in the same or different CPUs, another important concept is Virtual Voices. This is explained in the following section.

**Virtual Voices**

Users who have a Digidesign audio card and a Power Macintosh w/DAE PowerMix can take advantage of both systems’ capabilities by switching the Playback Engine. The ability to switch Playback Engine lets you run Pro Tools on your Digidesign audio card while recording (using the high-fidelity analog-to-digital converters on the card/audio interface), then switch to run Pro Tools with DAE PowerMix mode for up to 16-track playback using the built-in audio outputs of the Power Macintosh. Edit and mix using virtual tracks to get even more performance out of your system. When you’ve mixed your Session and bounced it down to a master audio file(s), switch the Playback Engine
back to your audio card/audio interface for maximum fidelity (using direct digital output) when you record the master files out to DAT or other digital medium.

All Sessions are compatible with all available Playback Engines. If you switch Playback Engines mid-Session, your Session will be saved, closed and reopened. When switching back and forth between Playback Engines, if the number of allocated voices in the Session exceeds the voice capability for the newly selected Playback Engine, all tracks with voice allocations over the maximum allowable will be set to “voice off” and these tracks are known as “virtual voices.” These tracks will still be displayed and may be edited, but will not playback audio.

When you switch back to a Playback Engine with increased voice capability, the Pro Tools Session will remember the previous voice allocation scheme for each track. If the voice allocation for a specific track has been edited while using a different Playback Engine, the original allocation prior to switching engines will not be retained.

Note: To switch Playback Engines before opening a Pro Tools Session, hold down the letter “N” when you double-click/launch the Pro Tools application. This will cause the Playback Engine dialog to appear, which will allow you to configure it prior to opening a Session.

---

### Assigning Voices, Output Channels and Track Priority

In the next section you will learn how to apply what you have just learned about track priority, voice assignment, output channel assignment, and output channels. In the next several examples, you can be in either the Mix or Edit windows, since they share most of the same basic track management functions.

**To assign an audio track to a Voice:**

- Click and hold the mouse button on the track’s Voice selector. A pop-up menu appears.

Assigning a Voice via the Voice Selector on a Pro Tools with Audiomedia system (left) and Pro Tools Project (right)
• Select the desired Voice and release the mouse button. The track is now assigned to the Voice you have chosen.

Choosing an Output Mode and Assigning Outputs

As you know, Pro Tools has two different operating modes, Direct Outputs mode and Stereo Mix Outputs mode. These modes allow you to configure Pro Tools to match your particular studio setup. If you are using Pro Tools Project or Pro Tools 442, you can utilize either mode.

In **Direct Outputs** mode, track outputs are routed to a single Audio Interface output: 1-8 (Pro Tools Project), 1-4 (Pro Tools 442). Panning controls are not available in Direct Outputs mode.

In **Stereo Mix Outputs** mode, track outputs are routed to pairs of Audio Interface outputs, either outputs 1-2 or 3-4, 5-6, or 7-8. Stereo Mix mode lets you set all your Pro Tools tracks to the same output pair and work entirely in Pro Tools virtual mix environment. In addition, each track contains controls for panning between the selected output pairs. You are not limited to a single pair of outputs. All output pairs remain available, which becomes useful when creating “stem” and “M&E” (music and effects) mixes, where it’s convenient to have audio elements in stereo pairs.

When using Pro Tools with DAE PowerMix as your Playback Engine, only Stereo Mix Output mode is available.

**To choose an output operating mode:**

• From the Options menu, choose Preferences. A dialog appears allowing you to choose and set several Session parameters.

• Choose the desired operating mode, Stereo Mix Outputs or Direct Outputs.

• If you choose Stereo Mix Outputs mode, track outputs are routed to a pair of Audio Interface outputs, either outputs 1-2 or 3-4 (and so on with 8-voice systems). In addition, each track contains controls for panning between the two selected output pairs.

• If you choose Direct Outputs mode, track outputs are routed to a single Audio Interface output: 1, 2, 3, etc. Panning controls are not available in Direct Outputs mode.

**To assign a track to an output channel:**

• If I/O controls are not currently visible on your tracks, choose the Show I/O View command from the Display menu.
• Next, choose either the Show Extra Views in Mix Window or Show Extra Views in Edit Window command, depending on which window you want to display these controls in. The selected controls then appear on the new track (and all other tracks in the window).

• Click and hold the mouse on the Output Selector button. A pop-up menu appears.

• If you are in Stereo Mix Outputs mode, select the desired output pair, 1-2 or 3-4, etc., and release the mouse button. The track’s Voice will now be routed to the chosen output channels.

• If you are in Direct Outputs mode (if available), select the desired output, 1, 2, 3, or 4, etc., and release the mouse button. The track’s Voice will now be routed to the chosen output channel.

![Image 1]
Setting the output of a Pro Tools Project audio track in Stereo Mix Outputs mode

![Image 2]
Setting the output of a Pro Tools Project audio track in Direct Outputs mode

---

**Changing a Track’s Playback Priority**

As explained earlier, when more than one track is assigned to the same Voice, the left-most (or top-most if you are in the Edit window) track has priority over the others assigned to that Voice. Moving another track of the same Voice to a higher position will then give that track priority.
You can change a track’s playback priority in either the Mix or Edit windows. In the Mix window, you will be dragging the track to the left to raise its priority. In the Edit window you will be dragging a track upwards to raise its priority.

To move a track’s position to change its playback priority (in the Edit window):

- Click and hold the mouse on the track’s Track Name button.
- Drag it above another track assigned to the same Voice. Though you can’t actually see a track as you drag it, you’ll notice that as you approach a border of another track, its edge begins to blink, indicating its position.
- Release the mouse button and the track will appear in the new location.

To move a track’s position to change its playback priority (in the Mix window):

- Click and hold the mouse on the track’s Track Name button.
- Drag it to the left of another track assigned to the same Voice. Though you can’t actually see a track as you drag it, you’ll notice that as you approach a border of another track, its edge begins to blink, indicating its position.
- Release the mouse button and the track will appear in the new location.

By experimenting with track priority, Voice assignment, and arranging Regions so that they are positioned to “pop through” holes in higher priority tracks, you will find many useful ways to apply virtual tracks and dynamic voice allocation to maximize the capabilities of your Pro Tools system.

---

**Setting MIDI Channels**

When you load a MIDI file into a Pro Tools Session, the Regions all retain the MIDI channel assignments that they had in the original sequence. Setting a MIDI track’s Channel Selector to “Channel -” will allow the Region to play back on its original channel. If however, you wish to “rechannelize” the Regions on a particular MIDI track, you can do so with the MIDI Channel selector.

**To assign all Regions on a track to a specific MIDI channel:**

- Click and hold the mouse button on the track’s MIDI Channel selector. A pop-up menu appears:
Chapter C: Working with Tracks

Soloing and Muting Tracks

Though a Pro Tools system can play back multiple Voices of audio simultaneously, you may not always want to hear all of them playing at once. It is useful to be able to isolate playback of one or more of the tracks at any given time for arranging purposes. To do this, you will use the Solo and Mute buttons. These functions can be engaged at any time during playback.

The Solo and Mute buttons affect MIDI as well as audio. In other words, if an audio track is solo’d, all other tracks in the Session—audio and MIDI—will be muted. It is possible to have more than one track soloed or muted at the same time in a Session.

As you learned previously, if you choose the Mute Frees Voice command in the Options menu, a muted track’s voice will be allocated to the next highest priority track assigned to the same voice. You should be aware that if you enable the Mute Frees Voice option, there may a delay (ranging in length from one to several seconds depending on the “size” of your system) between the time you mute or unmute a track and when you hear the effect on playback.

• Select the desired MIDI Channel and release the mouse.

The Solo and Mute buttons
To Solo a track:

- Click the Solo button on the track that you wish to solo. The button will be highlighted and all other tracks will be muted (unless they, too, are soloed) and the data on them will appear grayed-out.
- Click the Solo button again to turn off the Solo function.

Note: If you wish to unsolo all tracks, hold down the Option key when you click the Solo button.

To Mute a track:

- Click the Mute button on the track that you wish to mute. The track will appear grayed-out and be muted.
- Click the Mute button again to turn off the Mute function.

Note: If you wish to unmute all tracks, hold down the Option key when you click the Mute button.

Note: Though you can’t automate Solo and Mute buttons, you can achieve the same results using Pro Tools volume and pan automation. Volume and Pan automation are explained in the Mixing chapter.

Adjusting the Volume and Panning of a Track

In the Mix window, each track has its own Volume and Pan slider for adjusting the track’s playback volume and stereo placement. (Panning control for audio tracks is only available if your Session is set to Stereo Mix Outputs mode.)

On audio tracks, the Volume selector controls the track’s output volume. On MIDI tracks it controls MIDI volume on MIDI instruments that support this feature. If a track has Regions with MIDI Volume Controller data (created in the original sequence), its volume will be controlled by that data.
To Adjust the volume of a track:

- Click and drag the slider to the desired level. It has a range of \(-\infty \) (no output) to +6dB (full scale output).

NOTE: Holding down the Option key and clicking a Volume slider will automatically set its level to a default value of 0. In fact, holding down the Option while adjusting almost any of Pro Tools’ on-screen controls will set the control to its default position.

To adjust the panning of a track:

- Click and drag the slider to the desired level. It has a range of <100 (full left) to 100> (full right).

Panning a track full right or full left sends it to a single output channel.

Note: You can automate volume and pan using Pro Tools automation capabilities. You can also map MIDI Controllers to Pro Tools’ volume and pan sliders to control them remotely. Both of these features are explained in the Mixing chapter.
Configuring the Display

An important part of managing tracks is deciding how you want to display information on screen. Pro Tools gives you several options for configuring your recording and editing environment. These options include hiding tracks, reducing the on-screen size of tracks, selecting a Time Scale format, and more. Which options you choose depends largely on the nature of your Session and your needs at the time. Listed below are your options and how to implement them.

Show Mix Window
Choosing this command displays Pro Tools' Mix window.

To show the Mix Window:

• Select Show Mix Window from the Display menu. Pro Tools' Mix window appears.

Note: (To quickly switch between the Mix Window and the Edit Window, press "Command =".)

You can choose to show Pro Tools' Inputs/Outputs, Inserts (which contain Pro Tools' two digital EQs), and/or Pro Tools' two effects sends (when available) in either the Mix window or Edit window.

To show Track Inputs/Outputs in the Mix window:

• From the Display menu, enable Show I/O View.

• From the Display menu, enable Show Extra Views in Mix Window.

To show Inserts (EQs) in the Mix window:

• From the Display menu, enable Show Inserts View.

• From the Display menu, enable Show Extra Views in Mix Window.

To show Sends in the Mix window (Pro Tools Project only):

• From the Display menu, enable Show Sends View.

• Then, again from the Display menu, choose Show Extra Views in Mix Window.
Show Edit Window
Choosing this command displays Pro Tools' Edit window.

To show the Edit Window:

• Select Show Edit Window from the Display menu. Pro Tools' Edit window appears.

Note: (To quickly switch between the Mix Window and the Edit Window, press “Command =”.)

To show Track Inputs/Outputs in the Edit window:

• From the Display menu, enable Show I/O View.
• From the Display menu, enable Show Extra Views in Edit Window.

To show Inserts (EQs) in the Edit window:

• From the Display menu, enable Show Inserts View.
• From the Display menu, enable Show Extra Views in Edit Window.

To show Sends in the Edit window (Pro Tools Project and 442 only):

• From the Display menu, enable Show Sends View.
• Then, again from the Display menu, choose Show Extra Views in Edit Window.

Show Transport
Choosing this command displays Pro Tools' transport control. The transport looks and acts like the transport of a tape deck. It also contains autolocation buttons and Punch in/out indicators.

To show Pro Tools' Transport control:

• From the Display menu, choose Show Transport Window. Pro Tools' Transport control will appear.

Show/Hide Tracks
With large numbers of tracks, even a large display can quickly fill up, making it necessary to scroll through dozens of tracks to locate the one you want to edit. The Show/Hide Tracks command in the Display menu allows you to streamline your display by hiding
tracks you don’t wish to view. It also allows you to hide the Timeline, if you wish.

Be aware that even if a track is hidden from view, its position relative to other tracks still affects playback priority.

NOTE: Don’t confuse the ability to hide tracks with the ability to delete them with the Delete Track command. With the Show/Hide Tracks command, tracks remain open but invisible when hidden.

To hide one or more tracks:

- Select the Show/Hide Tracks command from the Display menu. A dialog appears listing all currently open tracks, and the Time Scale. A check next to an item indicates that it is currently displayed. An empty checkbox indicates that the item is currently hidden.

- Locate the name of the track(s) that you wish to hide and click the checkbox next to its name to remove the “X.” If you wish to hide the Time Scale, you may do so also.

- Click OK. When you return to the Mix or Edit window the items will no longer be visible.

Reduce Track Size

The Reduce Track Size command (in the Display menu) displays tracks on screen at roughly half of their full size. This mode is useful when the quantity of tracks shown is more important than the detail in which they are displayed. In this mode, buttons and selectors on tracks appear abbreviated.
Tracks as they appear in the Edit window at reduced size with Extra Views displayed

**To reduce the size of tracks on screen:**

- Enable the Reduce Track Size command from the Display menu. A check appears beside this item in the menu. Pro Tools will resize all of the tracks on screen to roughly half of their normal size.

**To restore tracks to their normal size:**

- Enable the Reduce Track Size command from the Display menu again. Pro Tools will resize all tracks to their full size.

**Track Display Format**

In the Edit window, each audio and MIDI track features a Track Display Format selector. This pop-up menu allows you to individually choose how you would like to view the data on each track. For audio Regions, you can choose Region Blocks, Waveform, Volume Graph, or Pan Graph. For MIDI Regions you can choose Region Blocks or Notes.

If you choose Region Blocks, Audio and MIDI Regions are displayed simply as blocks bearing the Region’s name. This mode is most useful when you have finished capturing and editing Regions at the waveform or MIDI event level and are simply moving and rearranging them. Screen redraw time is faster in this format.

If you choose Waveform mode for audio, audio Regions are displayed in graphic detail as waveforms with characteristic amplitude peaks and valleys. You will probably do much of your editing in Waveform mode because of the detail that it affords. Screen redraw time, however, is slower than in Region Blocks mode, due to the greater amount of detail rendered. After you have captured all of your Regions and merely wish to rearrange their order in tracks, you may opt to use the Region Blocks format in order to speed up screen redraw time.
If you choose Notes for MIDI, MIDI events are represented as dashes with relative durations and positions on the musical scale.

When an audio track is displayed as a volume or pan graph, the automation data for that track appears in the form of a line graph with a series of editable breakpoints. The breakpoints can be dragged to modify the automation data.

**To change the display format of a track in the Edit window:**

- Click and hold the track’s Display Format button. From the pop-up menu that appears, choose the desired format. Display formats can be chosen individually for each track in a Session.

Note: Holding down the Option key while selecting a display format will set all tracks to that format.
Color Coding Tracks

If you have a color monitor, you can take advantage of Pro Tools’ Color Code Tracks command. Enabling this option in the Preferences dialog (Setups menu) assigns a preset color to an audio or MIDI track according to its Voice assignment (audio tracks) or MIDI channel assignment (MIDI tracks). By default, this option is already enabled, but you can turn it on or off via Preferences.

This feature allows you to quickly identify tracks which are assigned to the same Voice (or MIDI channel). It is particularly useful in Sessions where you wish to make efficient use of virtual tracks. Since tracks assigned to the same Voice share the same color, you can easily identify and arrange Regions so that they do not overlap or conflict with other Regions on tracks assigned to the same Voice.

To enable/disable Color Code tracks:

• Choose Preferences from the Option menu. The Preferences dialog appears.
• Disable or enable the Color Code Tracks item in this dialog by clicking to toggle its status. Click OK to close Preferences.
Displaying the Time Scale

Pro Tools provides four different time formats for working with audio: Bars & Beats, Minutes:Seconds, Time Code (SMPTE frame numbers), or Feet:Frames. Which time format you use will depend on your project, but you can easily set Pro Tools' Time Scale to display any of them. The Time Scale can also be grabbed and dragged to be between any tracks.

If you are dealing mainly with MIDI, you may want to use Bars & Beats. If you are synchronizing sound to tape, you’ll use Time Code. In some cases you may even find yourself switching from format to format as you complete various editing tasks. Described below are each of the time formats and how they are used.

Bars & Beats

The Bars & Beats command displays the Time Scale in bars and beats. To create this time scale Pro Tools must have some tempo data to base it on. There are three main methods for setting up your Bars & Beats tempo map — Identify Beat, Import MIDI, and MIDI Metronome. Refer to Chapter E: Editing to learn how to create tempo with the Identify Beat command.

To display time in bars & beats:

- Select Bars & Beats from the Display menu. Pro Tools' Time Scale will display time in bars and beats.

Minutes:Seconds

Choosing this command displays the Time Scale in minutes and seconds. As you zoom in farther with the Zoomer, the Time Scale begins to display tenths, hundredths, and thousandths of a second.

To display time in minutes and seconds:

The Time Scale dialog
• Select Minutes:Seconds from the Display menu. The Time Scale will display time in minutes and seconds.

Time Code
Choosing this command displays the Time Scale in SMPTE frames. Frame rates are chosen in the Time Code window, available from the Setup menu. Pro Tools supports the following frame rates: 24, 25, 29.97 Non-Drop, 29.97 Drop, 30, or 30 Drop frames per second.

Pro Tools can be set to record or play back audio at specific SMPTE frame locations when it is on-line. For more information see Chapter F, Working with SMPTE.

To display time in SMPTE frames:
• From the Setups menu, choose Time Code and select the appropriate frame rate.

The Time Code dialog

• Select Time Code from the Setup menu. Pro Tools’ Time Scale will display time in the SMPTE frame rate that you have chosen.

Feet.Frames
Choosing this command displays the Time Scale in feet and frames for referencing audio-for-film projects. The Feet.Frames time display is based on the 35 millimeter film format.
When you choose this time format, you have the option of entering a Start Frame for your Session based on an appropriate frame location at the beginning of your project tape. Your Session will then use this value as its start frame reference.

The Feet.Frames dialog

To display time in feet and frames:

- Select Feet.Frames from the Display menu. A dialog appears allowing you to enter a start frame for your Session if you wish.
- Enter an appropriate start frame if you desire, and click OK. This value will become the “zero point” of your Session. The Time Scale will display time in feet and frames. Negative offsets are not supported.

You should now have a basic understanding of how to manage audio and MIDI tracks. In the next chapter, you will get started recording to disk with Pro Tools. Read on!
Chapter D
Recording
Recording

Introduction

In this chapter you'll learn how to use Pro Tools' Mix window to perform direct to disk recording. Though track recording can actually be performed in either of Pro Tools' windows, the Mix window is particularly well suited to this task. In addition to recording basics, you'll also learn how to work with MIDI.

Beginning a Recording Session

The first step in beginning a new Pro Tools project is creating a new Session.

To start a new Pro Tools recording session:

- Choose New Session from the File menu. A dialog appears asking you to name the Session.

The New Session dialog

- Use the pop-up menu at the top of this dialog to navigate to the drive you plan to record on. Create the Session there.

- Enter a name for the Session and click OK. The Pro Tools Transport appears, followed by the Edit window.
• To display the Mix window, choose Show Mix Window from the Display menu.

• Choose New Audio Tracks from the File menu. A dialog appears allowing you to specify the number of tracks you wish to create.

• Enter a number and click OK. The specified number of tracks appear.

• Double-click the new track’s Track Name button, and in the dialog that appears, name your track. This name will also be given to any audio files that you record on the track. Click OK.

• To display Input/Output controls, Sends (if available) and Inserts (EQs) on your track, choose Show Extra Views in Mix Window from the Display menu. Then, from the same menu, choose Show I/O View, Show Inserts View, and/or Show Sends View, as you desire. These will then appear on the new track (and all subsequent tracks in the Mix window).

**About EQs**

Pro Tools features pre-fader, in-line digital equalizers on its tracks. EQs are available via the Inserts pop-up menu on a track. The number of EQs available depends on your Pro Tools configuration:

• Pro Tools Project systems provide a maximum of 4 EQs.

• Audiomedia-based systems provide a maximum of 4 EQs.

• DAE PowerMix-based systems provide 2 EQs per playback track.

**About Sends (Pro Tools Project Systems Only)**

Pro Tools’ Sends are signal busses that allow you to send a track’s signal out through an Audio Interface output (outputs 7 and/or 8 on Project systems) to an effects processor, and then return that signal via an Auxiliary Return Track from the processor to the master output mix. Pro Tools offers two send and return buses. Each mixer module offers two independent monophonic effects sends or one stereo send. Auxiliary inputs for the effects returns must be created with the New Auxiliary Inputs command (in the File menu). Sends and Returns are covered in greater detail in Chapter G, Mixing.
Sends are only available on Pro Tools Project systems. Sends are not available on DAE PowerMix or Audiomedia III-based Pro Tools systems.

Labeling System Inputs and Outputs

Pro Tools' I/O Labels command provides you with a convenient way to give meaningful names to your system's inputs and outputs. This feature is handy for labeling your inputs according to the devices that are connected to them. (The number of inputs and outputs that appear in this dialog depends on which Digidesign card and interface device you are using with Pro Tools.)

To label your system's inputs and outputs:

• From the Setups menu, choose I/O Labels. The I/O Labels dialog appears.
• To name a system input or output, click in the appropriate text box and enter a descriptive name.
• When you have finished labeling all of the inputs/outputs that you wish, click OK.
• From now on, when you select an input from the Audio Input Selector pop-up, the input will be labeled with the name you have given it.
Recording to Multiple Hard Drives

If you are using multiple hard drives for audio recording, Pro Tools provides an easy-to-use scheme for recording different tracks in a single Session to different hard disks.

To configure your Session to record tracks to multiple hard drives:

- After you have used the New Audio Track command to create the audio tracks for your Session, choose Disk Allocation from the Setups menu. This dialog appears, listing all current tracks in the Session and hard drives attached to your computer or Pro Tools Project card.

The Disk Allocation dialog
• Choose a specific drive for each track by clicking on the pop-up Record Drive
  menu at the right of the dialog. Holding down the Option key while choosing
  a drive from the pop-up menu will set all tracks to the selected drive.

• If you wish to sequentially allocate any new tracks that you create to your drives,
  click the Use round robin allocation for new tracks option.

• Click OK.

From this point forward, when you record tracks, the tracks will be routed to the
selected drive. If you have chosen the Use round robin allocation for new tracks option,
when you create a new track, each subsequent track will be recorded on the next
available hard drive. A folder with the Session name is created on each hard drive. This
folder contains Audio Files and Fade Files folders.

---

A Few Words About Input Levels

One of the most important things to remember when recording digital audio is to
record at as high a level as possible without distortion. It is important to understand
that level refers to the amount of audio signal going to the recording medium, not just
the volume of the source of the audio. For example, adjusting the recording level of an
electric guitar not only involves finding the correct balance between the actual volume
of the guitar/guitar amp, but also the level of the signal from the microphone to the
recording device.

Setting Proper Levels: Keep Them High, But Avoid Distortion!
When you are setting input levels, remember the golden rule of digital recording: You
should supply the hottest signal possible—without clipping. Basically this means that
your input signal should register as high as possible on your input meter without
turning on the red clip LED. If the input level is too low, analog noise from your
instrument may be audible. If the signal is too high, it will be clipped. Clipping occurs
if you exceed the maximum level allowed. The result is distortion. With digital audio,
this is undesirable because digital distortion sounds terrible. Once clipping occurs, there
is no easy way to remove the distortion from the audio. Thus, it is always best to leave a
little headroom as a margin for error so that you don’t hit maximum levels and clip your
audio. Setting recording levels this way will leave you with some headroom in case you
unexpectedly make a sudden large jump in level.

It is important to remember that Pro Tools’ software track Volume and Pan faders only adjust
the monitoring level of a track—not the recording input gain.
Integrating MIDI into a Recording Session

Although Pro Tools is first and foremost a multitrack hard disk recording and mixing environment, it both supports and augments MIDI. If you plan to integrate MIDI into a Pro Tools Session, it is a good idea to plan for this from the very beginning. Pro Tools is an environment where both MIDI and digital audio can coexist, play simultaneously, and remain in a playable and editable form. Here are two possible scenarios for integrating MIDI into a Pro Tools Session:

1. Recording MIDI First
   If you have an existing MIDI sequence and you wish to record audio over that sequence, import the MIDI file into Pro Tools. Pro Tools supports both single- and multitrack Standard MIDI File formats, which means you can import and use sequences created in any full-featured sequencing software package, such as Vision, Cubase, Logic, or Performer. You can then record Pro Tools audio tracks in sync with the imported MIDI tracks.

   Pro Tools supports MIDI files with tempo maps, and supports playback of single-event and multi-event generated tempo maps. When you import a MIDI file into Pro Tools, the MIDI file is automatically loaded into the Session, and that file's tempo map becomes the master tempo map for the current Pro Tools Session. (Or if you wish, you can apply any existing tempo map in your Session to an imported MIDI file). Remember, however, that only one tempo map may be active at any time. If you wish to add more MIDI in your Session, you can record MIDI directly with Pro Tools or export the sequence and edit it in a dedicated sequencing program. If you are an advanced MIDI user, you may wish to do the bulk of your sequencing in a full-featured sequencing software package.

2. Recording Audio First
   If you wish to record audio first and then lay in some MIDI tracks, record the audio tracks in time to a MIDI click using Pro Tools’ MIDI Metronome feature (described in the next section). Although this is not absolutely necessary, it assures you that your recorded MIDI tracks will be easy to edit in Pro Tools or a sequencing program after they are recorded. Matching MIDI to audio tracks after the audio has already been recorded can be an arduous task. Although Pro Tools supports nonlinear tempo maps, the creation of these maps in Pro Tools can be very time-consuming. A click guarantees that recorded MIDI tracks will be easy to edit and export for editing to any external sequencers.
Again, as producer, before you begin a project, you should know the production order: Either the MIDI tracks will be sequenced first, or the audio tracks will be recorded first.

For integrated MIDI sequencing and audio recording, you may also want to consider a digital audio sequencer program that supports the Pro Tools hardware and DAE, such as Logic Audio, Studio Vision, Digital Performer, or Cubase Audio.

**Using the MIDI Metronome**

MIDI sequencing and editing systems are generally bar and beat oriented. Since Pro Tools integrates MIDI and audio, Pro Tools provides a MIDI Metronome for record and playback functions. The MIDI Metronome serves two purposes. First, it gives you a bar and beat framework for MIDI recording, so you can record MIDI tracks that will be easy to edit and export in dedicated sequencing programs. Second, the click also lets you select your MIDI tempo, so you can record audio tracks before recording MIDI tracks, and still be sure that the MIDI tracks will line up on correct bar/beat borders. In addition, recording audio to a MIDI click creates a tempo map in the Session, allowing you to take immediate advantage of Pro Tools’ powerful Grid mode for audio editing.

Pro Tools supports a real time method for entering a MIDI Metronome tempo. The method used is called “tap tempo” because it allows you to tap along (on the space bar) at a tempo you like. Pro Tools actually watches the timing of your tap and generates a tempo event that describes the average tempo you have played.

New Pro Tools Sessions have no designated tempo value. Without a tempo selected in the MIDI Metronome dialog, Pro Tools’ counter will not advance when the Time Scale is set to Bars/Beats. The counter will function properly if you set a tempo for your Session, import a MIDI file that contains a Tempo Map, or define a Tempo Map in the Edit window.

**To use the MIDI Metronome:**

- Make sure that your MIDI sound module(s) and MIDI interface are on and connected properly to the Macintosh.
- From the Setups menu, choose MIDI Metronome. The following dialog appears:
The MIDI Metronome dialog

• In the dialog, select the correct port for your MIDI Interface.

• Select the MIDI channel on which you want to transmit the click's MIDI event.

• Select a MIDI note number, and velocity. Make sure the sound you select for your click has a fast attack. Since the note-off event is sent immediately after the note-on, sounds with slow attacks are not suitable as clicks.

• Enter a value for a MIDI tempo. Or, if you like, tap a tempo on your computer keyboard's Space bar and Pro Tools will translate it into a numerical value.

• Choose whether to use the MIDI Metronome during recording, playback, or both.

• When you have finished, click OK.

Importing a MIDI File

If you wish to use an existing MIDI sequence in your Pro Tools Session, you can do so by importing the sequence with the Import MIDI command. This command is available in both the File and Region List menus in Pro Tools, though each imports the sequence in a slightly different way. When you bring MIDI data into your Session with either of these commands, Pro Tools converts a copy of the file into Session data which is saved within the Session file. The source MIDI file remains unchanged.

Import MIDI Command (File Menu)

Choosing the Import MIDI command from the File menu loads all tracks from the source MIDI file into Pro Tools' MIDI Regions List and automatically places them in individual Pro Tools tracks. If your original sequence had 32 tracks, Pro Tools will create 32 MIDI tracks, each with the appropriate MIDI Region placed in it. This command is a
real time saver if you intend to use all of the tracks in the original sequence.

The Import MIDI command also gives you the choice of either applying the Tempo data in the sequence to your Session, or applying the Tempo data in the Session to the sequence.

If your Session already has MIDI Regions in it, when you choose the Import MIDI command you will also have the option of discarding all MIDI data currently in your Session. If you want to keep the existing data and add additional MIDI Regions to your Session, simply click Cancel in this dialog.

The Import MIDI command gives you the choice of discarding all previous MIDI data in the Session before importing new MIDI data.

**Import MIDI Command (Region List Menu)**

Choosing the Import MIDI command from the Region List menu loads a Standard MIDI file into Pro Tools' MIDI Regions List only—not into individual MIDI tracks. From there you must drag the Regions into MIDI tracks you have created by yourself. This is useful if you intend to use only certain tracks from the original sequence.

Pro Tools supports Type 1 and Type 0 Standard MIDI Files. A Type 1 file appears as separate MIDI Regions (one for each track in the sequence) each with the name and channel settings that it had in the original sequence. A Type 0 MIDI file appears as a single MIDI Region with data from all tracks grouped together—each still retaining its individual parameters such as Channel assignment, etc. Your sequencing software should have an option for saving your sequence as one of these Standard MIDI File types. Unfortunately, the Standard MIDI File format doesn't keep track of your MIDI port assignment, so you may need to reassign the different tracks' MIDI ports.

When a Pro Tools MIDI track’s Channel selector is set to “Channel - “ all Regions on the track will automatically play on the MIDI channel(s) they were assigned to in the original sequence. Setting the MIDI Channel Selector of a track to a specific MIDI channel, on the other hand, will “re-channelize” all Regions on that track to play back on the selected MIDI channel.
Remember that Pro Tools imports single- and multitrack Standard MIDI Files only. Pro Tools does not open sequencer files directly. You will need to use your source sequencing program to export your sequence as a Standard MIDI File before it can be imported into Pro Tools.

**To import a Standard MIDI File:**

- Choose Import MIDI from either the File or Region List menu, depending on your needs. This dialog will appear:

  ![The Import MIDI dialog](image)

- Locate and select the MIDI file you wish to import.
- If you wish to use the Tempo Map of the selected MIDI file in your Session, click Import Tempo From MIDI File. If your Session already has a tempo map that you wish to keep, click Use Existing Tempo From Session. The MIDI file will, upon being imported, adopt the tempo already present in the Session.
- Click Open. Pro Tools will import the sequence into your Session.
Suggested Recording Techniques

How to Mic Specific Instruments
In general, if you are working in your home, you will want to keep your mics as close to the sound source as possible. This is called tight miking and it will help to reduce ambient noise (such as cars passing by). Here are some basic suggestions on how to mic typical instruments:

- Vocals/Narration: Use either a dynamic or a condenser microphone (see Glossary) depending on the vocalist/narrator’s style of singing/speaking. You may need a wind screen to prevent “popping P’s” and other strongly articulated sounds.
- Drums: Use dynamic mics pointed close to the skin of the drums. To pick up overhead cymbals and hi hat, use two condenser microphones in a cardioid pattern.
- Acoustic Guitars: Use a condenser microphone pointed 6-8 inches from where the neck of the guitar meets the body of the guitar.
- Electric Guitars: Use a dynamic microphone 8-10 inches away from the cone of the speaker, at a straight or a slight angle to the cone.
- Piano (Grand): Use a condenser microphone near the body of the strings and a dynamic microphone near the hammers.
- Piano (Upright): With the top lid open, place a condenser mic at each end of the sounding board.

Additional Tracking Suggestions

- If you can afford it, invest in a multi-effects device that provides compression and gating. These signal processing devices are a big help in reducing noise and distortion while recording. A compressor evens out signal levels by reducing the dynamic range of signals that exceed a selected threshold. This imparts a smoother sound to recorded material and cuts down on the possibility of distortion. A gate cuts off all unwanted signals below a certain user-selectable threshold. This effectively silences any low level noise that may be part of a signal (as in the case of a noisy guitar amp).
- Try not to use much EQ while you record. If you have to EQ, use subtractive EQ, (cut bottom frequencies instead of adding high end frequencies).
- If you are recording drums and have tracks to spare, try to keep the kick and snare drum of a drum kit on separate tracks. This will give you more flexibility when it comes time to mix.

- If you are recording bass guitar, use a little compression. This will give the bass more punch later when you create your final mix.

- If you aren’t sure how you want your final mix to sound, don’t record instruments “wet” (with effects such as chorus, flanging, etc.). Wait until you are ready to mix.

- If you are sure of what you want your final mix to sound like, and you don’t plan to use many effects, you may wish to record some instruments “wet.”

- Finally, get into the habit of writing down everything on a track sheet: the type of mics you used, EQ settings, any outboard signal processing gear used, etc. It’s helpful to be able to recreate your setup (and sound) in case you have to rerecord a particular track in the future.

Pro Tools’ Get Info command provides a convenient way to jot down information about a Session and save it with the Session itself. See Chapter H, Pro Tools Menus for an explanation of how to use this feature.

---

**Initiating Recording**

In many ways, recording your first track is the most important step in a multitrack recording project because it forms the framework upon which all other tracks are built. If the basic timing of the first track is sloppy, the entire production could be affected.

The production cycle of a Pro Tools recording Session typically progresses something like this: Set recording and monitoring levels and record your first track. Then, play back track 1 to make sure you like it, and set its volume level. Next, record track 2 while listening to track 1. Now play both tracks back while recording track 3. Follow this same procedure to record track 4, etc.

With this procedure in mind, you are now ready to begin recording digital audio to disk.

If you are using the 882 Studio Audio Interface you must make the appropriate connections between the 882 Studio’s inputs and Pro Tools before you begin recording. To do this, choose the Hardware command from the Setups menu and click the Options button. The Route dialog will appear allowing you to make the desired connections. If you are unsure how to use the Route dialog, please refer to Chapter B, “Pro Tools Basics.”
To record an audio track:

• If you are just beginning a recording session, choose Hardware from the Setups menu and click Recalibrate Inputs. This will help eliminate any DC Offset that may have built up in your system’s analog-to-digital converters. (DC Offset is an imbalance that sometimes occurs in digital-to-analog converters. It can cause loss of headroom in recording and clicks and pops during editing.)

• Make sure that a sound source is connected to the appropriate input of your Audio Interface, Audiomedia card, or Power Macintosh audio input jack.

• In the Mix window, click the track’s Rec button. The track is now record-enabled.

• Adjust your input monitor level and panning. (These settings will not affect what is recorded to disk—they are for monitoring purposes only.)

• If you are using DAE PowerMix and the built-in audio capabilities of a Power Macintosh, Pro Tools’ track faders only allow two monitor levels: on or off—that is, full volume or zero volume. This is a limitation of the Power Mac’s sound chip. Thus, if a track’s monitor level fader is set anywhere above zero, audio is passed through at full volume. If a track’s monitor level fader is set at zero, audio is not passed through for monitoring. (The audio is still recorded to disk, but you just can’t hear it through the Apple Sound Manager.)

• Click the track’s Input Selector to route the appropriate input to the track.

• Adjust the output level of your instrument, mixer or preamp. Be careful to watch the LED’s on your on-screen track metering so that you get the highest possible level without clipping.

• If you are using an Audiomedia III-based system, choose the Hardware command from the Setup menu and click the Options button. In the dialog that
appears, use the Input Gain buttons to adjust input gain appropriately. Avoid setting input gain so high that you cause distortion. Click Done to close this dialog when you have finished. Click OK to close the Hardware dialog.

Audiomedia III-based systems allow input gain adjustment via this dialog

- Click the Record button on the Transport. It turns red and begins to flash.
- When you are ready to begin, click Play. (You can also press Command-Space bar to initiate recording.) Direct to disk recording commences.
- When you have finished your take, click the Transport’s Stop button or press the Space bar on your computer keyboard to stop recording.

To play your track:

- Click the Rec button on your track once again to take it out of record-ready mode. The track’s volume fader now functions as a playback level control.
- Click Play on the Transport or press the Space bar to begin playback. Adjust playback level and panning as necessary.

At this point, if you wish to try your take again, you have the option of destructively recording over it, or non-destructively recording another take and creating a new audio file.

“Destructive” versus “Non-Destructive” Recording
You may find it most convenient to use Pro Tools in nondestructive recording mode. In this mode if you record over a track, the original track is simply “unloaded” from the track, and a new audio file is created and placed into the track. The new audio and the old audio both remain on your hard drive. Pro Tools will give the new audio file the name of your track and add a “take” number to it (a higher number for each subsequent take you perform).
Pro Tools does offer a destructive record mode. When you record in destructive record mode, new tracks permanently replace existing track data on the hard disk, thereby erasing the old data. There is no Undo function in destructive recording mode, so use it with care.

To non-destructively record a new take on the same track:

- In the Options menu, make sure that Destructive Record is disabled. When Destructive Recording is disabled, a check does NOT appear next to it.

- Repeat the steps outlined previously for recording a track.

In non-destructive record mode, hold the Option key while you press the Stop button (or press Command-period) to discard the take. In Destructive Record, this feature does not function (nor is there an Undo capability). Please note that this function cannot be undone!

If you like, you can begin recording at any point in time within a file simply by going to that point (either with the Transport, or by going to the Edit window and clicking the Selector at the desired point) and commencing recording in the same way as above. Pro Tools also provides a precise way of performing punch-in recording using the tools in the Edit window (or if you are using Pro Tools Project system, by using the QuickPunch feature, covered later in this chapter). Because this technique requires familiarity with Pro Tools’ editing tools, you will learn about it in Chapter E, Editing.

To destructively record over your previous take:

- Choose Destructive Record from the Options menu. When enabled, a check appears next to this menu item.

- Repeat the steps outlined previously for recording a track.
Of course, you can record additional new material into the same audio file at the end of the old take, too, if you like. To do this, simply “fast-forward” the track to its end with the Go to End button on the Transport. Then begin recording. Pro Tools will append the new audio to the end of the old take.

Naturally, you are not limited to appending audio only to the end of a file. If you like, you can begin recording at any point within a file, simply by going to that point and commencing recording. This type of recording is similar to “punch-in” recording on a conventional deck. Pro Tools provides a much more precise way to perform punch-ins, however. But because this technique requires familiarity with Pro Tools’ editing tools, you will learn about it in Chapter E, Editing.

If you inadvertently attempt to record to an input channel which is currently in use by an auxiliary input track, Pro Tools will automatically mute the auxiliary input track. Conversely, if you attempt to set an auxiliary input track to the same input channel as a record-enabled track, Pro Tools will take the track out of record enable.

---

**Stereo Recording**

To record in stereo (or to record on multiple tracks simultaneously) simply hold down the Shift key and click the Rec button on additional tracks. The rest of the recording procedure is identical to the explanation given previously. One of the most useful applications for recording two tracks simultaneously is recording vocals or instruments in stereo. If you plan to record an instrument in stereo, you must use two tracks so that you can capture both the left and right channels of the stereo signal. When you play the tracks, remember to pan one track full left and the other full right to preserve the stereo image.

NOTE: Option-clicking on any track’s Record button enables all tracks for recording.

**To record audio in stereo:**

- Make sure that your sound sources are connected to the appropriate inputs of the Audio Interface, Audiomedia III card, or Power Macintosh audio input jack.
- Click on the first track’s Rec button. It is now record-enabled.
- Click the first track’s Input Selector to route the appropriate input to the track.
- Hold down the Shift key and click on a second track’s Rec button. The second track is now record-enabled.
• Click the second track's Input Selector to route the appropriate input to the track.

• Set the Pan controls for the tracks to 100% right and 100% left respectively to allow stereo monitoring during playback.

• Adjust the output level of your instrument, mixer or preamp. Be careful to watch the LED’s on both tracks so that you get the highest possible level without clipping.

• Click the Record button on the Transport. It turns red and begins to flash.

• When you are ready to begin, click Play. Direct to disk recording commences.

• When you have finished your take, click the Transport's Stop button or press the Space bar on your computer keyboard to Stop recording.

Recording From a Digital Source
(Digidesign Audio Interface or Audiomedia Card Required)

If you have a Digidesign Audio Interface or Audiomedia card you can record directly from a digital source (such as a DAT player) by using the digital connectors on the Audio Interface or Audiomedia card. This allows you to avoid unnecessary digital-to-analog conversion, which if done repeatedly can compromise the quality if your audio material. The 888 I/O interface features both AES/EBU and S/PDIF digital inputs and outputs. The 882 I/O and Audiomedia III card feature S/PDIF digital inputs and outputs only.

If you plan to use a DAT player, CD recorder, or other digital input and output device with your Pro Tools system, be sure the device supports the correct digital format for your Digidesign Audio Interface or Audiomedia card—AES/EBU inputs and outputs should only be connected to another AES/EBU-equipped device. Similarly, S/PDIF inputs and outputs should only be connected to another S/PDIF-equipped device. Since the 888 I/O’s AES/EBU and S/PDIF outputs are active at all times, you can actually send digital audio to two different digital devices simultaneously at mix time if you own this Digidesign Audio Interface. However, Pro Tools can only receive digital audio in one format at a time.

To connect your Pro Tools system to a DAT recorder:

• Connect the digital output of the DAT recorder to the appropriate digital input of your Audio Interface.
• Connect the appropriate digital output of the Audio Interface to the digital input of the DAT recorder.

• From the Setup menu, choose Hardware. The Hardware Setup dialog appears.

![The Hardware Setup dialog](image)

• Click the Sample Rate pop-up and choose the appropriate sample rate.

• Click the Sync Mode pop-up and set it to Digital.

• Click on the Digital Format pop-up menu and set it to the proper format, AES/EBU or S/PDIF, depending on which of these you are using.

• Click on the Ch 1-2 Input pop-up menu and set it to Digital.

• Click OK to close the Hardware Setup dialog.

• Click the Record buttons on the tracks that you wish to record to. Then click the Input Selectors to route the Audio Interface Ch 1-2 Inputs to the tracks.

• Set the Pan controls for the tracks to 100% right and 100% left respectively to allow stereo monitoring during playback.

• Since this is a digital-domain transfer, there is no need to set levels.

• Click the Record button on the Transport. It turns red, indicating that you are ready to record.

• When you are ready to begin, click the Transport’s Play button. You’re now recording to hard disk.

• Press play on your DAT recorder to begin playback.

When the material on the DAT deck has finished, click Stop on Pro Tools’s Transport or press the Space bar to stop recording.
IMPORTANT
After you have successfully recorded the material from DAT be sure to do the following:

- Choose Hardware from the Setups menu and set the Ch 1-2 Input parameter back to Analog.
- Set the Sync Mode pop-up menu back to Internal.

You must remember to do this after you finish recording digitally or Pro Tools won’t be able to switch back to its own internal clock, and won’t be able to record or play audio on disk properly!

Transferring Audio From an Audio CD

Pro Tools conveniently allows you to transfer audio directly from an audio CD. Transferring audio from an audio CD requires an internal CD-ROM drive. It utilizes Apple’s Sound Control Panel. The method for doing this is explained below.

To record audio from an audio CD using an internal CD-ROM drive:

- Insert the desired audio CD in your CD-ROM drive.
- From the Apple menu, choose the Sound Control Panel. The Apple Sound Manager window appears.
- Click the pop-up menu at the top of the Sound Manager window and choose Sound In. The following dialog appears:

![Sound Control Panel](image)

- Click the Options button.
• In the next dialog that appears, select Internal CD. Click Playthrough (so that you can listen to the CD’s audio while recording) and then click OK to close the dialog.

• Close the Sound Manager window by clicking its close box.

• In Pro Tools, record enable the destination track (or tracks for stereo recording).

• To initiate recording, click Record and then Play on the Transport (or press Command-Space bar).

• From the Apple menu, choose AppleCD Audio Player.

• AppleCD Audio Player’s volume slider sets the level at which the audio will be recorded into Pro Tools. For optimum fidelity and signal-to-noise ratio, set this as high as possible without causing Pro Tools to clip.

• When the AppleCD Audio Player’s controls appear, select the CD track that you wish to record into Pro Tools and click Play.

• When you have finished, stop playback of the CD by opening AppleCD Audio Player and clicking Stop.

• Click Stop on Pro Tools’ Transport to stop recording (or press the Space bar).
Using QuickPunch
(Pro Tools Project Systems Only)

Pro Tools features an intelligent punch-on-the-fly capability called QuickPunch. QuickPunch gives you the ability to instantaneously punch-in (initiate recording) on a record-enabled audio track during playback and then “punch-out” (exit recording) simply by clicking the Transport’s Record button.

This capability can be toggled on and off with the QuickPunch command in the Options menu. Once QuickPunch is enabled, simply record-enable the desired track, begin playback, and then use the Record button on the Transport to punch in and out. QuickPunch can also be conveniently triggered remotely with a MIDI controller (see the section entitled MIDI Mapping of Transport Controls later in this chapter).

When you use QuickPunch, newly-recorded material is recorded into a new audio file. Within this file, Regions (and surrounding Regions) are auto-named or renamed with appending take numbers. Up to 100 “running punches” can be performed during a single pass. Each punch will be recorded into the same new sound file with each in/out point automatically defined as a Region within the sound file.

All QuickPunch recording is non-destructive. Whenever QuickPunch is enabled, Destructive Recording is disabled. When QuickPunch is not enabled, Pro Tools’ standard autopunch is available for punching in at selection in/out points.

The Pro Tools Transport indicates whether you are using QuickPunch or Destructive Recording. When QuickPunch is enabled, the letter P will appear on the Transport’s Record button. When Destructive Recording is enabled, the letter D will appear on the Transport’s Record button.
When QuickPunch is enabled, a “P” will appear on the Transport’s Record button.

When Destructive Recording is enabled, a “D” will appear on the Transport’s Record button.

**QuickPunch Preferences**

The item called QuickPunch Crossfade Length in the Preferences dialog allows you to specify a length for crossfades which Pro Tools will write to disk at the punch in point and punch out point each time you use QuickPunch. At the punch-in point, QuickPunch writes a pre-crossfade (it occurs up to but not into the punch-in’s Region boundary) and at the punch-out point writes a post-crossfade (it occurs after the punch-out’s Region boundary). These crossfades can later be edited just as a standard crossfade can. A good general-purpose length is 14 milliseconds or so. If you leave this Preference at its default setting of zero, Pro Tools will not create any crossfades at the punch in/out point. When you are performing the punch-in/outs however, Pro Tools always executes a 4 millisecond “monitor only” crossfade (not written to disk) which avoids distracting pops that otherwise might occur as you enter and exit punch recording.
Guidelines for Using QuickPunch
The one restriction on using QuickPunch is that a free voice is required for each record-enabled track being punched — Pro Tools must hold an equal number of tracks/voices “in reserve” for QuickPunch recording as well as playback. For example, an 8-track Pro Tools Project system can only punch-in on 4 tracks at once while playing back 4 tracks. If voices are currently unused by on-screen disk tracks, they will automatically be allocated as necessary for use with QuickPunch. If all of the available voices on-screen are in use and QuickPunch is enabled, you will have to free-up voices so that they can be used by the available voice pool. Pro Tools will not let you QuickPunch and will alert you if voices need to be freed by muting a voice. You can also free a voice by setting a voice to Voice Off in the voice assignment pop-up, or by engaging Mute Frees Voice and muting the required number of tracks.

QuickPunching with a Selection in a Track
If you have made a selection on a track and perform a QuickPunch, these rules apply:

- If you are NOT online, punch-in begins whenever you click the Record button—regardless of the selection’s start point. Punch-out, however, will always automatically occur at the end of the selection.
- If you ARE online, punch-in/out behavior is controlled by the online preference settings in the Preferences dialog. If you choose Record Online at Insertion/Selection, QuickPunch will allow you to punch in/out only within the selection (or in the case of an insertion point, only after the insertion point). If you choose Record Online at Time Code Lock, QuickPunch will disregard the selection and allow you to punch in/out whenever you wish (after Pro Tools has locked to time code).
To punch on-the-fly using QuickPunch:

- Enable QuickPunch by selecting it from the Options menu. A check mark appears next to QuickPunch when it is enabled, and the letter “P” appears on the Transport's Record button.
When QuickPunch is enabled, a “P” will appear on the Transport’s Record button.

- Make sure that the QuickPunch Crossfade Length Preference in the Options menu for QuickPunch is configured as you wish. If you don’t wish to create any crossfades at punch in/out points, set this preference to zero. (If you wish, you can create crossfades later at the punch-in/out points by using Pro Tools “batch crossfade” feature. For details, see the section entitled “Creating Crossfades Between Several Regions at Once” in Chapter E of this User’s Guide.)

- Record-enable the track(s) you want to punch. If there are not enough voices available, you will not be able to use QuickPunch. Free up voices by muting them, and enable Mute Frees Voice. Or, turn the voice assignment of some tracks to Voice Off.

- Prepare to record by cueing Pro Tools to an appropriate location, (and enable a pre-roll value if you wish).

- Start playback by clicking the Play button on the Transport, or by pressing the Space bar. (You can also map a MIDI controller to the Play button to remotely control Pro Tools’ Transport buttons. See the next section: MIDI Mapping of Transport Controls for more information.)

- At the punch-point, click the Transport Record button (or press Command-Space bar). The Record button will stop flashing and stay lit during recording.

- To punch-out, click the Record button or press Command-Space bar again. While Pro Tools is still playing back, you can perform additional punch-ins simply by clicking the Record button at each punch-in/out point (up to 100 running punches per take).

- When you record running punches during a single take, a single sound file will be recorded to disk from which Pro Tools will create the appropriate Regions.
Region and Take Numbering with QuickPunch

After you have used QuickPunch, the new audio you have recorded will automatically appear in the Audio Regions List. This includes the sound file for all the audio recorded in a single take (a “take” is defined as all the punch-in/outs recorded in one pass), and the Region(s) derived from your punch-in/out points.

Here’s an example of how these takes and punches are numbered in the Audio Regions List. Let’s say you were punching in fixes to a track called “Lead Gtr”. If you only recorded one punch to the track, the Audio Regions List would list “Lead Gtr-01-00.” Sound files created by QuickPunch will always have 00 at the end of their Region name. The Region representing the punch in would be numbered “Lead Gtr-01-01.” If you did multiple punches during the take, they would be numbered “Lead Gtr-01-02” “Lead Gtr-01-03” and so on.

If you stop playback and record another take, Pro Tools will create a new sound file for it. To continue with our example scenario, if you were to start a new take, the Audio Regions List would list the new sound file as “Lead Gtr-02-00.” Regions (punches) on this take would be numbered successively “Lead Gtr-02-01” and so on.

Using QuickPunch to Record Automation

In addition to punch-recording of audio, QuickPunch can be used very effectively to punch-record automation, as well. QuickPunching Automation doesn’t require that you hold voices in reserve. Only QuickPunching audio requires this.

Be aware of the following rules when using QuickPunch to Record automation:

- When you punch-in with QuickPunch, new automation data is only recorded from the moment that you begin moving faders or sliders. If you punch in and don’t move a fader or slider, the original automation data will remain undisturbed. The moment that you begin moving things, however, the new automation data will overwrite any previous automation. When you punch out, the track’s original automation (if any) goes into effect again.
- As with audio, you can record up to 100 running QuickPunches in a single pass.

To use QuickPunch to punch-record Automation:

- Enable QuickPunch by selecting it from the Options menu. A check mark appears next to QuickPunch when it is enabled, and the letter “P” appears on the Transport’s Record button.
- Record-enable automation on the track(s) you want to punch on.
• Prepare to record by cueing Pro Tools to an appropriate location, (enable a pre-roll value if you wish).

• Start playback by clicking the Play button on the Transport, or by pressing the Space bar. (You can also map a MIDI controller to the Play button to remotely control Pro Tools’ Transport buttons. See the next section: MIDI Mapping of Transport Controls for more information.)

• At the punch-point, click the Transport Record button (or press Command-Space bar). The Record button will stop flashing and stay lit during recording. Remember, new automation data is only recorded from the moment that you begin moving faders or sliders. If you punch in and don’t move a fader, the original automation data will remain undisturbed.

• To punch-out, click the Record button or press Command-Space bar again. When you punch out, the track’s original automation (if any) goes into effect again. While Pro Tools is still playing back, you can perform additional punch-ins simply by clicking the Record button at each punch-in/out point (up to 100 running punches per take).

If you wish to automate Mutes, simply use a track’s Mute button during automation recording. Clicking the Mute button while doing an automation pass will record a value of zero for the automation while the Mute button is depressed.

---

**Mapping Transport Controls to a MIDI Controller**

Pro Tools allows you to map a MIDI controller to any of Pro Tools’ Transport controls. Besides being a convenient and ergonomic method for controlling Pro Tools’ Transport, MIDI Mapping also provides far faster response time than using the on-screen controls. Fast response time is essential for timing-critical functions such as QuickPunch recording.

To map a MIDI controller to any of Pro Tools’ Transport controls, simply use Pro Tools’ standard technique for mapping a MIDI Controller to a Pro Tools fader or slider. In this case, since the Transport is an on/off control, we recommend that you map a “switched” (on/off-type) controller rather than a continuous (slider-type) controller.

**To map a MIDI controller to a Transport control:**

• Hold down the Control key and click once on the Pro Tools Transport button you wish to remotely control. It turns green.
• On your MIDI device, move the controller that you wish to map to the Pro Tools Transport. When you move the MIDI controller, the on-screen Pro Tools Transport button will toggle in tandem with it.

• You can now engage the desired Transport function by moving the MIDI controller.

Recording a MIDI Track

Pro Tools offer multiple tracks of basic MIDI recording. Like audio recording, Pro Tools’ MIDI recording supports punch-in/punch-out recording, and other functions.

To record a MIDI track:

• Make sure your MIDI controller, sound modules and MIDI interface are properly connected to your Macintosh.

• From the File menu, select New MIDI Tracks. A dialog appears allowing you to specify the number of tracks you wish to create.

• Enter a number and click OK. The specified number of tracks appear.

• Double-click the new track’s Track Name button, and in the dialog that appears, name your track. This name will also be given to any MIDI files that you record on the track.

• If you plan to edit your MIDI tracks, or export your tracks for editing in another program, you may wish to use the MIDI Metronome, as explained earlier in this chapter.

• Click the track’s MIDI Port Selector pop-up to select the appropriate MIDI port. Depending on your particular MIDI setup this pop-up menu will appear differently. (This depends on whether you are using OMS or not, and whether you are using a MIDI Time Piece MIDI interface.)
• Click the track's MIDI Channel Selector pop-up menu to select the MIDI channel on which you wish to record.

• In the Mix window, click the MIDI track's Rec button. The track is now record-enabled.
• Watch the LED’s to make sure that the track is receiving the MIDI event.
• Click the Record button on the Transport. It turns red and begins to flash.
• When you are ready to begin, click Play. MIDI recording commences.
• When you have finished your take, click the Transport’s Stop button or press the Space bar on your computer keyboard to Stop recording.

To play back your track:

• Click the Rec button on your track to take it out of record-ready.
• Click Return to Zero on the Transport to take the Session back to its beginning.
• Click Play on the Transport or press the Space bar to begin playback.

Pro Tools offers these basic MIDI sequencing capabilities, including quantization and MIDI Note transposition features. However, if you are an advanced MIDI user you may still prefer to do the bulk of your sequencing in a full-featured sequencing software package such as Vision, Cubase, Logic, or Performer.

Exporting a MIDI File

If you find it necessary modify a sequence that you have created or imported into Pro Tools, the Export MIDI command will allow you to export the current Session’s entire MIDI Playlist as a Standard MIDI File for further editing in a full-featured MIDI sequencing program.

To Export a MIDI file from the current Session:

• Choose Export MIDI from the File menu. This dialog appears:
The Export MIDI dialog

- Enter a Name for the MIDI file.
- Select the Standard MIDI File format that you wish to export the file as. Type 0 is merged format. Type 1 is multitrack format.
- Click Export. Pro Tools will export the MIDI file to the selected destination on your hard drive. You can then import and edit the sequence with other sequencing software.

This concludes our section on direct to disk recording. You should now have the knowledge you need to integrate MIDI into your Sessions and record digital audio and MIDI to disk. The next chapter deals with one of the most important and powerful aspects of your Pro Tools system—random-access digital editing.
Chapter E
Editing
Editing

Introduction

In this chapter we'll cover one of the most important and powerful aspects of your Pro Tools system—how to edit audio, MIDI and automation using the tools of the Edit window. Because Regions are the basis of every track in your Session, learning how to create, edit, and arrange them is essential in order for you to use Pro Tools to its full potential.

Though many of the examples in this chapter deal specifically with audio Regions, the principles, techniques, and procedures apply to MIDI Regions as well.

Before you get started creating and editing Regions, keep in mind once again, that with two exceptions (the Regions List menu’s Clear Selected and Compact Selected commands), all editing of audio with Pro Tools is non-destructive. Whether you are cutting, pasting, trimming, separating, or clearing Regions, you are still only performing these functions on a map of the actual audio data. Your source audio files remain safe, so don’t be afraid to experiment.

While the Mix window provides you with a familiar mixing-console-style interface, the Edit window introduces tools and techniques that you may be less familiar with. Before we get into specific details, it’s important that you get a firm understanding of the underlying principles of disk-based digital editing. This chapter begins with a discussion of these crucial concepts. Following this overview, you’ll learn how to edit tracks.

How Non-destructive Editing Works

Before you learn about Pro Tools’ editing tools, you should know a bit of theory behind disk-based, non-destructive editing. Non-destructive editing works like this: When you edit a track with Pro Tools, you’re not really cutting and moving pieces of sound as you would if you were cutting analog tape. Instead, Pro Tools is creating a “map” of your sound file on your hard disk. This map merely describes the order in which you want portions of the track to be played.
If you'd like to play the middle of your track first, the end next, and the beginning last, then so be it. Pro Tools will make the hard disk (where the audio information is stored) go to the middle of the sound file and play that portion first, followed by the others. If you want to copy or repeat something, Pro Tools makes the hard disk play the same audio data twice. If you cut or delete something, Pro Tools simply tells the hard disk not to read that portion of the sound file.

The crucial point here is that when you edit, you are only editing a map of the original sound file. The actual source audio material remains unchanged. With non-destructive editing, you are free to experiment with music and sound in ways never before possible. You can cut, copy, and paste, move and rearrange pieces of sound with total freedom. And you can hear the results immediately. With this kind of fast, flexible digital editing, you have virtually unlimited power to “rewrite” music and sound even after you have recorded it!

Understanding Waveforms On Screen

Whenever you record audio, Pro Tools displays a picture of the sound that makes up the take. If you've never seen an audio waveform before, this graphic “waveform overview” of the data may seem strange to you. The following explanation will help you understand what you’re looking at so you can create and edit your own audio Regions.

When you look at a waveform, you are basically seeing a diagram of your recorded sound. This diagram tells you many things about the sound. For example, take a look at the following illustration, which shows a typical waveform.

A typical waveform

This is a recording of some music with a standard 4/4 beat. The “peaks” that you see are actually beats—places in the recording where the volume goes up momentarily. These are followed by “valleys” where the volume goes down.
Different types of sounds produce different types of waveforms. Drums, for example, generally produce the kind of waveform you see in the illustration: sharp peaks of short duration which are very clearly defined. If you think about a drum’s sound, you’ll understand why: A drum hit has a loud, sharp attack, and a rapid decay. Other sounds, such as a vocal or a keyboard pad, produce a very different waveform, one that has less pronounced peaks and valleys. That’s because these sounds generally have softer attacks and longer decays. Using Pro Tools’ Selector tool, you can select portions of these waveforms and divide them into segments called Regions, so that you can rearrange and manipulate them in tracks.

Getting back to our illustration, let’s look at a typical waveform selection. Notice that the selected range begins before a peak and ends immediately before a peak. This illustrates one of the golden rules for defining a music Region:

- Whenever possible, select a Region precisely before a volume peak, and end it immediately before another volume peak.

Here is a second rule:

- Whenever possible, make sure a Region starts and ends on exactly the same part of a beat.

One of the most important things to remember while you are editing a music session with Pro Tools is to create Regions that allow you to maintain a consistent beat. If the
beat or rhythm is not maintained, when you place several Regions next to each other and play back the track, it will seem to “skip” like a broken record. If you always define Regions so that they contain a whole number of beats (1 beat rather than 1.3 beats, for example), you’ll be able to string all of these Regions together and maintain a smooth, steady rhythm.

It’s sometimes useful to use a very steady, well-defined waveform, such as a drum track, as a guide when you select and define other Regions. If you’ve played in time with the beat, chances are that you can create rhythmically accurate regions by referring to the drum’s waveform.

Here is one final important tip for creating useful Regions: In order to avoid clicks or pops at the beginning or end of any Regions that you define, try to make sure that the start and end points of your selection are as close as possible to the point where the amplitude of the waveform tapers down to meet the “zero-crossing line” (the center line of your track’s waveform display). If you don’t do this, and the Region begins or ends at a point of high amplitude, you may hear an unpleasant click when Pro Tools plays from one Region to another. Use the Display Scale arrows and Zoomer to zoom in very closely to make a precise edit such as this. Once you have made your selection, you can hold down the Option key and click the Left Arrow to zoom back out to the prior track view level.

Notice how the selection begins and ends where the waveform meets the “zero crossing” or center line. This type of selection helps avoid pops and clicks.

These tips will start you on your way to understanding and creating Regions that are easy to use. As you work with Pro Tools, you’ll undoubtedly develop additional editing techniques of your own. Remember, Pro Tools allows you to arrange Regions in a track in any order you like, but it’s up to you to make the end product sound musical. Keep in mind also that the principles you’ve learned here apply to not only music but also audio post production and other applications.
Understanding MIDI Data On Screen

When you record or place a MIDI Region in a MIDI track, Pro Tools displays a visual representation of the MIDI note events that make up the Region. If you've used the event editor of a sequencer, this graphic display of the MIDI Note data may look familiar. If you haven't, it may not mean much to you. Like the preceding section on audio waveforms, this section is designed to help you understand MIDI data on screen so that you can create and edit your own MIDI Regions.

When you look at MIDI data in a track, you're basically seeing a diagram of the notes that make up the sequence. This diagram tells you several things about the data, and will help you edit MIDI Regions. Look at the following illustration. It is an example of a typical MIDI Region.

This is a simple sequenced bass line. The dashes are places where notes occur in the sequence. Each one has a “pitch” (a MIDI Note Number) which is indicated by its position on the musical keyboard at the left of the track, and a duration which is indicated by the length of the dash. By referring to the mini keyboard and Time Scale (particularly if it is set to Bar & Beats) it is easy to interpret these MIDI events. Look at the range of this selected Region:

A Typical MIDI Region

A one bar selection
Notice that the selected range begins precisely before a dash and ends precisely after a dash. In MIDI parlance, the beginning of the dash is known as the “Note On event.” The end of the dash is known as the “Note Off event.” For our example, we’ll define this range as a MIDI Region called “One Bar.” Looking at it you can see an important rule for defining MIDI Regions:

- Whenever possible, start a Region precisely before a Note On event and end it precisely after a Note Off event.

In many cases it is impossible to include both events in your selection—particularly when you are selecting a group of events (as in a chord). In this case you must at least get the Note On portion if you want a note to play. If your selection doesn’t include the Note On—that is, if it starts somewhere in the middle of the note—the note will not be played. On the other hand, if your selection doesn’t include the Note Off—that is, if the selection ends somewhere in the middle of the note—Pro Tools will automatically shut the note off for you where the Region ends. The Zoomer is a valuable aid in making precise selections of data since it allows you to zoom in and work on a very high level of detail.

Because MIDI sequences are by nature almost metronomically rhythmic, it is essential that a consistent beat is maintained in a MIDI track. If the rhythm is not maintained, the sequence will seem to ‘skip’ like a broken record. Just as with audio Regions, by always defining MIDI Regions so that they contain a whole number of beats you will be able to use all of them together and easily maintain a steady, consistent rhythm.

A second “Golden rule” for creating Regions is true of both audio and MIDI:

- Whenever possible, make sure your selection starts and ends on exactly the same part of a beat.

By making your playlist Regions begin precisely before a downbeat and end precisely before another downbeat, your Regions will be the most flexible. This type of Region generally starts on a downbeat and ends before another downbeat. They fit together with no interruption in the rhythm, and they can also be used to begin and end arrangements. Here is an example of a single note (which happens to comprise a single beat).

A single note selection
Notice that the selected range begins just before the beginning of the event and ends just after the end of the Note event.

These general tips will give you the background you need to get started defining MIDI Regions. Again, Pro Tools allows you to arrange the Regions of a track in any order, but it is up to you to make the end product “musical.”

**Auditioning Tracks**

Before you create any Regions, you’ll probably want to audition various points in your track to see which sections would make good Regions. You can do this quickly by clicking the Selector at a given location in a track and starting playback from there.

![Setting the playback point with the Selector](image)

**To set the playback point and start audio playback:**

- In the Edit window, click the Selector. The cursor turns into an I-beam.
- Click once and release the mouse button at any point in a track.
- Press the Space bar to begin playback from this point. To stop playback, press the Space bar again.

If you want to jump to a different location in your track, simply click the Selector at that point and press the Space bar again.

If you want the playback cursor to follow a track as it plays back (and stop where playback stops) do the following:

**To make the playback cursor and the screen follow audio playback:**

- Choose the Preferences command from the Setups dialog.
Enable Insertion Follows Playback.

Enable Scroll During Playback and click OK.

Various playback options in the Preferences dialog

Click the Selector. The cursor turns into an I-beam.

Click once and release the mouse button at any point in a track.

Press the Space bar to begin playback. The playback cursor and the Edit screen itself will follow playback of the track and stop where playback stops.

NOTE: Scroll During Playback will not function if your Track View level is zoomed in past a certain level. If you have zoomed in more than twice using the Zoomer tool, the screen may be unable to update the waveform quickly enough to reflect the current audio playback.

Using the Scrubber

The Scrubber is also a convenient tool for auditioning a specific portion of a track. By doing this, the exact beginning or end of a specific sound can be pinpointed. With the Scrubber, you can click anywhere on a track and drag the mouse to the right or left to begin playback at that point instantly. Playback speed and direction varies with mouse movement.

The Scrubber is not available on DAE PowerMix and Audiomedia III-based Pro Tools systems.

"Scrubbing" playback of a track with the Scrubber
To scrub a track:

- If you want the playback cursor to stop where scrubbing stops, choose the Preferences command from the Setups dialog and enable Insertion follows Scrub. Click OK.
- Click the Scrubber. The cursor changes to a speaker.
- Click the mouse within a track and drag it to the left or right.

As you drag the Scrubber, playback position moves backward and forward. To extend playback, drag further. Be aware that the Scrubber works best at certain “Zoom levels.” For instance, if your track display is zoomed out all of the way you may be asking Pro Tools to scrub faster than it is capable of, in which case it will continue to play at normal speed until it catches up to the cursor. Conversely, if you are zoomed in too closely when you scrub audio, the track display may rush by too quickly for you to pinpoint a desired editing point.

Note: Command-Clicking with the Selector temporarily toggles to the Scrubber.

---

Selecting Waveforms

Once you’ve found a portion of your sound file that you want to make into a Region, the next step is to select that portion of the sound file with the Selector. Keep in mind some of the points you learned about creating “musical” regions.

To select a waveform:

- Click the Selector to activate this tool.
- Position the Selector at one end of the selection you wish to make.
- Click and drag the mouse left or right. The selection range will change as you move the mouse.
- When the selection encompasses the desired range, release the mouse button. The selection is complete.

To make a selection “on the fly” during playback:

- Click the Selector at the beginning of the track you want to make the selection in.
- Press the Space bar or click the Transport’s Play button to start playback.
• As your track plays, press the down arrow key on your Mac keyboard at the point where you want the selection to begin. Press the up arrow key at the point where you want the selection to end.

• To stop playback, press the Space bar. The waveform range that you selected will appear highlighted on the track.

• To automatically scroll the display to the beginning of the selection (or to the location of the on-screen cursor), press the left arrow key (←). To scroll the display to the end of the selection, press the right arrow key (→).

Changing the Length of a Selection

If you change your mind and want to make a selection a little longer or shorter you can easily do this. Simply hold down the Shift key and click and drag the mouse at the beginning or end of the selection you wish to extend.

To change the length of a selection:

• Position the Selector over one end of the current selection.

• Hold the Shift key and click and drag the mouse. The range of the selection will change as you drag the mouse.

• When you have adjusted the selection to the desired size, release the mouse button.

This Shift-drag technique is also very handy when you want to make a very long selection. Here’s how you can put it to good use:

To quickly make a lengthy selection:

• Use the Selector to make a short selection where you want the selection to start or end.

• Release the mouse button and then scroll to the desired beginning or end point. (The other end of your selection will probably scroll out of sight, but don’t worry — it’s still there.)

• Hold down the Shift key, and click at the desired start or end point. Release the mouse button, and you will have made your lengthy selection.

• To verify the beginning and end points of your selection, press the left arrow key (←) to scroll the display to the beginning of the sessions, and press the right arrow key (→) to scroll the display to the end of the selection.
Making a Selection Across All Tracks at the Same Time

Most music Sessions have music on several tracks at once. For example, you may have drums, bass, and other sampled or synthesized rhythm parts playing on MIDI tracks while electric guitars, vocals, and other acoustic instruments occur on audio tracks. All of the parts work together at the same time but occur on different tracks. Because of this, being able to select data across multiple tracks—audio and MIDI tracks—and perform edits on those tracks simultaneously is essential. To select data on multiple tracks at the same time, you’ll use the following Pro Tools selection techniques.

In addition, Pro Tools allows you to “group” tracks together. In this state, when an edit is performed on any one of the selected tracks, all other selected tracks will also be edited. Grouping is discussed later in this chapter.

To select data on ALL tracks at the same time:

• Choose the Selector.

• Hold down both the Option and Shift keys.

• Click and drag the mouse to make a selection

• Release the mouse button at the end of your selection. The selection appears across all tracks in the Session. If you want to shorten or extend your selection across all tracks, simply hold down the Shift key and click or drag the cursor to change the range of the selection.

NOTE: This Option-Shift selection technique is also essential if you want to place the insertion point across all tracks in order to paste a multi-track selection into them. Simply click the Selector in any track while holding down these keys and the cursor’s blinking insertion point will appear in all tracks.

It is also useful to be able to select multiple tracks without selecting every track in the Session. To do this you will use a slightly different technique.

To select data on multiple tracks individually:

• Click the Selector.

• Click and drag the mouse to make a selection. Release the mouse button at the end of your selection.

• Hold down the Shift key and click the mouse in another track. The identical range will be selected in that track.

• Click in additional tracks to select the same range in them.
If you want to shorten or extend your selection across each of the tracks you have selected, hold down the Shift key and drag the cursor to change the range of the selection. As noted above, any command that you choose at this point will apply to all selected tracks.

There are several additional shortcuts for using the Selector:

• Option-Shift-Clicking with the Selector extends a selection across all tracks.
• Double-Clicking with the Selector selects a whole Region.
• Triple-Clicking with the Selector selects an entire track.
• Option-Clicking the Selector on a point before a Selection sets and enables that point as a pre-roll location.
• Option-Clicking the Selector on a point after a Selection sets and enables that point as a post-roll location.
• Option-Clicking within a Selection sets pre- or post-roll to zero depending on whether the click is closer to the selection’s start or end.
• Command-Clicking with the Selector temporarily toggles to the Scrubber.
• Command-Shift-Clicking with the Selector temporarily Scrubs and extends or shortens the selection.

Other Useful Selection Techniques

As you become more adept at selecting and defining Regions, you will develop many of your own techniques for quickly locating edit points. Here are some to get you started:

Shift-Scrub
One handy method of making a selection is by using the Shift key in conjunction with the Scrubber. To do this:

• Select the Scrubber. (The Scrubber is not available on DAE PowerMix and Audiomedia III-based Pro Tools systems.)
• Scrub to find an appropriate start point for your Region. Release the mouse button.
• Hold down the Shift key.
• Scrub to an appropriate end point for your Region. When you release the mouse button, the range will be selected.
**Shift-Tab/Option-Shift-Tab**
To make a selection that begins or ends at the exact start or end boundary of a Region, use the Shift key/Tab key combination. To do this:

- Make a selection in a Region.
- Press Shift-Tab and the selection will be extended to the exact end of that Region.
- Press Option-Shift-Tab and the selection will be extended to the exact beginning of that Region.

**Shift-Autolocate**
A final trick for making a selection is to use the Shift key in conjunction with the Transport’s autolocation buttons. This allows you to select the entire range between two user-defined autolocation points.

- Click an autolocation button.
- Hold down the Shift key.
- Click a second autolocation button. The range between these two points will be selected.

---

**Testing a Selection Before You Make it into a New Region**

Now that you know how to select waveforms, you’ll want to be able to audition your selections before you actually capture them.

**To play a selection:**

- With the Selector, select a portion of a waveform.
- Click the Transport’s Play button or press the Space bar. Your selection will play beginning to end and stop.

**Looping Playback**
When Loop Selection command is enabled, the selected portion of a waveform will be replayed endlessly until you press stop. If there is no selection, the Loop Selection command has no effect on playback. A looped selection must be at least 0.5 seconds in length.
Looping playback is a useful way to check how “musical” your selection is. For instance, if you’re making a one-bar selection, looping playback of the selection will allow you to hear whether or not the selection maintains a consistent rhythm as it repeats. If it seems to “skip,” then you know that you’ll have to adjust the length of the selection in order to make it work musically in the context of a Playlist.

The Loop Selection command

To loop playback of a selection:

• Select a portion of a waveform.
• From the Options menu, choose Loop Selection. When this option is enabled, a check will appear next to it in the menu.
• Click the Transport’s Play button or press the Space bar. The selection will play from beginning to end repeatedly, until you click the Stop button or press the Space bar.

Creating New Audio Regions

You are now going to learn how to create your own Regions. Pro Tools provides you with several commands for doing this, including the Capture Region command, the Separate Region command, and the Trim Region command. Each of these commands differ in their effect on a selection.

The Capture Region Command

The first of these commands, the Capture Region command, defines a selection as a new Region and adds it to the Audio Regions List. From there, the new Region can be dragged into a track.

To create a new Region with the Capture Region command:

• Click the Selector.
• Click and hold the mouse button where you want the Region to begin.
• Drag the mouse to select the portion of the waveform that you want to capture as your Region.
Selecting a waveform

- Release the mouse button where you want the Region to end.
- Choose Capture Region from the Edit menu. When Pro Tools prompts you to name the Region, enter a name and click OK.

Naming a new Region

Your new Region will appear in the Audio Regions List at the right of the screen. If you look at the new Region’s name in the Regions List, you will see that it has the name that you just gave it. All Region names are actually composed of two parts: the name of the sound file from which it came and the Region name you gave it. Regions can be renamed later, either by double-clicking on their names in the Audio Regions List or on the Region itself in a track.

The Separate Region Command

The next of these commands, the Separate Region command, defines a selection within an existing Region as a new Region and in the process, separates it from audio data adjacent to it. The new Region then appears in the track (separate from the sound file from which it was created), and in the Regions List at the right of the screen. By separating a Region you will also create “by-product” Regions from data on either side of the separation that have new “edit-take” numbers assigned to their names. These Regions also appear in the Regions List.

If you wish, you can have Pro Tools automatically name separated Regions for you with the Auto-name Separated Regions option in the Preferences dialog. With this option turned on (checked), when you separate a Region, Pro Tools will automatically name the separated Region(s) for you. The name will be a numbered variation of the Region’s name.
Enabling the Auto-name Separated Regions option in the Preferences dialog causes Pro Tools to automatically name separated Regions for you.

To separate a new Region with the Separate Region command:

• Click the Selector.

• Click and hold the mouse button within an existing Region where you want the new Region to begin.

• Drag the mouse to select the portion of the waveform that you want to separate as a new Region. Make sure the selection is within the bounds of the existing Region.

• Release the mouse button where you want the Region to end.

• Choose Separate Region from the Edit menu. When Pro Tools prompts you to name the Region, enter a name and click OK.

The new Region will appear in the track in which it was created, separate from the data surrounding it. As with all Regions, it will also appear in the Regions List at the right of the screen. From there it can be dragged into other tracks. Note that by separating the Region you have created “by-product” Regions from data on either side of the separation. These Regions also appear in the Regions List.
The Trim Region Command

The last of these commands, Trim Region, The Trim Region command removes audio before and after a selected waveform range—leaving only the selection. This command provides a handy means of quickly removing all data in a track except for the currently selected Region.

To trim unwanted data from a sound file:

- With the Selector, select a waveform range in a track.
- Choose Trim Region from the Edit menu. All data but the selected area will be removed from the track. Pro Tools prompts you to name your selection as a Region.
- Enter a name and click OK. The excess data is removed, leaving only the currently selected waveform range.

By using Grid mode (explained shortly), it is possible to quantize the Selector so that it selects data in specific intervals: quarter notes, eighth notes, sixteenth notes, and so on. To do this, simply choose Grid mode, the appropriate Time Scale (such as Bars & Beats or SMPTE time code), and a quantization value with the Nudge/Grid pop-up. When you make a selection, it will automatically snap to the chosen Grid value.

In order to use Bars & Beats as a Grid value, your Session must include Tempo data. If your Session has MIDI data it will already have this information. If your Session currently has no Tempo data, you can use the Identify Beat command to create Tempo data. For more information on creating Tempo data see Creating Tempo Data with the Identify Beat command later in this chapter.

Healing a Separation

If you’ve separated a Region and then decide that you want to undo the separation but your chance to “undo” is long gone, you still have a way to repair it. The Heal Separation command gives you a way to repair separated Regions—providing that the Regions are contiguous and their relative start and end points haven’t changed since the separation. Because there is no way to heal two Regions whose data is not contiguous, if you have trimmed or otherwise changed the start and end points of the two Regions, or moved them away from each other, you won’t be able to repair them with the Heal Separation command. Likewise, it is impossible to heal two Regions created from different sound files.
To Heal a Separation between two contiguous Regions:

- With the Selector, select the border (the separation point) between the two Regions you wish to repair.
- Choose Heal Separation from the Edit menu.
- The two Regions will become one. There is now one less Region in the Audio Regions List.

If the Regions aren’t exactly contiguous and won’t “heal,” you can delete one of them (make sure you’re in Slip mode so the gap doesn’t close) and use the Trimmer (see the next section) to expand the remaining Region to its former length.

Placing Regions in Tracks

Once you have created a Region, it appears in the Audio Regions List at the right of the Edit window. From here you can drag it into a track to add to an existing track or create a new track and start adding Regions from scratch. The exact placement of a Region in a track depends on whether you are in Shuffle, Slip, Spot or Grid mode. These modes are discussed later in this chapter, but for now, your mode should be set to Shuffle.

To place a Region in a track:

- Select the Grabber.
- Click and hold the Grabber on the name of a Region in the Audio Regions List. Remember, by typing the first few letters of the Region’s name on your Mac keyboard, the Regions List will locate the Region for you.
- Drag the highlighted Region name from the Audio Regions List into the track.
- When the Region is in position over the desired track, release the mouse button. The new Region will be added to the track.
If you want, you can drag several Regions from the Audio Regions List at the same time by Shift-selecting them. Each Region will be placed in a different track. This technique is useful for bringing Regions that are part of a stereo pair (the right and left channels of an instrument recorded in stereo) into two tracks while keeping them in lined up together in perfect phase.

Pro Tools is flexible as to where and how you place your audio Regions. For instance, you can place the same Region in a track several times (to repeat it, for example). Or you can put the same Region in several different audio tracks (to have it occur on different tracks at different times, for example). You cannot, however place an audio Region in a MIDI track or vice-versa.

Selecting an Entire Region
Now that you know how to place a Region into a track, you can manipulate it in a number of ways—such as moving or duplicate it. In order to move, duplicate, or delete a region, you can use the Grabber or Selector to select the entire Region and then perform one of these actions.

To select an entire Region:

- With the Grabber, click anywhere inside the Region you want to select. The entire Region is now selected.

or:

- With the Selector, double-click anywhere inside the Region you want to select. The entire Region is now selected.

Selecting Multiple Regions
You can select, move, and manipulate more than one Region at the same time by first selecting multiple Regions with one of these techniques:

To select multiple Regions:

- With the Grabber, click a Region to select it.
- Hold down the Shift key and click another Region. Now both Regions are selected.
- Repeat as necessary.
- Shift-clicking an already-selected Region allows you to deselect it.
To select all Regions in a track:

- With the Grabber, select a Region.
- From the Edit menu choose the Select All command.
- All Regions in the track are selected.

or:

- With the Selector, triple-click anywhere on a region in a track.
- All Regions in the track are selected.

To select all Regions in all tracks:

- With the Grabber, click on a blank space in a track, an area where there are no Regions.
- From the Edit menu choose the Select All command.
- All Regions in all tracks are selected.

Deleting Regions From a Track

A Region, or group of Regions may be deleted from a track at any time. When a Region is deleted from a track, the actual digital audio on the disk is unaffected, so deleting Regions from tracks won’t help you save any space on your hard disk. Deleting a Region from a track won’t even delete the definition of that particular Region. If it’s used elsewhere in the session, other occurrences of the Region will remain unchanged. Deleting a Region just means that the Region won’t appear in that particular spot in the track anymore.

To delete a Region from a track:

- With the Grabber, select the Region you wish to delete. If you wish to select multiple Regions, hold down the Shift key and click additional Regions.
- Press the Delete (or Clear) key on the Mac keyboard.

If you change your mind, this operation can be undone with the Undo command.

It's also possible to remove audio Regions from the Audio Regions List. How and why you would want to do this is covered later in this chapter in Removing Unused Regions.
Trimming Regions

After you’ve created a Region and placed it in a track, you may want to edit its length without having to go through the trouble of capturing a new Region. The Trimmer lets you do just that. With the Trimmer, Regions can be quickly shortened or expanded to a desired length. The first time you trim a Region, Pro Tools will automatically add it to the Regions List as a new Region (with a name derived from the original) in order to differentiate it from the original.

NOTE: Remember, because Pro Tools is non-destructive, you are not actually modifying the original audio in any way when you use the Trimmer. Be aware whether you are in Slip, Shuffle, or Grid mode before you begin trimming, as it will affect how neighboring Regions react.

To trim a Region:

• Click on the Trimmer icon.

• Click and hold the cursor on the right or left side of Region you wish to trim and drag. Note that the cursor changes into the appropriate “right trim” or “left trim” shape as it is placed over the right of left side of the Region. As you drag, the Region is trimmed off until you release the mouse button. If you wish to reverse the direction of the Trim tool, hold down the Option key.

To expand a Region beyond its original definition, click the cursor on the appropriate edge of the Region and drag outwards. Audio data reappears and the Region can be restored to its original length, a portion thereof, or all the way out to the entire length of the source file. Holding down the Control key will allow you to trim a Region right up to but not over another Region’s border. Holding down the Command key allows you to trim the boundary between two Regions.

As noted above, Slip, Shuffle, and Grid modes, have an effect on how trimming affects Regions. If you are in Slip mode, trimming data will cause the other Regions in the right in the track to shift to accommodate the data which has been trimmed away or newly exposed. If you are in Shuffle mode, trimming data will cause the other Regions in the track not to shift. But, if any Region gets “overlapped” by newly exposed data, it will be trimmed away by that amount. In Grid mode, the Trimmer will be constrained to the Grid value you have chosen in the Nudge/Grid pop-up menu.
Moving Regions: Slip, Shuffle, Spot and Grid Modes

One of Pro Tools' most integral features is its ability to move “pieces” of audio and MIDI data within a track. This feature is very useful in music and post production applications where the timing of audio events such as sound effects and dialog need to be “spotted” to music, film, or video.

Pro Tools has four modes which affect the movement of audio and MIDI Regions within tracks: Slip, Shuffle, Spot, and Grid modes. These modes affect both how the Regions can be dragged with the Grabber, and how commands such as Cut, Clear, Duplicate, Paste, or actions such as trimming Regions, affect other Regions in a track.

In Shuffle mode, Regions can be moved freely within a track or onto another track, but their movement is constrained by other Regions. That is, if you place three Regions in a track, they will automatically “snap to” each other like magnets. You can then “shuffle” their order, but you cannot separate them from each other nor can you make them overlap as in Slip mode. In Shuffle mode, adding another Region to the beginning of a track will move all subsequent Regions over to the right by the length of the Region added. If you are familiar with Digidesign’s Sound Tools' Playlist or with “butt-splice” editing on analog tape, then you are already familiar with the concept of Shuffle mode.

In Slip mode, Regions can be moved freely within a track or onto another track. Simply drag the Region anywhere you want with the Grabber. In this mode it is possible to place a Region so that there is space between it and other Regions in a track. When the track is played back, there will be silence where the open area is. It is also possible to move a Region so that it “overlaps” or even completely covers another Region.

Clicking the Spot mode button puts Pro Tools into Spot mode. This mode is useful for Sessions in which you wish to “spot” Regions to specific SMPTE frame locations. In this mode, a Region in a track can be quickly spotted by simply clicking it with the Grabber. A Move Region to dialog will then appear prompting you to enter an appropriate SMPTE frame location. (For even quicker spotting, if you are using VITC, enable Pro Tools’ Auto-Spot Regions feature, and simply click a Region with the Grabber to spot it to the current SMPTE frame location.) (see Chapter F: Working with SMPTE for more information on SMPTE and VITC.)

Clicking the Grid button puts Pro Tools into Grid mode. In this mode, the movement of Regions is quantized to a user-selectable time value on an invisible time “grid.” Grid values are selected by choosing the appropriate time format from the Display menu (Bars & Beats, Minutes:Seconds, Time Code, or Feet.Frames) and selecting the desired increments from the Nudge/Grid pop-up menu at the top right of the screen.
These four modes have a great impact on the way many edit functions such as Cut, Copy, Paste, Duplicate, etc., affect neighboring Regions in a track. For this reason, it is always a good idea to check which mode you are in before performing a particular type of edit.

The best way to understand how these modes work is to try the examples in the sections that follow.

### Shuffle and Slip Modes

#### To Shuffle a Region:

- At the top of the Pro Tools window, click the Shuffle button. Pro Tools switches to Shuffle mode.
- Click the Grabber. The cursor changes into a hand.
- Drag a Region from the Audio Regions list into a track and release the mouse button. The new Region snaps to the beginning of the track. Regions automatically do this when you place them into a track in this mode. Arranging Regions in Shuffle mode is a convenient way of making your Regions line up next to each other neatly, without overlapping or silence between them. Later, you can switch to Slip mode if you need to move them more freely.

Let’s continue exploring Shuffle mode.

- Drag a second Region into the same track, somewhere in the middle. It “snaps to” the first Region.
- Next, drag the second Region to the beginning of the track. The Selector will flash, indicating where the Region will be placed when the mouse is released.
- Pro Tools shuffles the position of the two Regions. The second Region now occurs first, yet the two still cling together.
Experiment more with Shuffle mode by dragging additional Regions into your track and moving them around. When you have a good feel for how Shuffle mode works, move on to the next section, Slip mode.

NOTE: In Shuffle mode, if a given Region is “locked” in place (with the Lock Region command) it will not be shuffled over by Regions placed in front of it. In fact, if there is not enough room to place or duplicate a Region in front of a locked Region, the insertion area will be disabled.

**Slip Mode**

To Slip a Region:

- Before you proceed, remove all Regions from your track by selecting them with the Grabber (Shift-Click to select multiple Regions) and pressing the Delete key on your Mac’s keyboard. Don’t worry about losing any audio data by doing this. The delete key simply removes the Regions from the track, but leaves the audio data intact in the Audio Regions List.

- Click the Slip button. Pro Tools switches to Slip mode.

- Select the Grabber. The cursor changes into a hand.

- From the Audio Regions List, drag a Region into your track. Place it at the very beginning of the track (the far left).

- From the Audio Regions List, drag a second Region into your track. Release the mouse button to place it somewhere in the middle of the track, away from the first Region. The second Region appears wherever you let go of it when you release the mouse button—it doesn’t “snap to” the first Region as in Shuffle mode.

- Drag your Regions to different locations within the track to get a feel for moving them in Slip mode.

Each time you move the Regions to a different location in the track, play the track to hear the results. You may want to solo the track in order to make listening easier.

Try placing the second Region so that it slightly overlaps the first Region. Play back the results.

When you have a good feel for how to use Slip mode, move on to the next section where you’ll learn about Pro Tools’ other two modes, Spot mode, and Grid mode.
Spot and Grid Modes

In addition to Slip and Shuffle, Pro Tools features two additional editing modes: Spot mode and Grid mode. Like Slip and Shuffle, Spot and Grid mode govern the movement of Regions and how tools such as the Grabber and Trimmer affect them.

Spot Mode

Clicking the Spot button puts Pro Tools into Spot mode. This mode is useful for Sessions in which you wish to “spot” Regions to specific SMPTE frame locations. In this mode, a Region in a track can be quickly spotted by simply clicking it with the Grabber. A Move Region to dialog will then appear prompting you to enter an appropriate SMPTE time location. (If you are using VITC, simply click Capture Time Code in this dialog to automatically spot the Region to the current SMPTE frame location.)

If you drag a Region from the Regions List into a track while in Spot mode, the Move Region to dialog will appear automatically when you let go of the Region, prompting you to specify a SMPTE time location for the Region.

Regions are spotted by their start times unless you have identified a Sync Point (covered in Chapter F) within the Region. If the Region contains a Sync Point, spotting is done in reference to the Sync Point, which will occur at the designated SMPTE time.

If you click a Region with the Trimmer in Spot mode, a dialog will appear allowing you to enter a value in SMPTE frames to specify exactly where you wish the Region’s beginning or end (depending on where you clicked) to be trimmed to. This is a convenient way to edit the length of a Region to correspond to a particular “hit point.”
In Spot mode, clicking on a Region with the Trimmer brings up this dialog.

To learn more about SMPTE (and all the features of this dialog box), refer to Chapter F, Working with SMPTE.

NOTE: Trimming a Region which contains a Sync Point will not affect the SMPTE location of the Sync Point (unless the Region is trimmed past the Sync Point).

**Grid Mode**

Clicking the Grid button puts Pro Tools into Grid mode. In this mode, the movement of Regions is quantized to a user-selectable time value on an invisible time “grid.” Grid values are selected by choosing the appropriate time format from the Display menu (Bars & Beats, Minutes:Seconds, Time Code, or Feet.Frames) and selecting the desired increments from the Nudge/Grid pop-up menu at the top right of the screen.

This mode is especially useful for lining up Regions at precise intervals (as in a music Session based around bars & beats). For example, if you have set the Grid to quarter note increments, dragging a Region to a new location in a track will cause it to snap to the nearest quarter note location on the Grid. This provides you with a handy way of “quantizing” Regions. Be aware that in order to use Bars & Beats as your Grid mode, you must first have Tempo data in your Session from either a MIDI file or the Identify Beat command.

NOTE: If you have placed a music Region at a desired location in Slip mode and then turn Grid mode on, Pro Tools preserves the “relative” timing and position of the Region when you move it in Grid mode.
As you would expect, Grid mode also affects the Trimmer and the Selector. If, as in our previous example, the Grid is set to quarter note increments, using the Trimmer to edit the length of a Region will cause the length to be trimmed to the nearest quarter note location on the Grid. The Selector, too will be constrained to quarter note “chunks” of audio. Again, this provides you with a handy way of “quantizing” audio as you edit.

You will also find that if you drag a Region from the Regions List into a track while in Grid mode, the Region will automatically snap to the grid when you let go of it. Pro Tools’ Nudge feature (covered next) works well in conjunction with Grid mode for fast, precise arrangement of Regions within a track.

Moving Regions

A Region, or group of selected Regions can be moved together. Multiple Regions in the same Playlist, or different Playlist can be moved as a group. Remember that the movement of Regions is constrained by the current mode, Shuffle, Sip, Spot, or Grid.

To move a Region or Regions:

• Click the Grabber.

• Click and hold the mouse button on a Region and drag left or right. You will see a dashed outline of the selected Region(s) moving as you drag.

• When the Region is in the desired position, release the mouse button. The selected Region(s) will be moved to the new location.

• If you want to move several Regions at once, Shift-click them to select them and then move them together.

If you don’t like the result, the move can be undone with the Undo command in the Edit menu.
Locking Regions

If you have a Region (or Regions) that you want to permanently associate with a particular location in a track—a beat, SMPTE frame, or time value—you can lock it in place so it cannot be accidentally moved. To do this, you will use Pro Tools' Lock Region command.

To Lock a Region:

- With the Grabber, select the Region you wish to lock. Multiple Regions can be selected by Shift-clicking.
- From the Edit menu, choose Lock Region/Unlock Region. The Region now cannot be moved from its current position until you unlock it again. A small lock appears in a Region to indicate that it has been locked. If you attempt to perform edits that move a locked Region, Pro Tools will alert you with a dialog.

If you are using Pro Tools to synchronize digital audio to tape or picture, Regions can be “spotted” to SMPTE frames and locked in place. For more information on using Pro Tools with SMPTE, refer to Chapter F.

NOTE: In Shuffle mode, if a given Region is “locked” in place (with the Lock Region command) it will not be shuffled over by Regions placed in front of it. In fact, if there is not enough room to place or duplicate a Region in front of a locked Region, the insertion area will be disabled.
Nudging Regions

Pro Tools allows you to move Regions in precise, user-selectable increments with the + and - keys on the Mac’s numeric keypad. By selecting the desired time scale (Bars & Beats, Minutes:Seconds, Time Code, or Feet.Frames) and an appropriate nudge value from the Nudge/Grid pop-up menu, you can make very precise incremental movements of a selected Region’s position within a track. The Nudge function can be used in Slip, Shuffle, or Grid mode.

• From the Display menu, choose the appropriate Time Scale.
• Click the Nudge/Grid pop-up menu at the top right of the screen and choose an appropriate Nudge value.

The Nudge/Grid pop-up menu with a Minutes: Seconds Time Scale

• With the Grabber, click on the Region(s) that you wish to nudge.
• On the Mac’s numeric keypad, press the + key to move the Region later in the track. Use the - key to move the selected Region earlier in the track.

NOTE: The value chosen in the Nudge/Grid pop-up menu also serves as the quantization value for the Quantize MIDI command.
Using Autolocation Points

The Pro Tools Transport provides 100 autolocation buttons for storing any combination of a point’s Name, Time Location or Selection Length; and/or Zoom Level. Autolocate points can be recalled either by clicking one of these buttons on the Transport or by typing the corresponding number on your Macintosh keyboard or numeric keypad followed by a period.

Autolocations can be used in a variety of ways. You can use them to quickly navigate to a location in a track. You can use them to store your favorite Zoom levels to speed up editing. You can use them to store a selection. And you can use them in conjunction with the Selector and Shift key to help you quickly define Regions. The attributes of each autolocation point can be set individually.

Autolocation points can either be “dropped on the fly” during playback, or created while playback is stopped. Autolocation points are not visible as markers, however, a flashing insertion point indicates their location when they are recalled. Although autolocation points cannot be deleted, they can always be redefined and renamed.
To create an autolocation point when playback is stopped:

- Click the Selector at the desired location in a track.
- On the Transport, Option-click (or double-click) an autolocate button (1-100). Because the Autolocation buttons are arranged on the Transport banks of ten, you may need to scroll to find the desired button. A dialog will appear prompting you to define the parameters of the autolocation point.
- If you wish to name your autolocate point, enter a name.
- If you wish to store the current Time Location or Selection Length, enable this option.
- If you wish to store the current Zoom level, enable this option.
- Click OK after you have finished. The new autolocation stores the parameters you have chosen.

NOTE: Pressing the Enter key followed by a location number on the keypad enters the current insertion point/selection into that locate point. If there is a selection on-screen, the autolocate’s Current-Time Location option is automatically enabled.

Option-clicking the Transport’s autolocation buttons brings up this dialog

To create autolocation points on the fly during playback:

- If you don’t want to be prompted to name each autolocation point you create on the fly, turn on the Auto-Name Memory Locations option in the Preferences dialog (in the Setups menu).
- Start playback of your Session.
• During playback, press the Mac keyboard’s Enter key at the desired location(s). Autolocation points will be “dropped” at those points in the track. If there are already autolocation points in the file, this method will set the first unused autolocation points.

• If you wish to assign a specific number to an autolocation point on the fly, press a number key on your Mac keyboard and then press the Enter key. The autolocation point will be assigned to that number.

To recall an autolocation point:

• On the Transport, click the autolocation button for the desired track location. Alternatively, on your keyboard (or numerical keypad), type the number of the desired autolocation point followed by a period. Pro Tools immediately recalls the autolocation point and/or zoom level (if these options were enabled for that point). A flashing screen cursor indicates the location.

To redefine an autolocation point:

• Click the Selector at the desired location in a track.

• Option-click on the autolocation button that you want to redefine. If you wish, enter the new name and click OK.

To rename an autolocation point or change the parameters stored with it:

• On the Transport, double-click on the autolocation button that you want to modify. Enter the new name, and if you wish, enable or disable any of the parameters. Click OK when you’ve finished.

---

**Stripping Silence from a Region**

The Strip Silence command examines a selected audio Region in a track and removes any areas of silence (sections where the amplitude level falls below a certain level for a user-selectable period of time). The Strip Silence command does this by dividing the selected Region into smaller Regions and removing the silent Regions from the Session. All new Regions will appear in the Audio Regions List except for the “stripped out” silent ones. You can use this feature to have Pro Tools “automatically” divide a track into Regions for you, by removing all areas of silence.
It is possible to type in dB and duration values as the Silence parameters for this command. However a faster, more intuitive way of defining exactly what qualifies as “silence” is to use the Identify Silence command (in the Edit menu). Selecting a segment of silence in a track and choosing Identify Silence causes Pro Tools to analyze the duration and amplitude of the selection and use these as the criteria for the Strip Silence command.

Note that the Strip Silence command can only be performed on entire Regions, not a selection within a Region. This command is non-destructive and does not actually remove any audio data from the original audio file. If necessary, the Heal Separation command can be used to mend undesirable stripped gaps. (The Heal Separation command is discussed in an earlier section of this chapter.)

To use the Strip Silence command:

• With the Selector, select a portion of silence in a track.
• From the Edit menu, choose Identify Silence. A dialog appears displaying the silence's parameters. If these seem satisfactory, click OK.

The Identify Silence dialog

• With the Grabber, select an audio Region in a track.
• From the Edit menu, choose Strip Silence. This dialog appears:
The Strip Silence dialog

If you used the Identify Silence command, this dialog will contain the parameters of the silence that you selected. If you do not wish to use these values, the dialog allows you to enter a value in milliseconds, and a value in dB to determine the threshold below which a section will be “stripped out.” In other words, if you enter a threshold value of 48 (dB) and a hold time value of 1000 (msec), any portion of the Region which falls below 48 dB for more than 1000 milliseconds will be removed from the Region.

• If necessary, enter the desired Threshold and Hold Time values.

• Click OK.

All silent areas that fall below the parameters entered in the dialog will be stripped out.

Using Other Edit Menu Commands with Audio or MIDI Regions

Pro Tools supports all of the Macintosh's standard editing commands (Cut, Copy, Paste, Undo) and adds a few of its own. In the next few sections you are going to go through each of these functions and learn how to use them with Pro Tools. Though you may feel that you are already familiar with these commands from your previous experience with the Macintosh or Digidesign’s Sound Tools system, you should read these sections in order to learn how they function in Pro Tools.
Before you use any of these commands, you should be aware of these rules:

1. In order to use the Cut, Copy, Paste, Clear, or Duplicate commands, you must first select audio data within a track. There are two types of selections upon which Edit commands can be performed:
   a) Contiguous data within a Region (selected with the Selector)
   b) Whole Regions (selected with the Grabber)
Either of these types of selections can occur across multiple tracks.

2. If you attempt to perform an Edit menu command on data within a Region (not a complete Region), Pro Tools will ask you to name the selection (or sometimes name it for you) and add it to the Audio Regions List as a new Region.

3. You should always be aware of which mode you are in (Slip, Shuffle, Spot, or Grid) before you use an Edit menu command as it will change its effect. Using the Cut command in Slip mode, for example, will leave a gaping hole in a track. Using the same command in Shuffle mode will leave no hole, since the Regions to the right of the cut will slide over, closing the gap.

   In the same way, data pasted in Slip mode will overlap an adjacent Region, while in Shuffle mode it will cause the entire waveform area to the right slide over to make room for the pasted data. Again, be aware of which mode you are before choosing any of these commands. For an explanation of each, read on.

**Cutting Regions**

With the Cut command you can “cut” a selected waveform range or entire Region out of its current position. The Macintosh holds it on the Clipboard (the Mac's internal memory) in case you want to paste it elsewhere. Of course, since Pro Tools is non-destructive, you aren't actually cutting data from the original audio file. In Shuffle mode, when a selection is cut, the entire waveform area to the right of the cut slides over so that no gap remains. In Slip mode, a gap remains where the audio data was. In Grid mode, the Selector will be constrained to the Grid value chosen in the Nudge/Grid pop-up menu.
To Cut a selection:

- Click the Selector.
- Click and drag to select the desired range.
- Choose Cut from the Edit menu. Pro Tools prompts you to name your selection as a Region.
- Enter a name and click OK. The range is removed and placed on the Clipboard. The cut data also appears as a new Region in the Audio Regions List.

To Cut an entire Region:

- Click the Grabber.
- Click on a Region to select it.
- Choose Cut from the Edit menu.
- The Region is removed and placed on the Clipboard.

Copying Regions

The Copy command is much like the Cut command, but instead of removing the selected waveform range, it leaves the original, and places a copy of it in the Macintosh’s Clipboard so that you can paste it elsewhere.

To Copy a selection:

- Click the Selector.
- Click and drag to select the desired range.
- Choose Copy from the Edit menu. Pro Tools prompts you to name your selection as a Region.
- Enter a name and click OK. The range is copied and placed on the Clipboard (the Mac’s internal memory buffer). The copied data also appears as a new Region in the Audio Regions List.

To Copy an entire Region:

- Click the Grabber.
• Click on a Region to select it.
• Choose Copy from the Edit menu.
• The Region is copied and placed on the Clipboard.

Pro Tools provides you with a handy shortcut for copying and placing a whole Region in a new location. You may be familiar with this technique if you’ve ever used Macintosh graphics software: Option-drag. With this technique you simply hold down the Option key, select a Region and drag a copy of it to a desired location.

**To Copy a Region by Option-dragging:**

• Select the Grabber.
• Hold down the Option key.
• Click and drag the Region you wish to copy to a new location. A copy of the selected Region will appear in the new location. The original will remain in its original location.

---

**Pasting Regions**

By using the Paste command, you can insert the contents of the Clipboard into a location that you have chosen with the Selector. It is only possible to paste audio data after it has been cut or copied to the Clipboard.

**To Paste a selection or Region:**

• Click the Selector icon.
• Click the Selector at the point where you wish to insert the audio data in a track. Alternately, click and drag to select a waveform range that you wish to replace with the pasted data.
• Choose Paste from the Edit menu.

If you want to paste multi-channel data into more than one track you will need to place the insertion point in each of the destination tracks. Do this by holding down the Shift key and clicking in each of the destination tracks (or hold down the Option and Shift keys to select all tracks).
The Clipboard contents are inserted into the selected track(s), beginning immediately after the blinking insertion point. If a range is selected, the range is deleted prior to insertion of the pasted data. In Shuffle mode, all data to the right of the insertion point is pushed farther to the right (later in time) to accommodate the newly pasted range. In Slip mode, the pasted data will overlap any data following the insertion point.

A handy trick for pasting data immediately after a Region is to use the Tab key to tab to the desired Region’s exact beginning or end. Option-Tab will allow you to move the selection point backwards.

### Clearing Regions

The Clear command allows you to remove a selected Region or a selected waveform range within a Region.

**To Clear a selection:**

- Click the Selector.
- Click and drag to select the desired range.
- Choose Clear from the Edit menu.
- Enter a name and click OK. The range is removed from the track. If the Clear creates a “by-product” Region, the new Region will appear in the Audio Regions List.

**To Clear an entire Region:**

- Click the Grabber.
- Click on a Region to select it.
- Choose Clear from the Edit menu.
- The Region is removed from the track.

NOTE: Pressing the Delete key is another quick way to clear a selection or Region from a track.
Duplicating Regions

The Duplicate command copies a selection and places it immediately after the end of the selection in a track. It provides you with a very handy way of repeating a Region (to create a drum “loop”, a repeating bass figure, etc.) and is faster and more convenient than copying and pasting data to achieve the same result — particularly if you want to duplicate data on multiple tracks. Use one of the Shift-click techniques explained earlier to select data on multiple tracks.

As explained earlier, selections must be either contiguous data within a Region, or an entire Region. The Duplicate command will be unavailable if a selection crosses two discontiguous Regions (unless the Regions are completely selected).

To Duplicate a selection:

- Click the Selector.
- Drag to select the desired range.
- Choose Duplicate from the Edit menu. Pro Tools will prompt you to name your selection as a Region.
- Enter a name and click OK.

The duplicated data will be placed immediately after the selected Region’s end point. In Shuffle mode, the duplicated data will be placed directly after the end of the selection. Data occurring after it will be pushed aside to accommodate it. In Slip mode, the duplicated data will overlap any adjacent data.

To Duplicate an entire Region:

- Click the Grabber.
- Click on a Region to select it.
- Choose Duplicate from the Edit menu.

The duplicated data will be placed immediately after the selected Region’s end point. In Shuffle mode, the duplicated data will be placed directly after the end of the selection. Data occurring after it will be pushed aside to accommodate it. In Slip mode, the duplicated data will overlap any adjacent data.
Muting/Unmuting Regions

Choosing the Mute/Unmute Region command mutes playback of a selected Region. Choosing the command a second time unmutes the Region. Tracks which are muted appear “grayed-out” to indicate their status.

If the Mute Frees Voice command is enabled in the Options menu, muting a Region will allocate its voice to the next highest priority track of the same Voice Number. When you use this feature, you may find that Pro Tools takes a moment or two to re-allocate Voices.

A muted audio Region

To Mute a selection or Region:

- Click the Selector icon (or Grabber if you want to Mute an entire Region).
- Drag to select the desired range, (or click with the Grabber to select an entire Region).
- Choose Mute/Unmute Region from the Edit menu. If your selection is less than an entire Region, Pro Tools will prompt you to name it as a new Region.
- If necessary, enter a name and click OK.

To unmute a Region, simply select it and choose Mute/Unmute Region from the Edit menu once again.
Quantizing Regions

Pro Tools’ Quantize Region command allows you to adjust the placement of a selected audio or MIDI Region in a track so that its start point (or Sync Point, if it contains one) precisely aligns to the quantization value currently chosen in the Nudge/Grid pop-up menu.

To quantize the placement of a selected Region:

• From the Nudge/Grid pop-up menu at the upper right of the Edit window, choose the value that you wish to quantize to.

• Click the Grabber and select the Region(s) that you wish quantize.

• From the Edit menu, select Quantize Region. Your selection will be quantized to the chosen value.

Quantizing MIDI Note Events

As you learned previously, the Edit window’s Grid mode works with both audio and MIDI. In the case of MIDI data however, you have an additional quantization function that you should be familiar with if you have ever worked with sequencers: MIDI quantization.

Pro Tools’ MIDI Quantize command offers the same type of quantization function found on most popular MIDI sequencers. Here, the Note On portion of a MIDI event can be adjusted to a user-selectable quantization value, ranging from quarter notes to 64th notes, or triplet values of any of these.
A Session must have Tempo data to quantize to or the MIDI Quantize command will be unavailable. If your Session has MIDI Regions which have been imported with their Tempo data intact and placed into MIDI tracks, it will already have this information. If not, you will have to use the Identify Beat... command to create a Tempo data. Only then can you use the MIDI Quantize command.

NOTE: When you select MIDI data, be sure that you include the Note On portion of the event in your selection. Otherwise, the event will not be quantized.

To quantize MIDI Note On events:

- If the Time Scale is not currently set to Bars & Beats, do so now by selecting this option from the Display menu.
- From the Nudge/Grid pop-up menu at the upper right of the Edit window, choose the value that you wish to quantize to.

![Nudge/Grid pop-up menu](image)

The Nudge/Grid pop-up menu

- Click the Selector.
- Position the cursor at the precise beginning of a MIDI event and click. Be as exact as possible by zooming in and clicking the cursor precisely before the beginning of the event. If necessary, use the Shift key to make adjusting your selection easier.
- From the Edit menu, select MIDI Quantize. Your selection will be quantized to the chosen value.

NOTE: This, along with the Transpose MIDI command, is one of the two commands in Pro Tools that will permanently alter MIDI data contained in a Session file (not the source MIDI file itself). You should exercise caution accordingly.
Transposing MIDI Data

Though you will probably have done most of the “finessing” of your MIDI sequence in your sequencing software before you import it into Pro Tools, you still have control over some aspects of the sequence after you import it. One of these aspects is MIDI note transposition.

Pro Tools’ MIDI Transpose command allows you to transpose MIDI data up or down the musical scale by a specific number of semitones (half steps). With this feature you can easily add MIDI-based key changes and other transposition effects to your MIDI tracks. To use Pro Tools’ MIDI Transposition feature, do the following:

To transpose a selection or Region:

- Click the Selector (or the Grabber if you want to transpose an entire Region).
- Drag to select the desired range (or click with the Grabber to select an entire Region).
- Choose MIDI Transpose from the Edit menu. This dialog appears, prompting you to enter a value in semitones:

![Transpose dialog]

- Enter the number of semitones you wish to transpose your selection up the musical scale. Typing a minus sign (-) in front of the number will transpose the selection down the musical scale by that number of semitones.

NOTE: This, along with the MIDI Quantize command is one of the two commands in Pro Tools that will permanently alter MIDI data contained a Session file. You should exercise caution accordingly.
Creating Crossfades Between Regions

Though Pro Tools’ digital editing tools give you the means to create extremely precise edits, there are still times when transitions between Regions may require some smoothing. For this reason, Pro Tools provides a Fades command which allows you to crossfade between two adjoining audio Regions — it is not possible to create a crossfade between two adjacent Regions whose boundaries do not touch. Crossfade duration, position, and shape are all user-selectable, allowing you to tailor the crossfade to your exact needs.

There are seven different Fade Out and Fade In curves to choose from. They look like this:

![The Fades dialog](image)

Different shaped curves can be assigned to the Fade Out and Fade In portions of the crossfade. These curves control the amplitude of the Regions as they are faded in or out. By examining the shape of a curve, you can see how the amplitude of a selected Region will change during the course of the crossfade. The following diagram will help you understand how combinations of these curves will affect the overall shape of your crossfade. By superimposing the Fade Out curve of Region 1 over the Fade In curve of Region 2, you will have a good idea of how the amplitude of each Region will be affected during the crossfade.

![A typical crossfade](image)
Here are brief explanations of each of the different Fade Out and Fade In curves:

**Fade Out Shapes**

![Fade Out](image)

This curve keeps Region 1 at full volume throughout the crossfade and then immediately drops the volume at the very end of the crossfade.

![Fade Out](image)

This curve fades out Region 1 relatively slowly, keeping the amplitude fairly high. Towards the end of the crossfade, the amplitude drops off sharply.

![Fade Out](image)

This curve fades out Region 1 slightly faster, with the amplitude slightly lower than the previous envelope. This curve is the same as the "equal power" curve found in Sound Designer II.

![Fade Out](image)

This curve fades out Region 1 with a linear fade curve. It creates a smooth, even fade out. It is the default curve.

![Fade Out](image)

This curve fades out Region 1 quickly at the beginning of the crossfade.

![Fade Out](image)

This curve drops the amplitude of Region 1 even more quickly at the beginning of the crossfade.

![Fade Out](image)

This curve silences Region 1 at the beginning of the crossfade.
Fade In Shapes

This curve brings up Region 2 at full volume immediately at the beginning of the crossfade and keeps it there throughout the crossfade.

This curve fades in Region 2 quickly in the beginning, reaching nearly full amplitude fairly early in the crossfade.

This curve fades in Region 2 with a moderately fast curve with slightly lower overall amplitude.

This curve fades in Region 2 with a linear fade curve. It is slightly slower with an even amplitude increase throughout the crossfade. It is the default envelope.

This curve fades in Region 2 slowly at the beginning of the crossfade.

This curve fades in Region 2 even slower than the previous curve.

This curve silences Region 2 until the end of the crossfade.
Some Basic Curve Combinations:
Here are some combinations of Fade Out and Fade In curves that you may wish to try. Some may be more useful than others. Please experiment with other curve combinations and selection types, too.

**Linear Crossfade.** A good general purpose crossfade with a smooth, even transition between Region 1 and Region 2.

(Selection same as above)

**Equal Power crossfade.** A good general purpose crossfade useful in cases where a linear crossfade seems to create a noticeable drop in volume across the splice point.

(Selection same as above)

**Overlap Fade.** This combination of curves keeps both Regions at full amplitude throughout the crossfade: Region 2 “jumps in” at the beginning and Region 1 “jumps out” at the end.

(Selection same as above)

**Silence.** Choosing these two curves will create silence for the duration of the crossfade.
Linear Pre-crossfade. This combination of curves creates a crossfade before the splice point. This will let you maintain the amplitude of the very beginning of Region 2 instead of fading across it. This is useful if there is a strong percussive downbeat at the beginning of Region 2, that you want to preserve, for example. The Tab key on your Mac’s keyboard is a useful tool for “tabbing” the cursor to the exact beginning or end of a Region for “pre” or “post” crossfade selections that start right on the border of two Regions.

Linear Post-crossfade. This combination generates the crossfade after the splice point. It is useful if you want to maintain the amplitude of Region 1 until its very end: in cases where you want to keep a strong upbeat that occurs at the end of Region 1, for example. The Tab key on your Mac’s keyboard is a useful tool for “tabbing” the cursor to the exact beginning or end of a Region for “pre” or “post” crossfade selections that start right on the border of two Regions.
To create a Crossfade between two adjacent Regions:

- Click the Selector.
- With the Selector, click at the point where you want the crossfade to begin in the first Region, and drag the mouse to where you want it to end in the second Region. Refer to the Selection Indicator Boxes at the top of the Edit window or Transport to see the exact duration of your selection. A variety of selection types are possible. Crossfades can be perfectly centered around a splice point or longer on either side. Don’t be afraid to experiment to get the exact effect you want.
- Release the mouse button.
- Select Fades from the Edit menu. A dialog appears prompting you to choose your Fade Out and Fade In curves.
- Click on the desired Fade Out and Fade In curves and click OK.

Pro Tools will calculate the crossfade and write it to disk. An "X" appears across the crossfaded area. Crossfades appear in their own Fades folder within the Session Folder.

![A typical crossfade](image)

To remove a crossfade, choose Undo from the Edit menu or select it with the Grabber and press the Delete key, or select Clear from the Edit menu. Moving one of the crossfaded Regions away will also remove the crossfade.

After you have created a crossfade, it is still possible to edit its length by using the Trimmer to shorten or lengthen the crossfade selection.

The Tab key on your Mac's keyboard is a useful tool for “tabbing” the cursor to the exact beginning or end of a Region for “pre” or “post” crossfade selections that start right on the border of two Regions. With the Selector active, click the mouse button once somewhere on the track. Press the Tab key to move forward to the next Region.
boundary. Holding down the Option key while you tab will allow you to move backwards. Next, hold the Shift key, click and hold the mouse button and adjust your selection as desired. Or, press the Shift-Tab to extend the selection forward to the next Region boundary. Holding down the Option key while you Shift-Tab will extend the selection back to the prior Region boundary.

Creating Crossfades Between Several Regions at Once

Pro Tools now allows you to conveniently create crossfades in “batch mode.” By selecting across several Regions, and choosing the Fades command, you can create crossfades for each of the Regions transitions at once. This feature can be a real time saver in a Session that requires many crossfades. If your selection includes Regions that already have crossfades, this feature allows you to modify them, too, if you wish.

To create Crossfades between several Regions at once:

• Click the Selector.
Chapter E: Editing

Creating Fade Ins/Outs

In addition to allowing you to crossfade between two Regions, the Fades command also lets you to create a fade in or fade out at the beginning or end of a Region. The length of your selection in the Region will determine the length of the fade in/out.

To Create a Fade In:

• Select the beginning of the Region or Regions that you wish to fade in. (The beginning of the selection must be the exact start of the Region. If necessary, make a selection in the Region and press Shift-Option-Tab to extend the selection back to the exact start point of the Region.)
• From the Edit menu, choose Fades... This dialog appears:

Creating a fade in with the Fades... command

• Select a fade in shape and click OK. The chosen fade curve will appear in the Region.

To Create a Fade Out:

• Select the end of the Region or Regions that you wish to fade out. (The end of the selection must be the exact end of the Region. If necessary, make a selection in the Region and press Shift-Tab to extend the selection to the exact end point of the Region.)

• From the Edit menu, choose Fades... This dialog appears:

Creating a fade out with the Fades... command

• Select a fade out shape and click OK. The chosen fade curve will appear in the Region.
After you have used the Fades command to create a crossfade or Fade in/out, you can still edit the length of the fade with the Trimmer. Simply click the Trimmer on the end of the fade that you wish to adjust, and then drag. The fade will be adjusted accordingly.

You can also redefine the fade shape by double-clicking on a fade with the Grabber selected.

NOTE: Though fades or crossfades may appear to be discrete Regions (and can even be deleted if you select them and press the Delete key), they cannot actually be separated from the Region(s) from which they were created.

Creating Tempo Data with the Identify Beat Command

If your Session doesn’t already have Tempo data (derived from MIDI data in the Session) the Identify Beat... command lets you create Tempo data by defining Beat Markers in a track. At least two Beat Markers are needed in order for Pro Tools to create this Bar & Beat-based time reference. Without this information, setting the Time Scale to Bars & Beats will not display anything, since it has no reference to base the scale on.

To create a Beat Marker:

• Click the Selector.
• Position the cursor at the precise beginning of a known bar/beat, and click. Be as exact as possible by zooming in and clicking the cursor precisely at the beginning of the beat.
• From the Edit menu, select Identify Beat... and a dialog will appear prompting you to identify the exact bar and beat value and the meter.
• Repeat this procedure once again to identify a second bar/beat and Pro Tools will have the information it needs to create a Bar & Beat time scale by interpolation.

![The Identify Beat dialog]
Another way to identify a beat is to make a selection which starts and ends on beats. Choosing the Identify Beat... command will bring up two successive dialogs, prompting you to identify the bar and beat of the beginning of the selected range and then the end of the selected range.

If you wish to mark a meter change, create a new Beat Marker or double-click an existing one and type in the new meter value. Pro Tools will recalculate all subsequent bars at the new meter.

If your Session was not recorded with a MIDI-based metronome or click track, it's probable that there will be some tempo changes in your music. Accordingly, the interpolated Bar & Beat information may be “off” in sections. To adjust the placement of Beat Markers, simply drag them to the appropriate location with the Grabber. Pro Tools will recalculate the rest of the Time Scale.

Quantizing Audio Regions

Now that you know how to create Tempo data with the Identify Beat command, you'll be able to use Grid mode to move Regions to a specific quantization value. To do so, do the following.

**To quantize movement of an audio Region:**

- Click the Grid button to put Pro Tools into Grid mode.
- From the Nudge/Grid pop-up menu, select the quantization value that you want.

The Nudge/Grid pop-up menu
• With the Grabber, drag the Region to the location where you want it to occur. The Region will automatically “Snap to” the nearest quantization value.

• To turn off quantization, select a different mode such as Slip or Shuffle.

NOTE: Grid mode also affects the Selector and Trimmer. Selections made in this mode are constrained to the chosen quantization value. Test this feature by selecting a quantization value such as quarter notes and making a selection in a track. The selection range will “snap to” the value you have chosen. This option is useful for “automatically” making selections of a chosen length.

Editing Automation Data

In addition to allowing you to edit and rearrange audio waveforms and MIDI data, Pro Tools also allows you to graphically edit automation data for any track in your Session. Like audio and MIDI data, automation data can be cut, copied, pasted, and rearranged using the tools and techniques you have learned in the Mix window.

Track volume and pan automation data take the form of a line graph with editable “breakpoints.” By dragging these breakpoints, you can modify the automation data for the Region in which it occurs. However, before you can begin editing automation data, you must first change your track’s data display format to show this type of data.

To show Volume or Pan automation data for a track:

• Click and hold the mouse on the Data Display Format selector for the track you wish to edit. From the pop-up menu that appears, choose Volume Graph or Pan Graph, depending on which of these you wish to edit. Your track’s data display changes to the format you have chosen.

A track displayed as a volume graph
To edit “breakpoint-style” automation data:

- To move a breakpoint, click on an existing point on the line graph with the Grabber and drag it to a new position. The automation data will be updated accordingly. (Dragging a breakpoint up on a volume graph will increase the volume; dragging it down will decrease the volume.)

- To create a new breakpoint, click the Grabber on the line graph. A new breakpoint appears.

- To remove a single breakpoint, hold down the Option key and click on an existing breakpoint. It is removed.

- To remove several breakpoints, use the Selector to select the range that contains them, and press the Delete or Clear key on your Macintosh keyboard. They are removed.

Other automation editing techniques:

- To move several breakpoints earlier or later in the track, select the range that contains them with the Selector. Then and press the + key to move them later (to the right) or the - key to move them sooner (to the left). The Nudge/Grid pop-up menu controls the increments.

- To move several breakpoints, up (louder) or down (softer), select the range that contains them with the Selector. Then, select the Trim tool and drag the breakpoints to the desired level. If you use the Trim tool without making a selection first, you can adjust all breakpoints within a given Region.

Punch-In Recording Using the Edit Window

Although sometimes a recorded track is perfect after the first try, in most situations at least part of the track will need to be recorded again. Picture, for example, a five-minute vocal track that has only a single line with a mistake. As the engineer on this Session, you would want to make one more recording pass and replace only a small piece of the recorded track. In traditional recording, this process of segment replacement is called “punching-in” or “dropping-in.”

To punch in a small section of a track, an engineer would watch the time on the track, and physically press (“punch”) the record button at the start of the section to be replaced. When the end of the replacement section was reached, the engineer would “punch” the record button out to prevent erasing any section of the track that should be kept.
This could be a risky process, and an unclean punch often damaged good sections of the track. For this reason, high-end multitrack recording decks began to offer automated punch-in and punch-out points. These points could be set carefully and stored, and at the time of replacement recording, the punch-in and punch-out points were handled automatically.

Pro Tools’ auto punch in/out feature is also designed to cope with this problem. To use this feature, you need only use the Selector to select the audio waveform or MIDI data range that you wish to rerecord, set an adequate amount of pre-and post-roll, and record the take normally.

During the recording process, playback will begin at the pre-roll time, proceed right up to the selection (the punch-in point), and at that moment, switch to record mode, where you will play over the mistake. When the punch-out point is reached, Pro Tools automatically switches out of record mode and continues playback through the specified amount of post-roll. This automated punch-in and punch-out feature offers a very powerful and precise way of rerecording a portion of a track.

**IMPORTANT**

Remember, if you are using Pro Tools to record non-destructively, punches do not destructively replace the source material. If you actually wish to “write over” the previous audio or MIDI data—erasing it forever—you can use Destructive Record mode.

**Monitoring During Punch-In**

When performing punch-in recording, Pro Tools monitors both the audio already recorded on disk and your live input signal—up until the punch point. Then, at the punch point, only the input signal is monitored. On punch-out, monitoring switches back to the audio on disk.

**To perform punch-in/out recording:**

- Make sure you are in the recording mode that you desire, destructive, or non-destructive, by enabling the appropriate mode in the Options menu. If you have chosen destructive recording, a check will appear next to the Destructive Record item in the menu. If you have chosen non-destructive recording, a check will NOT appear next to the Destructive Record item in the menu.

- With the Selector select the portion of the Region that you wish to rerecord.

- From the Setups menu, choose Pre/Post Roll. In the dialog that appears, enter appropriate pre- and post-roll times in the currently selected time base.
• Click the Rec button on the track to record-enable it. (For audio tracks set appropriate levels and input channel routing.)

• Click Record and then Play on the Transport.

Pro Tools begins playback at the pre-roll time, proceeds to the punch-in point, then switches to record mode. When the punch-out point is reached, Pro Tools automatically switches out of record mode and continues playback through the specified amount of post-roll.

If you have enabled Destructive Record, your new audio or MIDI data will be written into the existing file, erasing any previous data at the punch location. If you have enabled non-destructive recording, your new audio/MIDI data will be written into a new file.

---

**Managing Regions Efficiently**

Because a typical Session can get quite busy, with the Pro Tools window filled with many tracks and dozens of Regions, you’ll find that developing good “housekeeping” habits will help your Sessions go smoother. In particular, keeping on-screen clutter to a minimum will help your Sessions go better and faster. The next section offers some suggestions for managing things efficiently, followed by ways to end your Session and save your work.

---

**Abbreviated Region Names in the Regions List**

As you know, a Region’s name consists of two parts: the File name, which represents the audio file from which it originated, and the unique Region name that you gave it when you created it. Because Region names can become lengthy (up to 31 characters) and therefore difficult to view in the Regions list or a track, Pro Tools provides you with the option of displaying the File portion of the Region’s name.

Pro Tools defaults to displaying only the Region portion of a Region’s name. If you wish to display the full name of Regions (both the File and Region portions), simply choose Show File Names in Regions List command. This will affect all Regions in the Regions List.

**To show a Region’s full name:**

• From the Display menu, choose Show File Names in Region List.
The full names of Regions will now appear in the Regions List.

By default, when you type alphabetical characters on the Mac keyboard, Pro Tools Region’s List automatically scrolls and highlights any Region’s name that begins with those letters and also selects the Region on-screen. If you wish to turn this feature off, simply uncheck the Track Selection Follows Region List Selection option in the Preferences dialog. Turning this option off protects against the possibility of accidentally deselecting an on-screen selection.

If you wish, you can have Pro Tools automatically name separated Regions for you with the Name Separated Regions option in the Preferences dialog. With this option turned on (checked), when you separate a Region, Pro Tools will automatically name the separated Region(s) for you. The name will be a numbered variation of the Region’s name.

---

**Showing Hard Disk Volume Names in the Audio Regions List**

Pro Tools provides an option in the Display menu called, Show Volume Name in Regions List which is designed to make managing Audio Regions in multiple-hard drive systems easier. Enabling this command shows the volume name (the name of the hard drive where the audio file resides) of all Regions in the Audio Regions List. This allows you to see at a glance which drive a particular Region resides on. An added feature is that Pro Tools’ built-in alphabetic Region List search function (typing the first few characters of a Region name will highlight that Region’s name in the list) works intelligently: it ignores Volume and File names and finds the Region based on its Region name only.

(However, in order to sort by Region name most effectively, you may wish to disable Show Volume Name in Regions List.)

**To show hard drive (volume) names in the Audio Region’s List:**

- From the Display menu, choose Show Volume Name in Regions List. The hard drive where each Region resides appears as part of its name in the Audio Regions List.

- To hide volume names for Regions, choose the Show Volume Name in Regions List command a second time.
Choosing this option from the Display menu shows the name of the hard drive where each Region resides as part of its name in the Audio Regions List.

## Renaming Regions

In the course of a Session, you may wish to change the name of Regions, either to give them more descriptive names or merely to simplify them. Pro Tools allows you to do this with the Rename Selected command in the Regions List menu. This command can be used on “whole-file” Regions (Regions representing an entire audio file) as well as “sub-Regions” (Regions representing a segment of an audio file). If you attempt to rename a whole-file Region, Pro Tools will give you the choice of renaming just the Region as it occurs in the Session, or the audio file itself on disk. Be aware that when you rename a Region, Pro Tools will rename all occurrences of the Region in the Session.

If you select multiple Regions and then choose the Rename Selected command, you can rename a “batch” of audio Regions/files. Pro Tools will then continue presenting you with Rename Region dialogs until you have renamed all of the desired Regions/files.

### To Rename a Region:

- With the Grabber, click on the Region (or shift-click on multiple Regions) that you wish to rename. You can select a Region either in a track or in the Regions List.
From the Regions List menu, choose Rename Selected (or press Command-Shift-R). This dialog appears:

![Rename Selected dialog](image)

- Enter a new name for the Region.
- If you have selected a whole-file Region, you have the choice of renaming the Region only, or the Region and the original disk file itself. Choose the desired option.
- Click OK. Pro Tools will rename the Region and all other occurrences of the Region in the Session.

### Removing Unused Regions

In the course of a Session, the Regions List can fill up very quickly with Regions—Regions that you’ve created purposely and Regions that are “by-products” of actions such as cutting, pasting, and separating other Regions. Since many of these Regions may go unused, you may want to remove them from your Session to save you the trouble of scrolling through an unnecessarily long list of audio Regions.

The Clear Selected command allows you to remove these unwanted Regions from the Audio Regions List or MIDI Regions List. To use this command you must first select a Region by clicking its name in the Audio or MIDI Regions List. It offers two options for removing Regions from the Regions List. The first option, Remove, removes them from the current Session. The second option, Delete, (which is only available for audio files) permanently erases the audio from the source file on your hard disk.

**IMPORTANT**

The Delete option in this dialog will permanently and irreversibly delete the Region definitions from your hard disk. It cannot be undone! Please use this command with caution.
To remove unused Regions from a Session:

• Select the Region(s) you wish to clear in the Audio or MIDI Regions List. (Shift-click to select multiple Regions.)

• Choose Clear Selected... from the Regions List menu. A dialog box appears with two options: removing the Region(s) from the Session, or deleting the sound file from your hard disk. The first option simply “unloads” the Region(s) from the current Session. The second option, however, permanently erases the sound file from your hard disk and should be used with extreme care since it cannot be undone!

  The Clear Selected... dialog

  - Click Remove to unload the Region from the Session or Delete to permanently delete the file from your hard disk. Clicking Cancel will cancel the command. Should you attempt to remove or delete a Region that has been placed into a track, Pro Tools will warn you before proceeding.

Important

The Clear Selected command cannot be undone and should be used with care.

If you want to remove all unused Regions from the current Session, Pro Tools’ Select Unused Audio command facilitates the process by examining the current Session and, in the Regions List, highlighting all audio Regions which have not been placed in tracks. The Regions can then be removed from the current Session or their definitions permanently removed from the source audio file with the Clear Selected command.

To find all unused audio Regions in a Session:

• Choose Select Unused Audio from the Regions List menu.

  All Regions that have not been placed in a track in the current Session will be highlighted in the Audio Regions List.
• Choose Clear Selected... from the Regions List menu if you wish to remove all of these unused audio Regions. When the dialog appears, choose the appropriate option, Remove or Delete.

To find all unused MIDI Regions in a Session:

• Choose Select Unused MIDI from the Region List menu. All Regions that have not been placed in a track in the current Session will be highlighted in the MIDI Regions List.

• Choose Clear Selected... from the Regions List menu if you wish to remove all of these unused MIDI Regions.

Compacting an Audio File

In a disk-based recording and editing system such as Pro Tools, disk storage is at a premium. To help you get the most out of your storage, Pro Tools’ Compact Selected command allows you to “compact” sound files by removing unused areas in order to conserve disk space. The Compact Selected command does this by examining a selected source audio file, rewriting it to disk, while irretrievably deleting any data which has not been defined as a Region.

Because it permanently deletes audio data, this command should be used only after you have completely finished your editing Session and are sure that you have no further use for the unused audio data.

The Compact Selected command allows you to “pad” the Regions of the compacted file by a user-selectable amount. You will want to do this because Pro Tools requires extra audio data before and after an audio Region in order to create crossfades. So, if your Region has one or more crossfades, you should estimate how long your crossfades are and enter an appropriate amount of “padding” (in milliseconds) to account for this.

NOTE: The Compact Selected command is destructive and cannot be undone! It will permanently alter your original audio files. There is no way to recover data deleted with this command.

To compact an audio file:

• Choose Select Unused Audio from the Regions List menu. All Regions that have not been placed in a track in the current Session will be highlighted in the Audio Regions List.
• Choose Clear Selected... from the Regions List menu if you wish to remove all of these unused audio Regions. When the dialog appears, choose Remove.

• In the Audio Regions List, click on the Region (or shift-click on multiple Regions) that you wish to compact.

• Choose Compact Selected from the Region List menu. A dialog appears explaining your options:

```
'Compacting' is the process of removing audio from a file which is not used in any region. (Including the 'whole file' region.
All regions contained in a session are examined. What's left over is considered 'not used'. To maximize compaction clear unused regions first.
When the process is completed the 'whole file' region will be redefined to the new file size, and disk space will be recovered.
Regions can be 'padded' with extra audio so that after compacting you can still use some of the audio before and after a region for crossfades or region boundary tweaking.
Padding: [1000] milliseconds
After compacting a 'save' will automatically occur. Do you want to proceed?
[ Cancel ] [ Compact ]
```

The Compact Selected dialog

• Enter the amount of "padding" in milliseconds that you wish to leave around each Region in the file.

• Click Compact to compact the file or Cancel to cancel the command.

---

**Setting a Default Length for the Edit Window**

Pro Tools' Preferences dialog provides you with a convenient way to set a specific length for the Edit window. This capability is useful if you wish to assemble a Session of a particular length or leave extra room to expand the Edit window's work area in your Session. Currently, there is a 12 hour maximum limit for the length of a Pro Tools Session. Do not create a Session longer than 12 hours or System errors will occur.
The Preferences dialog allows you to set a default length for the Edit window.

**To set the Edit window to a specific length:**

- From the Setups menu, choose Preferences. The Preferences dialog appears.
- In the Edit Window Default Length box, enter the length that you want the Edit window to be (in Hours:Minutes:Seconds: and Frames).
- Click OK. The Edit window is now the length that you specified.

---

**Color Coding Tracks**

Enabling the Color Code Tracks option (in the Preferences dialog) assigns a preset color to an audio or MIDI track according to its Voice assignment (audio tracks) or MIDI channel assignment (MIDI tracks). This feature allows you to quickly identify tracks which are assigned to the same voice (or MIDI channel). It is particularly useful in Sessions where you wish to make efficient use of virtual tracks. Since audio tracks assigned to the same voice share the same color, you can easily identify and arrange Regions so that they do not overlap or conflict with other Regions on tracks assigned to the same voice.
To color code tracks:

- From the Setups menu, choose Preferences. The Preferences dialog appears.
- Enable the Color Code Tracks option. Click OK. All tracks assigned to the same voice will now share the same color.

Sharing Regions Between Sessions

If you would like a Region you created within a Pro Tools Session to be available to other Sessions, you will need to use the Export Selected command. This command essentially modifies the Region’s definition so that it will be available for Importing with the Import Audio command.

To make a Region definition available to other Pro Tools Sessions:

- In the Audio Regions List, select the Region(s) whose definition you wish to export.
- From the Region List menu, choose Export Selected. This dialog appears:
The Export Selected dialog

- Click Export to export the selected Region(s). Click Cancel to abort the export.

Pro Tools modifies the Region’s definition so that it is visible to other Sessions. The redefined Region will remain in its original Session folder. The next time that you use the Import Audio command, you will see the exported Region in the file dialog, from where it can be imported into the desired Session.

**Track Transfer™ Utility Software**

Track Transfer utility software greatly simplifies the process of exporting Regions. This convenient program, which was included with your Pro Tools system, lets you import, export, or merge entire track entities (including Region definitions) into other Sessions.

**Exporting Audio to Sound Designer II for Additional Editing**

The Open Selected in SD II command allows you to quickly switch to Sound Designer II to edit a selected Region in its original source audio file. Sound Designer II (available separately from Digidesign) offers other destructive DSP editing functions, such as Time Compression/Expansion and Reverse, which are not yet available in the Pro Tools software.

Selecting a Region and choosing this command will transfer you to the Sound Designer II software editor where the Region’s source audio file is opened and the Region itself is highlighted. From there you will be able to manipulate the selected Region or entire file with any of Sound Designer II’s editing tools or DSP functions.
This command requires that you use version 2.5 or later of Sound Designer II. If you are a Sound Tools or Sound Tools II owner and do not have a copy of this version, please send in the order form that is enclosed with your Pro Tools system and receive an update. If you are not a Sound Tools owner and wish to purchase Sound Designer II, contact your dealer or Digidesign.

NOTE: If you have version 2.8 or higher of Sound Designer II, selecting dual mono track Regions with a ".L" or a ".R" anywhere in their names will open both Region files in a single window for "stereo" editing.

To switch to Sound Designer II from within Pro Tools:

• With a Session open and an audio Region selected in a track or the Audio Regions List, choose the Open Selected in SDII command from the Region List menu.

If you have never used these versions of Pro Tools and Sound Designer II together, a dialog will appear prompting you to locate Sound Designer II. You should then locate Sound Designer II and click on the Open button. Sound Designer II will then launch. Pro Tools will remember Sound Designer II's location and automatically find it for you (unless you have moved Sound Designer II to a different location on your hard disk).

IMPORTANT
If you do anything to a file in Sound Designer II that will alter its length (cut, paste, trim, time expansion/compression, pitch shifting), do not attempt to play any Session that uses that file. The sound file's Regions must be deleted from the Regions list and reloaded into the Session. Do this with all Sessions that use Regions from the altered file(s).
Sound Designer II has no way of telling Pro Tools that a Region has been shortened. Pro Tools Sessions essentially make a copy of a file's start and end locations. If a Session is played that uses a Region that has been altered by SDII since the Session was saved, the program may “run out” of file and get a disk error.

You should now have the knowledge you need to create and edit your own audio and MIDI Regions in Pro Tools. If you plan to use your Pro Tools system to synchronize audio to tape, video, or film, proceed to the next chapter. There you will learn how to put your system to work using SMPTE and MIDI time code in these applications.
Chapter F
Working with SMPTE
Working with SMPTE

Introduction

This chapter covers the basics of using Pro Tools with SMPTE and explains the commands and functions needed to achieve proper and accurate synchronization of Pro Tools to an external source. You should also refer to Chapter C, Connecting your Studio for instructions on suggested configurations and proper hardware connections for setting up your Pro Tools III system to properly synchronize with SMPTE.

About Time Code and Synchronization

SMPTE (Society of Motion Picture and Television Engineers) time code is a running “clock” in the form of a digital data stream that can be recorded on magnetic tape as an audio or video signal. SMPTE time code can be used to synchronize the playback and recording of your Pro Tools system with another audio system, such as an analog multitrack tape machine (ATR) or a video tape recorder (VTR).

SMPTE time code is based on hours, minutes, seconds, frames and sub-frames. Depending on the SMPTE format (covered in the next section), one frame is equal to 1/24th, 1/25th, or 1/30th of a second. The frame unit is used as a unit of time measurement due to SMPTE time code’s origin in film and video applications.

Because SMPTE stores an absolute time reference on the tape in the form of time code, any location on that tape can be precisely located by devices that read time code. Once the time code has been recorded or “striped” on a tape, it provides a permanent time reference that allows Pro Tools to link the playback of an event to an exact tape location. Thanks to SMPTE synchronization, a gunshot sound effect can be played at the precise instant that the gun’s flash appears on-screen, and so on.
There are two basic techniques used to record SMPTE time code on magnetic tape: Longitudinal Time Code (LTC) and Vertical Interval Time Code (VITC). LTC is recorded as an audio signal on one of the audio tracks on the audio or video tape. VITC is recorded within the video signal in the video “blanking area” of each video frame. VITC cannot be recorded on audio tracks, so it has no application when working with audio tape recorders, but it does offer powerful features for post production professionals that work with video.

Each type of SMPTE has its own set of pro and cons:

LTC can be read at high tape shuttle speeds, allowing a machine’s time code reader to communicate with synchronizers and stay “in sync” at rewind or fast forward speeds exceeding 50 times playback speed (provided the tape recorder is able to reproduce the time code at this speed). Unfortunately, LTC cannot be read at very slow shuttle speeds (such as when you are “crawling” the tape frame by frame) or in pause. Sound effects editors often shuttle the video tape frame by frame to locate the exact point at which the sound effect should occur. With LTC, the VTR must be running (usually at a minimum speed of about 1/10th normal playback speed) in order to capture a SMPTE time address.

When VITC is used, Pro Tools can capture the current SMPTE time from the VTR when it’s paused or in “crawl” mode. However, most synchronizers cannot read VITC at speeds exceeding about 10 times playback speed, preventing slaved machines from maintaining synchronization during rewind and fast forward. Also, because VITC is recorded as part of each video frame, it must be recorded at the same time as the video signal—it cannot be added later as LTC can. Since VITC cannot be recorded on audio tracks, it’s never used to synchronize audio-only recorders. As a result, LTC is more commonly used in audio-only applications. VITC’s ability to capture a time code value when moving a VTR transport at slow speeds or paused makes it much more useful in audio post-production environments.

**IMPORTANT**

While none of the current Digidesign hardware can read VITC, Pro Tools can capture the current VITC time when using a VITC to LTC convertor in conjunction with a standard MIDI Interface. If a Digidesign SMPTE Slave Driver™ is used with a VITC to LTC convertor, it can only capture the current VITC time when the VTR is in “crawl” mode. When the VTR is paused, audio spotted with the SMPTE Slave Driver will be 2 frames ahead. Since the SMPTE Slave Driver processes LTC in two frame portions to determine the clock speed of incoming time code, it cannot process the same paused frame repeated over and over. Therefore the SMPTE Slave Driver only supports LTC and not VITC.
A workaround would be to use LTC from the VTR’s Time Code or Audio Track to drive the SMPTE Slave Driver, and have VITC from the VTR converted to LTC which would feed a standard MIDI Interface. Muting one or the other would then allow play sync via the SMPTE Slave Driver, and spotting via the MIDI Interface.

**SMPTE Formats**

Six different formats of SMPTE time code exist: 30 frames per second (fps), 30 fps Drop frame, 29.97 fps, 29.97 fps Drop frame, 25 fps (EBU) and 24 fps.

The 30 fps frame format is based on a frame rate of 30 frames per second. This is the original SMPTE format developed for monochrome (black and white) video, and is commonly used in audio-only applications.

The 29.97 Non-Drop frame format is used with NTSC color video. It runs at a slower frames per second rate of 29.97, but unlike 29.97 Drop-Frame time code, it makes no compensation for the discrepancies in “wall clock” time versus SMPTE time. It’s important to note that “one hour” of 29.97 Non-Drop frame time code is actually one hour and 3.6 seconds of “real time” due to the fact that the slower frame rate does not match “wall clock.”

NOTE: There is sometimes confusion in the audio/video world regarding SMPTE terminology referring to the 30 fps (black & white video standard) or 29.97 fps (color video standard) frame rates. When working with NTSC video (the standard in North America), one generally works with the color video standard: either 29.97 fps Non-Drop or 29.97 fps Drop-frame.

The 29.97 “Drop-Frame” format was developed for NTSC color video programs which need to remain in sync with “wall clock” time, and is commonly used in broadcast television. Since NTSC color video has an actual frame rate of 29.97 frames per second, this slight deviation from the standard 30 frames/second rate causes time code numbers to be out of sync with “wall clock” time, such that an hour of elapsed 29.97 frame rate SMPTE time code is not equal to one hour of real time due to the fact that the time code is actually running slower. To compensate for this discrepancy in frame rates, the first two frames of each minute are “dropped” (omitted) with the exception of every 10th minute. This results in 108 frames being dropped every each hour, exactly the number required to avoid accumulation error (and reflect true “wall clock” in the time code clock values).
The 30 Drop-Frame format. See above for an explanation of this frame rate. This rate is used in film sync “pull-up” applications. (See the section entitled About Pull Up and Pull Down Sample Rates later in this chapter.)

The 25 fps (EBU) format is used with the European PAL video standard, which runs at a 25 fps frame rate. This format is also called the EBU (European Broadcast Union) format because it’s used by broadcasters throughout Europe.

The 24 fps format is used exclusively for film applications. Film is often photographed and projected at a rate of 24 frames per second, so this SMPTE format is useful when one time code frame should equal one film frame.

---

Why Synchronization is Necessary

Synchronization is necessary for two reasons. First, it allows connected systems to start and stop their transports together, without requiring an operator to run all the transports individually. Secondly, it keeps the systems in lock-step while their transports are running, so that no individual system gets ahead of, or behind any other system.

Without synchronization, even if the operator were able to start and stop each individual transport manually at precisely the same time, once the transports began running, they would all run at slightly different rates over time. Analog tape transports, being mechanical, take variable amounts of time to ramp up to full playback speed and have small fluctuations in tape speed called “wow and flutter.” And even servo-controlled capstans on tape machines can slip over time as well, generating changes in tape speed.

With disk-based systems such as Pro Tools, playback and record speeds are controlled by quartz crystal oscillators. However, no two oscillators are exactly the same, and an oscillator’s frequency can vary with time and temperature. What all this means is that when any two systems, analog or digital, are started at exactly the same time, they will begin to drift apart over time, and the audio on the different systems will eventually drift out of sync.

Synchronization is achieved in these systems by constantly checking to see the master device’s current SMPTE frame, and adjusting the playback speed to keep all devices locked. In analog systems, this is achieved by varying motor speed control. In digital systems it is achieved by adjusting the playback sample rate clock. The process of forcing a slave device to change its playback speed or sample clock (in the case of a digital audio system) in order to follow a master, is called resolving.
Using SMPTE

The basic idea behind a SMPTE-synchronized network of devices is that each device (analog tape machine, video tape machine, etc.) is initially “striped” with SMPTE before anything else is recorded. One of the devices is assigned to be the “master” and all other devices read and follow the SMPTE time code read from the master. They follow (or synchronize to) the master device by comparing their own SMPTE time code “stripes” to the incoming code from the master device, and continually adjust their own transport speed so that all devices are registering the exact same SMPTE time code value at the same time.

In such a system, if the master device begins to slow down, all other devices will slow down right along with it, matching the master’s speed variations so that all devices are playing back at the same speed. Even after long periods of time they will still be exactly locked to each other because the current master SMPTE time is mirrored by all slave devices.

To set up such a system, you must first “stripe” each medium (video tape, audio tape, etc.) with SMPTE time code. On analog tape machines, this means recording longitudinal SMPTE time code (LTC) on one of the tracks of the audio tape. On video tape machines, you can record LTC on one of the audio tracks or control track of the video tape—or you can record Vertical Interval SMPTE time code (VITC) in the vertical blanking interval of the video signal itself.

If you expect to send any of your SMPTE-striped material to someone else, or especially if you intend to provide it for professional broadcasting purposes, you must be sure that the SMPTE time code that your generator is producing is very accurate. This is accomplished by resolving (or synchronizing) the actual SMPTE time code generator itself to a very accurate clock signal, such as video “house sync” or “black burst.” This is the only way to guarantee that the SMPTE time code on tape is within the tight timing tolerances that professional broadcasting requires.

If you do not resolve your generator, or if your generator is incapable of being resolved (most low-cost SMPTE generators cannot be resolved), then you cannot ensure that a professional broadcaster will obtain accurate results from the tapes you produce. If you only use SMPTE within your own work environment, and especially if you do not use it in context with video, then an unresolved generator provides less of a problem. However, the most flexible choice is to buy the best resolvable generator (and black burst source, if needed) that you can afford, since this generator provides the heartbeat of your entire SMPTE system.
Because Pro Tools is a completely digital system, you do not need to stripe any track with SMPTE. Pro Tools uses the Pro Tools digital sample clock as a reference to generate and read very accurate time code. You only need to specify the SMPTE time at which you want a region to start, and Pro Tools can translate SMPTE times to digital sample numbers “on the fly.”

Any slave devices in the system other than Pro Tools will require their own transport synchronizer in order to follow the master SMPTE time code. The master device itself does not need a synchronizer, since it is generating rather than reading. Your Pro Tools III system can be used as master or slave, since it can read as well as generate time code (with the addition of the Digidesign SMPTE Slave Driver).

Pro Tools synchronizes to SMPTE time code by getting positional information from a LTC-to-MIDI Time code Converter such as Digidesign’s SMPTE Slave Driver, Opcode’s Time Code Machine, Opcode’s Studio 4 or Studio 5, or Mark of the Unicorn’s MIDI Time Piece. These converters take the SMPTE signal and convert into a MIDI-based version of SMPTE that is fed into your computer’s serial (modem or printer) port.

Note that the SMPTE time code formats striped on all devices must match. Different devices must not have different frame rates. Mismatched frame rates will result in major sync problems.

### Choosing a Synchronization Type

The Pro Tools software supports a type of SMPTE synchronization known as SMPTE Trigger through the use of inexpensive third-party SMPTE-to-MIDI Time Code converters. This type of synchronization allows Pro Tools to chase and start (or stop) playback and recording while slaved to other systems. With SMPTE Trigger alone, once playback or recording starts, there is no further synchronization, and Pro Tools will play back at a rate determined by your Interface’s quartz crystal oscillator.

For fairly short pieces of audio program material, SMPTE Trigger is acceptable, especially if the sync master has a fairly stable transport or is resolved. In this case, the master transport and Pro Tools will probably not drift very far apart in such a short period of time. On the other hand, if the audio piece is several minutes long, or if the sync master has an unstable transport (as in the case of a low quality recording deck striped with SMPTE, for example), SMPTE Trigger alone is probably not an acceptable solution, since the two systems may drift apart noticeably over the duration of the source material.
Two better alternatives exist, both of which use hardware synchronization peripherals from Digidesign.

The Digidesign Video Slave Driver
The Video Slave Driver is a peripheral device for Pro Tools Project and Pro Tools 442 that allows you to control Pro Tools’ recording and playback clock via an external video black burst or word clock signal while triggering to external Time Code via an MTC converter. The Video Slave Driver accepts either of these signals and then converts it into a master 256-times sample clock “Super Clock” signal which it sends to your Interface. By sending the same master black burst clock signal to Pro Tools and your video deck or synchronizer system, all elements of your system will run at exactly the same speed, thereby staying in sync.

In this case, SMPTE Time Code is only used to locate, chase, and trigger playback or recording via an MTC converter. As explained above, playback speed of both Pro Tools and the video tape or synchronizer are then resolved by the black burst or word clock signal. Since with the Video Slave Driver Pro Tools and all audio and video transports are resolved to a common clock, long-term synchronization is achieved.

For applications which require high fidelity, and long-term synchronization to free-running Longitudinal SMPTE time code, Digidesign provides another alternative in the form of the SMPTE Slave Driver.

The Digidesign SMPTE Slave Driver
The SMPTE Slave Driver is a peripheral device for Pro Tools Project and Pro Tools 442 that provides high-fidelity direct hardware synchronization between Pro Tools and external Longitudinal SMPTE time code (LTC), as well as functioning as a MTC converter. The SMPTE Slave Driver accepts an external longitudinal SMPTE time code signal and then converts it into a master “Super Clock” clock signal which it sends to your Pro Tools Interface. The SMPTE Slave Driver monitors any variations in rate of the external time code. Then, via the Super Clock connection between the SMPTE Slave Driver and the Interface, Pro Tools’ actual sample clock rate is varied directly by the SMPTE Slave Driver. This uses none of Pro Tools’ audio processing power, thereby preventing the audio degradation common to other software-based varispeeding schemes.

In addition, since a hard disk digital recording system such as Pro Tools is a much more stable timebase reference than a tape recorder, the SMPTE Slave Driver is also designed to generate LTC, allowing Pro Tools to function as a very stable master sync source. Thus the SMPTE Slave Driver can function as both a SMPTE-to-MIDI time code converter and as a SMPTE/MTC generator. In addition, in generate mode, the SMPTE Slave Driver can output a 256x slave clock reference signal, and also allows users who work in post-production access to “pull-up” and “pull-down” sample rates for Pro Tools sessions.

Chapter F: Working with SMPTE
In summary, you have three choices for synchronizing Pro Tools to an external source:

1) Using SMPTE Trigger by itself, which could result in timing errors if you are working with lengthy program material and an unstable sync source.

2) Using SMPTE Trigger with the optional Video Slave Driver to control Pro Tools' recording/playback speed with a black burst generator or word clock. This enables accurate long-term synchronization when all transports within the system are resolved to this common sync source.

3) Using SMPTE Trigger with the optional SMPTE Slave Driver to resolve Pro Tools' recording/playback speed while slaving to LTC. This enables long-term, high-fidelity synchronization by resolving to any variations in incoming time code.

By adding a SMPTE Slave Driver to your Pro Tools III system, you actually have a fourth choice: using Pro Tools as the master device in your synchronization setup. All other devices are then slaved to Pro Tools. This is possible because Pro Tools and the SMPTE Slave Driver together have the ability to generate SMPTE LTC, MIDI Time Code, or Slave Clock. Which of these solutions you choose depends on your needs and the nature of your audio projects.

Before you proceed, your Pro Tools III system should be connected to your external synchronization source according to the instructions given in Chapter C, Connecting Your Studio. If you haven't made the appropriate connections, do so now by referring to the instructions given there.

Preparing Pro Tools to Work with SMPTE

After you have decided on your synchronization scheme and made the appropriate system connections, your next task is preparing your Pro Tools software. The first step is choosing a SMPTE frame rate for your Session that matches your project.

SMPTE Formats

Pro Tools supports all standard SMPTE frame rates. These formats are: 30 fps; 30 drop-frame, 29.97 fps Non-Drop Frame for NTSC color video (this is the format most commonly used for audio transport synchronizers which are resolved to house sync); 29.97 drop frame for wall-clock accurate broadcast NTSC color video; 25 fps for PAL/SECAM video; and 24 fps for film. Make sure that you know without a doubt which of these formats your project's tape has been striped with before you begin your session. A little
extra care up front is always preferable to hours spent redoing work later. (If you own a SMPTE Slave Driver you can confirm the incoming frame rate by looking at the SMPTE Slave Driver’s front panel LED indicators. However, the SMPTE Slave Driver cannot distinguish between 29.97 and 30 fps, due to the close proximity between the two frame rates. Consult your SMPTE Slave Driver User’s manual for more details.)

If you intend to work at a “pull down” sample rate, please read the section entitled About Pull Down and Pull Up Sample Rates, later in this chapter.

To choose a SMPTE format:

• Select Time Code from the Setups menu. This dialog appears:

![The Time Code dialog]

  - Select the SMPTE frame format appropriate to your session.
  - If you wish to protect against errors that may occur in your Session if your source of SMPTE time code has drop outs, enable the Ignore Time Code Drop Outs option in this dialog box. When this option is enabled, it allows Pro Tools to “freewheel” for 8 frames over any areas of bad time code that it receives while on-line.

Setting a SMPTE Start Frame

The Time Code dialog also allows you to set a SMPTE Start Frame for your session. Because video work tapes are rarely striped beginning at a SMPTE frame address of 00:00:00:00, this is a very useful function. With it, you can quickly enter a “start time” for your session based on an appropriate frame number at the beginning of your project.

Chapter F: Working with SMPTE 225
tape, Pro Tools' SMPTE-related functions (such as Spot mode) will then use this value as their reference for the Session's start point. If you are generating time code, it is a good practice to stripe your time code at a number greater than 00:00:00:00. This prevents problems that can occur with some synchronizers when the striped time code crosses from 24:59:59:29 to 00:00:00:00.

If you wish to set a SMPTE Start Frame for your Session, do the following:

**To choose a SMPTE Start Frame for your Session:**

- From the Setups menu, choose Time Code.
- In the Start Frame item in this dialog, type in an appropriate SMPTE frame number.
- Click OK. The Pro Tools session will use the frame number you have entered as its SMPTE start frame when on-line.

Entering a SMPTE Start Frame

**NOTE:** Pro Tools will not support the existence of Region elements which are more than 12 hours apart from one another in a Session. When you are spotting a Region, the time entered in the Move Region To dialog must not be 12 hours less than or 12 hours greater than the value you have entered as your Session’s SMPTE Start Time.

**Displaying Time in SMPTE Frames**

The next step in preparing Pro Tools for synchronization is setting the Time Scale to Time Code. Though Pro Tools will still synchronize to incoming SMPTE time code if the
Time Scale is displayed in Bars & Beats, Minutes:Seconds, or Feet:Frames, it is obviously more useful to use SMPTE Time Code as your reference.

**To Set the Time Scale to SMPTE Time Code:**

- From the Display menu, choose Time Code.
  
or:
  
- Double-click the Time Format box in the Time Scale Indicator.
- Select Time Code. Click OK.

![Selecting a Time Scale Format](image)

Pro Tools will display time in the currently selected SMPTE frame rate.

---

**About Pull Down and Pull Up Sample Rates for Editing Film**

Pull Up and Pull Down are terms used to refer to the deliberate “miscalibration” of the audio sample rate clock (the audio pitch) in order to compensate for a speed change elsewhere in the production chain. The usual situation in which these rates are encountered is when film footage (at 24 fps) is transferred to color video tape (at 29.97 fps).

Consider the following scenario:

If you had a film clip that lasted 1000 seconds, you would have 24,000 film frames (pictures). If you wanted to transfer that film to 1000 seconds worth of color videotape, you would have to “fit” your 24,000 film frames into 29,970.02997 video frames. Because you can’t have a fraction of a picture, the best you could do would be to repeat a film frame occasionally to make up the difference in the frame counts. But if you did that, a fraction of a picture (the 0.02997 part) would be left over. Thus, this scheme wouldn’t work.
When film is transferred to NTSC videotape, the solution is not to convert to the color video rate of 29.97 fps, but to use the black and white frame rate of 30 fps. You can then put 24,000 frames into 30,000 video frames evenly. This can be done by repeating certain fields of video. Every video frame has two fields (every film frame has 1 field). By repeating certain fields you get four frames of film “mapped” to 5 frames of video in the following way:

<table>
<thead>
<tr>
<th>Film frames</th>
<th>[A]</th>
<th>[B]</th>
<th>[C]</th>
<th>[D]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video frames (2 fields/frame)</td>
<td>[AA]</td>
<td>[BB]</td>
<td>[BC]</td>
<td>[CD]</td>
</tr>
</tbody>
</table>

This preserves the 4:5 ratio between the film rate of 24 frames per second and the video rate of 30 frames per second. In this situation, certain frames of video actually have two different fields from two different frames of film. This is called a “2-3 pulldown.”

Unfortunately, NTSC color video decks do not playback at 30 fps: they play at 29.97 fps. If you play your video tape that was just transferred from film, you will notice that it plays slightly slower than the film. The audio that was transferred to the video tape is also running slower than the film making the pitch slightly flat. This process of transferring film to video is called Telecine. If the reference audio track on the film was transferred to video tape during the Telecine process, this audio then becomes pulled down as well. In the Post Production process, the terms “film speed” and “tape speed” are commonly used to clarify which speed your source or disk based audio is running. This becomes an important issue as you will need to know if the audio you have been supplied matches the film mag stock or a slowed down video reference.

You now have a color video work tape of the film. However, in most cases, you will be given source audio takes at film speed, such as dialog or sound effects. These need to be edited against the video tape, and then laid back to film at a later date. (The layback to film is usually done by a Transfer House, and they will generally request a specific format in which you are to supply the edited audio). To compensate for this expected speed mismatch and to allow for easy adjustment back to film speed after you have finished your edits, you will use the Pull Down process.

Use the following process to correctly record audio into Pro Tools for use with Pull Down.

- Record your source audio into Pro Tools at a standard sample rate of 44.1k or 48k, depending on the sample rate of your session. Once the recording process is complete, your next task is to configure for Pull Down in two locations:
- First, set your SMPTE Slave Driver, Video Slave Driver or Micro Lynx™ to Pull Down mode on the front panel (for Micro Lynx users, choose ACG Setup and select 44.056 or 47.952 under nominal SR out).
• Secondly, choose Time Code from Pro Tools’ Setup menu and enable “Using Film Transfer Pull Down”. Using Film Transfer Pull Down is not available if the current SMPTE format is 30 fps or 30 fps drop (the checkbox will read “Using Film Transfer Pull Up” at those SMPTE formats).

By using this process, the audio that is subsequently recorded to disk will now playback at the same speed as your video tape.

In some situations, recording the scratch or reference track from the video tape into Pro Tools will allow you to spot waveforms much more quickly, using the reference track as a guide. If you choose to do this, however, be aware that you will be attempting to have audio at film speed and audio at video speed in the same session. This will cause problems, and here's why.

If you record the scratch track from the video into Pro Tools at a nominal sample rate of 44.1k or 48k, it will playback in sync with the video, no problem. But, if you are planning on adding location audio or dialog at film speed, you will have to pull the session down to load these elements. Now your field audio at film speed matches the video tape, but your scratch track is playing a little slow because it has been pulled down.

The solution to this problem is as follows. Record your scratch track from the video tape into Pro Tools using the Pull Up feature of the SMPTE Slave Driver. Once the scratch track has been recorded, deselect Pull Up and record your source or film speed audio in at your selected session sample rate, 44.1k or 48k. As mentioned before, once these tracks have been recorded, activate the Pull Down function and all your audio files will playback in sync with the video tape. If you need to add more location audio to your session, simply deactivate both Pull Down settings, record in your additional audio, and then reactivate the Pull Down feature at both locations (on your SSD/VSD/MicroLynx, and in Pro Tools’ Time Code Setup dialog).

By using a Digidesign SMPTE Slave Driver in conjunction with Pro Tools, you can do both a deliberate “pull up” and a “pull down” so that even a misprinted transfer can be used. Remember however, that you should always check with both the supplier and the receiver of your audio material to find out exactly what sample rate you should use. If you have a Digidesign SMPTE Slave Driver and intend to work with material that has been pulled down or up (or needs to be), do the following.

To work with a pull down/ up sample rate:

• Make sure that your SMPTE Slave driver is set to the appropriate frame rate and pull down/up sample rate for your material. (Please refer to your SMPTE Slave Driver User’s Guide.)
• Make sure that your Pro Tools Session’s sample rate is appropriate for the pull down/up rate you have chosen on the front panel of the SMPTE Slave Driver.

• From the Setups menu, choose the Serial Ports command and make sure that the serial port that the SMPTE Slave Driver is connected to is enabled.

• From the Setups menu, choose the Peripherals command and make sure that the SMPTE Slave Driver is enabled and that the appropriate port is selected.

Selecting the appropriate serial port for the SMPTE Slave Driver

• Choose the Time Code command from the Setups menu. Choose a frame rate that is appropriate for the settings on the front panel of your SMPTE Slave Driver.

• Enable the Using Film Transfer Pull Down option by clicking in this box. An "X" indicates that it is enabled.

Selecting the Using Film Transfer Pull Down in the Time Code dialog
• Click OK.

Your Pro Tools system should now be ready to work at the pull down rate.

Generating Time Code with Pro Tools

In addition to being able to synchronize itself to an external device by reading and slaving to SMPTE (via MIDI Time Code), Pro Tools can also generate SMPTE, MIDI Time Code, or Word Clock. Pro Tools can then be used as a master synchronization source, with other devices slaved to it. In many ways this is an advantageous setup because the Pro Tools will generate a rock-solid master clock for the slaved devices to follow.

To make Pro Tools the Sync Master (using a SMPTE Slave Driver):

• Connect the SMPTE OUT connector of the SMPTE Slave Driver to the SMPTE IN connector on the device(s) you are slaving. If you are slaving a device that recognizes MTC and you wish to use MTC instead of SMPTE, connect the MTC OUT connector to the MTC IN connector of the slaved device.

• Make sure that your SMPTE Slave driver is on and set to the appropriate frame rate and sample rate for your material.

• On the front panel of the SMPTE Slave Driver, set the Mode selector to Generate from Internal.

• In Pro Tools, choose the Serial Ports command from the Setups menu and enable the serial port that the SMPTE Slave Driver is connected to.

• In Pro Tools, choose the Time Code command from the Setups menu. Choose the appropriate frame rate, making sure it matches the settings on the front panel of your SMPTE Slave Driver.

• Enable the Output Time Code option by clicking in this box. An “X” indicates that it is enabled.

• Enable the Using SMPTE Slave Driver option by clicking the button next to this item.

• Click OK.

• Click Play on Pro Tools Transport. Pro Tools will generate and send Time Code through the SMPTE Slave Driver.
Generating SMPTE Time Code while Pro Tools is On-Line

You can also use the SMPTE Slave Driver to generate SMPTE time code while Pro Tools is on-line (slaved to another device). This is useful in cases where you wish to “regenerate” the time code that Pro Tools is receiving in order to stripe it onto other external devices such as an analog tape deck.

To make Pro Tools generate time code while on-line:

• In Pro Tools, choose the Serial Ports command from the Setups menu and enable the serial port that the SMPTE Slave Driver is connected to.

• Choose the Time Code command from the Setups menu. Choose the appropriate frame rate, making sure it matches the settings on the front panel of your SMPTE Slave Driver (or use the Send Parameters to SSD button).

• Enable the Output Time Code option by clicking in this box. An “X” indicates that it is enabled.

• Enable the Using SMPTE Slave Driver option by clicking the button next to this item.

• Click OK.

• Click the On-line button on the Pro Tools Transport. Pro Tools will generate and send Time Code through the SMPTE Slave Driver corresponding to the Session time code.
Synchronizing an OMS-compatible Sequencer to Pro Tools

Another useful application for generating time code with Pro Tools is slaving an OMS-compatible sequencer to a Pro Tools Session. This allows you to integrate full-featured MIDI sequencing programs such as Vision, Cubase or Logic with a Pro Tools Session. To do this, you must have installed the OMS IAC driver (included with Pro Tools) in your OMS folder and Pro Tools' Active in Background command enabled.

The exact synchronization setup your sequencer requires will vary depending on the software itself and your specific OMS setup. The following instructions describe the general steps that you should take, using Opcode's Vision software as an example, and Pro Tools as the Master.

To slave an OMS-compatible MIDI sequencer to Pro Tools:

- Install the OMS IAC driver that came with your Pro Tools system by dragging it from the floppy disk to the OMS Folder inside your System Folder.

In the OMS Setup application:

- In the Studio menu select Interfaces, click Update Setup, enable port(s), then click Search.
- Confirm that the OMS IAC driver appears here. If it appears, save the document and make it your current setup.
- The IAC Driver defaults to containing one bus, named “IAC Bus #1”. If you want to define additional busses, or rename any of them, you can do so by double-clicking the IAC Driver, and defining/reNaming the bus.
- In OMS MIDI Setup window in the Edit menu, set Compatibility to “Only OMS Applications.” If you are using OMS version 2.0 or later, you should enable “Run MIDI In Background.”

In Vision:

- In the Enable Input Devices window in the Setup menu, enable IAC1.
- In the Options menu set Receive Sync Mode to MIDI Time Code.
- In the Options menu set Receive Sync Device to IAC1.
- In the Options menu select the correct SMPTE format that will match Pro Tools (30 non drop, for example).
- Set the sequence start time: for example, 01:00:00:00. The Offset at the top of the Sequence window should usually match the Offset in Pro Tools.
• Click the Play button. Vision should now be ready to start synchronized playback.

In Pro Tools:
• Open the Time Code window in the Setups menu.
• Choose an appropriate frame rate. Unless you have other requirements, 30 fps (Non-Drop) is Pro Tools' default rate. You will need to make sure this setting matches the corresponding settings in your sequencer.
• Use the Start Frame field to match the starting SMPTE frame number of your sequence in Vision. The time that you enter here will determine the SMPTE frame number at which your session will begin playback. This value should either match or be earlier than the SMPTE Start Time you set in your sequencer.
• Enable the Output Time Code option by clicking in this box. An “X” indicates that it is enabled.
• Enable the Using port option by clicking the button next to this item. In the pop-up menu next to this item, choose IAC Bus1#. Click OK to close this dialog box.
• From the Options menu, enable Active in Background. A check next to this item indicates that it is enabled.
• Click Play in the Transport or press the Space bar to start playback, and Pro Tools will send MIDI Time Code to Vision and trigger synchronized playback for Vision. Click Stop in the Transport or press the Space bar again to stop playback.

Once synchronized playback is operating correctly, you can record new takes in Pro Tools while listening to your MIDI tracks play from your sequencer. Simply follow the procedure described above for synchronized playback, and then record new material in Pro Tools by following the steps outlined in the Recording chapter of this manual. You should also be able to record new MIDI tracks while the sequencer is slaved to Pro Tools. See your sequencer’s user’s manual for details on recording while the sequencer is in an external synchronization mode.
About Time Stamping

Pro Tools supports "time stamping." This feature allows Pro Tools to remember the original SMPTE time at which audio was recorded when it was recorded on-line. This feature is always "on." In other words, because Pro Tools saves the original SMPTE time as part of the Region (if the audio was recorded with Pro Tools on-line), it can recall the original SMPTE time whenever you choose to do so.

If you have spotted the Region to a different SMPTE time and wish to recall the original SMPTE time, you need only click the Enter Original Time button which appears in the Move Region To dialog. This dialog appears whenever you Spot a Region. With this feature you will always be able to re-spot a Region to its original SMPTE location. (To display this dialog box for any region in the Edit window, put Pro Tools into Spot mode and click on the region with the Grabber.)

![Move Region To dialog](image)

The Move Region To dialog supports Time Stamping by providing an "Enter Original Time" button.

NOTE: The Use Subframes option in this dialog box enables you to work with subframe accuracy by adding an additional time field in the SMPTE hours:minutes:seconds:frames box. This additional time field, (which appears as the far right time field when enabled), allows you to enter subframe values in SMPTE dialogs. (Use a period to separate sub-frame values from whole frames.)

If you wish to redefine the Time-Stamped SMPTE time, Pro Tools now allows you to do this by using the Time Stamp Selected command (covered shortly).

About the Show Original Time Code in Regions command

This command displays the original "time stamped" SMPTE time in all Regions currently placed in tracks. This SMPTE frame number represents the time at which the...
Region was originally recorded on-line with Pro Tools, and does not necessarily reflect the Region’s current SMPTE location in a track.

**About the Time Stamp Selected Command**

This command allows you to select a Region (or Regions) and redefine its SMPTE time stamp. Because Pro Tools stores only one time stamp per Region, this command replaces the SMPTE frame number that was originally stamped on the take when it was recorded online. This feature is particularly useful in post production situations where the SMPTE time code on video “work prints” often changes from one edit revision to another during the video post-production process.

**To time stamp a Region (or Regions) with a new SMPTE frame number:**

- In a track, select the Region that you wish to time stamp.
- From the Regions List menu, choose the Time Stamp Selected command. This dialog appears:

```
Name: Ripping Flesh
Time Stamp: 00:00:11:25.11

Capture
Use Selection

Cancel OK
```

- Enter a new SMPTE time. You can do this in three ways: enter the numbers manually (with the help of the arrow keys); click Capture if you wish to capture the incoming time code address; or click Use Selection if you wish to enter the start time of the current on-screen selection.
- Click OK.

This command can be used in “batch mode” to set new Time Stamps for several Regions at the same time. To do this, simply select several Regions and choose the Time Stamp Selected command. One after another, Pro Tools will present a dialog for each Region, allowing you to quickly enter a new value for each.
Putting Pro Tools On-line

In order to trigger playback or recording of Pro Tools from an external source, you must put the system on-line. In this state, it waits for a specific SMPTE frame number. When Pro Tools sees that frame number, it will begin audio and MIDI playback and recording.

There are several ways to put Pro Tools on-line: with the Transport’s Online button, with the Option menu’s Online command, by pressing Command-J on your Mac keyboard, or by holding down the Option key and pressing the Space bar. All of these methods have the same effect.

To put Pro Tools on-line:

- From the Options menu, choose Online. A check appears in front of this command to indicate that the current Session is on-line. At the same time, the Current Position Indicator at the upper right of the Pro Tools window will display your incoming Time Code as soon as Pro Tools begins On-line playback.
- Click the Online button at the far left of the Transport. The button becomes highlighted. Pro Tools is now on-line and waiting for a SMPTE frame to trigger its playback.

To take Pro Tools off-line, either choose Online on the Display menu again, press Command-J, click the Online button on the Transport a second time, or press Option-Space bar once again.

Recording On-Line

The Preferences dialog contains two options that affect how Pro Tools initiates recording when on-line: Record On-line at Time Code Lock and Record On-line at Insertion/Selection.

If you choose Record On-line At Insertion/Selection, on-line recording begins wherever you have placed the insertion point in a track. Recording then continues until Pro Tools stops receiving time code. If you make a selection in a track, Pro Tools will record on-line only for the length of the selection. When using this mode, make sure that your selection is actually where you want it to be. You can quickly find its location by pressing Command-Left Arrow key. This will scroll the display to wherever the insertion point is.
If you choose Record On line at Time Code Lock, on-line recording begins as soon as Pro Tools receives and locks to time code. In this case, you don’t need to make an insertion or selection in a track to designate a start point. Instead, simply enable this option, record-enable the track and the Transport, and click the On-Line button on the Pro Tools Transport. As soon as Pro Tools locks to time code, it will begin recording. Keep in mind that in this mode, Pro Tools disregards any on-screen selection—it simply begins recording as soon as it starts receiving time code.

斑点地区到 SMPTE 帧位置

“斑点”是指在音频后期制作中将音乐和声音线索分配到特定的 SMPTE 帧位置的过程。Pro Tools 斑点模式提供了一种方便的方法来进行此操作。此功能可以用于斑点：

1) 整个区域，选中（或双击）与拾取器一起的（多个区域可以被选中）。

2) 区域内部的特定位置（通过点击区域中的选择器并选择 IDENTIFY SYNC POINT 命令从编辑菜单）。在 Spot 模式中，可以通过简单地点击区域并使用 Grabber 选项来快速斑点区域。一个 Move Region To 对话框将显示出来，提示您输入适当的 SMPTE 帧位置。您可以简单地点击 Capture Time Code 在此对话框中自动斑点区域以匹配当前 SMPTE 位置。使用 VITC，您可以准确地捕获暂停或“爬行”VTR 的 SMPTE 位置。

重要

尽管当前的 Digidesign 硬件均无法读取 VITC，Pro Tools 可以通过使用 VITC 到 LTC 转换器与标准 MIDI 接口一起使用来捕获当前的 VITC 时间。如果使用 Digidesign SMPTE Sl ave Driver™ 与 VITC 到 LTC 转换器一起使用，它只能捕获当前的 VITC 时间，只要 VTR 在“爬行”
mode. When the VTR is paused, audio spotted with the SMPTE Slave Driver will offset by two frames due to a processing delay. Since the SMPTE Slave Driver processes LTC in two frame portions to determine the clock speed of incoming time code, it cannot process the same paused frame repeated over and over. Therefore the SMPTE Slave Driver only supports LTC and not VITC. A workaround would be to use LTC from the VTR’s Time Code or Audio Track to drive the SMPTE Slave Driver, and have VITC from the VTR converted to LTC which would feed a standard SMPTE-to-MIDI Time Code converter. Muting one or the other would then allow play sync via the SMPTE Slave Driver, and spotting via the MIDI Interface.

The Use Subframes option in the Move Region To dialog box enables you to work with subframe accuracy by adding an additional time field in the SMPTE hours:minutes:seconds:frames box. This additional time field (which appears at the far right time field when enabled), allows you to enter subframe values in SMPTE dialogs. (Use a period to separate sub-frame values from whole frames.)

In Spot mode, clicking on a Region with the Grabber brings up this dialog:

With Use Subframes enabled, an additional "subframes" time field appears.

If you drag a Region from the Regions List into a track while in Spot mode, the Move Region To dialog will appear automatically when you let go of the Region, prompting you to specify a SMPTE time location for the Region.
For absolute accuracy, frame numbers can be typed into the Move Region To dialog. Pro Tools also allows you to easily “capture” a frame locations on the fly in this dialog by clicking the Capture Time Code button, or hitting the Enter key on the Mac's keyboard.

Be aware that although the Capture Time Code button will work with free-running Longitudinal Time Code (LTC) or VITC, frame numbers of a paused frame can only be captured with VITC. This is because LTC, being an audio signal, is NOT refreshed when a tape is paused or played at very slow speeds—such as those used when “crawling” through a video to isolate “hit” points. Also, be aware that when spotting a Region, the time entered in the Move Region To dialog must not be 12 hours less than or greater than the value you have entered as a SMPTE Start Frame value (in the Setups menu’s Time Code dialog).

Regions are spotted by their start times unless you have identified a Sync Point (covered later in this chapter) within the Region. If the Region contains a Sync Point, spotting is done in reference to the Sync Point, which will occur at the designated SMPTE time.

NOTE: Pro Tools provides you with a handy shortcut for increasing or decreasing SMPTE values in this dialog by a specific number of frames. Simply press + or - on your Mac’s numeric keypad, enter a number, and press =. The designated number of frames will be added to or subtracted from the currently selected time field.

If you click a Region with the Trimmer in Spot mode, a dialog will appear allowing you to enter a value in SMPTE frames to specify exactly where you wish the Region’s beginning or end (depending on where you clicked) to be trimmed to. This is a convenient way to edit the length of a Region to correspond to a particular visual “hit point.”

In Spot mode, Clicking on a Region with the Trimmer brings up this dialog

NOTE: Trimming a Region which contains a Sync Point will not affect the SMPTE location of the Sync Point (unless the Region is trimmed past the Sync Point).
To spot a Region to a specific SMPTE frame:

- From the Display menu, choose Show Edit Window to go to this window.
- From the Display menu, choose Time Code as your Time Scale format.
- Click the Spot button at the top left of the Edit window to put Pro Tools into Spot mode.

![Enabling Spot mode]

- Identify the SMPTE frame location where you wish to trigger playback of your Region by pausing your video deck on that frame. (If you are using VITC you will able to click Capture Time Code to automatically enter the frame you are paused on.)
- With the Grabber, click a Region in a track (or drag a Region from the Region’s List into a track). The Move Region To dialog appears.

![The Move Region To dialog]

- Type in the desired SMPTE frame location. The Mac keyboard’s left/right and up/down arrow keys allow you to move from time field to time field or increase/decrease SMPTE values. If you wish to increase or decrease SMPTE values by a specific number of frames, you can also press + or - on your Mac’s numeric keypad, enter a number, and press =. The designated number of frames will be added to or subtracted from the currently selected time field.
- If you are using VITC, you can click Capture Time Code or press Enter on the Mac’s keyboard to enter a paused VTR’s current SMPTE location.
• If you recorded the Region while on-line, you can use the Enter Original Time button to automatically recall and enter the SMPTE frame location at which the Region was originally recorded.

• Click OK.

The Region is now spotted to the chosen SMPTE frame location. When the Session is On-line, this frame number will trigger playback of the Region.

Auto-Spot Regions

Pro Tools’ Auto-Spot Regions option simplifies the task of spotting Regions even further. If you are using VITC with this option enabled, you can pause your video deck on an appropriate SMPTE frame location, click on a Region with the Grabber, and the Region will be automatically spotted to the current time code location—bypassing the usual SMPTE dialog.

Note: As mentioned earlier, the Digidesign SMPTE Slave Driver™ does not support VITC, even when used in conjunction with a VITC to LTC convertor. A workaround would be to use LTC from the VTR’s Time Code or Audio Track to drive the SMPTE Slave Driver, and have VITC from the VTR converted to LTC which would feed a standard SMPTE-to-MIDI Time Code convetor. Muting one or the other would then allow play sync via the SMPTE Slave Driver, and spotting via the MIDI Interface.

To Auto-Spot a Region:

• If you are using VITC, identify the SMPTE frame location where you wish to trigger playback of your Region by pausing your video deck on that frame.

• Select Auto-Spot Region from the Options menu.

Options

| Auto-Spot Regions | 36P |

The Auto-Spot Regions Command

• Click the desired Region with the Grabber. The Region will be automatically spotted to the current time code location.
NOTE: Clicking a Region with the Trimmer will allow you to trim the Region to the current time code location.

NOTE: As you learned earlier, Regions are spotted by their start times—unless you have identified a Sync Point within the Region. If the Region contains a Sync Point, spotting is done in reference to the Sync Point which will then occur at the designated SMPTE time. Sync points are explained in the next section.

Identify Sync Point

Pro Tools’ Identify Sync Point command allows you to identify a specific point within a Region and spot that point to a SMPTE frame location.

Imagine the following sound effects spotting scenario: You have a single sound effect that consists of a door closing creakily to a slam, followed by a few seconds of ambient reverberation. The slam portion of the effect—which you must precisely match to picture—occurs neither at the very beginning of the audio file nor at the very end. It is somewhere in the middle, making it tougher to spot in the usual way.

This is where the Identify Sync Point command comes in handy. This command allows you to click the Selector and identify a point within an audio Region (such as our door slam) and sync that point to a particular SMPTE time by identifying it as the “sync point.” The command then offsets the Region so that playback begins... continues... and Bang! The portion of the file that you have identified as the Sync Point occurs exactly at the SMPTE time you have entered.

When you choose this command, the current SMPTE time is automatically entered as the SMPTE location for the Sync Point.

To spot a point within a Region to a SMPTE frame location:

- Pause your video deck on the SMPTE frame location that you wish to match to the Sync Point.
- Click the Selector at the point in the Region that you wish to synchronize to the selected SMPTE frame location.
- From the Edit menu, choose Identify Sync Point. A marker appears in the audio Region indicating the location of this Sync Point.
The Selector’s insertion point—the Sync Point—is now spotted to the chosen SMPTE frame location. When the Session is On-line, this point in the Region will occur at the selected SMPTE time.

Identifying a Sync Point in a Region

To change the location of a Sync point in a Region, click the Selector in the Region and choose Identify Sync Point from the Edit menu again. The new location will then be identified as the Sync Point.

To remove a Sync point from a Region, select the Region with the Grabber and choose Remove Sync Point from the Edit menu. The Sync Point marker will disappear from the Region.

Locking a Region

After you have spotted your Region you may wish to lock it to prevent inadvertently moving it later. To do this, use Pro Tools’ Lock/Unlock Region command.
To Lock a Region:

• With the Grabber, select the Region you wish to lock. (Multiple Regions can be selected and locked together.)

• From the Edit menu, choose Lock/Unlock Region. The Region is now locked and cannot be moved from its current position. If you perform edits that attempt to move the Region, Pro Tools will alert you with a dialog.

Synchronization Troubleshooting

Getting SMPTE synchronization to work properly can seem like a formidable task at times. If you’re having trouble getting your system to work properly, the following checklist may help you solve the problem:

If Pro Tools does not recognize the OMS IAC Driver:

• Verify that you are running version 1.2.3 or higher of Opcode Systems’ OMS software. If OMS is not installed, install it from your OMS disks (provided by Opcode). Then run the Custom Install from your Pro Tools disk set to install the IAC Driver.

• Verify that the OMS IAC Driver is in the OMS Folder inside the System Folder. If it is not there, run the Custom Install from your Pro Tools installation disks to install the OMS IAC Driver.

If Pro Tools does not trigger to MIDI Time Code:

• Verify that the SMPTE start time in Pro Tools either matches or is later than the SMPTE start time set in your sequencer or external SMPTE source.

• Verify that the frame rate in Pro Tools matches the corresponding setting in your sequencer or external SMPTE source.

• Verify that Pro Tools’ Online command is enabled in the Options menu, or that the Online button on Pro Tools’ Transport is flashing.

• If the sequencer is running in the foreground, make sure Pro Tools has Active in Background enabled first in the Edit menu. A check next to this item indicates it is enabled.
• You should be using OMS to work with MIDI and synchronization in Pro Tools. If OMS is not installed, run the OMS installer provided by Opcode and install OMS.

If Pro Tools won't lock to MIDI Time Code; it triggers, but won't stay Online:

• Try allowing for 5-10 seconds of pre-roll.
• There may be a half-second or more of bad or missing Time Code. The maximum Pro Tools can free-wheel is 3 seconds, or 90 frames, whichever is greater. Try another SMPTE-striped tape or MIDI sequence.

If Pro Tools and your sequencer or external device start playing back in sync (starting anywhere in the session) but drift during playback.

• Make sure the frame rate in Pro Tools matches the corresponding setting in your sequencer or SMPTE source.
• There may be problems with the current MIDI sequence or SMPTE source. Try another MIDI sequence or SMPTE-striped tape.
• The transport for your external device may be unstable. Try resolving the device to a stable clock reference such as a “black burst” or house sync generator.
• The tape machines in your setup may not have been striped with SMPTE Time Code before recording any audio onto them or to the Pro Tools system. If this is the case, your system may seem to work, but synchronization will never properly occur. You must re-record the audio after you stripe the tape, if at all possible.
• The audio may have been recorded into Pro Tools without a resolved SMPTE source. (If, for example, it was recorded before the current Session.) The audio cannot be accurately synchronized with an analog tape recorder or video tape deck, since the original audio on the computer was not recorded referenced to the SMPTE Time Code from the analog tape recorder or video tape deck.
• AppleTalk may be Active, which can cause the Macintosh to ignore MIDI data (such as MIDI Time Code) coming into its serial ports. Make sure AppleTalk is Inactive in the Chooser under the Apple menu.
• In very rare instances, the Audio Card’s Sample Rate clock may have drifted out of specifications. To test this, connect a DAT machine and put the Session in Digital Sync mode for playback.
If Pro Tools and your sequencer or external device play back in sync when starting from the beginning of the session, but starting anywhere else they're immediately out of sync:

- The sample rate in Pro Tools is different from the source tape.
- The start location is calculated based on the current SMPTE received (from the sequencer, for example) and the session’s frame rate. If the session’s frame rate doesn’t match the source frame rate, then the start location is calculated incorrectly and the session starts where it thinks it should. Double-check the following items:
  - Make sure the frame rate in Pro Tools matches the corresponding setting in your sequencer or SMPTE source.
  - Sometimes the external device may not be up to speed when Pro Tools gets a SMPTE trigger. Try starting playback of your external device earlier to allow it to come up to speed.
  - In very rare instances, the Audio Card’s Sample Rate clock may have drifted out of specifications. This can cause the sample count (from which the current MTC time is calculated) to be off. To test this, connect a DAT machine and put Pro Tools in Digital Sync mode in the Hardware Setup dialog.

If you are unsure of the actual SMPTE frame rate on your (audio or video) tape:

- You may think this unlikely, but if you get your tapes from a production company instead of recording them yourself, you are at their mercy as to what SMPTE frame rate is actually used on that tape. It may have been incorrectly labeled. Worse, it may be different than the frame rate of the SMPTE you have already striped on another work tape! If you have some serious doubts about the actual SMPTE frame rate on a tape, verify with the production company before you begin working.
- Similarly, some production companies will distribute color video work prints striped with 29.97 fps Non-Drop but mark them as “30 fps NTSC,” by which they actually mean 29.97 fps Non-Drop. By the time the tape gets to you, you may have no idea what’s actually on it. Feeding 29.97 fps Non-Drop to Pro Tools when it’s set for 30 fps (Non-Drop) will result in timing errors of about 1.8 frames per minute, causing audio playback to trigger out of sync. So if you’re working with color video work prints in the US, they will most commonly be striped with 29.97 fps Non-Drop.
If your MIDI Controller is not recognized by Pro Tools:

- Make sure the MIDI cable connections from the MIDI controller to the MIDI Interface are configured correctly and secured. Make sure the serial cable connections from the MIDI Interface to the computer are configured correctly and secured.

- If you are using OMS, verify the MIDI controller is correctly defined as a device in OMS. (Review the Using a MIDI Control Surface with Pro Tools section in this chapter for instructions on how to do this.)

- In the OMS Device Info window for the MIDI controller, verify the Is Controller button is highlighted and the proper MIDI channel has been selected for the controller.

- In the OMS MIDI Setup, verify the Only OMS Applications Compatibility mode is enabled and the correct serial port is selected.

- Verify the MIDI channel and port settings in the Pro Tools’ MIDI Controller Mapping dialog match the OMS Device Info settings for the MIDI controller.
Chapter G
Mixing
Mixing

Introduction

After you have recorded all of the tracks in your Session and edited them to your satisfaction, you are then ready to begin mixdown. You will begin by putting all of the audio tracks together, setting their levels relative to each other, adding EQ and effects as needed, and recording the final master arrangement to a stereo file on disk, a CD recorder using Digidesign’s MasterList CD™, or to an external stereo mastering recorder. This final will be used to make your final product, whether it is a compact disc, album, cassette, or a stereo hard disk file for other purposes.

In this chapter you will learn the processes and techniques involved in creating such a final mixdown with Pro Tools, including the use of equalization, effects, mix automation, bouncing, and mastering.

Suggestions for Creating Good Mixes

A good mix will have a good stereo image and good “depths” in terms of near and far. These perceived depths are created by the use of panning, mix levels, and often, processing gear (reverb, delays, chorus etc.).

When you start to mix music, it’s generally a good idea to start with the rhythm section. Quickly put together a mix of all of the basic sounds. Then add the main instrument in the mix (typically the lead vocal), and work everything else around it. Remember your goal is to create a good mix—the sum total of the parts. You are not trying to create the “perfect” snare or guitar sound, so listen to the overall mix and don’t get hung up on any one part for too long. Once you have all the elements in place, with their relative levels about right, you can go back and start fine tuning things—changing EQ on the vocals or instruments, or adding effects to things.

Use Commercial CD’s as a Reference

When mixing it is very useful to consult commercial CD’s as a reference. Listening to professional mixes is one of the fastest ways to check how good your own mix is. Another helpful technique for getting a good finished mix is to listen to your finished
mix on different stereos and in different environments (home, car, or other location). Try to listen to your finished mix in the same environments in which it will ultimately be heard.

Additional Mixing Tips
Here are some more basic tips for producing good solid mixes, especially music mixes:

- Subtracting from a mix generally works better than adding to one. Less effects, less EQ, fewer instruments—these will always yield a cleaner, more defined sound.
- Use EQ sparingly. And remember, subtractive EQ is often better than additive EQ.
- Take breaks when you mix. Your ears will get fatigued sitting in front of speakers for long periods of time.
- Always have another person listen to your mix.
- Write down what you do, because you may want (or need) to do it again.

Pro Tools' Get Info command provides a convenient way to jot down information about a Session and save it with the Session itself. See Chapter H, Pro Tools Menus for an explanation of how to use this feature.

Using a MIDI Control Surface with Pro Tools

Although the mouse is a very useful control device, it is extremely limited in a mixing environment because it only allows you to adjust a single fader or other on-screen controller at a time. This is much more cumbersome than using your hands on a standard mixing board, where you can move multiple faders at once.

To solve this problem, Pro Tools offers “MIDI controller mapping.” Pro Tools' MIDI mapping feature allows you to use a MIDI continuous controller to move faders and other Pro Tools controls on screen. For example, you could map your keyboard modulation wheel to control the movement of pan faders. Or, if you have a MIDI fader unit such as the JL Cooper CS-10, you could control Pro Tools' on-screen level faders with the CS-10’s real faders.

Pro Tools also allows you to map a MIDI controller to any of Pro Tools' Transport controls. In this case, since the Transport is an on/off control, we recommend that you map a “switched” (on/off-type) controller rather than a continuous (slider-type) controller. Besides being a convenient and ergonomic method for controlling Pro Tools on-screen controls, MIDI Mapping also provides far faster response time than using the on-screen controls.
To map a MIDI controller to a Pro Tools fader or slider:

- Make sure that your MIDI device and MIDI interface are both on and connected to the Macintosh properly.
- From the Setups menu, choose Serial Ports. (The dialog that appears here will vary depending on whether or not you are using OMS.) In the dialog that appears, enable the MIDI port that your interface is connected to (Modem or Printer) and click OK.
- Hold down the Control key on your computer keyboard and click once on the Pro Tools fader, slider or Transport button that you wish to control with the external MIDI device. The Pro Tools fader, slider, or Transport button turns green, indicating it is ready to be mapped. (If you wish to control multiple faders, hold down Shift-Control and click additional faders.)
- Move one of the controllers on your MIDI device. The controller is now mapped to the Pro Tools fader, slider, or Transport button. When you move the controller, the on-screen Pro Tools control will move or toggle in tandem with it.
- If you want to unmap a Pro Tools fader, slider or Transport button, hold down the Control key and click twice on the Pro Tools control you wish to unmap. It is now unmapped.

MIDI Mapping is not stored when you quit and reopen a Session.

Using Digital EQ

Pro Tools provides you with pre-fader, in-line digital equalizers for enhancing the tonal character of your mix. EQs are available via the Inserts pop-up menu on tracks. The number of EQs available depends on your Pro Tools configuration:

- Pro Tools Project systems provide a maximum of 4 EQs.
- Audiomedia-based systems provide a maximum of 4 EQs.
- DAE PowerMix-based systems provide 2 EQs per playback track.

These EQs are designed to work non-destructively: they do not process the audio signal as it is recorded. Instead, the source audio signal is only modified according to the current EQ settings during playback. This guarantees that you will never alter your original source track unless you decide to destructively process the track by applying the EQ while bouncing it to disk. You will learn how to do this later in this chapter when we cover digital track bouncing.
If you use EQ properly and in moderation, your mixes can be made punchier, and instruments and vocals can be brought out of the depths of a mix and given more of an edge. On the other hand, if you overuse EQ or use it improperly, your mix can become distorted.

In general, good use of EQ is more about taking away than it is about adding. While a novice engineer will often concentrate only on using EQ to boost things, the more experienced engineer will focus on using EQ to cut—finding frequencies that interfere with the mix and removing them. In reality, judicious use of both cutting and boosting will allow you to achieve the ultimate goal: giving your mix clarity by carving out different frequency ranges for each instrument in your mix.

A word to the wise: Human ears are very sensitive to the range between 1kHz and 5kHz. The reason for this is simple: this is the range where human speech falls, thus our ears are naturally tuned to this range. If you want something to really stand out in a mix, put it in this range. However, don’t bunch everything up in this range or your mix will sound claustrophobic.

Ideally, if you’ve been careful in the recording stages of your project, your tracks will need very little EQ at all. If you’ve used good microphones and paid extra attention to the sound of your instruments before committing them to disk, you won’t have to resort to “fixing things in the mix.” The best rule of thumb is this: use your EQs when and where you really need to. They’re great for solving problems or adding a little extra zing to a mix, but in the end, a little extra care during recording is always preferable to fixing things later.

**Accessing EQs**

Pro Tools’ digital EQs are located on the Inserts section of each audio track.

**To access Pro Tools’ EQs:**

- Choose the Show Inserts View and Show Extra Views in Mix Window commands from the Display menu.
- Click the Inserts pop-up menu and select an EQ type. When you do this, the Inserts/Sends Editor will appear. This floating window allows you to conveniently access EQ and Sends controls for audio tracks.
Chapter G: Mixing

Types of EQ

Pro Tools provides five types of EQs: High Pass, High Shelf, Peak/Notch, Low Shelf, and Low Pass. Each EQ has controls for Frequency (the specific frequency to be cut or boosted), Gain (the amount the frequencies are cut or boosted), and a Bypass button for disabling the EQ. In the case of the peak/notch EQ, Width buttons are also included for choosing how wide a range of frequencies (in octaves) will be affected.

The High Pass Filter

A High Pass filter attenuates all frequencies below the selected cutoff frequency setting at a rate of 12dB per octave while allowing all others above to pass through. For this reason, no gain control is available for this filter. High Pass filters can be useful for removing low frequency rumble or thinning out the lower end of a sound for special effects like “telephoning.”
The High Pass Filter is good for getting rid of low end “rumble” and noise. If you record material using microphones in a room with air conditioning or other low-end noise, try setting the High Pass Filter in the 50Hz range. This will cut the noise and still leave the essential tone of your audio material. This is especially useful for cleaning up dialog.

**High Shelf**

A High-Shelf EQ produces a lift or a cut at or above the specified frequency. The High Shelf is one of the most useful EQs because you can use it to brighten up or add “shimmer” to a specific part. For instance, to add “air” to cymbals without adding much noise or giving them a hard edge, set the High Shelf to 10kHz or higher and boost slightly. Boosting lower ranges such as 4kHz or 5kHz can help add intelligibility and definition to audio material as well.

**The Peak/Notch EQ**

A Peak/Notch EQ boosts or cuts only those frequencies centered around the selected center frequency. The Width button sets the width or “Q” (in octaves) of the center frequency (from 1/3 to 3 octaves). This determines the width of the filter’s overall slope—from a broad “bell” shape to a narrow “notch.” Broad curves tend to be most useful for musical applications. Narrow curves are useful for special purpose processing such as hum removal.

The Peak/Notch EQ is the most effective “surgical tool” of all of the EQs because it lets you tightly tune into a particular band of frequencies and make very precise adjustments to them. To use the Peak/Notch EQ most effectively, set its width to a relatively narrow band (1/3 octave) and adjust the frequency slider to find the undesirable frequencies. Then increase the bandwidth to an octave or more and cut. (Alternatively, find the desirable frequencies and boost).
The Low Pass Filter

A Low Pass filter attenuates all frequencies above the selected cutoff frequency setting at a rate of 12dB per octave while allowing all others below to pass through. For this reason, no gain control is available for this filter. The Low Pass Filter is very useful for cutting hiss, particularly if you have transferred material from analog audio with tape hiss or other high-end noise.

Low Shelf

A Low-Shelf EQ produces a lift or a cut at or below the specified frequency. The Low Shelf is good for “cleaning up” audio, especially if you use it to cut rather than boost. When used to cut, the Low Shelf is particularly good for thinning out the bottom end of a sound and leaving the higher frequencies. If, for example, you record a drum kit with overhead mics and wish to leave mainly the cymbals while filtering out the other drums and low-end rumble, you could set the Low Shelf to cut the range below 200Hz. Conversely, if you boost with the Low Shelf, you can increase the overall bass response of a part. 200Hz to 400Hz is a good frequency range for beefing up overall bass response without focusing on a particular range.

Auditioning EQs

A useful way to audition the effect of an EQ is to increase its gain and then drag the frequency up or down until you hear its effect. Then go back and make more precise adjustments to the EQ’s gain (and width, for the Peak/Notch EQ). Remember that some instruments occupy only a very small frequency range, so you may need to fine tune the EQ’s frequency range to hear its effect on your track. You can freely adjust the EQ’s parameter values during recording or playback, but avoid switching EQ types or you may cause pops and clicks to occur.

Pro Tools’ EQs are pre-fader, so you can accidentally cause clipping if you boost EQ gain to extremes. This is particularly true on tracks recorded at high amplitude. Be sure to listen to your tracks carefully to avoid clipping when applying EQ.
Suggestions for EQing Specific Instruments:

• Drums: Use one Peak/Notch EQ to tune into the fundamental tone of the drums and boost it a little (don’t use too narrow a bandwidth). Use a second EQ at the 2kHz-4kHz range to boost the “snap” of the drumstick. This will give you a much sharper sound. (Alternatively, to achieve a mellower sound, cut at the 2kHz-4kHz range).

• Guitar: Use the Peak/Notch EQ to cut undesirable frequencies from the guitar’s tone. Alternatively, use it to boost slightly to give the guitar tone more of an edge. Try the ranges from 1kHz-2.5kHz and from 5kHz-6 kHz.

• Piano: Use the High Shelf to boost slightly and add brightness to the piano’s tone. Then use the Peak/Notch EQ to remove unwanted resonances.

• Vocals: Use one Peak/Notch EQ to cut in the 2.5kHz range. This is often where there is a nasal edge to vocals. Use a second Peak/Notch EQ to boost the body of the vocal and add warmth if the vocalist has a breathy tone. Alternatively, if the vocal has enough tone but not a lot of “air,” cut slightly in the 2kHz range and use a High Shelf to boost and add a little more presence to the vocal.

• To create the classic “old-time radio” effect, set the High Pass Filter to the 1kHz - 2kHz range and a Low Pass Filter in the 5kHz range. This creates a heavily mid-ranged sound reminiscent of old-time radio.

• Use your ears and experiment to find EQ settings that enhance your mix. Though we’ve provided a few basic guidelines here, there are no real hard and fast rules in the world of audio production, so let your ears be your guide!

To select and use a digital EQ:

• If Pro Tools’ Inserts are not currently visible, choose the Show Inserts View and Show Extra Views in Mix window commands from the Display menu.

• Click the Inserts pop-up menu to select the type of EQ you wish to use. (The default setting is No Insert.) Your choices are High Pass, High Shelf, Peak/Notch, Low Shelf, and Low Pass.

• The Inserts Editor appears, along with the parameters for the EQ you have chosen. Different EQs provide different parameters.

• Click Play on the Transport to begin audio playback.

• Adjust the parameters of the EQ you have chosen to achieve the desired result.
To select a different EQ or a different track:

- To select a second EQ on the same track, click the EQ Selector and choose the desired EQ from the pop-up menu.
- To adjust the parameters for a second EQ on the same track, click the Insert Selector and choose Insert B from the pop-up menu. Then, click the EQ Selector pop-up and choose the desired EQ.
- To adjust the EQ parameters for another track, click the Track Selector and choose the desired track from the pop-up menu. Then repeat the steps above.
Copying, Pasting, Importing and Exporting EQ Parameters

Pro Tools lets you conveniently copy, paste, import, and export EQ parameters using the commands found in the Effect menu. By doing so, you can create your own library of commonly used settings that you can easily use on any track in any Session.

Export Settings
The Export Settings command allows you to save the settings of the currently active EQ in the Inserts/Sends Editor as a parameter file on your hard disk. You can then import and apply these settings to a different track or Session by calling up a track in the Inserts/Sends Editor and choosing the Import Settings command. This saves you the time and trouble of adjusting the parameters manually.

Import Settings
The Import Settings command allows you to load and use a previously saved EQ parameter settings file. When the settings are loaded, they are applied to the currently active EQ in the Inserts Editor. The Inserts/Sends Editor window must be open for this command to be available in the Effect menu.

Copy Effect Parameters
The Copy Effect Parameters command allows you to copy the current settings of the Inserts/Sends Editor. Choose Copy Effect Parameters from the Edit menu, or press Command-Shift-C. You can then apply these settings to a different track by calling up the track in the Inserts Editor and pasting them with the Paste Effect Parameters command. This saves you the time and trouble of adjusting the parameters manually. Effect parameters can be copied and pasted during playback. To apply a EQ’s parameters to a track in another Session, use the Export Settings and Import Settings commands, explained above.

Paste Effect Parameters
The Paste Effect Parameters command allows you to paste EQ parameters copied in the Inserts/Sends Editor with the Copy Effect Parameters command. Choose Paste Effect Parameters from the Edit menu, or press Command-Shift-P. Effect parameters can be copied and pasted during playback. To apply a EQ’s parameters to a track in another Session, use the Export Settings and Import Settings commands, explained above.
Revert Settings
The Revert Settings command restores the selected EQ’s settings to the state they were in the last time you saved your Session. The Inserts/Sends Editor window must be open for this command to be available in the Effect menu.

To save the parameters of a EQ to disk:

• Make sure the Inserts/Sends Editor is open and that the parameters for the desired EQ are displayed.

• From the Edit menu, choose Export Settings. This dialog appears:

![The Export Settings dialog](image)

• In the dialog, enter a name for the settings file.

• Click OK. Pro Tools saves the currently displayed EQ’s parameter settings to disk.

To load and use a saved EQ’s parameter settings file:

• Make sure the Inserts/Sends Editor is open.

• In the Inserts Editor, click the Track Selector pop-up and choose the track that you wish to import the EQ parameters into.

• When the desired track appears in the Inserts Editor, click the Insert Selector pop-up and choose Insert A or B from the pop-up menu depending on which of these you wish to import the parameters into.

• From the Edit menu, choose Import Settings. This dialog appears:
The Import Settings dialog

- In this file dialog locate the desired settings file and click Open. Pro Tools loads the previously saved effect parameters into the Effects/Sends Editor where they are applied to the currently selected track.

**To copy EQ parameters from one Insert and paste them into another:**

- Make sure the Inserts/Sends Editor is open and that the parameters for the desired EQ are displayed.
- Choose Copy Effect Parameters from the Edit menu, or press Command-Shift-C. Pro Tools copies the current settings of the Inserts Editor.
- In the Inserts Editor, click the Track Selector pop-up and choose the track that you wish to paste the EQ parameters into.
- When the desired track appears in the Inserts Editor, click the Insert Selector pop-up and choose Insert A or B from the pop-up menu depending on which of these you wish to paste the parameters into.
- Choose Paste Effect Parameters from the Edit menu, or press Command-Shift-P. Pro Tools pastes the previously copied effect parameters.

**Setting Up Effects Loops**

(Sends are not available on Audiomedia III or DAE PowerMix-based Pro Tools Systems. See the section entitled “Adding External Effects to Tracks in Audiomedia III and DAE PowerMix-based Pro Tools Systems”)

Pro Tools is designed to allow you to use your Audio Interface's analog or digital inputs and outputs as external effects sends and returns. Pro Tools allows you to set up external sends and returns as you would on an analog mixing console. There are two external send busses available for each track in Pro Tools Project-based systems. In these systems, outputs 7-8 of the Audio Interface are used as sends. Any audio inputs can be
used as returns. Depending on your studio and your specific needs, you can use these for either stereo or mono operation.

To access Pro Tools’ Sends:

- Choose the Show Sends View and Show Extra Views in Mix Window commands from the Display menu.
- Click the Sends pop-up menu and select a Send. When you do this, the Sends Editor will appear. This floating window allows you to conveniently access Sends (and EQ) controls for any audio track.

The following section explains how to set up and use these sends and returns to create an effects loop. For the sake of our example, let’s imagine that our effects device is a reverb with stereo inputs and stereo outputs. In the examples given here, the Audio Interface is connected in the following way:

- Analog Inputs 1-2 are your record inputs. They are connected to your instrument’s preamp or your mixer.
- Analog Outputs 1-2 are your master stereo outputs. They are connected to your mixer.
- Analog Outputs 7-8 are connected to the inputs of your effects device.
- Analog Inputs 7-8 are connected to the outputs of your effects device.

Before you begin:

- Set the mix/balance control on your effects device to 100% wet.
- From the Setups menu, choose Hardware, make sure the Ch 1-2 Input parameter is set to Analog and that Sync Mode is set to Internal. Click OK.
• From the Display menu, choose Show Mix Window to go to the Mix Window.
• From the Display menu, choose Show Extra Views in Mix Window.
• If the Sends aren’t already visible, choose Show Sends View. The Sends appear near the top of your track(s).
• If track inputs and outputs aren’t already visible, choose Show I/O View. The I/O controls appear near the top of your track(s).

If you are using the 882 Studio Audio Interface, you must make the appropriate routing connections between the 882 Studio’s inputs, the effects device, and Pro Tools in order to properly set up an effects loop. To do this, choose the “Hardware” command from the Setups menu and click the “Other Options” button. The “Route” dialog will appear allowing you to make the desired connections. If you are unsure how to use the Route dialog, please refer to Chapter B, “Pro Tools Basics.”

**To set up an analog effects send/return loop:**

• Click on the Output selector of your audio track and set it to outputs 7-8.
• Click the Sends pop-up on your audio track. The Sends Editor appears.

![The Sends Editor](image)

• If the Mute button is on (highlighted), click it once to unmute the Send. (You can also unmute a Send by Option-clicking the Send button on your track, without having to open the Sends Editor.)
• In the Send Editor, set the track to output 7 or 8.
• Drag the Send level slider to the right. This slider controls the amount of signal sent to the effects device. Make sure it’s not set so high that it causes your effects device to distort.
• From the File menu, choose New Auxiliary Inputs. This dialog appears:

  The New Auxiliary Inputs dialog

- In the dialog specify the number of auxiliary inputs that you wish to create and whether they should be mono or stereo. For our example, let’s imagine that we have one external reverb with stereo outputs. Thus, we will create one Auxiliary input with a stereo input. Click OK. (When you create a stereo Auxiliary Input, be sure to set the panning controls to full right and full left.)

- Click on the Input selector of the auxiliary track and set it to Inputs 7-8 (the stereo return from the effects device).

- Click on the Output selector of the auxiliary track and set it to outputs 1-2 (the main outputs to the mixer).

- Click the Transport’s Play button to begin playback.

- On the Auxiliary Input track, drag the track level slider up. This slider controls the level of the Auxiliary Input (the effect).

- As the track plays back, you should hear the effect now applied to it.

You have now set up an analog effects loop for monitor mixes.
Recording An Effect to Disk

(For Audiomedia III or DAE PowerMix-based systems, see the section entitled “Adding External Effects to Tracks in Audiomedia III and DAE PowerMix-based Pro Tools Systems”)

By using the effects loop setup described in the previous sections, it is possible to “print an effect to disk.” This expression refers to the technique of permanently adding an effect (such as reverb) to a track after the track has been recorded. This is done by routing the dry track through your effects loop and re-recording it to disk—with the effect added. This is an especially useful technique for creating polished submixes when you have a limited number of tracks and/or effects devices.

When you print an effect to disk, you can control the amount of the effect by varying the settings of the Sends on the original dry tracks, or by adjusting the wet/dry knob on the effects device itself. Pro Tools will mute playback of the Auxiliary Input track while you print an effect to disk.

To print an effect to disk:

- Follow the instructions in the previous section for setting up an analog effects loop.
- If your Audio Interface is connected to your studio/effects device as suggested in the previous section, make sure to set the Output Selector of the original “dry” track(s) to Outputs 1-2.
- From the File menu, choose the New Audio Tracks command to create a new audio track (or two if you are using a stereo effect return). You will be printing the effect to this track.
- Start playback to begin sending audio to the effects unit.
- On the original “dry” track, drag the Sends fader up to send audio to the effects device. You should be able to hear the effect.
- When you have the amount of effect you desire, stop playback.
- Click the Rec button on your new track(s) to record-enable it. You will be printing the effect here.
- Click the Input Selector pop-up on your new track(s) and select Inputs 7-8.
- Click the Record button on the Transport. When you are ready to begin, click Play. You are now recording the original track into a new disk file with the effect only on it.
When you have finished, click Stop on the Pro Tools Transport. Before you audition the new track with the printed effect, either mute, or turn the Send level all the way down on the original “dry” track. If you don’t do this, you will hear the original track still being routed through the effects device—in addition to the new track with the printed effect—essentially doubling the effect!

Adding External Effects to Tracks in Audiomedia III and DAE PowerMix-based Pro Tools Systems

Because Audiomedia III and DAE PowerMix/Power Macintosh-based Pro Tools systems do not utilize a Digidesign Audio Interface, these systems do not provide effects send and return capability. However, if you wish, you can still add effects to your mix using the technique outlined here.

This technique essentially involves soloing the desired track(s) that you wish to add an effect to, sending Pro Tools’ output to an external effects processor, and then “looping” the effected or “wet” signal back into Pro Tools and recording it. Once you have recorded the “wet” version of the track into Pro Tools, you can mix it with the unaffected, or “dry” version of the track and bounce them together to get the exact balance of wet/dry that you desire. By creating various submixes (vocals, drums, and so on), adding effects this way, and then bouncing down, you can piece together a full mix with all the effects that you desire—even if you own only a single effects device.

To add effects to a track:

• Connect your effects unit to your mixer. (Refer to the instructions included with your mixer.)

• Since you only want to add the effect to a specific track, Mute the other tracks in the session so that their output is not sent to the effects device when you begin playback.

• Set the gain faders on the source track high enough to send the proper amount of signal to your effects device. Be careful not to set your output gain so high that it causes your effects device to distort. (Sending as much signal as you can to the effects device will help improve your signal-to-noise ratio.)

• Adjust the wet/dry balance on your effects device and mixer so that the Pro Tools audio is 100% wet. (Later, in Pro Tools you can mix—or bounce—the original dry source track and the rerecorded wet track together to get precisely the balance of wet/dry you desire.)
• Record-enable a track for recording the effected part. If you wish to record a stereo effect such as a stereo reverb, stereo delay, or stereo chorus, record-enable two tracks so that you can record both the right and left channels of the effect.

• Set the gain faders to zero on the record-enabled tracks to prevent a feedback loop from occurring. (Unfortunately, this will prevent you from monitoring the track with the effect applied to it. This is OK, as long as you know that you are not causing distortion.)

• Press Command-Space bar to begin playback/recording.

• When you have finished, press the Space bar to stop recording.

• To listen to the result, turn off record-enable on the new “wet” tracks, unmute the other tracks in your session, and begin playback. As the session plays, adjust the level of your dry source tracks against the wet track to get the exact balance you desire.

• If you wish, once you’ve found the right balance of your dry source tracks against the wet tracks, you can bounce them together to free up additional tracks. Refer to the section entitled Bouncing Tracks later in this chapter for instructions on how to do this.

---

**Using Mix Automation**

In a basic recording environment, final mixdown is accomplished by playing back the multitrack source repeatedly. During each playback pass, you set levels and EQ, and practice moving the faders to fade the audio in and out, change levels, and change EQ settings. When you have practiced the mix enough to feel confident, you attempt to “perform” it as you record it to a mastering deck. This is an exacting process that is particularly difficult to perform live.

Pro Tools solves this problem by offering moving fader automation of track volume and panning. Pro Tools lets you automate all audio track playback levels and panning in real time, using the mouse or an external fader controller. This automation is recorded and played back exactly as you performed it. (Although MIDI controllers only have a resolution of 128 positions, Pro Tools interpolates these to a much higher resolution. The result is fader resolution that is smooth enough to satisfy professional requirements.)

Like audio and MIDI data, automation data can be recorded and edited using the same editing tools and techniques you have already learned. These tools allow you to build up a mix slowly and save it in stages. When it comes time to create a stereo master, you can be assured of having exactly the same mix every time.
Because Pro Tools treats Volume and Pan automation separately, they can be both recorded and edited separately. Thus, recording an automation pass in which you move only Pan sliders will not record over any Volume automation, or vice-versa. In addition, if you record volume automation for a track that has been grouped to other tracks, the automation will be recorded for all tracks in that group. However, this is not true for panning. Pan sliders are not affected by grouping.

To record fader automation on a track:

• Click the Auto button on the track that you wish to automate. The button turns red, indicating that the track is automation record-enabled.
• Click the Record button on the Transport. It begins to flash.
• When you are ready to begin, click Play or press the Space bar. Automation recording begins. Move the faders as you wish. When you have finished, click Stop or press the Space bar again.
• Click Return to Zero and then Play on the Transport to listen to the effects of your automation.
• If you like what you've recorded, make sure to save it by choosing the Save Session command in the File menu.
• Now you can follow the same procedure on another track to record more mix automation.

Recording automation is virtually identical to recording audio or MIDI. This means that you can use any of the recording techniques that you have learned, such as punch in/out recording. Automation data can be edited too, in much the same way audio and MIDI data are. However, to edit this data, you must first use the track's Data Display Format selector to view the track as a Volume Graph or a Pan Graph. For more information about editing automation data, refer to Chapter H.

On slower Macintosh computers, the Pro Tools faders may appear to jump from position to position and move in a “jerky” manner during automation playback and recording. This occurs because Pro Tools’ audio tasks take precedence over the screen display. Please be reassured that this type of response is not reflected in the audio, and does not affect mix automation. If you move a fader smoothly during automation recording, a smooth adjustment will be made to the audio—even if the fader appears to jump. If you feel that this phenomenon makes it difficult to record automation accurately, you may wish to try creating automation data manually using the tools in the Edit window. This will allow you to create extremely precise automation for your Session.
If you are using a Pro Tools Project system, you may experience small amounts of "zipper noise" when recording volume automation to an auxiliary track. This noise is never recorded to disk, but only occurs when you move auxiliary input faders rapidly during automation recording. During playback, however, "de-zippering is applied, so that the fader-moves sound flawless after you have recorded them.

**Turning Off Automation**

While you are working on your mix and setting up effects and EQs, you may not always want automation to be active. For this reason, Pro Tools allows you to turn off automation for all tracks in a Session at any time with the Ignore Automation command in the Options menu.

To turn off automation:

- From the Options menu, choose Ignore Automation. A check next to this item indicates that automation is turned off. Pro Tools disables automation until you turn it back on by choosing this command again.

**Using QuickPunch to Record Automation**

QuickPunch can be used very effectively to punch-record automation, as well. QuickPunching Automation doesn’t require that you hold voices in reserve. Only QuickPunching audio requires this.

Be aware of the following rules when using QuickPunch to Record automation:

- When you punch-in with QuickPunch, new automation data is only recorded from the moment that you begin moving faders or sliders. If you punch in and don’t move a fader or slider, the original automation data will remain undisturbed. The moment that you begin moving things, however, the new automation data will overwrite any previous automation. When you punch out, the track’s original automation (if any) goes into effect again.

- As with audio, you can record up to 100 running QuickPunches in a single pass.

To use QuickPunch to punch-record Automation:

- Enable QuickPunch by selecting it from the Options menu. A check mark appears next to QuickPunch when it is enabled, and the letter “P” appears on the Transport’s Record button.

- Record-enable automation on the track(s) you want to punch on.
• Prepare to record by cueing Pro Tools to an appropriate location, (enable a pre-roll value if you wish).

• Start playback by clicking the Play button on the Transport, or by pressing the Space bar. (You can also map a MIDI controller to the Play button to remotely control Pro Tools’ Transport buttons.

• At the punch-point, click the Transport Record button (or press Command-Space bar). The Record button will stop flashing and stay lit during recording. Remember, new automation data is only recorded from the moment that you begin moving faders or sliders. If you punch in and don’t move a fader, the original automation data will remain undisturbed.

• To punch-out, click the Record button or press Command-Space bar again. When you punch out, the track’s original automation (if any) goes into effect again. While Pro Tools is still playing back, you can perform additional punch-ins simply by clicking the Record button at each punch-in/out point (up to 100 running punches per take).

If you wish to automate Mutes, simply use a track’s Mute button during automation recording. Clicking the Mute button while doing an automation pass will record a value of zero for the automation while the Mute button is depressed.

---

**Bouncing Tracks**

By nature, multitrack recording imposes certain limitations on the producer. All tape recorders have a fixed number of simultaneous playback tracks, and at some point those tracks will be full. In traditional tape recording, one remedy for this problem has always been “bouncing” or mixing together existing tracks to open up more tracks for recording.

Like tape-based machines, Pro Tools offers you the ability to bounce tracks, but Pro Tools’ bounce function differs from tape in two significant ways. First, Pro Tools accomplishes all of its bouncing in the digital realm, introducing no noise or signal degradation. Second, Pro Tools can bounce all tracks down to two tracks, so you don’t need to keep destination tracks open for the bounce.

Because Pro Tools bounces tracks to hard disk, this means that unlike tape, you can repeatedly bounce without having to select “destination” tracks. It is almost like having an infinite number of tracks to bounce to. This is a particularly powerful feature because Pro Tools always retains the original audio that is on the source track. So you
never run the risk of erasing old audio with new audio! The new audio is simply written to a new disk file. And by making good use of virtual tracks, you will be able to combine parts from many tracks together.

Here are some rules to remember when bouncing to disk with Pro Tools:

- With Pro Tools, “What you hear is what you get,” literally. Pro Tools bounces all audible tracks. When you play back your Session, all tracks that are heard are included in the bounce. Any tracks that are muted will not appear in the bounce.

- When you bounce tracks, the relative levels of the resultant track are set according to the levels of the mix at bounce time. Equalization is applied permanently to each track during the bounce, so make sure that you set levels carefully before bouncing tracks. Before you perform the bounce, you should play back the Session in its entirety. Listen and make sure that everything sounds as it should, with all desired EQs and automation.

- If you select a portion of any track (or tracks) in the Edit window, Pro Tools will bounce only the selected material—not the entire session. If there is no selection in any track, Pro Tools will bounce all audible tracks in the Session.

Pro Tools allows you to save a bounce as one of these three file types:

- **A Mono file.** Choose this option to create a single audio file. A monophonic mix of all audible tracks in the Session will be bounced to this destination audio file. In this case, all stereo image information (panning) will be disregarded.

- **A Split Stereo file.** Choose this option to create two separate audio files that retain the original stereo image. A Split Stereo bounce creates two mono audio files that have “.L” and “.R” appended to the chosen name (for left and right, respectively). This file type is recommended if you wish to preserve the stereo image of bounced material and want to be able to immediately use it in your Pro Tools Session without “importing” it. Since Pro Tools does not directly import stereo interleaved files (it has to split them) this option is better suited to using such bounced stereo material in your Sessions.

- **A Stereo file.** Choose this option to create a single interleaved stereo file. This is recommended if you plan to use the file in another application such as Digidesign’s Sound Designer II, which supports an interleaved stereo file format. We recommend that you also choose this file type when you create a final stereo master mix of your Session to disk.
NOTE: In a “split stereo” or “interleaved stereo” bounce, tracks assigned to outputs 1, 3, 5, or 7 will be sent to the left channel, and tracks assigned to outputs 2, 4, 6, or 8 will be sent to the right channel.

To bounce all currently audible tracks:

• Adjust track output levels and finalize an automated mix. Any EQs settings that are active on your tracks will be permanently written to the bounced track. If you don’t wish to apply EQ to the bounce, click the EQ’s Bypass button.

• Make sure that all of the tracks you wish to include in the bounce are audible (not muted).

• From the File menu, choose Bounce to Disk. This dialog appears:

The Bounce to Disk dialog

• Choose the appropriate file type: mono, split stereo, or stereo. If necessary, click the Scaling box to prevent the possibility of clipping as the track outputs are mixed during the bounce.

• Click Bounce. A dialog appears prompting you to name the new audio file.
The Save Bounce As dialog

- Select a destination for the new audio file, enter a name, and click Save.

On the Pro Tools systems covered by this User’s Guide, bounces are not made in real time, so you will not hear any audio during the bounce process. After Pro Tools has finished writing the new audio file to disk, you can use the Import Audio command to import and use the bounced track(s) in your Session.

Remember, your original source files have not been rewritten or erased. Pro Tools has merely created a new audio file that is a combination of the original source tracks. The original source files are still safely in your Session and on your hard disk.

Bouncing is also a very useful technique for creating a contiguous sound file from a track (or tracks) that was originally composed of many smaller Regions. This allows you to create a new sound file with all of your edits made permanent.

Bouncing is not only useful for combining “submixes” in Pro Tools. It is also the process you will use to create a stereo master mixdown file. In this case, you will use the Bounce to Disk command to create a stereo (not a split stereo) file, which you can edit and play back in other environments (such as Digidesign’s MasterList CD pre-mastering utility), and use to create DAT masters for CD duplication.
Final Stereo Mixdown

The last step in a recording project is generally the mastering process. During mastering, a final stereo mixdown of the recording is created. This stereo version is the "master", from which all distributed copies will be made. For this reason, the master must be of the highest quality.

Once your final mix is automated to your satisfaction, you will use Pro Tools to create a stereo Sound Designer II audio file on your hard disk. This audio file will be an exact digital copy of the mixdown from which it is created, including EQ and automation.

Remember, however, that there are some planning steps you will need to take before creating a digital master. If your Session plays back MIDI tracks as part of its audio material, the MIDI tracks will obviously not be included in a digital master until they have been recorded as audio on hard disk.

The easiest way to do this is a two step process: Mix your MIDI file into a stereo image at your mixing board, and record it in stereo on two Pro Tools tracks. Then, when all of your Pro Tools audio tracks are automated and ready for mastering, use the Bounce to Disk command to bounce them to a final stereo image. You now have your original audio and MIDI tracks in stereo audio form. Add any extra mixer automation you might need, and you’re ready for mastering.

To create a digital hard disk master of a Session:

- Open the Session you wish to master. Make sure that it plays back exactly as you wish the master to sound, because the master will be an exact copy of the Session as you hear it.
- Choose the Bounce to Disk command from the File menu. This dialog appears:
The Bounce to Disk dialog

- For mastering with Digidesign’s Sound Designer II or MasterList CD, choose stereo interleaved as the file type. If necessary, click the Scaling box to prevent the possibility of clipping as the track outputs are mixed during the bounce. If you want to use bounced tracks in a Pro Tools Session, choose split stereo, since Pro Tools does not currently support the interleaved stereo file format.

- Click Bounce. A dialog appears prompting you to name the new audio file.

The Save Bounce As dialog

- Select a destination for the new audio file, enter a name and click Save.
The mastering process does not take place in real time, so it may take a minute or two. When Pro Tools has finished writing the new master mix, you will find a Sound Designer II format audio file in the destination folder that you selected.

Once you have created a digital master of your Session, you are free to transfer it to a portable medium for duplication. You may wish to transfer the stereo master file to DAT to be used as a master for pressing CDs or albums. This is the highest-fidelity method for duplication because there are no analog steps after the original tracks are recorded. Remember, however, that it is better to master directly to hard disk and then transfer to DAT than to master directly to DAT. Your hard disk doesn't use error correction schemes to cope with bad data. It maintains a digital copy that is perfect, because every bit value is maintained. DAT recorders, and any other medium that uses error correction, do not offer perfect maintenance of your data, although they're generally quite good. The golden rule is that hard drives are better than error-corrected tape for data integrity.

If you are serious about doing your own digital mastering, you may wish to invest in a CD writer and MasterList CD, Digidesign’s CD mastering application which will allow you to write your own master/reference CDs or 8mm DDP tapes.

Mastering to a Digital Recorder

Although it is a better idea to master your Sessions directly to your hard disk for the reasons above, Pro Tools also allows you to master the current Session digitally, direct to any AES/EBU or S/PDIF-equipped digital recorder such as a DAT deck. To do so, follow these steps.

To configure Pro Tools for direct digital stereo mastering:

• Make sure that your digital recorder is connected to the Audio Interface’s digital outputs.

• On your digital recorder, choose the appropriate digital format (AES/EBU or S/PDIF). AES/EBU is the professional standard digital format that uses the balanced, XLR digital outputs on the back of your audio interface. S/PDIF is the consumer standard digital format that uses the RCA outputs on the back of your audio interface.

• In the Mix window, set all audio tracks to pan between outputs 1-2.

• Make sure that your Session is set to its beginning.
• Press Record on your DAT recorder to begin recording.
• Start playback of your Pro Tools Session.

When your Session has finished playing, stop your digital recorder. You now have a digital master of your Session.

As you know, Pro Tools' digital output is always turned on (digital input is not). This means that you always have digital outputs 1 and 2 running, even when analog outputs 1 and 2 are in use. (The current digital format is always indicated on the front of the Audio Interface). The fact that digital output is always available can be very useful, since it allows you, for example, to mix to analog and digital masters simultaneously.

Some Things to be Aware of When Mastering Digitally

Although digital audio is more robust than analog audio in many ways, there are a couple of things which you should always bear in mind when you are embarking on a project:

Using Audio Compression
Although audio compression is often an indispensable tool in the analog recording world, its use can present problems in the digital domain. If you compress an input signal at a very high ratio, you will create a signal that contains a much higher overall power level compared to its transients. By recording a number of such signals as hot as possible on multiple tracks, you create a scenario that is more likely to clip the mixed output signal. This can occur because these high-power compressed signals, when mixed together, create an extremely high-level output. This output often may dip above the 100% amplitude (or "full-code") level, resulting in clipping. To remedy this potential problem, closely watch the overall level of your program material—use your mastering deck’s meters to help avoid clipping. If you are bouncing to disk, avoid mixing full-scale audio signals together at "0" level, as this will invariably cause clipping.

Mastering to Error-correcting Media
When you are mastering digital audio, you should always remember that there is a difference between the different mastering media. True random-access media (such as hard disks, erasable optical cartridges, Bernoulli cartridges, WORM drives etc.) guarantee you better data integrity than most sequential digital media (audio DAT recorders, for example). Most sequential digital media use error correction schemes to fix the occasional chunk of bad data that is received. These "corrections" represent deviations from
the actual data that should be recorded, and the more often you transfer between error-correcting devices, the more likely it is that these deviations will accumulate. Although these deviations manifest themselves in an extremely subtle (often inaudible) fashion, you must still think of them as potential “digital generation loss” artifacts. You can avoid these potential problems by mastering to random-access media only and maintaining random-access masters.

This concludes the mixing portion of your Pro Tools User's Guide. The next chapter, Pro Tools Menus, is the final chapter of your User's Guide. It explains, in sequence, all commands found in Pro Tools' menus.
Chapter H
Pro Tools Menus
Introduction

This chapter explains, in sequence, all of the commands found in Pro Tools’ six menus: File, Edit, Options, Setups, Display, and Region List. Brief descriptions are given of each command and its use. If you want to know how to perform a specific task, consult the index in the back of this manual and refer to the appropriate chapter for more detailed instructions.

The File Menu

File

- New Session...  
- Open Session...  
- Close Session  
- Save Session  
- Save Session As...  
- Save Session Copy In...  
- Rewind to Saved...  
- Bounce to Disk...  
- New Audio Tracks...  
- New Auxiliary Inputs...  
- New Master Faders...  
- New MIDI Tracks...  
- Import Audio...  
- Import MIDI...  
- Import Movie...  
- Export MIDI...  
- Group Tracks  
- Delete Tracks  
- Get Info...  
- Launch NyxVerb™...  
- Quit
The Pro Tools File menu contains all of the commands used to create and maintain your audio files. Here are brief explanations of each.

**New Session**

The New Session command creates a new Pro Tools Session. When you select the New Session command, a dialog box appears prompting you to give the new Session a name. When you name the Session, Pro Tools creates a folder of the same name. Within this folder is the Session file itself, and two other folders: an Audio Files folder, and a Fade Files folder. The Audio Files folder contains all audio recorded during the Session. The Fade Files folder contains any crossfaded audio data generated by the Session. When you record a new audio track, the track is saved as a new audio file and automatically placed in the Audio Files folder. At any time in a Session, you also have the ability to import existing Sound Designer II or AIFF audio files into the Session, and work with them as well.
**Open Session**

The Open Session command lets you open a Pro Tools Session previously created with Pro Tools. When you select the Open Session command, a file dialog appears from which you will navigate to and open the desired Session. All files (audio, MIDI, etc.) associated with the Session will load. Only one Session at a time can be open.

![The Open Session dialog](image)

**Close Session**

The Close Session command closes the current Session without quitting Pro Tools. Before closing the Session, Pro Tools will ask you if you want to save any changes that have not been saved.

![The Close Session dialog](image)

**Save Session**

The Save Session command saves the changes you have made since the last time you saved and writes the Session in its current form over the old version. You cannot undo the Save Session command.
The Save Session dialog

**Save Session As...**
Pro Tools' Save Session As command is useful for saving a copy of the current Session under a different name, or in a different hard disk location. Because the Save Session As command closes the current Session and lets you keep working on the renamed copy, it is particularly useful if you are experimenting and want to save successive stages of the Session. This way, you can save each major step under a different name such as “FX Session1.0,” “FX Session 1.1,” etc. By working this way, you'll always have the option of retracing your steps should you want to go back to an earlier version.

The Save Session As dialog

**Save Session Copy In...**
Use the Pro Tools Save Session Copy In command to save a copy of the current Session under a different name or a different hard disk location. Unlike the Save Session As command, Save Session Copy in does not close the original Session, so subsequent edits are made to the original Session. Having the backup copy gives you the option of reverting to the earlier version.
The Save Session Copy In dialog

**Revert To Saved**

Use the Revert to Saved command to restore the most recently saved version of your Session, discarding all changes made since the last time you saved the Session. Reverting to the last saved version of your Session is like closing the Session without saving changes and then reopening it. Before reverting to the last saved version of the Session, Pro Tools will ask you if you wish to discard any changes made since you last saved.

**Bounce to Disk**

The Bounce to Disk command allows you to mix together the outputs of all currently audible tracks in your Session to create a new audio file. The new “bounced” audio file can then be imported into the Session with the Import Audio command and used. When you save a bounce you can save it as one of three file types: a Mono file, a Split Stereo file, or an interleaved Stereo file. With this function, "what you hear is what you get." In other words, when you play back your Session, all tracks that are heard are included in the bounce. Any tracks that are muted will not appear in the bounce. Pro Tools will bounce all audible tracks for the length of the selection. If there is no selection in any track, Pro Tools will bounce the tracks for the length of the longest audible track in the Session. This dialog also gives you the option of “scaling” the audio material included in the bounce to help prevent clipping. Choose No Scaling if you wish to disable scaling. Choose Average Case Scaling to prevent most problems. Choose Worst Case Scaling if your tracks were recorded very “hot” and there is a possibility that all audio tracks reach their peak amplitude at the same time.
The Bounce to disk dialog

New Audio Tracks
The New Audio Tracks command allows you to add one or more new empty audio tracks to your Session. A maximum of 64 audio tracks can be added to a Session. You may however, choose to “hide” some of them with the Show/Hide Tracks command in the Display menu in order to reduce window clutter.

New Auxiliary Inputs
The New Auxiliary Inputs command allows you to add one or more Auxiliary Inputs to your Session. (Auxiliary Inputs are only available on Pro Tools Project systems—not DAE PowerMix or Audiomedia III-based Pro Tools systems.) Auxiliary inputs can be used as effects returns or as additional on-screen inputs for live mixing of instruments connected to the Audio Interface. This dialog allows you to create either mono, or stereo inputs, depending on whether the device you have connected has mono or stereo outputs.
New Master Faders
This command is only available with TDM-equipped Pro Tools systems. Please refer to your TDM User's Guide.

New MIDI Tracks
The New MIDI Tracks command allows you to add one or more new empty MIDI tracks to your Session. Once a new MIDI track has been added, you can place a MIDI Region (or Regions) into it. A maximum of 64 MIDI tracks can be added to a Session. You may however, choose to “hide” some of them with the Show/Hide Tracks command in the Display menu in order to reduce screen clutter.

Import Audio
The Import Audio command allows you to load one or more audio files or Regions into a Session. Each audio file or Region that you import is then automatically placed into a new a track for you. When you choose this command, a File dialog appears allowing you to navigate to the desired audio file. When you’ve found the file, click on it and any Regions associated with it will appear in the items in current file list inside of the dialog. When you double-click on an audio file or Region, it is added to the items currently chosen at the right. When you have finished choosing all of the files you wish to import, click Done and Pro Tools will find and import all of these audio files into new tracks for you.

This command allows you to import monophonic Sound Designer II format files, original Sound Designer format files, interleaved stereo sound files, or Audio Interchange format [AIFF] files). Because Pro Tools doesn’t currently support the interleaved stereo file format, importing stereo sound files requires both time and hard disk space because an interleaved stereo file must be converted into two mono audio files. Each channel is then loaded into its own audio track.
The Play button at the bottom of this dialog allows you to audition a Region before you load it into a Session.

The Import Audio dialog

**Import MIDI**

The Import MIDI command loads all tracks in a Standard MIDI file into Pro Tools and automatically places them in new MIDI tracks. If you merely want to add additional MIDI Regions to your Session without automatically placing them in tracks, select the Import MIDI command in the Region List menu. As part of the MIDI file, the Import MIDI command also allows you to import the Tempo data in the sequence or apply any existing tempo data in the Session to the imported file. Tempo data supplies the information necessary to create a Bars & Beats Time Scale, which is necessary to be able to use commands such as MIDI Quantize. In addition, this command gives you the option of keeping or discarding any MIDI tracks and Regions currently in the Session.

When a Pro Tools MIDI track’s Channel selector is set to “Channel -” all Regions on the track will automatically play on the MIDI channel it was assigned to in the original sequence. Setting the MIDI Channel Selector of a track to a specific MIDI channel, on the other hand, will “re-channelize” all Regions on that track to play back on the selected MIDI channel.
The Import MIDI dialog

The Import MIDI dialog also allows you to remove all MIDI data currently in a Session

**Export MIDI...**

This command allows you to export all currently audible MIDI tracks in your Session as a standard MIDI file. If any tracks are muted, they will not be exported. You can choose to export the file as a Type 1 (multi-channel) or Type 0 (merged) Standard MIDI file.
Group/Ungroup Tracks
The Group Tracks command allows you to select two or more Pro Tools tracks (by Shift-clicking their Track Names) and group them, so that all subsequent editing and Region manipulation is performed on all tracks included in the group. To ungroup tracks, click the Track Name of any track in the group and select Ungroup Tracks. All tracks will then be ungrouped.

Delete Tracks
This command will remove a Pro Tools audio or MIDI track from the current Session. To delete a track, click on the name of the track to select it, and select Delete Track. Pro Tools will prompt you with a dialog alerting you that the chosen track(s) will be “deleted from the Session.” This means that the track will no longer appear in the Session. No sound files will be deleted. However, the arrangement of your Regions on the track (the Playlist) will be lost.

Get Info
This command allows you to save text information about a specific Session with the Session file itself. To enter descriptive information about a Session, click the cursor in the desired text field and type the information that you wish. The left text field in each of the five rows is the topic field. The text that you enter here is saved with your Pro Tools Preferences and will appear in all Sessions. This allows you to “preset” the field to topics that you commonly use. The right text field in each of the five rows is the information field. The text that you enter here is Session-specific.
Quit
The Quit command ends your Pro Tools Session and returns you to the Finder. Although Pro Tools will warn you before allowing you to quit without saving changes, it is still a good idea to save your work before quitting.
The Edit Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>KG</td>
</tr>
<tr>
<td>Cut</td>
<td>KB</td>
</tr>
<tr>
<td>Copy</td>
<td>KW</td>
</tr>
<tr>
<td>Paste</td>
<td>KB</td>
</tr>
<tr>
<td>Clear</td>
<td>KB</td>
</tr>
<tr>
<td>Duplicate</td>
<td>KB</td>
</tr>
<tr>
<td>Copy Effect Parameters</td>
<td>KE</td>
</tr>
<tr>
<td>Paste Effect Parameters</td>
<td>KE</td>
</tr>
<tr>
<td>Select All</td>
<td>KA</td>
</tr>
<tr>
<td>Capture Region</td>
<td>KB</td>
</tr>
<tr>
<td>Separate Region</td>
<td>KC</td>
</tr>
<tr>
<td>Trim Region</td>
<td>KE</td>
</tr>
<tr>
<td>Heal Separation</td>
<td>KH</td>
</tr>
<tr>
<td>Mute/Unmute Region</td>
<td>KM</td>
</tr>
<tr>
<td>Lock/Unlock Region</td>
<td>KL</td>
</tr>
<tr>
<td>Remove Sync Point</td>
<td>KI</td>
</tr>
<tr>
<td>Identify Start</td>
<td>KI</td>
</tr>
<tr>
<td>Identify Silence</td>
<td>KI</td>
</tr>
<tr>
<td>Strip Silence</td>
<td>KB</td>
</tr>
<tr>
<td>Fades...</td>
<td>KE</td>
</tr>
<tr>
<td>MIDI Quantize</td>
<td>KE</td>
</tr>
<tr>
<td>MIDI Transpose</td>
<td>KV</td>
</tr>
</tbody>
</table>

The Edit menu contains all of Apple's standard edit commands, as well as several Region editing commands. As you remember, Pro Tools performs non-destructive editing, meaning that the commands in this menu won't actually alter your source files, just their "playback map."

Before you use any of these commands, you should be aware of these rules:

1. In order to use the Cut, Copy, Paste, Clear, or Duplicate commands, you must first select data within a track. There are two types of selections upon which Edit commands can be performed:
   a) Contiguous data within a Region (selected with the Selector)
   b) Whole Regions (selected with the Grabber)

Either of these types of selections can occur across multiple tracks.
2. If you attempt to perform an Edit menu command on data within a Region (not a complete Region), Pro Tools will ask you to name the selection and add it to the Audio Regions List as a new Region.

3. You should always be aware of which mode you are in (Slip, Shuffle, Spot or Grid) before you use an Edit menu command, as it will affect the edit. Using the Cut command in Slip mode, for example, will leave a “hole” in a track. Using the same command in Shuffle mode will leave no hole, since the Regions on either side of the cut will snap together, closing the gap.

Here are brief explanations of each command in the Edit menu:

**Undo**
The Undo command is a very useful tool and something of a “safety valve.” It keeps track of your last action and allows you to undo that action if you don’t like the outcome. After you undo something, you can “redo” it by choosing the command again. This is a good way to compare before and after states of most edits. But be aware that the Undo command only keeps track of your last action, so use it with care—edits more than one mouse click back cannot be undone.

**Cut**
With the Cut command you can “cut” a selected range or entire Region out of its current position. The Macintosh holds it on the Clipboard (the Mac’s internal memory) in case you want to paste it elsewhere. Of course, since Pro Tools is non-destructive, you aren’t actually cutting data from the original file, but the effect is the same. In Shuffle mode, when a selection is cut, the entire area to the right of the cut slides over so that no gap remains. In Slip mode, a gap remains where the data was.

**Copy**
The Copy command is much like the Cut command, but instead of removing the selected range, it leaves the original, and places a copy of it in the Macintosh’s Clipboard so that you can paste it elsewhere.

**Paste**
With the Paste command, you can insert the contents of the Clipboard into a location that you have chosen with the Selector. It is only possible to paste data after it has been cut or copied to the Clipboard.

**Clear**
The Clear command allows you to remove a selected Region or a selected range within a Region. In Shuffle mode, when a range is cleared, the entire area to the right of the selection slides over so that no gap remains. In Slip mode, a gap remains where the data was.
**Duplicate**
The Duplicate command copies a selection and places it immediately after the end of the selection in a track. It provides you with a very handy way of repeating a Region (to create a drum “loop”, a repeating bass figure, etc.,) and is faster and more convenient than copying and pasting data to achieve the same result—particularly if you want to duplicate data on multiple tracks. Use one of the Shift-click techniques explained in this manual to select data on multiple tracks.

**Copy Effects Parameters**
The Copy Effects Parameters command allows you to copy the current settings of the Inserts/Sends Editor. You can then apply these settings to a different track by calling up the track in the Inserts/Sends Editor and pasting them with the Paste Effects Parameters command. This saves you the time and trouble of adjusting the parameters manually.

**Paste Effects Parameters**
The Paste Effects Parameters command allows you to paste effects parameters copied in the Inserts/Sends Editor with the Copy Effects Parameters command.

**Select All**
As its name suggests, the Select All command simply selects all Audio and MIDI data in one track, multiple tracks, or all tracks. The range of selection is variable as explained below.

To select all Regions in a single track, select a portion of the track, or place the Selector’s I-beam anywhere in the track and choose Select All from the Edit menu. To select all Regions on multiple tracks, Shift-click a Region on each track with the Grabber and choose Select All. To select all Regions on all tracks, hold down the Option and Shift keys and click the mouse on any track, then choose Select All.

**Capture Region**
The Capture Region command defines a selection as a new Region and adds it to the Regions List. From there the new Region can be dragged into a track. You cannot capture selections across multiple Regions unless the data happens to be contiguous data from the same file. For example, Pro Tools won’t let you select and capture a drum Region and a guitar Region that happen to be sitting next to each other on the same track.
Naming a new Region

**Separate Region**
The Separate Region command defines a selection as a new Region, and in the process, separates it from adjacent data in the track where it was created. By separating a Region you will also create “by-product” Regions from data on either side of the separation that have new “edit-take” numbers assigned to their names. These Regions also appear in the Regions List. If you wish, you can have Pro Tools automatically name separated Regions for you with the Auto-Name Separated Regions option in the Preferences dialog. With this option turned on, when you separate a Region, Pro Tools will automatically name the separated Region(s) for you. The name will be a numbered variation of the Region’s name.

Naming a separated Region

**Trim Region**
The Trim Region command removes audio before and after a selected waveform range—leaving only the selection. This command provides a handy means of quickly removing all data in a track but the currently selected Region. To trim unwanted data from a sound file, select a waveform range in a track and choose Trim Region from the Edit menu. All data but the selected area will be removed from the track.

**Heal Separation**
The Heal Separation command gives you a way to repair separated Regions—providing that the Regions are contiguous and their relative start and end points haven’t changed since the separation. Because there is no way to heal two Regions whose data is not contiguous, if you have trimmed or otherwise changed the start and end points of the two Regions, or moved them away from each other, you won’t be able to repair them with
the Heal Separation command. Likewise, it is impossible to heal two Regions created from different files. To use this command, use the Selector to make a selection that crosses the border (the separation point) between the two Regions. Select the Heal Separation command and the two Regions will become one.

**Mute/Unmute Region**
Choosing the Mute/Unmute Region command mutes playback of a selected Region. Choosing the command a second time unmutes the Region. Tracks which are muted appear “grayed-out” to indicate their status. If you enable the Mute Frees Voice command in the Options menu, a track that is muted will allocate its voice to the next highest priority track assigned to the same voice.

**Lock/Unlock Region**
This command allows you to select a Region and lock it in place so it cannot be moved (unless you unlock it). This command is very useful in cases where you have a Region (or Regions) that you want to permanently associate with a particular location in a track—a beat, SMPTE frame, or a time value. A small lock appears in a Region to indicate that it has been locked. If you attempt to perform edits that move a locked Region, Pro Tools will alert you with a dialog.

![A locked Region](image)

**Identify/Remove Sync Point**
This command allows you to identify a specific point within a Region and spot that point to a SMPTE frame location. This is done by clicking the Selector once inside the Region and choosing this command. A small triangle appears in a Region to indicate the Sync Point. When you choose this command, the current SMPTE time is automatically entered as the SMPTE location for the Sync Point.

**Identify Beat**
This command allows you to identify and mark where beats fall in a track. If your Session doesn’t already have Tempo data (derived from MIDI data in the Session) the Identify Beat command will create Tempo data. Pro Tools needs this Tempo data in order to display time in Bar & Beats and to enable commands such as MIDI Quantize.
Pro Tools supports changes in meter, too. If you wish to mark a meter change, create a new beat marker or double-click an existing one and type in the new meter value. Pro Tools will recalculate all subsequent bars at the new meter.

The Identify Beat dialog

**Identify Silence**

This command simplifies the use of the Strip Silence command by allowing you to select a segment of silence in a Region and use its parameters as the threshold below which silence will be removed by Strip Silence.

The Identify Silence dialog

**Strip Silence**

The Strip Silence command examines a selected audio Region in a track and removes any areas of silence (sections where the amplitude level falls below a fixed level for a user-selectable period of time). The Strip Silence command does this by dividing the selected Region into smaller Regions and removing the silent Regions from the Session. All new Regions will appear in the in the Audio Regions List except for the “stripped out” silent ones.

Note that the Strip Silence command can only be performed on entire Regions, not a selection within a Region. This command is non-destructive and does not actually remove any audio data from the original audio file. If necessary, the Heal Separation command can be used to mend undesirable stripped gaps.
The Strip Silence dialog

Fades...
The Fades command creates a user-definable crossfade between two adjacent audio (but not MIDI) Regions or a fade in/out of a single Region. Crossfade duration, position, and shape are all user-selectable. This command is useful in smoothing transitions between Regions that would otherwise be abrupt. There are seven different Fade Out and Fade In curves to choose from when creating a crossfade.

Pro Tools now allows you to conveniently create crossfades in “batch mode.” By selecting across several Regions, and choosing the Fades command, you can create crossfades for each of the Regions transitions at once. This feature can be a real time saver in a Session that requires many crossfades. If your selection includes Regions that already have crossfades, this feature allows you to modify them, too, if you wish. For precise details on how to create a crossfade and the effects of each crossfade curve, refer to Chapter E.
The Fades dialog’s appearance when you create multiple crossfades.

**Quantize Region**

Pro Tools’ Quantize Region command allows you to adjust the placement of a selected audio or MIDI Region in a track so that its start point (or Sync Point, if it contains one) precisely aligns to the quantization value currently chosen in the Nudge/Grid pop-up menu.

**MIDI Quantize**

The MIDI Quantize command provides a quantization function similar to that found on most popular MIDI sequencers. Here, the Note On portion of selected MIDI events can be adjusted to fall precisely on a user-selectable quantization value, ranging from quarter notes to 64th notes, or triplet values of any of them. Quantization values are chosen with the Nudge/Grid pop-up menu in Edit window. It is imperative when selecting MIDI data that you include the Note On portion of the event in your selection. Otherwise, the event will not be quantized.
**MIDI Transpose**
The MIDI Transpose command allows you to transpose MIDI data up or down the musical scale by a specific number of semitones (half steps). With this feature you can easily add MIDI-based key changes and other transposition effects to your MIDI tracks. Typing a minus sign (-) in front of a value will transpose your Region downwards by that value.

```
Transpose selection:
0 semitones
```

The MIDI Transpose dialog

---

**The Options Menu**

<table>
<thead>
<tr>
<th>Options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Destructive Record</td>
<td></td>
</tr>
<tr>
<td>QuickPunch</td>
<td></td>
</tr>
<tr>
<td>Auto Input Monitor</td>
<td>Input Only Monitor</td>
</tr>
<tr>
<td>Online</td>
<td></td>
</tr>
<tr>
<td>Pre/Post-Roll Playback</td>
<td>Loop Selection</td>
</tr>
<tr>
<td>Mute Special Voice</td>
<td>Ignore Automation</td>
</tr>
<tr>
<td>Auto-Spot Regions</td>
<td>MIDI Thru</td>
</tr>
<tr>
<td></td>
<td>Active In Background</td>
</tr>
</tbody>
</table>

This menu contains commands for several Pro Tools' functions that can be toggled on or off.

**Destructive Record**
Choosing this command enables Pro Tools' destructive record mode. In this mode, new audio recorded into a Region records over and erases any previously recorded audio at that location in the Region. If you have sufficient hard disk space, you may wish to use
Pro Tools mainly in non-destructive recording mode. In this mode, if you record over a Region, the original Region is simply “unloaded” from the track, and a new audio file is created and placed into the track in its place. The new audio and old audio both remain on your hard drive. Pro Tools will give the new audio file the name of your track and add a number to it (a higher number for each subsequent take you perform on that same track).

**QuickPunch**
*(Pro Tools Project systems only)*
QuickPunch gives you the ability to instantaneously punch-in (initiate recording) on a record-enabled audio track during playback and then punch-out (exit recording) simply by clicking the Transport’s Record button.

This capability can be toggled on and off with the QuickPunch command in the Options menu. Once QuickPunch is enabled, simply record-enable the desired track, begin playback, and then use the Record button on the Transport to punch in and out. QuickPunch can also be conveniently triggered remotely with a MIDI controller. When you use QuickPunch, newly-recorded material is recorded into a new audio file. Within this file, Regions (and surrounding Regions) are auto-named or renamed with appending take numbers. Up to 100 “running punches” can be performed during a single pass. Each punch will be recorded into the same new sound file with each in/out point automatically defining a Region within the sound file. All QuickPunch recording is non-destructive. Whenever QuickPunch is enabled, Destructive Recording is disabled. When QuickPunch is not enabled, Pro Tools’ standard auto-punch is available for punching in at selection in/out points.

**Online**
This command puts Pro Tools on-line so that playback or recording can be triggered by an external source. In this state, Pro Tools waits for a specific SMPTE frame number, and when it sees that frame number, it will begin audio and MIDI playback. There are several ways to put Pro Tools on-line: with the Transport’s Online button, with the Option menu’s Online command, by pressing Command-J, or by pressing Option-Spacebar. Each of these methods has the same effect.

**Pre/Post Roll Playback**
Choosing this option allows you to audition a selected Region plus the amount of pre/post roll specified in the Pre/Post-Roll dialog each time you initiate playback.

**Loop Selection**
Pro Tools gives you the option of being able to continuously loop playback of a selection with the Loop Selection command. This option will make your selection play in loop fashion until you stop playback. This “auto loop” feature is especially useful in
cases where you need to test the rhythmic integrity of your selection before defining that selection as a Region. If your selection seems to maintain a consistent rhythm as it loops, it is “musical.” That is, it will probably work rhythmically when placed next to other Regions. If the selection seems to skip as the loop repeats, you may wish to adjust your selection. Selections must be a minimum 500 milliseconds in length in order to loop playback.

Mute Frees Voice
When this option is enabled, an audio track that is muted will allocate its voice to the next highest priority track assigned to the same voice.

Ignore Automation
When this option is enabled, pan and volume automation is turned off for all Pro Tools tracks in a Session. To turn automation back on, choose this command a second time.

Auto-Spot Regions
This command simplifies the task of spotting Regions. If you are in Spot mode and using VITC with this option enabled, you can pause your video deck on an appropriate SMPTE frame location, drag a Region from the Region’s List into the Edit window (or click on a Region already in a track with the Grabber), and the Region will be automatically spotted to the current time code location.

MIDI Thru
When this option is enabled, Pro Tools allows you to play a MIDI controller and have any MIDI devices connected to your system respond to it even if Pro Tools MIDI playback is not engaged. A MIDI track must be record-enabled, however, for MIDI devices to respond.

Active in Background
This command allows Pro Tools to operate in the background with another application. This allows you to integrate products such as MIDI sequencing programs with Pro Tools.

To use a MIDI sequencer with Pro Tools, you must install the OMSIAC driver (included with Pro Tools) in your OMS folder. For detailed instructions on how to use this feature, refer to Chapter F, Working with SMPTE.
The Setups Menu

This menu allows you to configure the various hardware and software parameters of your Pro Tools system.

**Pre/Post-Roll**
By selecting the Pre/Post-Roll command and entering a specific amount of Pre- and Post Roll time, you can adjust playback of a selection to begin before and last until after your selection by a chosen amount. With this feature you can audition a selection and the data just before and after it to hear it in context.

The Pre/Post-Roll Setup dialog

**Playback Engine**
This command allows you to close the current Session and reconfigure Pro Tools to use another Digidesign DSP card or the built-in recording and playback capabilities of a Power Macintosh. (To use a Power Mac’s built-in recording and playback capabilities to run Pro Tools you must use the DAE PowerMix extension.) If you are using a Power
Macintosh and the DAE PowerMix extension to run Pro Tools, this dialog allows you to increase or decrease the number of tracks in your Session. To choose the number of tracks that are available on a Power Macintosh, click the # Playback Tracks pop-up menu and choose the desired number of tracks. The maximum number of tracks that are available depends on your Power Mac’s processor speed. Slower Power Macintoshes will not be able to run a 16-track Session.

The Playback Engine dialog

**Hardware**

This dialog allows you to specify the various parameters of the Pro Tools hardware such as sample rate, digital format, channel 1-2 input format, and others. Pro Tools Sessions can be either 48 kHz or 44.1 kHz. Though audio files of different sample rates can be used in the same Session, we strongly recommend against doing this. If you have audio files recorded at sample rates other than these, or wish to use audio files sampled at different rates together in the same Session, you will have to use Sound Designer II (available separately) to convert them to one of the supported sample rates.

The Hardware Setup dialog
Disk Allocation
If you are using multiple hard drives for recording with your Pro Tools system, this command allows you to choose a specific drive for each track in a Session. From this point forward, when you record tracks, the tracks will be routed to the selected drive. If you have chosen the Use round robin allocation for new tracks option, when you create a new track, each subsequent track will be recorded on the next available hard drive. A folder with the Session name is created on each hard drive, and these folders will contain the audio files.

The Disk Allocation dialog

Serial Ports
The Serial Ports command allows you to specify which Macintosh serial ports (modem or printer) are enabled for MIDI communications with a MIDI interface. If you have a MIDI device connected to your computer, you must enable the serial port to which it is connected or Pro Tools will not recognize it. Pro Tools supports OMS (the Open Music System). This software facilitates communication between MIDI software and the Macintosh. If you want to use a dedicated sequencer with Pro Tools you may need to use OMS. Vision, Cubase and Logic sequencing software support OMS. Please be aware that some sequencers do not support OMS. To find out if your sequencer is compatible with OMS, consult its user’s manual. Depending on whether or not you are using OMS, the appearance of the Serial Ports dialog will differ.

The Serial Ports dialog
If OMS is installed in your system, the OMS MIDI Setup dialog will appear when you choose the Serial Ports command.

**MIDI Metronome**

This command allows you to set up a MIDI Metronome or "click" which both provides a bar and beat framework for MIDI recording and also allows you to select a MIDI tempo so that, if you wish, you can record audio tracks before you record MIDI. This command allows you to specify MIDI port, channel, note, velocity, and tempo for the MIDI Metronome.

The MIDI Metronome dialog

**Peripherals**

If you are using Digidesign's SMPTE Slave Driver for synchronizing Pro Tools to SMPTE Time Code or JL Cooper's CS-10 Controller for hands-on control of Pro Tools faders, select the Peripherals command from the Setups menu and click in the appropriate checkbox for these devices. Then, from the pop-up menu next to each of these items in this dialog, select the MIDI port over which you wish to send and receive MIDI data.
The Peripherals dialog (without-OMS)

The Peripherals dialog (without-OMS, but using a MIDI Time Piece™ MIDI Interface)

The Peripherals dialog (with-OMS installed)

I/O Labels
Pro Tools’ I/O Labels command provides you with a convenient way to give meaningful names to your system’s inputs and outputs. (Depending on which Digidesign card and interface you are using, the number of inputs and outputs available in this dialog will vary.) This feature is handy for labeling your inputs according to the devices that are connected to them. To label your system’s inputs and outputs, choose I/O Labels. Click in the appropriate text box and enter a descriptive name. When you have finished labeling all of the inputs/outputs that you wish, click OK. From now on, when you click
a track’s Audio Input or Output Selector, the input/output will be labeled with the name you have given it.

The I/O Labels dialog. An external reverb is connected to inputs and outputs 3-4.

Preferences

Pro Tools Preferences command allows you to specify the default settings for several Session parameters. When enabled, these options function as follows:

- Insertion Follows Playback: Causes the screen cursor to stop where playback stops.
- Insertion Follows Scrub: Causes the screen cursor to stop where scrubbing stops.
• Track Selection Follows Region List Selection: When you select a Region in the Region’s List, this option causes Pro Tools to highlight that Region’s occurrence in a track (or tracks).

• Region List Selection Follows Track Selection: When you select a Region in a track, this option causes Pro Tools to also highlight it in the Regions List.

• No Auto-Scrolling: With No Auto-Scrolling enabled, Pro Tools’ screen will not scroll during or after playback.

• Scroll After Playback: Causes the screen to scroll to final playback location after playback has stopped.

• Scroll During Playback: Causes the screen to scroll during playback.

• Auto-Name Separated Regions: When this is enabled, Pro Tools will name newly separated Regions for you by automatically appending a number to the Region’s name. When this is disabled, Pro Tools will prompt you to name Regions when they are created with the Separate Regions command.

• Auto-Name Memory Locations: When this is enabled, Pro Tools will give new autolocation points the default name, “used.” You can rename the autolocation points at your convenience later. When this is disabled, Pro Tools will prompt you to name autolocation points as they are created.

• Moving Faders During Playback: Causes Pro Tools’ on-screen faders to move if automation has been recorded for them. When this option is disabled, automation will still operate, but on-screens faders won’t move. Turning this option off can help speed up screen redraws and take some of the burden off of your computer’s processor if you are using an older model Macintosh.

• Color Code Tracks: Causes Pro Tools to assign a color to the waveform display of each track in the Edit window according to its Voice assignment.

• Compute Missing Overviews: This option prompts Pro Tools to look for missing or corrupted overview data (the data that allows it to create a waveform display) when it opens Sessions. If it finds that overview data is missing or corrupted, it will recreate the overview(s) for the Session. This may take several moments if there are many tracks in the Session. If you feel that overview data for a Session has become corrupted, or if you import audio files which have no overview data into a Session, make sure this preference is enabled for the Session, save the Session, and then reopen it. Pro Tools will recreate the overview(s) for the Session when it opens.

• Edit Window Default Length: Allows you to set a default length for the Edit window in hours, minutes, seconds, and frames. This capability is useful if you
wish to assemble a Session of a particular length or leave extra room to expand the Edit window’s work area in your Session. Currently, there is a 12 hour maximum limit for the length of a Pro Tools Session. Do not create a Session longer than 12 hours or System errors will occur.

• With Record On-line At Insertion/Selection: On-line recording begins wherever you have placed the insertion point in a track. Recording then continues until Pro Tools stops receiving time code. If you make a selection in a track, Pro Tools will record on-line only for the length of the selection.

• With Record On line at Time Code Lock: On-line recording begins as soon as Pro Tools receives and locks to time code. In this case, you don’t need to make an insertion or selection in a track to designate a start point. Instead, simply enable this option, record-enable the track, and click the On-Line button on the Pro Tools Transport. As soon as Pro Tools locks to time code, it will begin recording.

• Stereo Mix Outputs: In Stereo Mix Outputs mode, track outputs are routed to a pair of Audio Interface outputs: 1-2, 3-4, 5-6, or 7-8. In addition, each track contains controls for panning between the two selected output pairs.

• Direct Outputs: In Direct Outputs mode: Track outputs are routed to a single Audio Interface output. Panning controls are not available in Direct Outputs mode.

• QuickPunch Crossfade Length: On Pro Tools Project systems, this item allows you to specify a length for equal-power crossfades which Pro Tools will write to disk at the punch-in point and punch-out point each time you use QuickPunch. (QuickPunch is not available on Audiomedia III or DAE PowerMix-based systems.) At the punch-in point, QuickPunch writes a pre-crossfade (it occurs up to but not into the punch-in’s Region boundary) and at the punch-out point writes a post-crossfade (it occurs after the punch-out’s Region boundary). These crossfades can later be edited just as a standard crossfade can. A good general-purpose length is 14 milliseconds or so. If you leave this Preference at its default setting of zero, Pro Tools will not create any crossfades at the punch in/out point. When you are performing the punch-in/outs however, Pro Tools always executes a 4 millisecond “monitor only crossfade” (not written to disk) which avoids distracting “pops” that otherwise might occur as you enter and exit punch recording.

**Time Code**

This command allows you to select the SMPTE format appropriate to your project. Five different formats of SMPTE time code exist: 30 frames per second (fps), 29.97 fps, 29.97 fps Drop frame, 25 fps (EBU) and 24 fps.

The 30 fps frame format is based on a frame rate of 30 frames per second. This is the
original SMPTE format developed for monochrome (black and white) video.

The 29.97 Non-Drop frame format is used with NTSC color video. It runs at a slower frames per second rate of 29.97, but unlike 29.97 Drop-Frame time code, it makes no compensation for the discrepancies in “wall clock” time versus SMPTE time. It’s important to note that “one hour” of 29.97 Non-Drop frame time code is actually one hour and 3.6 seconds of “real time” due to the fact that the slower frame rate does not match “wall clock.”

NOTE: There is sometimes confusion in the audio/video world regarding SMPTE terminology referring to the 30 fps (black & white video standard) or 29.97 fps (color video standard) frame rates. When working with NTSC video (the standard in North America), one generally works with the color video standard: either 29.97 fps Non-Drop or 29.97 fps Drop-frame.

The 29.97 “Drop-Frame” format was developed for use with NTSC color video, which has an actual frame rate of 29.97 frames per second. This slight deviation from the standard 30 frames/second rate causes time code numbers to be out of sync with “wall clock” time, such that an hour of elapsed 29.97 frame rate SMPTE time code is not equal to one hour of real time due to the fact that the time code is actually running slower. To compensate for this discrepancy in frame rates, the first two frames of each minute are “dropped” (omitted) with the exception of every 10th minute. This results in 108 frames being dropped every each hour—exactly the number required to avoid accumulation error (and reflect true “wall clock” in the time code clock values).

The 30 Drop-Frame format. See above for an explanation of this frame rate. This rate is used in film sync “pull-up” applications.

The 25 fps (EBU) format is used with the European PAL video standard, which runs at a 25 fps frame rate. This format is also called the EBU (European Broadcast Union) format because it’s used by broadcasters throughout Europe.

The 24 fps format is used exclusively for film applications. Film is often photographed and projected at a rate of 24 frames per second, so this SMPTE format is useful when one time code frame should equal one film frame.

Make sure that you know without a doubt which of these formats your project’s tape has been striped with before you begin your Session. A little extra care up front is always preferable to hours spent redoing work later.

The Time Code dialog also provides other SMPTE synchronization-related options. Start Frame allows you to specify a SMPTE “zero frame” reference for your Session. Upon
receipt of this frame number, Pro Tools will chase to the correct point and begin playback of digital audio and MIDI. Output Time Code allows you to use Pro Tools to generate MIDI time code (or optionally, with Digidesign’s SMPTE Slave Driver to generate LTC or MTC). Using Film Transfer Pull Up (or Pull Down) allows you to work with sample rates that have been “pulled up” or “pulled down.” And Finally, Ignore Time Code Drop Outs lets you protect against errors that may occur in your Session if your source of SMPTE time code has drop outs by allowing Pro Tools to “freewheel” for a few frames over any areas of bad time code that it receives while on-line. For more information on these features, refer to Chapter F: Working with SMPTE.

The Time Code dialog

**Feet.Frames...**

For Sessions in which feet and frames are the time scale of reference, this command allows you to quickly enter a Start Frame in feet and frames that becomes a start point for your Session based on an appropriate frame location at the beginning of your project tape. Your Session will then use this value as its start frame reference. In this dialog, use a period (.) to delineate feet and frame values. Pro Tools does not currently support negative frame offsets for Sessions.

The Feet.Frames dialog
The Display Menu

The Pro Tools Display menu contains the commands you’ll use to configure how Pro Tools displays its windows, tracks, and track data. Here are brief explanations of each command.

**Show Mix Window**
This command displays Pro Tools' Mix window. You will use this window for recording, and mixing tasks.

**Show Edit Window**
This command displays Pro Tools' Edit window. You will use this window for graphical editing and arranging of audio, MIDI and automation.

**Show Transport Window**
This command displays Pro Tools' transport control. The transport looks and acts like the transport of a tape deck, and provides controls for (from left to right) on-line, return to zero, rewind, stop, play, fast forward, and go to end.

**Show/Hide Tracks**
The Show/Hide Tracks command allows you to streamline your display by hiding tracks.
you don’t wish to view. It also allows you to hide the Time Scale. Don’t confuse this command with the Delete Track command in the File menu. With the Show/Hide Tracks command, tracks remain open, but invisible when “unchecked.” Be aware that even if a track is hidden from view, its position relative to other tracks still affects playback priority.

To hide a track, select Show/Hide Tracks. A dialog appears listing all currently open tracks, as well as the Time Scale. If necessary, scroll through the list until you find the desired track. Click the box next to the name of the item that you wish to hide to “uncheck” it. Click OK and when you return to the Pro Tools window, the item will be hidden. To make it reappear, choose the command again and click on its check box once again. The Time Scale can be hidden in the same way.

The Show/Hide Tracks dialog

**Show Extra Views in Mix Window**
Choosing this command displays Pro Tools’ Inserts, Sends, and Inputs/Outputs modules in the Mix window.

**Show Extra Views in Edit Window**
Choosing this command displays Pro Tools’ Inserts, Sends, and Inputs/Outputs modules in the Edit window.

**Show I/O View**
This command displays I/O module in the window currently chosen with the Show Extra Views in — Window command.

**Show Inserts View**
This command displays Inserts (EQ) module in the window currently chosen with the Show Extra Views in — Window command.

**Show Sends View**
This command displays the Send module in the window currently chosen with the Show Extra Views in — Window command. Sends are not available on Audiomedia III or DAE PowerMix-based systems.

**Show Current Time Code in Regions**
If you are using SMPTE as your Time Scale, this command displays the SMPTE time of all Regions in tracks according to their current location in the track.

**Show Original Time Code in Regions**
If you are using SMPTE as your Time Scale, this command displays the original “time-stamped” SMPTE time of all Regions currently placed in tracks. This SMPTE number represents the time at which the Region was originally recorded on-line (or user time-stamped) with Pro Tools, and does not necessarily reflect the Region’s current SMPTE location in a track.

**Reduce Track Size**
Choosing this command will reduce the size of all tracks on screen to roughly half of their full height. This mode is useful when the quantity of tracks shown is more important than the detail in which they are displayed. To restore tracks to their full size again, choose this command again.

**Show File Names in Region List**
This command shows the full name of all Regions in the Audio and MIDI Regions Lists. A Region’s name consists of two parts: the File name, which represents the audio or MIDI file from which it originated, and the unique Region name that you gave it when you created it. Because Region names can become lengthy (up to 31 characters) and therefore difficult to view in the Regions List or a track, Pro Tools provides you with the option of displaying the File portion of the Region’s name.

**Show Volume Names in Region List**
This command shows the volume name (the name of the hard drive where the audio file resides) of all Regions in the Audio Regions List. Show Volume Name in Regions List which is designed to make managing Audio Regions in multiple-hard drive systems easier. Enabling this command shows the volume name (the name of the hard drive where the audio file resides) of all Regions in the Audio Regions List. It allows you to see at a glance which drive a particular Region resides on. An added feature is that the built-in alphabetic Region List search function (typing the first few characters of a Region name will highlight that Region’s name in the list) works intelligently: it ignores
Volume and File names and finds the Region based on its Region name only. (However, in order to sort by Region names most effectively, you may wish to disable Show Volume Name in Regions List.)

Bars & Beats
Choosing this command displays the Time Scale in Bars & Beats. If there is no MIDI Tempo data in the current Session, you will need to use the Identify Beat command to identify at least two reference beats from which Pro Tools can interpolate the Bars & Beats Time Scale.

Minutes:Seconds
Choosing this command displays the time scale in minutes and seconds.

Time Code
Choosing this command displays the Time Scale in SMPTE frames. The frame rate is chosen in the Time Code... dialog.

Feet.Frames
Choosing this command displays the Time Scale in feet and frames for referencing audio-for-film projects. The Feet.Frames time display is based on the 35 millimeter film format.

The Region List Menu

<table>
<thead>
<tr>
<th>Region List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Audio...</td>
</tr>
<tr>
<td>Import MIDI...</td>
</tr>
<tr>
<td>Select Unused Audio</td>
</tr>
<tr>
<td>Select Unused MIDI</td>
</tr>
<tr>
<td>Select All Audio</td>
</tr>
<tr>
<td>Select All MIDI</td>
</tr>
<tr>
<td>Clear Selected...</td>
</tr>
<tr>
<td>Compact Selected...</td>
</tr>
<tr>
<td>Rename Selected...</td>
</tr>
<tr>
<td>Time Stamp Selected...</td>
</tr>
<tr>
<td>Open Selected In SDII...</td>
</tr>
</tbody>
</table>

The Region List menu contains commands for adding or removing Regions to the Audio Regions List or the MIDI Regions List.

Import Audio
This command allows you to add audio Regions to the Audio Regions List. Unlike the
Import Audio command in the File menu, choosing this command from the Region List menu does not automatically load Regions into new tracks; it simply adds the Regions to the Audio Regions List from where they can be dragged into tracks.

When you choose this command, a File dialog appears allowing you to navigate to the desired audio file. When you've found the file, click on it and any Regions associated with it will appear in the items in current file list inside of the dialog. When you double-click on an audio file or Region, it is added to the items currently chosen at the right. When you have finished choosing all of the files you wish to import, click Done and Pro Tools will find and import all of these audio files into the Audio Regions List.

This command allows you to import monophonic Sound Designer II format files, original Sound Designer format files, interleaved stereo sound files, or Audio Interchange format [AIFF] files) Importing interleaved stereo sound files requires both time and hard disk space because the right and left channels of a stereo file must be converted to individual mono files. After the file is imported it appears in the Audio Regions List. If the file is a stereo file, the left and right channels will be loaded individually into the Audio Regions List.

When you click on an audio file's name in this dialog, information appears about the sample rate of the file. The Play button allows you to audition a Region before you load it into a Session.

The Import Audio dialog

**Import MIDI**
The Import MIDI command loads a Standard MIDI file into Pro Tools' MIDI Regions List.
From there you must drag the Regions into MIDI tracks you have created by yourself. This is useful if you intend to use only certain tracks in the original sequence. Unlike the File menu's Import MIDI command, choosing this command from the Region List menu will not automatically create new MIDI tracks for the imported file.

The Import MIDI dialog

**Select Unused Audio**
This command examines the current Pro Tools Session and, in the Regions List, highlights all audio Regions which have not been placed in a track. The Regions can then be removed temporarily or permanently (if so desired) from the Regions List with the Clear Selected command. The main purpose of this command is to help you find and remove unneeded Regions from the Audio Regions List.

**Select Unused MIDI**
This command functions in the same way as the Select Unused Audio command: it examines the current Session and, in the MIDI Regions List, highlights all MIDI Regions which have not been placed in a track. The Regions can then be removed from the Regions List with the Clear Selected command. The main purpose of this command is to help you reduce clutter in the MIDI Regions List.

**Select All Audio**
This command selects all audio Regions in the Audio Regions List.

**Select All MIDI**
This command selects all MIDI Regions in the MIDI Regions List.

**Clear Selected**
This command offers two options for removing Regions which are selected in either the
Audio or MIDI Regions List. The first option, Remove, removes them from the current Session. The second option, Delete, applies only to audio Regions and if chosen will permanently erase the audio data itself from the source audio file. To use this command you must first select a Region by clicking its name in the Regions List. If your goal is to clear all unused Regions, choose the Select Unused Audio (or MIDI) command. This command should be used with care. Should you attempt to remove or delete a Region that has been placed into a track, Pro Tools will warn you before proceeding.

The Clear Selected dialog

**Compact Selected**
The Compact Selected command allows you to “shrink” sound files in order to conserve disk space. It does this by examining a selected source audio file and irretrievably deleting any data which has not been defined as a Region. The Compact Selected command allows you to “pad” the Regions of the compacted file by a user-selectable amount. You’ll want to do this because Pro Tools requires extra audio data before and after an audio Region in order to create crossfades. So, if your Session has one or more crossfades, you should estimate how long your crossfades are and enter an appropriate amount of “padding” (in milliseconds) to account for this. Because it permanently deletes audio data, the Compact Selected command should be used only after you have completely finished your editing Session and are sure that you have no further use for the unused audio data.
The Compact Selected dialog

**Rename Selected**

In the course of a Session, you may wish to change the name of Regions, either to give them more descriptive names or merely to simplify them. Pro Tools allows you to do this with the Rename Selected command. This command can be used on “whole-file” Regions as well as “sub-Regions.” If you attempt to rename a whole-file Region, Pro Tools will give you the choice of renaming just the Region as it occurs in the Session, or the audio file itself on disk. Be aware that when you rename a Region, Pro Tools will rename all occurrences of the Region in the Session.

If you select multiple Regions and then choose the Rename Selected command, you can rename a “batch” of audio Regions/files. Pro Tools will then continue presenting you with Rename Region dialogs until you have renamed all of the desired Regions/files.

---

Pro Tools User’s Guide
**Time Stamp Selected**

This command allows you to select a Region (or Regions) and redefine its SMPTE time stamp. Because Pro Tools stores only one time stamp per Region, this command replaces the SMPTE frame number that was originally stamped on the take when it was recorded on line. This feature is particularly useful in post production situations where the SMPTE time code on video “work prints” often changes from one edit revision to another during the video post-production process. To time stamp a Region (or Regions) with a new SMPTE frame number, select the Region that you wish to time stamp. From the Regions List menu, choose the Time Stamp Selected command. Enter a new SMPTE time. You can do this in three ways: enter the numbers manually (with the help of the arrow keys); click Capture if you wish to capture the incoming time code address; or click Use Selection if you wish to enter the start time of the current on-screen selection. Click OK.

This command can be used in “batch mode” to set new Time Stamps for several Regions at the same time. To do this, simply select several Regions and choose the Time Stamp Selected command. One after another, Pro Tools will present a dialog for each Region, allowing you to quickly enter a new value for each.

The Time Stamp Selected command

**Export Selected**

The Export Selected command allows you to “export” a selected audio Region’s definition so that it becomes available to other Pro Tools Sessions. If you wish to share Regions between Sessions (by importing them with the Import Audio command) you must first select them in the Audio Regions List and choose Export Selected in order to do this. In the dialog that appears, click Export to export the selected Region(s). Pro Tools modifies the Region’s definition so that it is visible to other Sessions. The redefined Region will remain in its original Session folder. The next time that you use the Import Audio command, you will see the exported Region in the file dialog, from where it can be imported into the desired Session.
The Export Selected dialog

**Open Selected in SD II™**
The Open Selected in SD II command allows you to quickly switch to Sound Designer II to edit a selected Region in its original source audio file. Sound Designer II (available separately from Digidesign) offers other editing functions, such as Graphic Equalization and Pitch Shifting, which are not available in the Pro Tools software.

Selecting a Region and choosing this command will transfer you to the Sound Designer II software editor where the Region’s source audio file is opened and the Region itself is highlighted. From there you will be able to manipulate the selected Region or entire file with any of Sound Designer II’s editing tools or DSP functions.

If you do anything to a file in Sound Designer II that will alter its length (cut, paste, trim, time expansion/compression, pitch shifting), do not attempt to play any Session that uses that file. The sound file’s Regions must be deleted from the Regions list and reloaded into the Session. Do this with all Sessions that use Regions from the altered file(s). Sound Designer II has no way of telling Pro Tools that a Region has been shortened. Pro Tools Sessions keep track of a file’s start and end locations. If a Session is played that uses a Region that has been altered by SDII since the Session was saved, the program may “run out” of file and a disk error may occur.

This command requires that you use version 2.5 or later of Sound Designer II. If you are a Sound Tools or Sound Tools II owner and do not have a copy of this version, please send in the order form that is enclosed with your Pro Tools system and receive an update. If you are not a Sound Tools owner and wish to purchase Sound Designer II, contact your dealer or Digidesign.
The Open Selected in SD II dialog
Pro Tools Key Commands and Shortcuts
Pro Tools Key Commands and Shortcuts

Pro Tools has many key commands and shortcuts that provide convenient ways to perform common Session tasks. This chapter gives you a comprehensive list of these time saving techniques.

Record/Playback Functions:
- Space bar = starts/stops playback.
- Command-Space bar = initiates recording. (The same as clicking record and play on Transport.)
- Shift-Space bar = half speed playback
- Command-Shift-Space bar = half speed recording.
- Command-Option-J = enables/disables record On-line.
- Command-Period = Aborts recording. Deletes audio file created by recording process.

Mixer Operation Shortcuts:
- Option-Click on solo/mute button = clears all solo/mutes.
- Shift-Click on track record enable button = Necessary for record-enabling more than one track. Clicking on another track without shift-clicking merely switches which track is enabled for recording.
- Option-Click on track record enable button = sets/clears all record enables.
- Shift-Click on track name = selects additional tracks.
- Option-Shift-Click on track name = select/deselect all tracks.
- Clicking on a clipped meter clears the red clip hold light.
- Option-Click on clipped meter clears clip hold lights on all tracks.
• Option-Click on the Track Display Format pop-up (waveform, blocks, volume graph, pan graph) switches all tracks to the selected display format.

Return Key:
• Return key = return to zero.
• Shift-Return = extends selection to zero.
• Option-Return = goes to end of session.
• Option-Shift-Return = extends selection to end of session.

Editing Shortcuts:
• Delete key = deletes whatever is selected in a track—depending on the chosen view (audio, automation, or panning data).
• Clear Key = deletes whatever is selected in the Regions List.
• Hold down Option to reverse the direction of the Trim tool. (Avoids scrolling and re-sizing when working with long regions.)
• Left/Right Arrow Keys = scrolls to selection start/end.
• Selecting an on-screen Region, holding down the Control key and dragging a region from the region list allows you to place the dragged region exactly at the start point of the selected on-screen Region; either directly on top of it, or on a another track. This is the best method for quickly comparing multiple punch-in takes for ADR or music. Select the punched area on-screen, hold down Control, select an alternate take from the Region List, and drag into position over the older take. If it’s a punch-in where you have multiple performances with the same in/out points, the new element lines up exactly overlapping the older one. If you wish, you can place the alternate takes on another track. This method allows the start time to line up quickly and precisely.
• Control dragging now constrains with respect to the sync point in the Region that is being moved. (For example, set an insertion point and the sync point of the Region will line up with it. This can be used to get a Region to line up at the front of another region in slip mode, by placing a sync point at the very end of a region.
Transport/Location Window:
- Clicking on a memory location in the transport window recalls the memory location.
- Option-Click on a memory location in the transport window = sets memory location.
- Number Keys = specifies memory location. (Typed numbers accumulate until you press either the Period key or Enter key.)
- Enter Key = sets a memory location. If a number has been typed, sets to that location. If no number is typed, sets to the first available unused location.
- Period Key = recalls a memory location. If a number has been typed, recalls that location. If no number is entered recalls the next location after the current selection.
- Shift-Location number-Period Key = Extends selection to recalled memory location selection.

Tab Key:
- Tab Key = advances the insertion point to the next Region boundary.
- Option-Tab = moves selection point backwards to previous Region boundary
- Shift-Tab = extends selection to next Region boundary.
- Option-Shift-Tab = extends Selection backwards to previous Region boundary.

Auditioning Edit Points:
- Option-Left Arrow/Option-Right Arrow = plays by pre-roll time up to selection start/end.
- Command Left Arrow/Command-Right Arrow = plays post-roll time after selection start/end.
- Command-Option-Left Arrow/Command-Option-Right Arrow = plays through selection start/end using pre and post roll times.
- Up/Down Arrow Keys During Playback: Sets selection start/end “on-the-fly.”
- Up/Down Arrow Keys While Stopped: Sets selection start/end to incoming time code.
**Plus/Minus Keys:**
- Plus/Minus Keys = nudges selected region by grid value.
- Option-Plus/Option-Minus = trims left edge of Region by grid value.
- Command-Plus/Command-Minus = trims right edge of Region by grid value.
- Control-Plus/Control-Minus = nudges the region data by grid value, but keeps the same Region boundaries, (i.e. the Region start/end doesn’t move but the sound data does).

**Region List Shortcuts:**
- “A” to “Z” Keys (upper or lower case) = Alphabetical scrolling in the Region List. Supports multiple letters: Typing “cra” will scroll to “crash”, and “cri” will scroll to “crisp”. Preferences settings determines whether or not scrolling to Regions disturb on-screen selections.
- Double-Clicking on Region in Region List = renames Region.
- Option-Clicking on Region in Region List = plays Region as long as mouse button remains depressed.

**Zoom Magnification Shortcuts:**
- Option-Click on Zoomer = zooms so that the current selection fills the window.
- Double-Click on Zoomer = zooms all the way out, so that the entire session fills the window.
- Holding Option while using Zoomer = magnifies time axis only, not amplitude.
- Option-Click on Zoom Arrows = goes back to the last zoom orientation.

**Selector Tool Shortcuts:**
- Shift-Click with Selector tool = extends selection.
- Option-Shift-Click with Selector tool = extends selection across all tracks.
- Double-Click with Selector tool = selects whole Region.
- Triple-Click with Selector tool = selects entire track.
- Option-Clicking with Selector tool at point before selection: sets and turns on pre-roll amount.
• Option-Clicking with Selector tool at point after selection: sets and turns on post-roll amount.

• Clicking within the selection sets pre- or post-roll to zero depending on whether the click is closer to the selection start or end.

• Command-Click with Selector tool = scrubs.
• Command-Shift-Click with Selector tool = scrubs and extends the selection.

Grabber Tool Shortcuts:
• Control-Click with the Grabber Tool = constrains the Region to the current selection start.
• Double-Click with Grabber Tool = renames Region.

Editing Automation with the Trim Tool:
• If a selection is not made, the whole track will be trimmed.

• When Trimming within a selection, all points within the selection get trimmed. When trimming an on-screen selection, new breakpoints are created at the boundaries of the selection. Pro Tools 2.03 didn’t create these nodes, and trimming automation within a selection resulted in slopes that started from the nearest existent node points on either side of the selection. To use this older mode, use the Option key.

• When Trimming within an audio region, all points within the region get trimmed.

• When Trimming within an automation “plateau” (two equal points), the two points get trimmed.

• Option-Clicking with Trim tool on automation = doesn’t “pin” automation points outside the trim range.

Parameter Adjustments:
• Option-Clicking on Volume Faders, Pan Faders or EQ Faders sets fader to default value.

• Command-Clicking and adjusting a parameter allows “fine-tune” adjustment of values.
Disk Allocation:
• Disk Allocation Dialog: Option-Clicking on pop-up menu of drive assigns all tracks to the selected drive.

Import Audio Dialog Shortcuts:
• Enter or Return key = adds currently selected audio file/Region to list.
• Command-P = auditions currently selected audio file/Region.
• Command-S = stops audition (playback) of currently selected audio file/Region.
• Tab key = tabs between file windows.
• Command-Period = Cancels (closes) dialog.

Spot Dialog Shortcuts:
• Right Arrow key = selects time field to the right.
• Left Arrow key = selects time field to the left.
• Up Arrow key = increases numerical value entered in time field.
• Down Arrow = decreases numerical value entered in time field.
• Plus key, followed by a number, followed by equal sign = adds entered value to selected time field
• Minus key, followed by a number, followed by equal sign = subtracts entered value from selected time field
Glossary of Terms

A/D Converter
Analog-to-digital converter; a circuit that converts an analog signal to a digital signal. With an Audiomedia III card, DAT deck, or most other digital audio devices, each analog input channel is equipped with an A/D converter. A/D converters operate at particular bit-rate resolutions, and at particular sampling rates.

AES/EBU Digital Interface
Describes an industry standard for transferring digital audio between professional-quality audio devices. Stands for “Audio Engineering Society/European Broadcasters’ Union.” Most AES/EBU connections utilize an XLR-style 3-pin connector, which is able to carry two channels of digital audio (as opposed to one channel of analog audio). Most professional gear, including Digidesign’s professional Pro Tools audio interface, is equipped to handle at least one AES/EBU I/O, and often more. See also S/PDIF.

AIFF
Audio Interchange File Format, an Apple audio file format that is supported by many Macintosh software applications. The AIFF format is best if you plan to use bounced audio in other Macintosh applications that do not support the Sound Designer II format.

Amplitude
A term used by recording engineers to describe relative levels. See Signal Levels.

Analog Audio
Audio which is transmitted, processed, amplified, or otherwise managed in the analog domain. Unlike digital audio, which represents audio in terms of discrete numbers, analog audio can be represented by continuously variable voltages. The signals between home stereo and recording components, for example, are usually analog audio.

Audio Card
Refers generically to computer cards that process or generate sound. On the Mac, examples include Digidesign’s Audiomedia III, and Pro Tools Project card; older Mac cards are of the NuBus standard, but an increasing number are PCI-bus standard. On the PC-compatible side, the most common card of all is Creative Lab’s SoundBlaster; professional-grade cards include Digidesign’s Session 8 PC; older PC cards utilize the ISA-bus standard, but as with the Mac, PCI-bus cards are becoming a de facto standard.
Audio File
A digital recording, as stored in digital form, typically on a hard disk. Audio files (also referred to as sound files) are stored in one of four primary file formats. Also see AIFF, Sound Designer II File Format, Sound Resource File Format, and .WAV.

Audio Interface
Among many DAWs, such as Digidesign's Pro Tools, the audio interface is a separate box that is attached with a special cable to the audio card. An audio interface typically has analog and digital audio inputs, and may be equipped with level meters, level controls, and other features.

Audio Post-Production
The process of adding dialog, music, sound effects, and other audio to video, film, or computer-based movie. The “post” reference comes from the fact that these elements are added once the film or video has already been shot.

Audio Region
See Region.

Audio Regions List
See Regions List.

Audition
[verb] A term that recording engineers use for listening to, or “monitoring,” one or more tracks or audio files. Within Pro Tools, for instance, you can audition files before you load them into the program; you can also audition individual tracks using the solo feature, or audition regions/files in the Regions List by Option-clicking on them in the Regions List window.

Autolocation
A feature that allows you to store and recall points of time into a recording system’s memory. Pro Tools’ autolocator function allows you to set up to 100 markers at specific events. Individual locations can then be recalled, which automatically jumps the playback point to the marker’s time.

Automation
A feature that allows you to record and playback changes in fader levels and pan controls. Pro Tools allows you to view and edit all fader and pan automation. During automation recording, all audio regions remain intact; only changes in automation are recorded.
Automation Record Enable
Within Pro Tools, an onscreen button that prepares a track to record automation. Similar to record enable.

Auxiliary Send
See effects send.

Balanced & Unbalanced Audio
Most professional +4dBu and microphone-level analog signals (see signal levels) utilize balanced audio, with balanced cables and balanced connectors. Digidesign’s Pro Tools 882 audio interface, for instance, has balanced analog inputs and outputs. Balanced lines are typically less susceptible to noise (such as hum, radio frequency interference, and so forth) than unbalanced lines.

Here’s how balancing works: A balanced cable has two conductors and a ground, and usually ends in either XLR-type 3-pin connectors or TRS 1/4” connectors. Both of the two conductors carry the audio signal. However, the “cold” or “negative” (-) conductor carries a signal that is 180° out-of-phase with the “hot” or “positive” (+) conductor. (See phase.) When the two conductors’ signals are recombined at an audio device’s input stage, a phase “inverter” reverses the cold conductor’s phase, so that its audio signal is in-phase with the hot conductor. Why go to all this trouble? Balanced lines “reject” RF (radio frequency) or other electromagnetic interference that may be introduced into the signal path. When the two sides of the line are summed, the noise products are now out-of-phase with each other, so they cancel each other out.

Most semi-pro and home stereo -10dBV analog lines are unbalanced, which means they have just a single positive (+) conductor and a ground. Digidesign’s Audiomedia III card has unbalanced analog inputs and outputs, as do Apple’s PowerPC computers. Although noise can accumulate in the positive conductor, functionally speaking, these days, most unbalanced systems are capable of performing very quietly, with very low noise. Professional applications, however, demand balanced interconnections as a safeguard against noise.

If you need to connect a balanced output signal to an unbalanced input, the most reliable method is to use a “balancing transformer,” which assures that the line stays balanced from output to input, and also helps to match impedance.

Bars & Beats
Pro Tools allows you to define both a tempo and a time signature to create beat markers within the Edit window that delineate the beat. This function is most useful for identifying location with a musical piece, and for Grid alignment of regions to the nearest beat.

Bit
The digital “alphabet” is composed of just two binary digits, or bits: “0” and “1”. Digital circuits usually represent a 1 with a relatively “high” voltage, and 0 with a low voltage. Eight bits form a byte.
Bit-Rate Resolution
One of two main specifications that define digital audio quality. Along with sample rate, which defines an audio file’s upper frequency limit, bit-rate resolution defines how precisely a sound’s dynamic range is represented.

Remember that digital audio uses numbers to represent sound. The more numbers, the more precisely you can represent a sound. Consider first that analog sound — such as the sound we hear in the every day world around us — has a virtually infinite dynamic range of levels, from loud to quiet. Now let’s imagine we wanted to capture this infinite range with a recording system that has a 2-bit recording system. With such a system, we could use four number combinations (2^2) in the following way:

11 = Loudest
10 = Medium Loud
01 = Quiet
00 = Silent

In other words, a two-bit audio file gives you just four possible levels — not even enough for a low-fidelity telephone answering machine. An 8-bit audio file, however (2^8) gives you a dynamic range of 256 possible levels, which isn’t bad, but not nearly as good as the 65,536 levels that you get with 16-bit resolution (2^16). Practically speaking, 16-bit files have a much better signal-to-noise ratio than 8-bit files, which means they have much less audible noise. There’s a rule-of-thumb you can use to figure out the approximate dynamic range of any particular bit rate: simply multiply the bit rate by 6. For instance, 8-bit audio has a dynamic range of “8x6” or 48dB; 16-bit audio has a dynamic range of “16x6” or 96dB.

Professional applications call for 16-bit or greater audio. Other resolutions, such as 8-bit audio, may be suitable for presentation or multimedia applications. As with sample rate, bit rate also has a bearing on the size of a file.

Bouncing
The process of combining two or more audio tracks into a single track. With Pro Tools, bouncing is much like mixdown — although instead of mixing to an external device (such as a DAT deck), you mix back to your system’s hard disk. Bouncing is done to free up disk space or to free up tracks. The primary disadvantage of bouncing is that once you have performed the bounce, you can’t change the relative levels or panning of the combined tracks. For this reason, the original “source” tracks should be deleted only once you are completely satisfied with the bounced track.

Byte
A “word” comprised of eight bits. A byte has 2^8, or 256 possible combinations, from “00000000” to “11111111”.

---

Pro Tools User’s Guide
Cardioid Microphone
A cardioid, or unidirectional, microphone is one that is sensitive to sound sources that emanate primarily from in front of the microphone. Because of its design, a cardioid mic will reject most sound that emanates from beside the mic, and almost all sound that emanates from behind the mic. It’s called “cardioid,” by the way, because its response pattern resembled the shape of a heart. A cardioid microphone is the best all-around pattern for most music and dialogue recording, particularly when used outside of a professionally soundproofed studio, because it will be less likely to pick up unwanted background noise.

Channel
A channel is a discrete signal path. A mixing console, for instance, is a device that combines two or more channels. A channel is not necessarily the same as a track (although some people consider the two words synonymous). In Digidesign’s terminology, channels refer to how many discrete audio inputs or outputs an audio interface has; tracks, on the other hand, are areas in the Edit window that allow you to playback simultaneous audio events.

Chorusing
A type of processing that many digital effects processors can perform. Chorusing adds a swirling, shimmering sound to your audio, similar to flanging but not quite as intense. Chorusing is actually a modulated type of digital delay setting, with a delay of about 11 to 30 milliseconds.

Clear
A Pro Tools function, similar to Cut, that removes a region from the Edit window or Audio Regions List. Unlike Cut, however, Clear does not store the removed region to the Macintosh’s Clipboard memory.

Clip Indicator
A light or other indicator that warns you that a level may have run out of headroom, and may be approaching clipping. Within Pro Tools, the clip LED functions as a clip indicator.

Clipping
Distortion that occurs when a signal is so high that it runs out of available headroom. The term comes from the shape of audio waveforms when viewed on an oscilloscope, or within the Edit window; the tops (and bottoms) of each waveform look as if they’ve been “clipped” off. Clipping of a digital signal generally sounds like a snapping or crunching sound (unlike analog clipping, which usually sounds “warmer,” like the distorted sound of an electric guitar through a tube amplifier that is driven to clipping). While occasional clipping is tolerable (or even desirable) with analog signals, digital clipping must be avoided in all circumstances.
Compressor; Compressor/Limiter
A type of signal processor that effectively reduces a signal’s dynamic range. A compressor can be used to make loud passages that exceed a preset “threshold” level sound less loud. Effectively, this makes quiet passages sound louder and loud passages sound quieter. A compressor is typically used to “smooth out” dynamically uneven tracks—such as a vocal track where the vocalist has not kept a very consistent level. It can also be used with a bass guitar or other instrument to enhance the apparent sustain, by making the quiet decaying portions sound louder. Extreme compression forms a type of limiter, which sets a maximum threshold level that cannot be exceeded. Limiting is useful to prevent clipping.

Connectors
Refers to the many different types of input and output jacks, and cable plugs, that are used in audio recording. The most popular connectors are Quarter-inch, Eighth-inch, XLR, RCA, and TRS.

Condenser Microphone
A type of microphone that uses a charged, or polarized, diaphragm to capture sound. Condenser mics can be externally powered from a mixer or microphone preamp; this type of power is called phantom power, because it travels “unnoticed” through the microphone cable, without affecting the audio signal. Phantom power is usually 48 volts DC, and requires a professional-style balanced microphone and microphone input (or microphone preamplifier). Some condenser mics are internally powered, using a small battery (usually AA or 9v).

An electret microphone is similar to a condenser, except that its diaphragm is permanently charged, and doesn’t require power; however, most electret microphones still require phantom or internal battery power to drive their preamplifiers—which raise the relatively weak signal from the capsule up to a microphone level.

Copy
A Pro Tools function that allows you to copy a region (or regions) in the Edit window, much like the copy function of a word processor. Copied regions are held in the Macintosh’s Clipboard memory in order to be pasted, until something new is copied or cut into the Clipboard.

Crossfade
[verb] To reduce the playback level of one portion of audio as you raise another portion—much like a dissolve between scenes in video or film. Crossfades are performed using either an external mixing console, or (with Pro Tools or most other DAWs) the onscreen faders within the Mix window, or a “crossfade” function.

Crossfade
[noun] In Pro Tools, the crossfade function allows you to fade out from one region as
you fade in to another region. Crossfade types and duration are user selectable from within the Fades dialog (Edit window>Edit menu>Fades...). As with fades, portions of audio for which the fade function has been applied are stored in Pro Tools’ “Fade Files” folder.

**Cut**
A Pro Tools function that allows you to remove a region (or regions) in the Edit window, much like the cut function of a word processor. Cut regions are held in the Macintosh's Clipboard memory in order to be pasted, until something new is copied or cut into the Clipboard.

**D/A Converter**
Digital-to-analog converter, a circuit that converts a digital signal to analog. With most digital audio devices, each analog output channel is equipped with a D/A converter, much as each input channel is equipped with an A/D converter.

**DAE**
See Digidesign Audio Engine.

**DAT**
Stands for Digital Audio Tape, a type of cassette that uses 4mm tape. A DAT deck is a common type of stereo recording deck used in professional studios. DAT is also used as a SCSI backup drive, capable of holding up to 8GB of data. Audio DAT decks and DAT backup drives are different devices, even though they use the same type of cassette.

**DAW**
See Digital Audio Workstation.

**Decibel**
The primary unit for measuring audio levels; also spelled deciBel, for Alexander Graham Bell. There are a variety of different decibel scales, but for our purposes, the primary scale that allows us to measure different devices on the same level “playing field” is known as the dBu, or dBv (not the same as dBV). Also see Signal Levels.

**Defragmentation**
As data is written and erased from a hard disk (or a hard disk partition), gaps form between different “chunks” of data. These gaps can slow down the hard disk’s seek-time speed, as the drive’s heads have to seek here and there to find data, and this can impede audio playback performance. Consequently, it’s important to “defragment” the drive frequently, using a program such as Symantec’s Norton Utilities. To play it safe, Digidesign recommends you defragment frequently. Alternately, erasing everything on the hard disk regularly allows you to begin writing contiguous data, that will be free of seek-time troubles.
Delay
A type of audio processing that many digital effects processors and certain types of software can perform. Delay is the process of storing portions of an audio signal briefly in memory, and then playing them back. With the typical digital effects processor, delay times can be adjusted from about 1/2000 of a second (0.5 milliseconds) to one or two seconds (1000 to 2000ms), or longer. Delay can be used to create an echo or a doubling effect. When the delay’s signal is “modulated” — that is, its time is varied slightly at a user-definable rate — modulated delay effects such as chorusing and flanging can be created.

Destination
Something that receives an audio signal. See Sources & Destinations.

Digidesign Audio Engine (DAE)
Digidesign’s real-time operating system for its digital recording systems. When you install your Pro Tools Software, DAE is automatically installed inside your System folder into a DAE folder. In the same way that the Macintosh System software provides the foundation for Macintosh software applications, DAE provides the core functionality of hard disk recording, digital signal processing, mix automation, and MIDI required by Pro Tools 8 and other Digidesign products. Because DAE is an application itself, separate from Pro Tools, it supplies these same capabilities to products such as Studio Vision™, Logic Audio™, Digital Performer™, and Cubase Audio™ which utilize Digidesign DSP resources to record and play digital audio.

Digital Audio
Audio which is transmitted, processed, amplified, or otherwise managed in the digital domain. Digital audio uses numbers — bits comprised of “0” or “1” — to represent sound. Digital audio requires an A/D converter to convert sound from analog into digital, and a D/A converter to convert it back to analog. Digital audio quality is described primarily by two specifications: the bit-rate resolution, and the sampling rate.

Digital Audio Workstation (DAW)
The more common name for a hard disk recording system, that can be used to record, edit, and mix audio.

Digital Delay
See delay.

Digital Effects Processor
A device or type of software that applies various types of effects processing — such as reverberation, chorusing, doubling, etc. — to an audio source. Uses DSP technology to perform its functions.
Distortion
Occurs when usually unwanted components are added to a sound, often as a result of clipping. (Some types of distortion are desirable, such as the “warm” clipped sound of an electric guitar amplifier, but most are not.) Analog audio distortion is most common, but digital equipment can be susceptible to distortion, especially in the A/D and D/A converters. Most equipment specifications include two common types of analog distortion: harmonic distortion and intermodulation distortion.

Doubling
An effect similar to an echo, but with only a single “slapback” of sound. The result is something that sounds as if there are two of the original source. In Pro Tools, a track or region can be doubled by copying it and pasting the copy onto a new track, and then “slipping” the new track roughly 1/20 to 1/2 of a second (50 to 500 milliseconds) behind in time. Using a digital effects processor, a track can be doubled with a delay setting of 50 to 500ms.

Drop-Frame
Refers to a variance of SMPTE/EBU timecode which omits two frames every minute except for every tenth minute. Serves to compensate for the fact that 29.97 frame-rate timecode runs “slow” by 3.6 seconds every hour compared to a 30 frame-per-second timing reference; that is, “one hour” of 29.97 non-drop timecode is equal to one hour and 3.6 seconds of real time, due to the fact that the slower frame rate does not match “wall clock.” Dropping — or more descriptively, skipping — frames allows this format to “jump ahead,” in order to maintain a true relationship between the timecode and “real time,” so that one hour of 29.97 drop-fame does indeed last exactly one hour of real time.

DSP
Digital Signal Processing. In audio terms, DSP refers to manipulation of digital audio — everything from reverberation to changes in level.

Duplicate
A Pro Tools function that allows you to duplicate a region in the Edit Window. Unlike the copy function — where the region is held in the Macintosh's Clipboard memory until it is pasted — duplicate automatically places a copy of the selected region adjacent to it. Duplicate is useful for repeating regions, such as a repeated musical passage, sound effect, and so forth.

Dynamic Range
The variation between a signal’s quiet and loud passages, measured in decibels. Consider a symphony orchestra, which is capable of great dynamic variation. At its loudest, the typical orchestra may be able to produce roughly 110 to 115dB (using the “acoustic” dBA scale for decibels, the same sort of scale that’s used for measuring the noise of a
jet aircraft). At its quietest moments, perhaps the most pianissimo flute passage, the orchestra may measure only 50dB. (Any quieter, and the flute would probably be drowned out by the "ambient" noise of the concert hall, caused mostly by the hall's air conditioning and other background noise.) Given this span, we could say this orchestra has a dynamic range of roughly 60 to 65dB; if we include the portions when the orchestra is silent, and all we're left with is the ambient sound of the hall, the dynamic range could then be over 80dB. Even this, however, is well within the capabilities of 16-bit audio — which has a dynamic range of 96dB.

Dynamic range is similar to, but not the same as, signal-to-noise ratio. Also see bit-rate resolution.

**Echo**
A type of audio processing that many digital effects processors and certain types of software can perform, and a variation of delay. An echo is one or more distinctly audible repetitions of a portion of sound. Unlike delay, however, which can be as "short" as 1/2000 of a second (0.5ms), echo is usually no shorter than 1/20 of a second (50ms), since times less than that no longer sound like a distinct repetition. Multiple echoes are achieved using a feedback control, which sends the first echo (and if desired, subsequent ones) back into the delay-generating process.

**Edit Window**
In Pro Tools, the Edit window is where regions and tracks can be arranged, for moving sound about in time; for copying, pasting, duplicating, or cutting regions; and more. In the Edit window, tracks appear as graphic waveforms. As in the Mix window, each track has controls for audio record-enable, automation record-enable, and mute/solo.

The Edit, Mix, and Transport windows are Pro Tools' three main control environments.

**Effects Send**
Mixing consoles (and some DAWs) include effects sends, which allow you to route the signal from individual channels to an external effects device (such as a digital effects processor). Pro Tools Project and 442 systems provide effect sends. Pro Tools AM II and Pro Tools PowerTracks do not include true effects sends, although a means of adding external effects is described in Chapter G, Mixing.

**Eighth-Inch (1/8") Connector**
Also called a miniphone connector, miniplug connector, just a mini connector. This relatively small connector is used most commonly as an inexpensive input or output connector for analog audio. For instance, a stereo 1/8" connector is commonly used as a headphone output jack on CD-ROM players, portable stereos, and inexpensive sound cards, or as a microphone or line level input jack on sound cards. Apple PowerPC- and Quadra AV-series computers use 1/8" connectors for their analog audio inputs and outputs.
Electret Microphone
See Condenser Microphone.

Equalization (EQ); Equalizer (EQ)
The process of cutting or boosting one or more areas of a particular sound’s frequency range. EQ is generally used as a tone-shaping tool — for instance, to increase bass, decrease treble, or bring out a particular “brightness” or other tonal characteristic. EQ works by boosting or cutting specific frequency ranges. The bass and treble controls of a home or car stereo are what is called a 2-band equalizer; add a mid-range control and you have a 3-band EQ. (Pro Tools provides two bands of EQ per track.)

Pro Tools provides five types of EQs. Each EQ has controls for selecting the EQ type, Gain (the amount the frequencies are cut or boosted), Frequency (the specific frequency to be cut or boosted), and a Bypass button for disabling the EQ. In the case of the parametric EQ, an EQ Bandwidth selector is also included (for choosing how wide a range of frequencies will be affected). Also see Low-Shelf EQ; High-Shelf EQ; Parametric EQ; High-Pass EQ; and Low-Pass EQ.

A graphic EQ is another common type of EQ. “Outboard” graphic EQ signal processors usually have five to 30 bands of EQ, each with a fixed frequency. They’re called “graphic” because they usually use slider-type controls, and when you view them as a whole you get a graphic representation of how the sound’s frequency range is being affected by the processor.

Expander
A type of signal processor that effectively increases a signal’s dynamic range; in some ways the opposite of a compressor. An expander can be used to make quiet passages that drop below a preset “threshold” level sound quieter, and is an effective means of reducing unwanted sounds, such as tape hiss, background rustling of papers, and so forth. An expander set to operate in an extreme mode is also called a gate, which effectively silences signals that drop below the preset threshold level.

Fade
[verb] Normally synonymous with “fade-out” — to reduce the playback level of one or more tracks. Fading is performed using either an external mixing console, or (with Pro Tools or most other DAWs) the onscreen faders within the Mix window, or Pro Tools’ “fade” function.

Fade; Fade-In; Fade-Out
[noun] A section of audio where the level has been increased or reduced. A “fade-in” is where the level is raised from inaudibility; a “fade-out” is where the level has been reduced to inaudibility. With Pro Tools, fades can be accomplished using either automation, or using the “Fade” feature, where a region or portion of a region is selected, and raised or reduced in level using one of the program’s preset fades. As with crossfades,
portions of audio for which the fade function has been applied are stored in Pro Tools’ “Fade Files” folder.

**Fader**
Most commonly, a type of potentiometer found on a mixing console that controls individual channel levels. Faders are usually “linear” pots — that is, instead of working in a rotary fashion, they slide in a straight line. Digidesign’s Pro Tools, and most other DAWs, have onscreen “virtual” faders, that are manipulated either by a mouse or an external MIDI controller. Faders are usually calibrated to indicate the amount of boost or cut in decibels. With most systems, the lowest possible level is usually indicated as “-∞”, as in “infinite cut.” Highest levels are typically shown as “+3dB” to “+10”. The nominal level, sometimes referred to as “unity gain,” is represented as “0dB” — which is not the same as “no level at all.” Rather, a fader setting of 0dB is one which neither boosts nor cuts the audio level.

**Feedback**
The most common form of feedback occurs when a “live” microphone is brought near a loudspeaker or headphone: The mic picks up the loudspeaker, the signal is then re-amplified through the speaker, which gets picked up again by the mic — and on it goes, forming a squealing feedback “loop.” Consequently, whenever working with a microphone in the same room as monitor speakers, it’s important that the microphone’s monitor level signal be kept low or off. When working with headphones, “closed ear” or “semi-ported” headphones should be used, which form a relatively tight seal around one’s ears.

“Electronic” feedback is also a danger, especially with a mixing console, where the output of a device might accidentally be routed to the input of the same device.

**Filter**
Usually refers to a type of equalization designed to remove one or more of a sound source’s frequencies. See High-End Filter and Low-End Filter.

**Flanging**
A type of processing that many digital effects processors can create. A “swirling”-type effect, similar to chorusing but more intense. Flanging is also a modulated type of digital delay setting, with a delay of about 0.5 to 15 milliseconds.

**Frequency**
A means of describing how frequently a particular tone or sound source induces periodic cycles. We can hear these cycles as sound waves if they exist in the natural world — or if they have been amplified through a loudspeaker or headphones — and are within our frequency range of hearing. Frequency is usually measured in Hertz (Hz), the common term for cycles per second (cps).
Frequency Range
A range of frequencies, usually as they apply to a particular sound source, and usually expressed in Hertz. The frequency range of human hearing is generally considered 20Hz to 20,000Hz (20kHz) — but practically speaking, most adults' hearing is limited to an upper-end response of 12kHz to 16kHz.

Frequency Response
Most frequently refers to a specification that describes a particular component's ability to reproduce the frequency range of human hearing. Ideal response, in most circumstances, is so-called “flat” response, where all frequencies from 20Hz (or lower) to 20kHz (or higher) are reproduced with equal amplitude. It’s called flat because the chart of the frequencies on the horizontal axis, with the “deviation” on the vertical axis, would look like a flat line. Depending upon the standards applied, a deviation of anywhere from 0.1dB to 3dB can still be considered flat. For instance, flat frequency response with a deviation of 3dB would be indicated as “20Hz - 20kHz ±3dB”.

Gain
Boost (amplification) or a signal. See Signal Levels.

Gate
A type of signal processor. A gate is actually an expander set to operate in an extreme mode, so that signals which drop below a preset “threshold” level are effectively silenced. Whether used as an outboard processor or as a software program, a gate is a good way to eliminate occasional unwanted background sounds, such as breath noise, paper rustling, and so forth.

GB
Abbreviation for Gigabyte.

Gigabyte
One billion, or one thousand million, bytes (actually 1024 megabytes, or 1,073,741,824 bytes). A 1GB hard disk is generally a good minimum size for digital audio production purposes. Abbreviated GB or sometimes GByte.

Grabber
A tool within Pro Tools Software. The Grabber lets you move or rearrange regions simply by dragging them to a new location in a track.

Grid
Pro Tools’ Grid mode is a means of aligning regions in tracks to the nearest unit of a user-defined value. When Grid mode is on, the Selector will “snap to” the currently
selected grid mode value, and regions placed in the Edit window will also line up with the selected value. Grid mode is similar to the “quantizing” of note start times in MIDI sequencers, or the “Snap to Ruler” function of many page layout programs.

Grid Mode provides three types of external alignment references: alignment to time bases, alignment to the beginning and end of other regions, and alignment to beat markers. These external references create invisible “snap points” to which the start points (or user-defined Sync Points) of regions are attracted. See also Sync Points.

**Grouping**
The linking of two or more faders, in order to move them as a group; a feature common to automated mixing consoles, and many DAWs. Grouping, for instance, allows you to control the overall level of several tracks of background vocals — by moving just one fader, while retaining the same relative level of the different tracks. A collection of grouped faders can also be thought of as a “submix,” or a “subgroup.”

**Hard Disk (Hard Drive)**
A data storage device capable of holding relatively large amounts of data; named because the magnetic platter(s) upon which data is written are physically hard, as compared to a floppy disc, which uses a pliable, tape-like magnetic surface. For digital audio recording, typically one or more hard disks of 1 gigabyte or larger are in order.

**Hard Disk Recording**
Digital recording that records and plays back audio to and from a hard disk, as opposed to tape. A hard disk recording system is more commonly called a digital audio workstation (DAW).

**Harmonic Distortion**
A common type of distortion; sometimes called “THD,” for Total Harmonic Distortion. Refers to distortion that contains new frequencies that are harmonic multiples of the original sound’s frequency. Generally, most people can detect harmonic distortion when it reaches a level of 0.5 to 1% of the sound’s complete harmonic content, although most recording equipment has THD specifications of less than 0.1%.

Because of the essentially musical relationship between the original sound and its harmonic distortion components, this type of distortion is sometimes desirable, and is certainly less objectionable than intermodulation distortion. For instance, the “warm”-sounding distortion of a tube guitar amplifier is largely harmonic distortion.

**Headroom**
The amount of remaining gain available for a given signal before the onset of unacceptable distortion. Practically all analog audio devices (and all digital devices with A/D converters) have a specified amount of headroom for their inputs; most devices have roughly 10dB to 24dB of available headroom above their nominal input level (typically -10dBu or +4dBu). See Signal Levels.
Hertz (Hz)
The unit of measurement for frequency; also the same as cycles per second (cps). A thousand Hertz is referred to as kiloHertz, or kHz. Also see Frequency, Frequency Range, and Frequency Response.

High-End Filter
A type of equalization that reduces high frequencies. See Low-Pass Equalizer.

High-Pass Filter (EQ)
Effectively removes all frequencies below the selected frequency setting (called a "hinge" frequency), while allowing all other frequencies to pass through. Confusingly, also called a "low-end filter," since it filters out low frequencies, while letting higher frequencies pass.

High-Shelf Equalizer (EQ)
Boosts or cuts frequencies at or above the selected frequency setting (called a "shelf" frequency). Also see Equalization.

Hypercardioid Microphone
A more "extreme" version of a cardioid microphone, with even less sensitivity to sounds emanating from the side. This can be a good choice when background noise is a major problem, but it has two major trade-offs: 1) The mic has to point exactly at the sound source — if it or the sound source moves even a little bit, levels will drop dramatically; and 2) a hypercardioid design causes certain frequencies to be canceled, so the overall quality of sound is not as good as an equivalent cardioid mic. Also called "supercardioid."

IMD
See Intermodulation Distortion.

Impedance
A type of electronic "resistance" to signal flow, measured in "Ohms" (Ω). Impedance is also sometimes referred to as "Z" — as in low-Z (low impedance) or high-Z (high impedance).

The details of impedance are quite complicated, but there are several key things to know about it: 1) most balanced microphones and other professional-quality gear have low-impedance output signals, usually about 100Ω to 600Ω; 2) most musical instruments, home hi-fi equipment, and other unbalanced "semi-pro" gear (including many less expensive audio cards) have high-impedance output signals; and 3) most gear — whether home hi-fi, semi-pro, or professional — has high-impedance line inputs.

Here's how this knowledge helps you: Low-impedance output signals are designed to maintain signal quality over long cable lengths, even up to a hundred meters (330 feet)
or longer. High-impedance output signals, however, tend to lose high-end frequency response if the cabling is much more than 7 meters (23 feet), and perform poorly if the cable length approaches 15 meters (50 feet) or more. Consequently, in the typical project studio, high-impedance outputs are not necessarily a liability, but since they are almost always unbalanced, they may be more susceptible to noise than a low-impedance output (which is often, but not always, balanced).

Regarding line input impedance, equipment used to be designed such that low-impedance outputs were always to be connected to low-impedance inputs, and that high-impedance outputs were always to be connected to high-impedance inputs. As mentioned above, however, most current gear utilizes high-impedance inputs. To figure out whether or not one type of gear will connect properly to another, remember this rule of thumb: Low into high will fly; high into low won't go. In other words, low-impedance output signals can be plugged into either low or high-impedance inputs, whereas high-impedance output signals require high-impedance inputs.

**Intermodulation Distortion (IMD)**
Unlike harmonic distortion, which in some situations is considered “warm” and desirable, intermodulation distortion is a particularly nasty-sounding form of distortion. The main difference is that whereas the components of harmonic distortion have a “musical” relationship to one another, the components of IMD have a dissonant, “enharmonic” relationship. This also explains why our ears are more sensitive to IMD, and are generally able to detect as little as 0.01% to 0.1% of it, in relation to the non-distorted signal. Most quality gear has a spec of less than 0.005% IMD.

**I/O**
Abbreviation for Input/Output. “I/Os” is an abbreviation for Inputs/Outputs.

**Jack**
A “female”-style connector, typically an input. Plugs connect to jacks.

**kB**
Abbreviation for Kilobyte.

**kHz**
Abbreviation for kiloHertz.

**Kilobyte**
One-thousand bytes (actually 1,024 bytes). Abbreviated kB or sometimes kByte.

**KiloHertz**
1,000 Hertz. Also see Frequency, Frequency Range, and Frequency Response.
**Level Meters**
See VU; VU Meters

**Limiter**
See Compressor/Limiter.

**Line Levels**
See Signal Levels.

**Low-End Filter**
A type of equalization that reduces low frequencies. See High-Pass Equalizer.

**Low-Pass Filter (EQ)**
Effectively removes all frequencies above the selected frequency setting (called the “hinge” frequency) while allowing remaining frequencies to pass through. Confusingly, also called a “high-end filter,” since it filters out high frequencies, while letting lower frequencies pass.

**Low-Shelf Equalizer (EQ)**
Boosts or cuts frequencies at or below the selected frequency setting (called a “shelf” frequency). Also see Equalization.

**Marker**
See autolocation.

**Mastering**
1) The process of mixdown. 2) The final stage of preparing audio for replication as a compact disc, CD-ROM disc, vinyl record, or analog tape. A “mastering house” is a facility that specializes in this process.

**Mastering Deck**
A 2-track (stereo) audio recorder, typically to which a multitrack recording is mixed. Common mastering decks include a DAT deck, an open-reel analog tape machine, or even an analog cassette recorder.

**MB**
Common abbreviation for megabyte.

**Megabyte**
One million bytes (actually 1024 kilobytes, or 1,048,576 bytes). Abbreviated as MB or sometimes MByte.
Microphone
See cardioid, hypercardioid, and omnidirectional microphone.

Microphone Preamplifier
See Preamplifier

MIDI
The Musical Instrument Digital Interface standard, which is a language that musical instruments, recording equipment, and computers can use to communicate information back and forth. MIDI uses 5-pin “DIN” connectors. Computer-based DAWs, such as Digidesign’s Pro Tools, use MIDI to communicate time code information, Mix window fader levels, and much more.

MIDI Channel
MIDI utilizes 16 different channels. Much like a television, a MIDI device typically is set to receive (or transmit) information on only one channel at a time — although most MIDI devices can actually handle multiple channels of information at once.

MIDI Controller
An external device that uses MIDI information to manipulate a MIDI device. For instance, Digidesign’s R1 or JL Cooper’s FaderMaster have physical faders. Using MIDI, these devices can generate “continuous controller” information that can be used to adjust the levels of on-screen Mix window faders in Pro Tools. Similarly, “switch controller” information can be used so that physical buttons can control on-screen buttons, such as solo, mute, and so forth.

MIDI Timecode
See MTC.

Mini Connector
See Eighth-Inch Connector

Mixing Console
A device that allows you to sum together the signals from two or more channels of audio. Most mixing consoles have between four and 32 channels. Typically, each channel has two or more bands of equalization, plus several effects sends, a pan control, a fader, microphone and line-level inputs, level meters, and more.

Mix Window
In Pro Tools, the Mix window has controls that perform most of the functions of a true mixing console. The Mix window is used to record tracks and adjust monitor and mixdown levels, equalization, and more. Each of Pro Tools’ tracks has its own controls for
monitor level, record-enable, pan, solo, mute, bounce to/from, and more.

The Edit, Mix, and Transport windows are Pro Tools’ three main control environments.

Mixdown
The last stage of an audio recording project, where, typically, multiple tracks of audio are mixed together to a stereo DAT cassette, an analog cassette, an open-reel tape, or an audio file on a hard disk. During mixdown, final decisions are made regarding the relative levels of different tracks, EQ settings, automation, panning, any digital effects processing, and more.

Monaural (Mono)
Sound with just a single channel of information. Even if played back on a stereo system with two speakers, a mono tape, track, or audio file will playback the same information through both speakers. (Assuming the pan and balance controls are “centered.”) With Pro Tools (or any DAW), mono audio files take up half as much hard disk space as equivalent stereo audio files.

Monitor Level
Refers to the level at which one listens to one or more tracks, or a complete mix. On a mixing console, the monitor level adjusts the level sent to headphones, or to a power amp, which in turn drives monitor speakers.

In DAWs such as Pro Tools, monitor level controls can be used to adjust the level at which you listen to different tracks. They have no bearing upon record level. The collection of different control settings forms a “monitor mix.”

Monitor Mix
See Monitor Level.

Monitor Speakers
Loudspeakers designed for recording studio use. Professional studio monitors are designed to be as “accurate” as possible, with as flat a frequency response as possible. This contrasts to many home stereo speakers — and almost all “multimedia” speakers — which often are designed to emphasize bass and treble response. Many monitor speakers are also shielded.

MTC
MIDI Timecode. An industry standard for transmitting the MIDI equivalent of SMPTE/EBU timecode between devices. While not the same as SMPTE timecode (it’s a digital, rather than analog signal, for one), a SMPTE-to-MTC converter can be used to bridge the gap. MTC can follow all the frame-per-second rates of SMPTE timecode.
Multitrack Recording
The process of recording different passages of audio or music on more than one discrete track. Multitrack recording allows for “overdubbing,” where a new track or part can be added to a track that has already been recorded. There are various types of multitrack recording systems, from tape recorders (with any where from four to 48 tracks), to MIDI sequencers (which usually have dozens of available tracks), to DAWs (which offer anywhere from two to 96 or more tracks).

Some DAWs differentiate between the number of available “simultaneous” tracks and “virtual” tracks. Simultaneous tracks refer to how many tracks can be heard playing at once — which is a limitation of the number of voices that the DAW has available. Virtual tracks, however, refer to those tracks that can assembled within an Edit window, but which are not necessarily heard during playback. Virtual tracks allow you to keep a number of different “takes,” or edits of audio onscreen, and to assign them an available voice when you wish to hear them.

Mute
A common mixing console feature that is used to remove one or more channels from the mix, so that they are no longer heard. Digidesign’s Pro Tools includes a mute function for each of its tracks.

Noise Gate
See Gate.

Nondestructive Editing
Editing that leaves audio files intact. As you edit audio within Pro Tools, all you are editing are the regions, or “pointers,” to audio files that are stored on the hard disk. This is called “nondestructive” editing because the original audio files are always left intact (unless you choose to delete them, or overwrite them with new files that are based upon edited regions). This way, you can edit to your heart’s delight, and always return to the original audio files if necessary.

Nondestructive Recording
Recording that leaves previously recorded takes intact. You can switch Pro Tools between destructive and nondestructive recording. When recording nondestructively, as you record each new take, previous takes are left on the hard disk as separate audio files, allowing you to return to a previous take (or portions of a previous take) whenever you so desire — unless you choose to delete your previous takes. The one disadvantage of nondestructive recording is that you may need lots of hard disk space, particularly if your takes are long and numerous.

Non-Drop-Frame
Timecode in which frames haven’t been “dropped.” The standard format outside of color video production or post-production is typically 30 FPS non-drop.
**Omnidirectional Microphone**
A microphone that is equally sensitive to sound from almost all directions. An omnidirectional mic is a good choice when you only have one mic and you want to pick up sound from a variety of directions (such as roundtable discussion). This benefit is also the main drawback of an omnidirectional mic, since unwanted background noises — from cars to dogs to an airplane overhead — can be picked up easily.

**OMS**
Open Music System, developed by Opcode. OMS handles “background” MIDI issues, such as tempo and synchronization, and shares the information between OMS-compatible programs, such as Pro Tools. Using OMS, for instance, Pro Tools can communicate with and synchronize to such full-featured sequencing software packages as Opcode’s Vision™, Passport’s MasterTracks Pro™, Mark of the Unicorn’s Performer™, Emagic’s Logic™ and Steinberg’s Cubase™. For instance, OMS allows you to record Pro Tools tracks while you listen to a previously recorded MIDI sequence.

**Response Pattern**
Also known as polar response pattern. Describes the shape of a microphone’s sensitivity to sound. The three main patterns are cardioid (unidirectional), hypercardioid (supercardioid), and omnidirectional.

**Pan Control**
A mixer-style control which allows you to place a particular track or sound within the stereo field, from left to center to right. Pro Tools includes pan controls on each channel within the Mixer window. Pan stands for “panorama.” Often referred to as a pan “pot” — see Potentiometer.

**Parametric Equalization (EQ)**
Boosts or cuts only those frequencies centered around a selected frequency setting. In Pro Tools, a pop-up menu allows you to select the width (from 1/3 to 3 octaves) of the parametric EQ. This determines the width of the filter’s overall slope—from a broad “bell” shape to a narrow “notch.” Also see Equalization.

**Paste**
A Pro Tools function that allows you to place regions that have been cut or copied back into a track in the Edit window. Cut and copied regions are held in the Macintosh’s Clipboard memory until they are pasted, or until something new is copied or cut into the Clipboard.

**Patch Cord**
A cable that links an input and an output; typically a short cable, as would be used with a patchbay.
Patchbay
Essentially, a “switchboard” of inputs and outputs; a common studio accessory. Typically, device outputs and inputs are all connected to the rear of one or more patchbays. The rear-panel connectors also show up on the front of the patchbay, where the various inputs and outputs can be labeled. This way, using patch cords, devices can be quickly and easily connected together, without having to scramble around behind different pieces of gear. The most convenient types of patchbays for general use utilize 1/4” unbalanced (or TRS balanced) jacks on both the front and rear panels.

Peak Indicator
An indicator light designed to warn of the possibility of clipping, which illuminates as a device’s input reaches a preset degree of headroom. Usually part of a VU meter (on a mixing console).

Phantom Power
A type of DC power (usually 48 volts) that is used to power many condenser and some electret microphones. See condenser microphone for more information.

Phase
Refers to the relationship of audio signals, in terms of time. If two identical audio signals originate from the same source at the same time, they will travel through air “in-phase,” so that the sound wave “peaks” and “troughs” rise and fall at the same time. When two in-phase signals are combined, their signal level is essentially doubled. If, however, the two sounds are “out-of-phase,” so that as one sound wave peaks the other troughs, when combined, they will cancel each other out — so that neither signal can be heard. Balanced audio uses principals of phase to help reduce noise.

Phone Connector
Another name for Quarter-Inch Connector.; comes from the fact that these connectors were used when telephone companies still operated manual switchboards.

Phono Connector
Another name for RCA Connector; comes from “phonograph.”

Plug
A “male”-shaped connector, typically found at the end of a cable. Plugs plug into jacks.

Potentiometer (Pot)
A type of control, commonly found on mixing consoles, outboard effects processors, and so forth, that varies resistance in order to control pan, level, EQ, etc. A fader is a common type of potentiometer. Usually abbreviated as a “pot.”


**Power Amplifier**
In the recording studio, a power amplifier uses high current to raise line-level signals — usually from a mixing console, audio card, or audio interface — up to a level suitable to power monitor speakers. Most studio power amps are stereo, or 2-channel, devices. In most personal studio applications, a home stereo receiver or power amplifier can substitute for a professional amp. Suitable power ranges run from about 30 watts per channel (for relatively quiet listening situations) to 100 watts or more per channel. While it is desirable to match a power amp’s output to your monitor speakers’ rated power, it is actually better to somewhat overpower your speakers than underpower them, since too little power can introduce momentary clipping, which can damage monitor speakers more readily than momentary overpowering.

**Preamplifier**
In recording studio terminology, a circuit designed to boost relatively low signal levels, such as a microphone output, up to standard line levels of -10dBu or +4dBu. Practically all mixing consoles include preamplifier stages in each of their input channels.

**Quarter-Inch (1/4”) Connector**
A very common type of connector found in the project studio, usually used for unbalanced analog audio connections. A variation, called the TRS connector, provides for either balanced or stereo operation. Also called a phone connector.

**QuickTime**
Apple's system extension for control of time-based events, such as digitized video “movies” and digitized sound. Originally developed for the Macintosh platform, QuickTime is also available for Windows. QuickTime movies can be converted to or from ordinary video with a "video capture card," or with an "A/V"-equipped computer, such as the Quadra 840AV.

**RCA Connector**
A type of connector used most commonly with home stereo setups, but also found commonly with multimedia and project studio equipment. The RCA connector’s historical application has been for unbalanced analog audio, but it is also used commonly for “composite” video and also S/PDIF digital audio connections. Also called Phono Connector.

**Record Enable**
Within Pro Tools, an onscreen button that prepares a track to be recorded. Recording begins once the record button in the Transport window has been selected and the play button is engaged.
**Record Level**
Within Pro Tools, the level at which individual tracks are recorded. Pro Tools itself does not have a means of controlling input and record levels (they're determined either by the mixer or other sound source that is feeding your digital audio card or Power Mac computer). During recording, it's important to use Pro Tools' level meters to help you adjust your mixer's (or other sound source's) output level, to avoid clipping.

**Region**
Within Pro Tools, a region is a “pointer” to a particular audio file or portion of an audio file. Regions can be dragged from the Audio Regions List into a track. As the program plays back, a region instructs Pro Tools to play its associated audio — either an entire audio file, or, if any editing has been performed, a user-defined portion of an audio file.

**Regions List**
A holding area for any regions that you create. Regions can be dragged from the Audio Regions List into a track and arranged as desired.

**Resize**
See Trim.

**Reverberation; Reverb**
A type of processing that many digital effects processors and some DSP programs can create. Reverb adds a sense of ambience to recordings, simulating how sound reflects around and reverberates within concert halls, cathedrals, arenas, and even such pedestrian spaces as a shower stall or coffin. Technically speaking, reverb is similar to delay, but the sound is generally diffuse, so that no individual echoes or other reflections are distinct. Reverb processing simulates “early reflections” — those reflections of sound that would be amongst the first to reach our ears in a concert hall or other space — as well as later reflections. Natural reverb settings have a decay, or duration, of up to a second or two.

In practice, judicious use of reverb is an excellent way to add a professional “sheen” to a production, but too much reverb — or too long a decay setting — can “muddy” a production’s sound, making everything indistinct and lost in a “wash” of reverb.

**Sample Rate**
Sample rate is one of two main specifications that describe digital audio quality (the other is bit-rate resolution). In digital audio, sample rate refers to how frequently incoming audio is “sampled” as its converted from an analog to a digital signal. A sample is like an instantaneous “snapshot” of sound; if you take lots of snapshots and string them together, you can get an accurate representation of what’s going on, sound wise — just like a movie is a strung-together collection of pictures. High-quality audio is usually sampled 44,100 times, or cycles, per second, and is often referred to as a “44.1 kiloHertz” (44.1kHz) sample rate. Some people use a higher sample rate of 48kHz, but
this has to be “sample rate converted” if it’s to be used on an audio CD, so it’s generally preferable to stick to 44.1kHz. Lower sample rates are also possible: Broadcasters sometimes work at a 32kHz rate, and many games and other multimedia programs use audio sampled at a 22kHz or even 11kHz rate.

Why all these different rates? Sample rate has a direct bearing on two things: audio quality, and file size. In terms of quality, the sample rate is what defines the upper frequency response of audio; for reasons that are a bit too technical for the scope of this glossary, the upper frequency response is roughly half the sample rate. For instance, 44.1kHz sampled audio has a frequency range of up to 22kHz — somewhat beyond most people's hearing range. Audio sampled at an 11kHz rate, however, has a frequency range of up to 5.5kHz — which, consequently, will sound a bit “muffled” to almost everyone's ears. (The typical telephone connection is good to about 6kHz.) On the other hand, a one-minute 16-bit 44.1kHz-sampled mono file takes up roughly 5MB of hard disk space, whereas a one-minute 16-bit 22kHz file will use roughly half as much space. As usual in life, it’s a trade-off between quality and quantity. Also see Bit-Rate Resolution.

SCSI
Small Computer System Interface, a standard means of connecting hard disks, scanners, and other important peripherals to personal computers, especially Macintosh computers. The basic SCSI specification allows up to seven devices to be connected to a SCSI “chain,” usually via 25-pin and 50-pin SCSI connectors. The last device physically connected to the SCSI chain needs to be “terminated,” either through an electronic switch, or more commonly, with a terminator block that is attached to one of the device’s SCSI connectors. Pro Tools Project (as well as PT III/TDM systems) provide their own SCSI chain for attaching external hard disks directly to the Pro Tools audio cards.

Seek Time
Refers to the average time it takes the heads of a hard disk to locate a desired portion of data. Digital audio applications — such as Pro Tools — require seek times in the neighborhood of 18 milliseconds or faster, depending upon how many tracks are being played back at once.

Selector
A tool within Pro Tools. The Selector lets you select regions or portions of regions with an “I-beam”-like tool, in order, for instance, to cut, copy, or paste.

Sequencer
A MIDI-based computer program (or stand-alone device) that records MIDI data such as notes, duration, and so forth. A MIDI sequencer is essentially a multitrack recording system for synthesizers, drum machines, and other MIDI-capable devices. Using OMS, Pro Tools can communicate with, and work in tandem with, a MIDI sequencer.
Session
1) a working session file, much like a word processing document or a graphics program file. Each separate project you work on should be stored as its own session;
2) Digidesign’s software-only audio production program (i.e., “Session™ Software”), available separately from Digidesign dealers.

Shielded Monitor Speakers
Most loudspeaker designs utilize large magnets, which — when placed near a computer video display — can bend and otherwise distort onscreen images. Many professional monitor speakers, consequently, are shielded with an internal antimagnetic barrier or foil, which allows them to be placed directly adjacent to a video monitor with no visual distortion.

Signal Levels
There are a wide range of different audio signals, from the relatively faint level that comes directly from a microphone to the sometimes dangerously high-voltage signal that travels out of a power amp on its way to a loudspeaker. (While digital audio signals travel through wiring at measurable levels, the levels we’ll discuss here — and the only ones you need to worry about — are all analog levels, because digital levels are generally standardized.)

There are also a wide range of ways to measure signal level, though most are some variation of the decibel (dB), such as dBV (typically used for home stereo and other “semi-pro,” unbalanced gear; dBm (for professional, balanced gear); and dBA (for measurement of acoustic sounds, like that jackhammer outside your window that you’d like to report to the proper authorities). The actual differences between these various levels are more complicated than anyone other than a professional engineer needs to understand, but fortunately, there is a common scale that we can use — the “dBu” (also known as dBv, which is not to be confused with dBV; we told you this could get complicated).

In a nutshell, microphone signals are at the bottom of the scale, pumping out a puny -60 to -50dBu (-50dBu is a higher signal than -60dBu). The next step is “instrument level,” such as the level produced by an electric guitar; this ranges in the -50dBu to -20dBu range. Now we come to “line level” signals, which refer to the most common connections between components. Most home stereos, semi-pro recording systems, computer sound cards, and other such unbalanced products operate at a “nominal” line level of -10dBu. (We say nominal because the actual levels vary as output levels vary; -10dBu represents the theoretical maximum line level, although almost every -10dBu product can produce or receive levels as high as -5dBu, 0dBu, or higher; see headroom.)

Next stop on our way up the chain: +4dBu, which is the nominal line level for most professional balanced gear. As long as we’re using the dBu scale, a +4 product’s line level can be said to be 14 decibels “hotter” (stronger) than a -10dBu product, which — all other things being equal — translates to a somewhat better signal-to-noise (S/N) ratio. Finally, some broadcasters set their gear to operate at +8dBu. Most electronic keyboards,
drum machines, and other MIDI gear, by the way, have variable outputs that go up to -10dBu, 0dBu, or even +4dBu.

It's always important to match output signals to the proper type of input, to avoid a level mismatch. For instance, if you plug the +4dBu output of a pro-quality effects box into a microphone input, you'll almost certainly overload the input, and cause distortion. If you connect a low level signal — like the output of an electric guitar — into a -10dBu line level input, you'll probably hear something, but it will be so faint that you'll need to crank up the input, which means you'll hear an excess of noise. This is why microphones should always be connected to a microphone-level input, and why line level-devices should always be connected to the proper line-level input. If in doubt, check with your dealer or the product manufacturer.

Mixing consoles, digital audio workstations, and other audio equipment typically use VU meters to measure relative differences in level.

**Signal Processor**

An “outboard” analog or digital box — or type of software — that processes sound in one or more specialized ways, such as an equalizer, a delay, and so forth.

**Signal-To-Noise Ratio (S/N Ratio)**

Similar to dynamic range. Whereas dynamic range describes the span between a signal’s lowest and highest possible levels, the S/N ratio describes the span between a signal’s highest (or near-highest) level and the average “residual” noise of the device which is being measured. Effectively, the S/N ratio describes how “quiet” a signal is — how free it is of hiss, hum, and other relatively continuous noise. The S/N ratio is expressed in decibels; the higher the number, the better. Professional digital products usually exhibit a S/N ratio of 85dB to 93dB; analog cassette recordings, on the other hand, might exhibit a S/N ratio of 45dB to 75dB, depending upon the type of noise reduction used (if any).

Sometimes, you’ll find specifications that are expressed simply as signal-to-noise (without the ratio part). In this case, the figures are shown in “−” decibels, which reflect how many decibels lower the noise is compared to the signal. In this case, for instance, we would say that professional digital products usually exhibit a S/N specification of -85dB to -93dB.

**SMPTE/EBU Timecode**

The standard timecode of the Society of Motion Picture and Television Engineers/ European Broadcasters’ Union. Divides time into hours:minutes:seconds:frames:subframes. Typical frame-per-second (fps) rates include 24 (film), 25 (European video), 29.97 (North American Color Video), and 30 (North American B&W video). 30fps timecode can be in drop-frame or non-drop-frame formats. Also see MTC.
**SND**
See Sound Resource File Format.

**Solo**
A common mixing console feature that is used to isolate one or more channels within the mix, so that they can be monitored alone — without hearing any tracks that have not been soloed. Solo is rather like the opposite of mute. Pro Tools includes a solo function for each of its tracks.

**Sound Card**
See audio card.

**Sound Designer II (SDII) File Format.**
One of the two most common high-quality digital audio file formats for the Macintosh. Created by Digidesign, the Sound Designer II format is used primarily for “CD quality audio” — 16-bit audio at a 44.1kHz sampling rate, although some users work at a 48kHz sampling rate. Named for Digidesign’s Sound Designer II professional audio editing program.

**Sound Resource (SND) File Format**
Apple’s sound resource file type, used primarily by the Macintosh System Software, and by some Macintosh software applications.

**Sources & Destinations**
In audio terms, signals are routed from sources (such as a microphone) to destinations (such as a microphone input on a mixer).

**S/PDIF Digital Interface**
Describes an industry standard for transferring digital audio between audio devices; essentially a “semi-pro” version of the AES/EBU standard. Stands for “Sony/Philips Digital Interface Format.” Most S/PDIF connections utilize an RCA connector, which is able to carry two channels of digital audio (as opposed to one channel of analog audio). All Pro Tools audio interfaces (888 I/O, 882 I/O, 882 Studio, 442 I/O) offer S/PDIF connections. Some audio cards, including Digidesign’s Audiomedia III, are equipped with S/PDIF I/Os.

**Spotting**
An audio post-production process of aligning audio events to visual events. Pro Tools has a Grid mode that allows you to spot regions to particular time code events.

**Stereo**
Audio comprised of two discrete channels — a left, and a right. “Stereophonic” hearing allows us to locate sounds within the stereo field. Also see pan control.
Stereo Field
An imaginary “sound stage” that defines the stereo panorama where a particular sound is placed — from left to center to right. Also see pan control.

Submix; Subgroup
See Grouping.

Superdirectional Microphone
See Hypercardioid Microphone.

Synchronization
The process of having two or more audio, video, or other devices run together at exactly the same speed (usually during playback, though sync during record, fast-wind, and “crawls” is possible). Professional applications require the use of an external or plug-in “transport synchronizer.” Pro Tools Project and Pro Tools 442 support the use of such devices. With Pro Tools AM II and/or PowerTracks, synchronization is usually performed either between Pro Tools and a sequencer using OMS, or in Trigger Sync mode, where an external SMPTE-to-MTC converter (such as Opcode’s Studio 4 interface) sends a “start” signal to the DAW at a predetermined start time.

Sync Point
A user-defined point within a region which defines where and how that region will be placed, for instance, when moved within a grid, or when spotted to a particular time.

Take
[noun] Originally a term from film production (as in “Scene 7, Take 3”), recording engineers have expropriated it to refer to each attempt, however successful, at recording a desired section of audio or music. For instance, a musician attempting to record an important musical solo, or an actor attempting a voice-over, frequently will require several takes before successfully “nailing” the right one. Through careful editing, a final track can be assembled from a variety of takes, using portions of a variety of takes. With Pro Tools’ nondestructive recording capabilities, multiple takes can be recorded on each track.

Terminator Block
A small accessory that is usually attached to the last device in a SCSI chain.

THD
Total Harmonic Distortion; see Harmonic Distortion.

Thermal Recalibration
Some hard disks, particularly older ones, perform a function called thermal recalibration, which can interrupt the recording or playback of digital audio or video files. This happens when the hard disk’s internal platter(s) expand slightly from the heat generated by continual use, which in turn causes the hard disk to pause momen-
tarily to recalibrate the relationship of the head to the platter. Hard disks that are
certified “A/V compatible” defer thermal recalibration to low activity periods. Drives
with “embedded servo” are free of thermal recalibration, and are the best choice for use
with any DAW, including Pro Tools.

Track
Refers originally to a continuous longitudinal (lengthwise) strip of a magnetic tape that
would hold an audio recording. Tape designed for stereo recording has two tracks (or
four tracks, if it’s designed to be flipped over to record on a second “side”, such as with
an analog audio cassette). In recent years, a track has expanded beyond tape, and
beyond this literal definition. A typical MIDI sequencer, for instance, can record dozens
of MIDI tracks, usually overdubs of one or more MIDI instruments, with each track on a
different MIDI channel. A DAW, on the other hand, can also record overdubs of different
audio or musical events on multiple different tracks. (Pro Tools’ number of available
tracks varies depending upon the type of computer and audio card being used.) Also see
Multitrack Recording.

Transport Window
Within Pro Tools, the Transport window contains controls for Online, Return to Zero,
Rewind, Stop, Play, Fast Forward, and Record. The Transport also contains controls for
creating autolocate markers, which allow you to quickly navigate to a desired point in a
recording.

TRS (Tip-Ring-Sleeve) Connector
Most commonly, a balanced version of a 1/4” connector, in which the “tip” of the plug
is “hot,” the “ring” is “cold,” and the “sleeve” is the ground. TRS connectors can also be
used as stereo connectors, where the tip is usually “right channel,” the ring is “left,”
and the sleeve is “ground.” The standard headphone plug, as found with home stereo
headphones and receivers, is a 1/4” TRS stereo plug. (The connector found on most
portable stereos is typically an 1/8” TRS stereo plug.)

Unbalanced Audio
See Balanced & Unbalanced Audio.

Unidirectional Microphone
See Cardioid Microphone.

Virtual Track
An onscreen track that isn’t assigned a voice. See Multitrack Recording.

Voices
With a DAW, this refers to the number of tracks that can be played back simulta-
neously. See Multitrack Recording.
VTR
A video tape recorder. Professionals use this term instead of “VCR” (for video cassette recorder) since some professional VTRs use open-reel tape instead of cassette tape.

VU; VU Meter
Stands for Volume Unit. Recording equipment and programs such as Pro Tools use VU meters to indicate relative signal levels. Each device's VU meters are usually calibrated so that “0VU” represents a signal with the same level as the device's nominal operating level.

For instance, when a -10dBu device (such as an Audiomedia III card, or a home stereo analog cassette recorder) receives a signal of -10dBu strength, its input meters will indicate a level of 0VU. If the same device receives a signal of -25dBu strength, its input meters will indicate -15dBu. Alternately, when a professional-style +4dBu device (such as Pro Tools, with the 882 audio interface) receives a signal of +4dBu strength, its input meters will indicate 0VU. If the same device were to receive a signal of +7dBu strength, its input meters will indicate +3VU.

VU meters are usually calibrated from a low of -40VU or -20VU to a high of about +6VU or +10VU.

.WAV
Pronounced “wave”; Microsoft's Audio File Format for Windows. Many Windows software applications, and some Mac applications, support this file format.

Waveform
A means of visually representing a sound. When sound regions are imported into Pro Tools' Edit window, they can be viewed in waveform mode, which displays the changing amplitude of the region over time. Waveform display is very useful for editing sounds; an unwanted click, for instance, may appear as a sharp “spike” in the waveform, allowing you to select it and cut it.

XLR (3-pin) Connector
A common connector for professional audio devices, that utilizes balanced audio connections. "Male"-style XLR connectors are used as audio output connectors, and have three pins. In most professional audio gear, pin 1 is universally the ground conductor; pin 2 is the “hot” conductor; and pin 3 the “cold” conductor. (See Balanced & Unbalanced Audio.) Some devices, however, reverse the roles of pins 2 and 3. "Female"-style XLR connectors are used as audio inputs, and have three holes to accommodate the male connector's pins. Also called “Canon” connector, for the brand name owned by ITT Corporation.

Z
Another term for impedance.
Zoom
A function within Digidesign’s Pro Tools program, that allows you to view waveform displays within the Edit window with greater detail.
Index
Index

Symbols

#Playback Tracks 28, 31
-∞ 348
2-3 pulldown 228
882 Studio 24
  and "Route" dialog 122, 264

A

Abbreviated Region names 202
Active in Background 234, 245, 304
AIFF 319
Allocating tracks to hard drives 114
Analog 5
analog effects send/return loop 264
analog-to-digital converters 123
AppleCD Audio Player 130
archive 9
archiving soundfiles 9
Audio 5, 44
  adding to Sessions 44
  analog 5
  compacting 321
  Deleting from disk 321
digital 6
  recording 122
  selecting unused 320
Audio files
  icon associated with 42
  padding 321
Audio Files folder 9
Audio Interface
  and CD Recorders 127
  and DAT players 127
Audio regions
  icon associated with 42
Audio Regions List 73
Audio Track 53, 70
  creating a new 85
  auditioning files 43
  auditioning regions in the bin 74
Auditioning Tracks 151
Auto Spot Regions 242
Auto-Name Memory locations 311
Auto-Name Separated Regions 159, 297, 311
Auto-Spot Regions 304
Autolocate 76
  points 175
  redefining points 176
  renaming 176
Automating Mutes 137, 271
Automation 98, 268
  editing 199
  ignore automation command 270
  recording with QuickPunch 136, 270
  turning off 270
Automation Record Enable 55, 71
Average Case Scaling 287

B

Bars & Beats 106, 318
batch crossfade 135
batch Importing 44
bit resolution 6
black burst 221, 246
Bounce to Disk 287
Bouncing Tracks 271

C

Capture Region 158, 296
Capture Time Code 238
CD duplication 274
CD pre-mastering 274
CD Recorder
and Audio Interface 127
center line 148
CH 1,2 Input pop-up 24
Changing the Length of a Selection 154
Changing the location of a Sync point 244
Channels 11
Choosing a Synchronization Type 222
Clear 295
Clear Selected 205, 320
Clearing Regions 182
clip hold feature of meter 60
clip lights 115
Clipping 115
Close Session 285
Closing a Session 50
Color Code Tracks 104, 209, 311
and virtual tracks 104
Compact Selected 321
Compacting an Audio File 207
compressor 121
Compute Missing Overviews 311
Concepts of digital recording 8
defined 9
configuring routing (882 Studio) 24
Configuring your system 23
Project systems 24
contiguous recording 294
Control Surfaces 252
controller mapping 252
Copy 295
Copy Effect Parameters command 260
Copy Effects Parameters command 296
Copying and Pasting Plug-In Parameters 260
Copying Regions 180
Creating a Custom Session Template 47
Creating Audio Regions 158
Creating Audio Tracks 38
Creating Fade Ins/Outs 195
creating new tracks 84, 85
Crossfades 188, 300
between several regions 135
duration 300
crystal oscillators 220
current SMPTE time 243
current Time Code in Regions 317
Curve Combinations 191
Custom Session Template 47
Cut 295
Cutting Regions 179

D

DAE 7
DAE PowerMix 7, 11, 28
using 30
What is 7
DAT
and Audio Interface 127
recording from 127
DAT recorder
connecting 127
DC Offset 123
de-zippering 270
Delete audio command 321
Delete Track 86, 292
Deleting
Regions from a Playlist 164
Desktop 17
Destructive Record 125, 302
Digidesign Audio Engine 7
Digital audio 6
Digital EQ 253
Digital Format pop-up 24
digital sampling 6
Digital Source recording 127
digital-to-analog converters 123
Direct Outputs mode 94, 312
directory
hard disk 16
Disk Allocation 114, 307
dialog 114
Display 100
Configuring 100
Display Menu 315
Display Scale Arrows 64
Displaying Time in SMPTE 226
Distortion 115
Drag-drop (batch import) 44
Drop Outs
  Time Code 225
Duplicate 296
Duplicating Regions 183

E
Edit Menu 294
Edit Window 51, 62, 315
  setting length 208
Edit Window Default length 209, 311
  maximum length of 311
Editing 145
Editing Automation Data 199
Effects 262, 266, 267
  printing to disk 266
Effects Loops 262
Enter Original Time button 235
EQ
  subtractive 121
EQ (Inserts) 61
EQ types 255
EQing Specific Instruments 258
EQs (showing) 100
Erasing audio 321
essential concepts/definitions 9
Export MIDI 291
Export Selected 323
Export Selected command 45
Export Settings command 260
Exporting a MIDI File 140
Exporting Audio 211
Exporting region definitions 323
Exporting Regions 45

F
Fade Files folder 9
Fades 300
  fade in shapes 190
  fade ins/outs 195, 300
  fade out shapes 189
Fast-Forward 76
Feet + Frames 107, 318
  setup 314
File Menu 283
File Names in Region List 317
Film Transfer Pull Down 230
Format
  SMPTE 219, 312
Formatting a Drive 16
  fragmentation 15
frame rate 234
free-wheel 246
frequency 5

G
gate 121
Generate from Internal 231
Generating Time Code 231, 232
Get Info 47, 48, 49
  command 292
Go To End 76
Grabber 67
Grid 63
Grid Mode 64, 170
  region movement, effects on 171
Group/Ungroup Tracks 292

H
hard disk 6
Hard Disk maintenance 9, 15, 17
  initializing 16
  Optimizing 15
Hard Disk Volume Names in the Audio Regions List 203
Hardware 306
headroom 115
Heal Separation 297
Healing a Separation 161
Hide Tracks 315
High Pass EQ 255
high-shelf EQ 256
house sync 221, 246
Hz 6
I

I/O controls 39
I/O Labels command 113, 309
IAC Bus #1 233
IAC Driver 33, 233
Identify Beat 197, 298
Identify Silence 299
Identify/Remove Sync Point 298
Identifying Sync Points 243
Ignore Automation command 270, 304
Ignore Time Code Drop Outs command 225
Import Audio 289, 318
Import Audio command 42
auditioning in 43
batch importing (drag/drop) 44
Import MIDI 290, 319
Import Settings command 260
Importing a MIDI File 118
Importing and Exporting Plug-In Parameters 260
Initializing a Drive 16
Input Gain slider 26
Input Level Indicator 59
Input Levels 115
Input Selector 56
Insertion Follows Playback 152, 310
Insertion Follows Scrub 153, 310
Inserts 61, 100, 255
Integrating MIDI 116
Interface pop-up menu 24
interleaved Stereo file 287, 319
Internal CD 130

L

Labeling System Inputs and Outputs 113
linear recording 8
Loading Audio Regions 41
Lock/Unlock Region 245, 298
Locking Regions 172, 244
Longitudinal Time Code 218
Loop Selection 158, 303
looping playback 157, 158
Low Pass EQ 257
low-shelf EQ 257
LTC 218, 223

M

maintenance (hard drive) 9, 15
Managing Regions 202
mapping a MIDI controller 253
Mapping Transport Controls to a MIDI Controller 137
Master List 274
Mastering 275, 277
Mastering MIDI tracks to disk 275
meters
clip hold feature 60
Micro Lynx 228
MIDI 32, 33, 96
channels, setting 96
mixing to disk 275
New MIDI Tracks 38
volume 98
MIDI Channel Selector 58, 72
MIDI Channels, setting 96
MIDI Control Surface 34, 252
MIDI Controller 34, 87
mapping 252
MIDI interface 32, 33, 307
MIDI Metronome 308
MIDI Port Selector 58, 72
MIDI Quantize 301
MIDI Regions List 74, 319
MIDI sequencers
slaving to Pro Tools 233
MIDI Thru 34, 304
MIDI Time Code 234
MIDI TimePiece 222
MIDI Track 54, 70
creating a new 85
MIDI Transpose 302
Miking suggestions 121
Minutes:Seconds 106, 318
Mix Automation 268
Mix Window 51, 315
Mixdown 275
Mixes
  suggested techniques 251
Mixing MIDI to disk 275
Mixing Tips 252
Monitor Level Slide 59
monitor levels 123
  on Power Macs 123
Mono file 272, 287
Moving
  Regions 171
Moving Faders During Playback 311
Moving Regions 166
Mute 55
Mute Frees Voice 304
Mute/Unmute Region 298
Mutes
  automating 137, 271
Muting Tracks 97
Muting/Unmuting Regions 184

Name 85
Name Separated Regions command 203
Naming a Region 159
Naming tracks 38
New Audio Track 38, 84, 112
New Audio Tracks command 85, 288
New Auxiliary Inputs command 288
New Master Faders command 289
New MIDI Tracks 38, 84, 289
New Session 284
No Auto-Scrolling 311
No Scaling 287
non-destructive editing 8, 145
Nudge 171
Nudge/Grid pop-up 171, 173
Nudge/Grid Units Selector 68
Nudging Regions 173

OMS 33
  configuring for SMPTE Slave Driver 35
OMS Folder 233
OMS Setup and Patches 233
On-line 75, 237, 303
  recording 237
Open Music System (OMS) 33
  open an existing session 40
Open Selected in SD II command 211, 324
Open Session 285
Optimizing Your Drive 15
Options Menu 302
Original Time Code in Regions 235, 317
oscillators, crystal 220
Other Options 24
Output Mode 94
  choosing 94
direct 94
  stereo mix 94
Output Selector 56
  overviews 311

Padding audio files 321
Pan Graph 73
  viewing 103
Pan Indicator 59
Pan Slider 59
Panning 94, 98
  full right or full left 99
Paste 295
Paste Effect Parameters command 260
Paste Effects Parameters command 260, 296
Pasting Regions 181
peak/notch EQ 256
Peripherals command 308
Play 76
  looped 158
Play Point
  Moving 151
Playback
of a selected range 157
scrubbing 153
playback cursor
following playback 151
Playback Engine 26, 31, 93, 305
switching 40, 93
Playing an Audio Track 86
Playlist 10
deleing Regions from 164
placing a Region in 162
Playbackthrough 130
Position Indicator Box 67
Post Roll Playback 303
post-crossfade 132, 312
post-fader (sends) 39
Power Macintosh 28
configuring Pro Tools for 28
pre-crossfade 132, 312
Pre/Post Roll Playback 303
Pre/Post-Roll dialog 303
Preferences 49, 310
previewing audio files 43
Pro Tools
as sync master 231
Pull Down and Pull Up Sample Rates 227
pull down/up sample rate 229
Punch In/Out Time Indicators 77
punch-on-the-fly 303
Q
Quantize Region 301
Quantizing Audio 198
Quantizing MIDI 185
quartz crystal oscillators 220
QuickPunch 303
enabling 131
recording automation 136, 270
take numbering 136
using 131
with a Selection 133
QuickPunch Crossfade Length 132, 312
QuickPunch guidelines 133
QuickPunch Preference 132
Quit 293
Quitting a Session 50
R
RAM 8, 33
and System 7.5.2 33
random-access memory 8, 33
rebuilding the desktop 17
Recalibrate Inputs 123
Record 76
Record Enable Button 55, 71
Record On line at Time Code Lock com-
mand 238, 312
Record On-line At Insertion/Selection com-
mand 237, 312
Recording 122
punch in/out 200–202
Recording a MIDI Track 138
Recording Audio 116
Recording Audio From Audio CD 129
recording audio in stereo 126
Recording From a Digital Source 127
Recording MIDI 116
Recording MIDI to disk 275
Recording On-Line 237
Recording Techniques 121
recording time 9
Recording to Multiple Hard Drives 114
Reduce Track Size 102, 317
Region
locking 244
Region Blocks 73
(viewing) 103
Region definitions
exporting 323
Region List
full names in 317
Region List Menu 318
Region List Selection Follows Track Selection 311
Region names
showing full name 202
Regions 10, 202
auto-spotting 242
deleting from Playlist 164
managing 202
Movement, undoing 171
Effects of Grid mode on 171
Explained 171
placing in a Playlist 162
renaming 159
selecting 163
Selecting all to the Left 164
Selecting all to the Right 164
selecting multiple 163
sharing between Sessions 323
spotting 238
sub-Region 204
tabbing with Tab key 182
using in other Sessions 45
whole-file 204
Remove audio command 321
Remove Sync Point 244, 298
Removing Unused Regions 205
Rename Selected command 205, 322
Renaming Regions 204
Resolving SMPTE devices 221
Return to Zero 75
Revert Settings command 261
Revert To Saved command 287
Rewind 75
round robin disk allocation 307
Route window (882 Studio) 122, 264
routing (882 Studio) 24
Run MIDI In Background 233

S

sample rate 6
Sample Rate pop-up 24
Sample Rates
pull down/up 227
samples 6
Save Session 45, 285
Save Session As 46, 286
Save Session Copy In 46, 286
Saving a Session 45
Scaling 287
Scroll After Playback 311
Scroll During Playback 152, 311
Scrubbber 65, 153
using 152
Select All 296
Select All Audio command 320
Select All MIDI command 320
Select Card Type button 23
Select Unused Audio 320
Select Unused MIDI 320
Selecting
Long selection techniques 154
Playing back a selection 157
Regions
Demonstrated 163
Multiple 163
to the Left 164
to the Right 164
Using to move the play point 151
Waveforms 153
Selecting Waveforms 153
Selecting Waveforms Across Multiple Tracks 155
Selection
changing length of 154
Selection Indicator 67
Selection Techniques 156
selections
types of 294
Selector 66
shortcuts 156
toggling to Scrubber 66
Sends 39, 100
displaying on tracks 39
post-fader 39
Separate Region 297
sequencers
slaving to Pro Tools 233
Serial Ports 33, 34, 307
Session 9, 37
and Get Info 49
creating new 37
Session Files 13, 37
Session Templates 47

Sessions
maximum length of 208, 312
Sharing Regions Between Sessions 210
Show Current Time Code in Regions 317
Show Edit Window 101, 315
Show Extra Views in Edit Window command 85, 95, 316
Show Extra Views in Mix Window command 85, 95, 316
Show File Names in Region List 202, 317
Show I/O View command 85, 316
Show Inserts View command 85, 316
Show Mix Window 100, 315
Show Original Time Code in Regions 235, 317
Show Sends View 85, 316
Show Transport Window 101, 315
Show Volume Name in Regions List 203, 317
Show Volume Names in Region List 74, 317
Show/Hide Tracks 101, 315
Shuffle 63
Shuffle Mode 63, 167
Shutting Down Pro Tools 21
slaving OMS-compatible sequencer 233
Slip 63
Slip Mode 63, 168
SMpte 312
generating on-line 232
generating with Pro Tools 231
setting a start time 225
striping 221
synchronizing Pro Tools to 217
time stamping 235
SMpte devices
resolving 221
SMpte format 312
SMpte Formats 219, 224
SMpte frames 107
SMpte generators 221
SMpte Slave Driver 222, 223, 228
OMS, using with 35
SMpte Trigger 222
Software for hard drives 17

Solo 55
Solo and Mute Buttons 55, 71
Soloing Tracks 97
Sound 5
Sound Designer II 211
Sound Designer II format files 319
Sound files 9
  compacting 321
Sound Manager window 130
sound wave 5
Space bar 87
Split Stereo file 272, 287
Spot 63
Spot mode 63, 169, 238
  Auto spot Regions 242
Spotting 238
Standard MIDI file 120, 319
Start Frame 234, 313, 314
Start Frame (SMpte) 225
Starting up Pro Tools 21
Stationary 47
Stationary pad 48
Stereo file 272, 287
Stereo Mix Outputs mode 94, 312
stereo recording 126
stereo sound files 319
Stop 76
Strip Silence 299
Striping SMpte 221
Stripping Silence 176
Studio 3 222
Sub-Regions 204
Subframes 235, 239
subtractive EQ 121
Suggestions for Creating Good Mixes 251
Sync Mode pop-up 24
Sync Point 243
Synchronization 217
  black burst 246
  house sync 246
Synchronization Troubleshooting 245
Synchronizing
  sequencers to Pro Tools 233
System 7.5.2 (RAM requirements) 33
system names (past and present) 4

T
Tab key 182
Table of System Capabilities 11
Take Numbering with QuickPunch 136
Templates for Sessions 47
Tempo Data 197
Tempo Map
  importing into Session 119
Terminology 8
Time Code 106, 217, 312, 318
  generating 231
  Generating with Pro Tools 231
  Synchronizing Pro Tools to 217
  time stamping 235
  time stamping of 235, 317
Time Code dialog 313
Time Code Drop Outs 225
Time Code Formats 224
Time Code Machine 222
Time Indicator Box 68
Time Scale 105
  Bars & Beats 318
  Displaying 105, 227
  Feet + Frames 318
  Minutes:Seconds 318
  Time Code 318
Time Scale Indicator 69
Time Stamp Selected Command 236, 323
Time Stamping 235, 317
  tools 65
  selecting with “esc” 65
Track 70
  audio 70
  MIDI 70
Track Display Format 103
Track Display Format Selector 73
Track limits, all systems 11
Track Name 60, 70
Track Priority 88
  changing 95
Track Selection Follows Region List Selection 203, 311
Track Size 317
Track Transfer™ Utility Software 45, 211
Track Volume Indicator 59
Track Volume Slider 59
Tracking Suggestions 121
Tracks 10, 84
  adding new tracks to a Session 38
  audio 84
  color coding 104
  creating 84
  DAE PowerMix 11
  limits, all systems 11
  MIDI 84
  naming 38
  Reduce Track Size 102
  Show/Hide 101
  virtual track 12
Transferring Audio From an Audio CD, CD-ROM, or Qu 129–131
Transport 75, 87
  mapping a MIDI controller to 87
Transport Controls
  mapping to MIDI controller 137
Transport Window 315
Transposing MIDI Data 187
Trim Region command 161, 297
Trimmer 66
Trimming Regions 165
Troubleshooting
  synchronization 245
  Tuning up hard disks 15, 17
Types of EQ 255
types of selections 294

U
Understanding MIDI Regions 149
Understanding Waveforms 146
Undo 171, 295
Ungroup Tracks 292
Unlock Region 298
Unmute Region 298
Unused Audio 320
Use round robin allocation option in Disk Allocation 307
Use Subframes 235, 239
Using Autolocation 174
Using Film Transfer Pull Down 230

V
Vertical Interval Time Code 218
Video Slave Driver 223, 228
virtual mix 94
virtual track 12, 88, 104
and color coding 104
and switching Playback Engine 12
of each system 12, 92
Virtual Voices 40, 92
Vision 233
VITC 218, 304
and SMPTE Slave Driver 218, 238
VITC to LTC convertor 218, 238
voice allocation 41, 93
voice-off 40
Voice Selector 57, 71
Voices 10, 88, 92
DAE PowerMix 11
limits, all systems 11
virtual 92
Volume 98
Volume Graph 73
(viewing) 103
Volume Names
showing in Regions List 203

W
Waveform 73
(viewing) 103
Selecting 153
waveforms (generating overviews) 311
Whole File Region 42, 204
Working with SMPTE 215, 217
Worst Case Scaling 287

Z
zero frame 313
zero-crossing line 148
zipper noise 270
Zoomer 65